CONTENTS

CHAPTER 1: HOSPITAL SETUP .............................................................................................................1
  Verifying Hospital Information .........................................................................................................1
  Entering Demographics and Default Hospital Information ..............................................................2
  Values for Invoicing ............................................................................................................................3
  Values for Statements .........................................................................................................................8
  Values for Documents .......................................................................................................................10
  Values for Reminders .........................................................................................................................12
  Appointment and Boarding Values ....................................................................................................16
  Miscellaneous Hospital Values ..........................................................................................................18
  Specify System Information ..............................................................................................................21
  Set Advanced Hospital Options .......................................................................................................26

CHAPTER 2: SYSTEM TABLES ..............................................................................................................29
  Working with System Tables ..............................................................................................................29
  Abnormalities Table .........................................................................................................................31
  Additional Data Fields/Tables ...........................................................................................................31
  Allergy Table ....................................................................................................................................31
  Antech® Profile Names ....................................................................................................................31
  Antech® Test Names .........................................................................................................................31
  Appointment Groups .........................................................................................................................31
  Appointment Type .............................................................................................................................31
  Audit Trail .........................................................................................................................................31
  Body Subsystems Table ....................................................................................................................32
  Breed and Color Tables ....................................................................................................................32
  Chemistry Table ...............................................................................................................................32
  Client Discount Classes Table ..........................................................................................................32
  Client/Patient Relations Table ..........................................................................................................32
  Clock Out Reasons Table ..................................................................................................................32
  Company Table ..................................................................................................................................32
  Contract Prices ..................................................................................................................................32
  County Table ......................................................................................................................................33
  Discount Classes Table ......................................................................................................................33
  Discount Plan Table ...........................................................................................................................33
  Facility Table ......................................................................................................................................33
  Local Prefix Table .............................................................................................................................33
  Payment Types Table .........................................................................................................................33
  QuickBooks® Accounts Table ...........................................................................................................33
  Referral Selections Table ....................................................................................................................33
  Route Table .......................................................................................................................................34
  Special Fees Table ..............................................................................................................................34
  Species Table .....................................................................................................................................34
  Tax Table ..........................................................................................................................................34
  Units of Measure Table ....................................................................................................................34
  Vaccine Table .....................................................................................................................................34
  Variance Reasons Table ....................................................................................................................34
  VetConnect® Test Names Table ..........................................................................................................35
  Whiteboard Categories Table .............................................................................................................35
  Work Lists Table ................................................................................................................................35
  Zip Code Table ....................................................................................................................................35

CHAPTER 3: TREATMENT LIST ............................................................................................................37
CHAPTER 6: CLIENT AREA

Open a Client’s File ................................................................. 105

CHAPTER 5: CLIENT INFORMATION DISPLAY ........................................... 99
CID Speed Bar Buttons ............................................................. 102
Client Area ........................................................................... 102
Medical History Area ............................................................. 103
Medical View Tabs ................................................................. 103

CHAPTER 4: INVENTORY LIST ..................................................................... 61
Setting up Your Inventory Categories ........................................ 61
Category and Item colors ........................................................ 63
Inventory Categories Shortcut Menu ....................................... 63
Removing an Inventory Category ............................................ 63
Moving to Treatments ............................................................. 63
Undeleting Inventory Items .................................................... 64
Add an Inventory Item ............................................................ 64
Advanced Tab Values ............................................................. 70
Contract Prices Tab Values .................................................... 71
Documents Tab Values .......................................................... 71
Pharmacy Tab Values ............................................................. 72
Purchasing Tab Values .......................................................... 73
Sales Tab Values .................................................................... 74
Whiteboard Tab Values .......................................................... 74
Inventory List Shortcut Menu ................................................ 75
View and print the Whogot list ................................................. 82
Inventory Reports and Documents ......................................... 83
Update Inventory Sales .......................................................... 84
Add Vendors ........................................................................... 84
Create Purchase Orders .......................................................... 85
Purge Orders .......................................................................... 85
AVP for Canadian Clinics ........................................................ 87
Needs List ................................................................................. 87
Intelligent Inventory ............................................................... 91

Marking up Treatment Prices .................................................. 39
The Mark up Analysis window ............................................... 41
Adding a Treatment ............................................................... 42
Working with Attachments ..................................................... 48
Adding Additional Data Fields ................................................ 53
Advanced Tab Values ............................................................. 53
Contract Prices Tab Values .................................................... 55
Documents Tab Values .......................................................... 55
Whiteboard Tab Values .......................................................... 56
Laboratory Tab Values ........................................................... 56
Treatment Right-Click Menu .................................................. 56
View and print the Whogot list ............................................... 58
Undelete a deleted treatment ................................................... 59
Print the Treatment List ........................................................ 59
Sort the Treatment List report ............................................... 60
Print a Travel Sheet ............................................................... 60

Setting up Treatment Categories ............................................. 37
Adding a Treatment Category .................................................. 38
Undeleting Treatments ........................................................... 39
Marking up Treatment Prices .................................................. 39
The Mark up Analysis window ............................................... 41
Adding a Treatment ............................................................... 42
<table>
<thead>
<tr>
<th>Chapter 7: Patient Area</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choosing Patients</td>
<td>121</td>
</tr>
<tr>
<td>Add/Change Patient(s)  Information</td>
<td>121</td>
</tr>
<tr>
<td>Patient Insurance Tab</td>
<td>126</td>
</tr>
<tr>
<td>Viewing a Patient Chart</td>
<td>127</td>
</tr>
<tr>
<td>Printing a Patient Chart</td>
<td>127</td>
</tr>
<tr>
<td>Additional Chart Advanced Option</td>
<td>129</td>
</tr>
<tr>
<td>Work with the Reminders Folder</td>
<td>130</td>
</tr>
<tr>
<td>Set up a Patient Follow-up</td>
<td>132</td>
</tr>
<tr>
<td>Specify a Patient Estimate</td>
<td>133</td>
</tr>
<tr>
<td>Set up Ownership/Split-Billing</td>
<td>133</td>
</tr>
<tr>
<td>Work with the Schedule Folder</td>
<td>134</td>
</tr>
<tr>
<td>Add Patient Notes</td>
<td>136</td>
</tr>
<tr>
<td>Delete a Patient</td>
<td>136</td>
</tr>
<tr>
<td>Undelete a Patient</td>
<td>136</td>
</tr>
<tr>
<td>Move a Patient to another Owner</td>
<td>136</td>
</tr>
<tr>
<td>Access Patient Lab Information</td>
<td>136</td>
</tr>
<tr>
<td>Print Patient ID Collar</td>
<td>137</td>
</tr>
<tr>
<td>View Patient Problem History</td>
<td>137</td>
</tr>
<tr>
<td>Printing Documents for Patients</td>
<td>138</td>
</tr>
<tr>
<td>Creating a Patient Alert</td>
<td>138</td>
</tr>
<tr>
<td>Add File Attachments</td>
<td>139</td>
</tr>
<tr>
<td>Viewing Patient Photos</td>
<td>141</td>
</tr>
<tr>
<td>Print Patient Labels</td>
<td>141</td>
</tr>
<tr>
<td>Define a Patient Work List</td>
<td>142</td>
</tr>
</tbody>
</table>
### CHAPTER 8: ENTERING MEDICAL HISTORY ................................................................. 147
- Sorting Medical History .................................................................................. 147
- Use the Medical History Search Box .............................................................. 149
- Working with the Attachments Window ......................................................... 149
- Entering Medical History ............................................................................... 150
- Change Medical History Information ............................................................ 154
- Adding Medical History Notes .................................................................... 154
- Deleting and Undeleting Medical History .................................................... 155
- Printing a Rabies Certificate ......................................................................... 156
- Declining Medical History Entries ................................................................. 156
- Discounting Medical History Entries ............................................................ 156
- Printing an MS Word Document ................................................................ 156
- Printing Prescription Labels ......................................................................... 157
- Refilling Prescriptions .................................................................................. 157
- Adding File Attachments ............................................................................. 157
- Entering Medical History Forms ................................................................ 157
- Using History Mode ...................................................................................... 158
- Specifying Inventory Used ........................................................................... 158
- Moving Medical History ............................................................................... 158
- Changing Medical History Sequence ........................................................... 159
- Linking an Image to an Entry ........................................................................ 159
- Entering Vaccination Information ................................................................ 160
- Using the WhoGot List .................................................................................. 160

### CHAPTER 9: CLIENT INVOICE ..................................................................... 161
- Post Charges to the Client’s Account .............................................................. 161
- Choose not to print the client invoice ............................................................ 162
- Invoice Posting Date ..................................................................................... 162
- Entering a Payment ....................................................................................... 162
- Using a Cash Drawer ...................................................................................... 163
- Display and Print an Invoice/Receipt .............................................................. 164
- Modifying the invoice ................................................................................... 164
- Using the calculator ...................................................................................... 164
- Reprinting an Invoice .................................................................................. 164
- Return an Item .............................................................................................. 165
- Payments with X-Charge® ......................................................................... 165
- X-Charge Partial Approval Implementation .................................................. 166
- Payments with MPS ...................................................................................... 166
- MPS Partial Approval Implementation ......................................................... 167
- Handling Unprocessed Payments ................................................................. 168
- Transfer Invoices .......................................................................................... 168

### CHAPTER 10: ACCOUNTS RECEIVABLE .................................................. 171
- Printing Statements ....................................................................................... 171
- Undo Statements ............................................................................................ 172
- Reprint Statements ........................................................................................ 173
- Print the A/R Summary Report ...................................................................... 173
- Printing Collection Letters ......................................................................... 174

### CHAPTER 11: REMINDERS ....................................................................... 177
- Creating a Reminder ...................................................................................... 177
- Remind As ...................................................................................................... 178
Printing Reminder Templates ................................................................. 180
Applying Reminders Globally ................................................................. 181
Creating Patient Specific Reminders .................................................... 181
Changing a Patient Reminder Template .............................................. 182
Purging Reminders .............................................................................. 182
Printing Reminders/Reminder Analysis .............................................. 182
Printing Reminders using AVImark or MS Word* .................................. 185
E-Mailing Reminders ........................................................................... 186

CHAPTER 12: DIAGNOSIS LIST .................................................................. 187
Add a New Diagnosis Category .............................................................. 187
Add a New Diagnosis ........................................................................... 187
Undo and Redo Options ....................................................................... 188
Use Diagnosis List Shortcut Menu ....................................................... 189
Create Doctor’s Instructions ................................................................. 190
Specify Doctor’s Notes ........................................................................ 190
Enter Recommendations ..................................................................... 190
Sort Your Diagnosis List ...................................................................... 191
Enter a Treatment Protocol ................................................................. 191
Enter Diagnosis Notes ......................................................................... 191
Sort the Selected Diagnosis ............................................................... 192
Customizing Columns ......................................................................... 192
Using the Speed Bar Buttons .............................................................. 193
Changing Multiple Entries .................................................................. 193
Previewing Text .................................................................................. 193

CHAPTER 13: PROBLEM LIST .................................................................. 199
Creating your Problem List ................................................................. 199
Adding a Duplicate Problem ................................................................ 200
Selecting Problems ............................................................................. 200
Editing Changes .................................................................................. 200
Sorting and Printing the Problem List ............................................... 201
Attaching Diagnostic Protocols .......................................................... 202
Changing Quantity Values ................................................................. 202
Entering Rule-Outs .............................................................................. 203
Customizing Columns ........................................................................ 203
Using Problem List Speed Bar Buttons ............................................. 204
Changing Multiple Entries ................................................................. 204
Previewing Text in the Problem List .................................................. 204

CHAPTER 14: MEDICAL CONDITION RECORD ..................................... 207
Medical Condition Options ................................................................. 207
Work with the Objective Area .............................................................. 208
Work with Client Instructions .............................................................. 209
Work with the Assessment Area .......................................................... 209
Work with the Plan Area ..................................................................... 210
Work with Attachments ..................................................................... 210
Print Patient Report Card ................................................................. 211
Create Additional Data Fields ............................................................. 211
Print Medical Condition Record ......................................................... 212
Graph Vital Signs Data ....................................................................... 212

CHAPTER 15: PRESCRIPTION LABELS .................................................... 215
Printing a Prescription Label ........................................................................................................... 215
Use the Drug Label Wizard ............................................................................................................... 216
Type and Save a New message ......................................................................................................... 216
Automatically Display Saved Messages ............................................................................................ 216
Choose a Linked/Saved Message ...................................................................................................... 216
Choose from all Saved Messages ..................................................................................................... 216
Delete a Saved Message .................................................................................................................. 217
Refill Prescriptions ........................................................................................................................... 217
DVM Dispensary Services’ MyVetsMeds’ .......................................................................................... 218
VetCentric” Home Delivery Interface ............................................................................................... 219

CHAPTER 16:  ESTIMATES .................................................................................................................. 225
Set Up Your Estimates ....................................................................................................................... 225
Create Estimates for Patients ............................................................................................................. 228
Save a Patient Estimate as a Canned Estimate .................................................................................. 232
Select a Canned Estimate for a Patient ............................................................................................. 232
Print the Estimate ............................................................................................................................... 232
Post an Estimate ................................................................................................................................. 234
Customize Columns ............................................................................................................................. 234
Sort the Estimate Entries ..................................................................................................................... 234
Change Multiple Entries ..................................................................................................................... 234
Preview Text in the Estimate List ....................................................................................................... 235

CHAPTER 17:  APPOINTMENT CALENDAR ....................................................................................... 237
Displaying the Appointment Calendar ............................................................................................... 237
Setting up the Appointment Calendar ............................................................................................... 241
Making Appointments .......................................................................................................................... 241
Link Appointments ............................................................................................................................. 242
Grouping Appointments ...................................................................................................................... 243
Use the Appointment Openings Feature ............................................................................................ 243
Working with the Appointment Window .............................................................................................. 244
Appointments for New Clients ........................................................................................................... 246
Appointments for New Patients .......................................................................................................... 247
Working with “Stacked” Appointments ............................................................................................... 247
Locating an Appointment ..................................................................................................................... 247
Adding Appointment Notes ................................................................................................................ 247
Recurring Appointments .................................................................................................................... 247
Sizing Appointment Rows and Columns ............................................................................................. 249
Checking In an Appointment .............................................................................................................. 249
Confirming an Appointment ............................................................................................................... 249
Deleting an Appointment .................................................................................................................... 249
Return to the CID ................................................................................................................................. 250
Scheduling Next Appointment ............................................................................................................ 250
Moving Appointments ........................................................................................................................ 250
Rescheduling Appointments .............................................................................................................. 251
Printing the Appointment Schedule ................................................................................................. 251
Out of Office Schedule ....................................................................................................................... 252
Creating Block-off Exceptions ........................................................................................................... 255

CHAPTER 18:  BOARDING CALENDAR .............................................................................................. 257
Charge for Boarding ............................................................................................................................. 257
Change Boarding Calendar Views ..................................................................................................... 258
Add and Define Facility Groups .......................................................................................................... 259
Add New Facilities ............................................................................................................................... 261
CHAPTER 19: WHITEBOARD.................................................................267
Accessing the Whiteboard ..........................................................267
Patient Check-In .........................................................................267
Add Services to the Schedule Tab ..................................................268
View Patient Activities .................................................................268
Post Services from the Schedule Tab .............................................269
Release a Patient ........................................................................269
Check a Patient Out .....................................................................269
Print Reservations, Census and Whiteboard Layout ......................269
Print Scheduled Activities .........................................................270
Link a Whiteboard Category to Treatments, Items, and/or Diagnosis ..................................................270
Sort Whiteboard Entries ...............................................................270
Expand a Treatment Group on the Whiteboard ............................271
Create Additional Data Fields for Whiteboard ..............................271
Access Additional Data Fields from the Whiteboard .....................272
Record Estimate Details on the Whiteboard ..................................272

CHAPTER 20: PERIOD-TO-DATE REPORTS.................................273
Run the Reports .........................................................................273
Choose a Report .........................................................................275
See the Bottom Line .................................................................275
Account Summary .....................................................................276
Audit Trail ..................................................................................276
Controlled Substance .................................................................276
Deposit Slip ...............................................................................276
Health Plan Report .....................................................................276
Held Check Report .....................................................................276
Income by Provider Report .......................................................276
Income by Treatment Summary Report .....................................276
Inventory Used Report (Illinois) ..................................................277
Open Invoice Report ...................................................................277
Patients by Treatment Report ....................................................277
Payment Summary Report ..........................................................277
Period Totals .............................................................................277
Rabies Report ............................................................................277
Referral Report ..........................................................................278
Sales Summary ...........................................................................278
Tax by Area ...............................................................................278
Transaction Journal .....................................................................278
Transaction Summary Report .....................................................278
Treatment Control Log ...............................................................278
Unposted Transactions ...............................................................279
K.A.S.P.E.R. (Kentucky All Schedule Prescription Electronic Reporting) .................................................279
CHAPTER 21: SECURITY ADMINISTRATION ................................................................. 281
  Add Categories and Employees ................................................................. 282
  Completing the Setup .............................................................................. 285
  Change User Information ...................................................................... 285
  Change Passwords .................................................................................. 285
  Specify Doctor Sequence and Location .................................................. 285
  Authorize User Functions ...................................................................... 286
  Specify Security for other User Groups ................................................... 288
  Print the Users and Security Report ....................................................... 288
  On-going Security Administration ......................................................... 288
  Log On to AVImark ................................................................................. 288
  AVImark Compliance with FACTA Red Flags Rule ............................. 288
  AVImark Account Locking Feature ....................................................... 289

CHAPTER 22: TIME CLOCK ............................................................. 293
  Set up the Time Clock ........................................................................... 293
  Enter Clock out Reasons ...................................................................... 294
  Track Hourly Staff ................................................................................ 294
  Work with the Employee Time Card ..................................................... 295
  Use the Time Card Report ..................................................................... 295
  Undo and Redo Time Card Changes ..................................................... 296
  View History of Entry ........................................................................... 297

CHAPTER 23: WORD PROCESSING .................................................. 299
  Use Merge Words .................................................................................. 299
  Use Merge Words for Additional Data Fields ....................................... 307
  Work with Microsoft Word* .................................................................. 307

CHAPTER 24: DISCOUNT PLANS ..................................................... 309
  Defining a Discount Plan ...................................................................... 309
  Reminding for the Plan ........................................................................ 309
  Tracking Discount Plans ...................................................................... 309
  Setting Up a New Plan ......................................................................... 309
  Specifying Covered Services .............................................................. 310
  Changing the Discount Rate and/or Quantity of a Selected Service .... 311
  Putting a Patient on a Plan .................................................................... 311

CHAPTER 25: ADDITIONAL DATA FIELDS .................................... 313
  Define Additional Data Fields for Clients/Patients ............................... 313
  Set Normal Values ............................................................................... 317
  Define Additional Data Fields for Treatments ...................................... 317
  Set up a Data Table .............................................................................. 318
  Define Additional Data Fields for SOAP Records ............................... 319
  Define Additional Data Fields for Whiteboard .................................... 319
  Create New Generations of Definitions ............................................... 320
  Enter Information on the CID .............................................................. 320
  Enter Multiple Entries ......................................................................... 320
  Enter Information into the Diagnosis Window .................................... 321

CHAPTER 26: INFORMATION SEARCH ....................................... 323
  Access the Information Search Display ............................................... 323
  Utilize New Search Criteria Window ................................................... 325
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>FOLLOW-UP LIST</td>
<td>337</td>
</tr>
<tr>
<td>28</td>
<td>BACKING UP &amp; RESTORING</td>
<td>343</td>
</tr>
<tr>
<td>29</td>
<td>AVIMARK SIDEKICK</td>
<td>347</td>
</tr>
<tr>
<td>30</td>
<td>NOTE GLOSSARY AND Q &amp; A</td>
<td>349</td>
</tr>
<tr>
<td>31</td>
<td>EXPORTING TO QUICKBOOKS</td>
<td>355</td>
</tr>
<tr>
<td>32</td>
<td>CUSTOMIZING COLUMNS</td>
<td>359</td>
</tr>
</tbody>
</table>
CHAPTER 33: LAB INSTRUMENTS ................................................................. 361
Instrument Management ................................................................. 361
Set up the Abaxis’ VetScan® HMT, HM II, HMV and the VetScan® Chemistry .................................................. 365
Defining Fields and Importing Results for Abaxis’ Instruments .......................................................... 366
Set up the Abaxis’ VS2 ................................................................. 367
Interface with the CDC Hemavet® ....................................................... 368
Interface with the Hemagen® Analyst .................................................. 369
Interface with the Heska®/Sci Vet® ABC ............................................... 372
Interface with the Heska® Spotchem EZ ............................................. 373
Interface with the Heska® CBC-Diff ................................................... 375
Interface with the Heska® DCU ......................................................... 376
Interface with the IDEXX® VetTest ................................................... 377
Interface with the IDEXX® LaserCyte ................................................. 378
Interface with the IDEXX® LabREXX ................................................ 379
Interface with the Forcyte® .............................................................. 384
Interface with Antech® ................................................................. 385
Antech® XML Result Storage ............................................................ 389
Work with Requisition Management ................................................ 390
Interface with VetConnect® ............................................................. 390
Interface with VDIC VetMedStat Telemedicine ................................. 392
Interface with Vmed® Technology .................................................... 395
Abaxis’ i-STAT Integration .............................................................. 395
Abaxis’ VetScan VSpro Integration ................................................... 396
Sci Vet abc Plus+ Integration ........................................................... 398

CHAPTER 34: AVIMARK SITE SUPPORT ........................................................... 401
Set up Site Support ........................................................................ 401
Set up Users and Security ............................................................... 401
Work with Site Manager ................................................................ 402
Choose a Treatment and Inventory List ......................................... 403
Change Site Options .................................................................... 404

CHAPTER 35: PRACTICE ANALYSIS .............................................................. 407
Use the Different Reports ............................................................... 407
Work with Graphs ....................................................................... 408
Print, Save, Export, and/or Email Reports ....................................... 409

CHAPTER 36: DENTAL CHART ................................................................. 411
Working with the Dental Chart ....................................................... 411
Record Probing Depths ................................................................ 413
Record Gingival Recession ............................................................. 413
View Previous Dental Charts ........................................................ 414
Work with Annotations ................................................................ 414
Create Dental Abnormalities ......................................................... 415
Print the Dental Chart ................................................................... 416
AFP® Imaging .............................................................................. 416
CHAPTER 37: DIGITAL RADIOGRAPHY ................................................................. 419
  DragonflyPACS® ............................................................................................ 419
  IDEXX® InterLink Technology for DICOM Imaging ........................................ 427
  Radiographs Medical History View Tab .......................................................... 432
  Sound-Eklin® DICOM Integration .................................................................... 434

CHAPTER 38: DOCUMENT MANAGEMENT ....................................................... 437
  Document Management Window .................................................................... 437
  Lifelearn .......................................................................................................... 441

CHAPTER 39: WORK LIST .................................................................................. 445
  Accessing the Work List .................................................................................. 445
  Toggling Between Lists .................................................................................. 445
  Manually Assign a Patient to Work List .......................................................... 445
  Automatically Link a Patient to a Work List .................................................... 446
  Enter/View Work List Notes ........................................................................... 446
  Use the Work List ........................................................................................... 447
  Posting Work List Entries .............................................................................. 447
  Renew a Patient on the Work List ................................................................... 447
  Go to the Selected Patient .............................................................................. 447
  Transfer a Patient to Another List ................................................................... 447
  Additional Work List Options ......................................................................... 448
  Add Patient to Work List at Check-In .............................................................. 448
  Work Lists More Stuff .................................................................................... 449

CHAPTER 40: AVIMARK EQ ............................................................................... 451
  Client Selection ............................................................................................... 451
  Hospital Setup Advanced Options ................................................................... 452
  System Tables .................................................................................................. 453
  Split Billing ....................................................................................................... 457
  Patient Area ...................................................................................................... 458
  Microchip ID Prompt ....................................................................................... 464
  Treatment and Inventory List Features ............................................................ 464
  Appointment Calendar ..................................................................................... 464
  Word Processing and Documents ..................................................................... 467
  Hoof Chart ....................................................................................................... 467
  Dental Chart ..................................................................................................... 469
Introduction
Welcome to the New Edition of AVImark User’s Manual. We’re pleased to introduce you to this informational guide to all of the task-orientated functions and window views within the AVImark software. Our goal is to make your experience with learning the AVImark software as quickly and easily as possible. The AVImark User’s Manual and the F1 help file is now loaded with the most up to date AVImark functions as well as views and contain all the information that you will need to quickly navigate through the program and learn its various functions to suite your clinical or hospital needs.

Using this Manual
This manual works like a reference. Start with a task or a topic that you need help on and then look it up in the Table of Contents or Index. When you have found the topic you need help on, follow the step-by-step instructions. Sometimes you will be referred to additional information found in the F1 Help.

As you utilize this manual you will notice that each chapter contains images within the left margin, these icons represent specific keystrokes, shortcut buttons and additional references.

Important information and tips
For more information, search the F1 Help Index

Using the F1 Help Index
Access the F1 Help by using the F1 key anywhere in the AVImark program. Use the Contents tab to browse through all of the manual topics. Or use the Search tab to search the Help for a specific topic.

The information contained within this help file is referencing AVImark Version 2010. For instructions on previous versions please contact Technical Support at 877-838-9273, option 1.

1. Most screen shots are interactive; this means you are able to click on different sections of the AVImark window screen shots and it will either take you to a different section of the program or will display a window giving you more information.

2. Each “section” contains a Table of Contents; we created this feature to allow you to go to one main screen and access others for that topic.

AVmark Hot Keys

Using AVImark Help
Access and view AVImark Help information from any window in the AVImark program.

View help information on a topic by topic basis or in the following ways:
1. If you are working in a certain field or window in AVImark, pressing the F1 key on your keyboard will display this help window.
2. Within each AVImark Help topic there are “jumps” that will take you to other specialized help topics. These links are displayed in blue lettering and underlined. The blue lettered words are linked to other topics relating to the help information currently being viewed.
3. After clicking on one of these links, you can immediately return to the original help topic by clicking the Back button on the AVImark Help title bar at the top of the help window.
4. The help file, also, contains green lettered words that when clicked will display more information about the green lettered topic.
Video Tutorials and other sources for help

McAllister Software Systems offers a variety of ways to get help and training in using the AVImark practice management software including video tutorials, web-based and telephone training, Authorized Training Representatives, and regional seminars. Visit our website at www.avimark.net to see what’s available to you.

Open Source Libraries

AVImark is proud to use the following open-source libraries:

- The Indy Project
  http://www.indyproject.org
- Jedi Code Library
  http://sourceforge.net/projects/jcl/
- Jedi VCL for Delphi
  http://sourceforge.net/projects/jvcl
- Portable Network Graphics Delphi
  http://pngdelphi.sourceforge.net/
- TDBF
  http://tdbf.sourceforge.net/
- TurboPower Abbrevia
  http://sourceforge.net/projects/tpabbrevia/
- TurboPower Async Professional
  http://sourceforge.net/projects/tapapro/
- TurboPower B-Tree Filer
  http://sourceforge.net/projects/tpbtreefiler/
- TurboPower Essentials
  http://sourceforge.net/projects/tpessence/
- TurboPower LockBox
  http://sourceforge.net/projects/tplockbox/
- TurboPower Orpheus
  http://sourceforge.net/projects/tporpheus/
- TurboPower SysTools
  http://sourceforge.net/projects/tpsystools/
- TurboPower XML Partner
  http://sourceforge.net/projects/tpxmlpartner/

SQL, or sequel, is short for Structured Query Language: SQL is a computer language for data retrieval and manipulation. Using a SQL database presents the data in a standardized way so that your data can be analyzed by other applications besides AVImark. For instance, there are tools and software available for creating your own customized information searches and reports allowing you to do your own comprehensive data analysis outside of AVImark through the SQL software. The motivation behind SQL is to allow customers more flexibility in data management, retrieval and manipulation. This kind of flexibility is not available in AVImark’s Classic or Client/Server versions that use non-SQL database systems.
## AVImark Hot Key Cheat Sheet

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td>Boarding</td>
</tr>
<tr>
<td>F2</td>
<td>New</td>
</tr>
<tr>
<td></td>
<td>Close Client File</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
</tr>
<tr>
<td>F3</td>
<td>Change</td>
</tr>
<tr>
<td></td>
<td>Field to Field</td>
</tr>
<tr>
<td></td>
<td>Work List</td>
</tr>
<tr>
<td>F4</td>
<td>Remove</td>
</tr>
<tr>
<td></td>
<td>Choose Client/Patient</td>
</tr>
<tr>
<td></td>
<td>Close AVImark</td>
</tr>
<tr>
<td>F5</td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Doctor’s Instructions</td>
</tr>
<tr>
<td></td>
<td>Change Patient Status</td>
</tr>
<tr>
<td>F6</td>
<td>Check In</td>
</tr>
<tr>
<td></td>
<td>Patient Chart</td>
</tr>
<tr>
<td></td>
<td>Whiteboard</td>
</tr>
<tr>
<td>F7</td>
<td>Choose Treatment</td>
</tr>
<tr>
<td></td>
<td>Diagnosis List</td>
</tr>
<tr>
<td></td>
<td>Invoice Instructions</td>
</tr>
<tr>
<td>F8</td>
<td>Post</td>
</tr>
<tr>
<td></td>
<td>Release Patient</td>
</tr>
<tr>
<td></td>
<td>Inventory List</td>
</tr>
<tr>
<td>F9</td>
<td>Appointment Calendar</td>
</tr>
<tr>
<td></td>
<td>Additional Data Fields</td>
</tr>
<tr>
<td></td>
<td>History Mode</td>
</tr>
<tr>
<td>F10</td>
<td>Accounting</td>
</tr>
<tr>
<td></td>
<td>E-Travel Sheet</td>
</tr>
<tr>
<td>F11</td>
<td>Refresh</td>
</tr>
<tr>
<td></td>
<td>Scroll through clients Numerically</td>
</tr>
<tr>
<td>F12</td>
<td>Log-on</td>
</tr>
<tr>
<td></td>
<td>Scroll through clients alphabetically</td>
</tr>
</tbody>
</table>
CHAPTER 1: HOSPITAL SETUP

In this chapter you will learn about...

» Verifying Hospital Information on page 1
» Entering Demographics and Default Hospital Information on page 2
» Values for Invoicing on page 3
» Values for Statements on page 8
» Values for Documents on page 10
» Values for Reminders on page 12
» Appointment and Boarding Values on page 16
» Miscellaneous Hospital Values on page 18
» Specify System Information on page 21
» Set Advanced Hospital Options on page 26

Verifying Hospital Information
When you begin using AVImark, you will first need to access Hospital Setup and verify the Hospital Information is correct. The Hospital Information area is encrypted and will not allow you to make changes without help from Technical Support. Call the Support department for assistance at 877-838-9273. It is from Hospital Setup that you will specify certain default information such as tax rates, discount values, and so on. Information about your hospital is entered into a series of “folders”, each with its own Folder Tab at the top of the AVImark Hospital Setup display.

For clinics setting up Users & Security or those that have already set up security, it is highly recommended that hospital values be defined under the Advanced Options area. By using the Advanced options, hospital values can be defined for each user or site.

• On the Client Information Display (CID), open the Work with menu and click Hospital Setup to display the Hospital Setup window.
Entering Demographics and Default Hospital Information

In addition to verifying the correctness of the Hospital Information, it is from the Demographics window where you will specify each of the “Default Values” that will be entered automatically when a new client is added to your files.

DEA no.
AVImark provides controlled substance reports to meet the requirements for Alabama, California, Kentucky, Michigan, New York and Oklahoma. The hospital’s DEA number will need to be entered for the use within these reports.

• Type the correct DEA number for the hospital.

Slogan
AVImark allows you to enter a Slogan to be printed at the top of all Invoices.

• If appropriate, type a Hospital Slogan to be printed on Invoices.

Logo
AVImark allows you to link a Logo to be printed on Invoices. This must be either a bmp, jpeg, or tif file and must be stored in the \PHOTOS folder of the server computer.

• If appropriate, type the Logo name without the extension.

When printing the invoice the quality must be set to Picture in order for the logo to be included on the invoice.

Logo Margins
The Logo margins allow you to specify appropriate margins to position the logo on the invoice in inches (use decimal values such as 2.25 for 2 1/4 inches). This will place the logo to a area on the invoice so as to not interfere with the printing of the patient’s picture if applicable.

• If appropriate, enter the Left and Top margin for placement of the Logo.

• If appropriate, click Border if you wish to place a Border around the Logo.

Web site
You may specify your clinic’s web site in this field giving you the capability to merge into MS Word or Open Office documents. This information will merge by using the merge word <web-address> on your documents.

• If appropriate, type the Hospital’s web site address.

Default City, State and Zip code
This is the name of the city, state and zip code you wish to be entered each time you add a new client to your records. This would typically be the information where most of your clients reside.

• Type the City name.

• Use the TAB key to move to the State field and type the 2-letter abbreviation for the State.

• Use the TAB key to move to the Zip field and type the Zip Code.

Default Area Code
This is the Area Code you wish to be automatically assigned to new clients.

• Type the Area Code.

Default Company Number
This will be the default Company number which will be assigned to newly added clients. AVImark automatically sets this value to 01. It is recommended that you leave this value set to 01 for your regular client records.
Default Client title
This will be the title you wish to be entered automatically for new clients.

- Type the **Client title**.

Auto-assign Client and Patient folder numbers
When selected, these options cause AVImark to automatically assign newly added clients/patients a folder number. These folder numbers are assigned in a simple “one-up” fashion, starting with 1. You may however, choose to start your folder numbers at any number you wish.

- If appropriate, select **Client folder no.** and/or **Patient folder no.**
- If appropriate, use the **Starting at** box, type or select the folder number you wish to start from.

Zip code lookup length (U.S. and Canadian usage)
This field defaults to 5 characters, which is the normal length for U.S. clinics, but because of the length and character assignment being different in Canada this field can adapt to 3 characters allowing the Canadian clinics full use of the feature. *(There are utility programs available to help change your Zip Code System Table to the new length. Please call technical support at 1-877-838-9273 for assistance in running Zipto Three and DelDup.)*

To learn more about:
- Hospital Demographics

Search the Help for:
- Hospital Demographics; Demographics

Values for Invoicing
Under this tab the values for pricing, discounting, taxing and other monetary issues for your clinic will be determined. The window is divided into an upper and lower section; the lower section having three sub-tabs specifying Formatting, Discounting and Fees.

- On the Hospital Setup window, click the **Invoicing** tab to display the Invoicing Values set up folder.
Tax Values
In these fields you will set the state (GST) and local (PST) tax rates along with your tax registration number for your area. If, however, you live in an area where more than one set of rates apply, you will need to become familiar with “CHAPTER 2: SYSTEM TABLES, Tax Table”. If you have set up a Tax Table and linked the various tax areas with appropriate Zip Codes, clients will be taxed accordingly. If you sell taxable items to a client whose Zip Code is either not in the Zip Code table or does not have a Tax Area linked to it, the client will be charged whatever tax rates you have assigned here.

• Specify the correct tax rates using decimal values.

Canadian Harmonized Tax
For those practices located in Canada which are required to charge a Harmonized Tax (HST) an HST field is available. For those clinics NOT required to use HST; the GST and PST fields are still available and these users will NOT make any changes to their current setup. When entering a value in the HST field, will automatically set the GST and PST amounts to 0. This is to safe guard inadvertently over taxing clients.

Kenai Peninsula Borough, Alaska Sales Tax Cap
According to the Kenai Peninsula Borough, Alaska tax code, businesses are only allowed to charge tax on the first 500.00 of an invoice. To help make this compliance easier for AVImark users, we have added a new Advanced Option – “Tax First $500 Only”. If you fall under this rule, you will need to open the Advanced Options (the wrench speed bar button) and set the option for “Tax First $500 Only” to True. This will only apply your tax rate to the first $500 of the invoice and after that will not apply any tax.

IMPORTANT: If you find it necessary to remove part of the invoice you MUST remove the entire invoice from medical history and accounting and reapply it. Without removing all entries from the invoice, the tax will not be calculated correctly on your reports.

Next invoice no.
This is a count forward feature that allows you to enter a beginning invoice number at will.

• If appropriate, enter a Next invoice number.

Auto-payment
You are able to specify how you want AVImark to prompt you for payments on posted charges, either “(none)”, for the “Invoice amount”, or for the “Balance due”.

• Use the Auto-payment drop-down list and select how you wish to be prompted for payments.

Open change-maker if payment amount
Payments taken that are greater than the Invoice total for a client that has an outstanding balance does not have to be applied to the entire balance. If the option “> Invoice total” is selected and a client makes a payment that is greater than the invoice total, but less than the outstanding balance, the Change-maker window will be prompted, allowing change to be returned to the client, rather than applying the change to the outstanding balance.

The “> Balance due” option will allow AVImark to perform as it has previously. The Change-maker window will not be prompted when a payment is made that is greater than the invoice total but less than the outstanding balance. The change would be automatically applied to the outstanding balance. The “(never)” option will prevent the Change-maker window from being prompted even when the client has no outstanding balance and a payment is made that is greater than the invoice total.

• Use the Open change-maker if payment amount drop-down list and select how you wish to use the Change-maker.

Returned check fee
This is the amount you would like to charge the client when a check is returned. The fee is automatically added to the clients balance when you return a check in the accounting window of the client.
- Specify the amount to be applied for returned checks. For example: (20.00).

**Default type**
Using the “Default type” menu, you may specify the type of payment you wish AVImark to default to; Check, Cash or None. If “None” is chosen as the default, AVImark requires you to manually select the payment type before the payment can be entered. This is intended to improve accuracy of entering different payment types.

- Use the **Default type** drop-down list and select the default payment type.

**Sub-tab, Formatting**

**Invoice title**
You may specify an alternate title for your invoices using up to 13 characters. For example: (RECEIPT). If no title is entered, the word INVOICE will be printed.

- If appropriate, type an alternate **Invoice title**.

**Print summary**
AVImark gives you the ability to print invoice totals in a ‘Vertical’ or ‘Horizontal’ manner.

- Use the **Print summary** drop-down list and select the manner you wish to print invoices.

**Print charges**
AVImark gives you a few options when printing charges on the invoice. You may; “Group by provider” (which will organize line items by doctor), “Group by category” (which will organize and total by category name), print “Chronologically”, or, print “As Shown” (how charges are displayed in Medical History). When “Group by category” is selected, the “Category summary only” option will become active by appearing in red. With this option checked, the printed invoice will show charges by category only. No line items will be listed.

- Use the **Print charges** drop-down list and select how you wish to print charges on the invoice.

**Options**
From this area of the Formatting sub-folder, AVImark allows you to choose what information you would like displayed on the invoice. You may select as many options that you wish.

- Select the **Options** you wish to have printed on the invoice.

To learn more about: Invoice options and their functions
Search the Help for: Invoicing Tab

**Closing notation**
In this field, AVImark allows you to enter notes that you want to periodically appear at the bottom of the client’s invoice. A different Closing Notation may be specified for each Company within AVImark.

- If appropriate, type a **Closing notation**.

**Sub-tab, Discounting**

**Non-discounted prices**
This option allows you to have AVImark print the regular (non-discounted) prices for discounted services and/or items on the client invoice. In this case, you will also want to make sure to check the next box, “Print total discount” so that the amount of the discount is printed on the invoice summary line below the list of charges.

- If appropriate, select **Non-discounted prices**.

**Print total discount**
This option allows you to have the total of all discounts printed on the invoice.
If appropriate, and if **Non-discounted prices** is checked, select **Print total discount**.

*Line item discounts*

With this option checked, AVImark will list retail, discount amount and net price as column headings in the line item section of the invoice. When using this option, ensure the “Non-discounted prices” box is not checked.

- If appropriate, select **Line item discount**.

*Cash discount %*

This field allows you to specify a percentage that you allow a discount for cash (or check) payments. If, once the payment has been entered in the payment window, you wish to change the payment type; AVImark will recalculate the amount due. If the payment (and appropriate cash discount amount) is already recorded on the invoice, you will need to delete these before you change the payment type.

- If appropriate, enter a **Cash discount** percentage using a whole number.

*Discount rates*

When you want to specify discounts for certain classes of clients on certain treatments and/or inventory items, you will do so on this display. AVImark allows you to give clients a class number for the sole purpose of determining what discount rate the client is to receive. For example, you would gather a homogenous group of clients together (e.g. senior citizens) and give that group a specific class number. By default, AVImark assigns a class number of 1 to all clients. There is no limit to the number of client classes you can create. In addition to clients having a class number, all treatments and inventory items can have a class number. Unlimited class numbers can also be created for treatments and items. AVImark calculates discounts to clients based on how you define which classes of clients are to receive what discount percentage for each treatment and/or inventory class. Inventory and Treatments may also be discounted on a cost plus basis for any given client class.

- In the **Discount rates** section, **right-click** and from the shortcut menu click **New** to display the New Discount Rate window.

- Use the **Client Class** drop-down list and select a **Client Group**. These are the groups that are set up in System Tables.

- To create a new Client Class from this window, click the **Paper** button next to the **Client Class** field.

- From the **New Client Discount Class Entry** window, enter a numbered **Code** and a **Discount Class** name.

- Click **OK** and select that **Client Group** from the **Client Class** drop-down list. This will add the New Client Class to System Tables as well.

- Use the **Discount Class** drop-down list and select the **class** of treatments and/or items which are to be discounted for the selected Client Class. Treatments and inventory must be assigned these client discount groups from within your Treatment and Inventory list.

- To create a new Discount Class from this window, click the **Paper** button next to the **Discount Class** field.

- From the **New Discount Class Entry** window, enter a numbered **Code** and a **Discount Class** name.

- Click **OK** and select that **Discount Class** from the **Discount Class** drop-down list. This will add the New Discount Class to System Tables as well.

- In the **Rate** box, type or select the correct discount percentage.

- If appropriate, select the **Cost Plus** and click **OK**.
You may use a negative discount percentage value to effectively surcharge certain classes of clients.

Cost Plus Discounts
The “Cost Plus” field allows you to tell AVImark whether or not you would like a certain client class to be charged your cost for a certain Treatment and/or Inventory class or cost PLUS a specified percentage. If the “Cost Plus” option is checked and a zero has been specified in the “Rate” field, AVImark will charge the client the Markup Cost of the item and the Cost of the treatment. With the “Cost Plus” option checked and a percentage specified in the “Rate” field, AVImark will charge the client the Markup Cost of the item, the Cost of treatment PLUS the specified percentage.

- In the Discount Rates section, select the correct Client Class.
- Right-click and from the shortcut menu click Change to display the Change Discount Rate window.
- To charge the client Cost only, type or select 0 in the Rate box and select Cost Plus.
- To charge the client Cost Plus, type or select the correct percentage in the Rate box and select Cost Plus.

To learn more about:
- Tax Values
- Discount Rate

Search the Help for:
- Tax Values; Invoicing Tab
- Discount Rates; Discounting sub-tab

Sub-tab, Fees

Fees
AVImark gives you the ability to add various fees and minimum values to the retail price of inventory items and/or treatments. For these fees to be added, you must specify the appropriate Action Code for each item. For more information on Action Codes, refer to "CHAPTER 4: INVENTORY LIST"

- Using the First column, enter the amount you wish to add to the normal price charged for the quantity of items dispensed. If this amount is less than the specified Minimum value, AVImark will charge the minimum amount.
- Using the Additional column, enter the amount you wish to add to the normal price charged, AFTER the initial entry of that particular code has been added to Medical History.

<table>
<thead>
<tr>
<th>Fees</th>
<th>First</th>
<th>Additional</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prescription</td>
<td>16.15</td>
<td>16.15</td>
<td>16.15</td>
</tr>
<tr>
<td>Handling</td>
<td>8.95</td>
<td>8.95</td>
<td>10.15</td>
</tr>
<tr>
<td>Intravenous Injection</td>
<td>18.50</td>
<td>18.50</td>
<td>20.50</td>
</tr>
<tr>
<td>Intra-muscular Injection</td>
<td>17.50</td>
<td>17.50</td>
<td>19.50</td>
</tr>
</tbody>
</table>

The initial entry of a code must remain un-posted for the Additional fee to be applied to all additional entries of the same code.

- Using the Minimum column, enter the minimum amount you wish to charge.
- If appropriate, select Refund fee on returned items to refund the fee as well as the item price when
the item is returned.

To learn more about:  
Inventory/Treatment Fees

Search the Help for:  
Fees; Fees sub-tab

Values for Statements
From this tab, AVImark lets you set the values for printing of your detailed statements at the end of any period (usually once a month).

• On the Hospital Setup window, click the **Statements** tab to display the Statements Values set up folder.

Service charge
This field allows you to specify the service charge you wish to charge for overdue accounts. This amount will need to be entered as a decimal. For example: 0.015 equals 1½%.

• Enter the amount you wish to charge for overdue accounts.

Minimum
This is the amount you wish AVImark to charge should the Service Charge be less than the minimum value specified.

• If appropriate, enter a **Minimum Service Charge**.

Days overdue
This field allows you to specify the number of days after which an account will have service charges applied. AVImark only charges interest on the number of days greater than what is specified here.

• Enter the number of days after which an account will have service charges applied.

Handling fee
AVImark allows you to add a fee to every client that owes you money whenever you print monthly statements, with the following exceptions: If a client has a Client Code “W” (Waive Charge) or the “I” code (Inactive Client), they will not be charged either the service charge or the handling fee. By “Client Code”, we are
referring to the “Code” field in the Client area of the Client Information Display. For more information on “Client Codes”, refer to “CHAPTER 6: CLIENT AREA”.

• Enter the amount of the Handling fee you wish to apply to every account that is being billed.

Messages
AVImark will print an appropriate message on a client’s statement depending on how many days the client has an outstanding balance; either current, over 30, over 60, or over 90 days. You may type any message you feel appropriate for these situations.

• If appropriate, type statement messages for the different situations.

Options
This area of the Statements folder allows you to select what information you would like displayed on the statement. You may select as many options that you wish. The following is a list of the available options and their meaning:

• Select the Options you wish to have displayed on the client’s statement.

Interest notice
This notice may be any message you would like to be printed at the bottom of the client invoice any time the client charges their balance. In addition, AVImark will print this message at the bottom of all statements.

Print patient summary
This option allows you to print a patient by patient summary of charges on each statement.

Print account aging
AVImark gives you the ability to print an aged account summary at the bottom of each statement showing what portion of the client’s balance is current, over 30 days past due, over 60 and so on.

Show folder number
This option allows you to print the client’s folder number on the statements instead of the client’s account number.

Don’t apply late fee if payment received
If you have received a payment of any amount from the client within the number of days specified in the “Days overdue” field, AVImark will not charge a service charge.

• If appropriate, select Don’t apply late fee if payment received.

Envelope
This option allows you to adjust the statement format to fit the envelope format you choose.

• If appropriate, use the Envelope drop-down list and select the correct envelope type.

Billing document
In this field, you may type the name of a Microsoft Word® document that you would like AVImark to print along with any unpaid invoice. This document will only print if the client’s balance exceeds the amount entered in the “Print only if balance at least” field. There is a default setting of 1.00 but you may change this amount if necessary.

• If appropriate, type the name of the Microsoft Word® document you wish to print.

• Enter a dollar amount in the Print only if balance at least field.

Closing notation
In this field AVImark allows you to enter notes you want to appear at the bottom of the client’s monthly
statement. A separate Closing Notation may be entered for each Company within AVImark.

- If appropriate, type a Closing notation.

### Values for Documents

The Documents folder allows you to specify the size and quantity of various documents and labels that AVImark will print for you. You will also use this screen to tell AVImark the name of the MS Word document you want to use for your Rabies certificate.

- On the Hospital Setup window, click the Documents tab to display the Documents Values set up folder.

#### Drug Labels

These fields allow you to specify the true size of the height, width, font size, and the left/top margins (in inches) for the prescription labels you will be using.

- Using the Height, Width, Left margin, Top margin and Font size fields, enter the correct size of your Drug labels.

#### Sequence number

This field allows you to enter a beginning label sequence number (or prescription number) to be printed on all prescription labels. AVImark will automatically sequence from the number entered.

- If appropriate, enter a beginning Sequence number.

#### Include

The Include area allows you to specify what information will be displayed on the prescription label. The option...
“Doctor’s license” is specific for New Jersey clinics and when selected, cannot be used in conjunction with
the DEA #. Just below the option check boxes, you also have the option to include on the label any brief note that
will be printed at the bottom of the label. For example: “For veterinary use only”, or “Keep out of reach of
children”.

- Select the Include options you wish to have displayed on the prescription labels.
- If appropriate, type a brief note to have displayed at the bottom of the label.

Copies to print
This area allows you to specify the number of copies of the daily deposit slip, client invoice, rabies certificate,
and patient charts to be printed at the time the invoice is printed. Also, you may specify the number of drug
labels you want printed at a time.

- Enter the number of copies you wish to have printed for each of the items.

Photographs
These fields allow you to specify the margins and dimensions of printed photos. These dimensions only apply
when printing images from the AVImark Image Editor window.

- Using the Left margin, Top margin, Width, and Height fields enter the dimensions for printed photos
  from the AVImark Image Editor.

Patient Labels
These fields allow you to specify the height, top and left margins, and the font size settings for your patient
labels. You may also choose to include basic client or patient information. When using labels that are one inch
in height and you wish to include client information, check the option ‘New Page after Client Info’. This will
allow an automatic page break after the client information is printed and force the patient information onto a
second label.

- Using the Height, Font, Top and Left margin fields enter the correct size of your Patient labels.

Mailing labels
These fields allow you to specify the height, top and left margins settings for your mailing labels.

- Using the Height, Top and Left margin fields enter the correct size of your Mailing labels.

Referral letter
This field gives you the ability to specify a Microsoft Word® Document that you would like printed for each
referring client included on the AVImark Referral report. These documents would be letters you want to
send to referring clients (not clients who have been referred) thanking them for referring new clients to you.
Understand that the AVImark Referral Report only includes new clients that have been added to your system
AND that have received an invoice during the period of time reported. Therefore, AVImark clients who have
referred these new customers to you would be the clients receiving the thank-you letters. In order for these
documents to be addressed to the referring client and be worded appropriately regarding the referred client,
you will need to be familiar with the AVImark merge words relating to referral correspondence. These special
words are listed in “CHAPTER 23: WORD PROCESSING”.

- Type the name of the Microsoft Word® Document that you wish to have printed for each referring
  client included on the Referral Report.

- Select Print? To have the document printed when printing the Referral Report.

Check-in
AVImark gives you the ability to specify a Microsoft Word® document that will be printed when you check-in a
patient from either the Boarding Calendar or the CID. You may specify multiple documents by choosing from a
list of client education documents or documents which you have created. This is accomplished by entering the
document names into this field separated by commas. When a patient is checked-in you will be prompted by a
screen to select a document to print. This feature will default to the first document that is listed in this field.

- Type the name of the Microsoft Word® Document(s) that you wish to have printed when you check-in a patient.

Rabies certificate
If this field is left blank (default), AVImark will print the rabies certificate form that is included with the AVImark program. You may however, customize your own Rabies certificate using Microsoft Word® and entering the name of the document in this field. This document must be saved in the My Documents folder on the server computer.

- Type the name of the Microsoft Word® Document you wish to use for the Rabies certificate, or leave this field blank to print the default certificate.

Chart length
AVImark gives you the ability to specify the length of the Patient chart by number of Days, Months, or Visits.

- Enter a whole number in the first field and then use the drop-down list and select Days, Months, or Visits.

To learn more about: Search the Help for:
Drug/Patient Labels Labels; Prescription Labels; Documents Tab

Values for Reminders
The Reminder folder allows you to specify the values in which to print your Reminders. In addition, if you choose to send Reminders through a source other then AVImark, you will need to specify that information from this folder. Should you need any assistance with setting up your reminder specifications, contact AVImark Technical Support at 877-838-9273.

Reminder intervals
It is from this area that you will tell AVImark the interval in which you wish to print/send Reminders. The “Reminder cycle ___ days” field will be the default setting for the number of days between sending of the first Reminder. For example: If you print Reminders on a monthly basis, you will want to enter either 30 or 31 in this field to represent a typical month. If you send Reminders twice a month, you would want to enter 15 and so on. Next, if you send out second and even third Reminders, you will need to specify the interval days between Reminders in the fields, “Wait ___ days, then send second”, and “Wait ___ days, then send third”. The way this works when sending second and third Reminders is AVImark looks at the date you sent your first Reminder. It then looks back from that date the number of days you specified for your second, and then it looks forward the number of days specified in the “Reminder cycle ___ days”. For your third Reminders, AVImark looks at the beginning date for the second Reminder interval and then looks back the number of days you specified for your third. Then it looks forward the number of days specified in the “Reminder cycle ___ days”. For a better perspective, let’s say on July 1st, you mail reminders to your clients. The “Reminder cycle ___ days” is 15 days, the “Wait ___ days, then send second” is 30 days and the “Wait ___ days, then send third” is 30 days. The first reminders will go to clients that have patients due from July 1st to July 15th. Second reminders will go to clients with patients due from June 1st to June 15th (back 30 days from July 1st, then forward 15 days). Third reminders will be sent to clients with patients due for treatments from May 1st to May 15th (back 30 days from the starting date of the Second Notices then forward 15 days).
Remind for overdue treatments
AVImark gives you the option to include past due treatments on your Reminder cards (or letters) along with the treatments that are due during a given reminder cycle. The past due treatments will only print on the card if the patient was to receive a card anyway for a treatment that is due during the cycle.

- If appropriate, select Remind for overdue treatments.

Print dates as mm/yy
This option allows you to have just the month and year of the due treatment printed on the card. Unchecked the date will be displayed as month, day and year.

- If appropriate, select Print dates as mm/yy.

Restrict to patients w/o appointments
This option allows you to prevent reminders from being printed for those clients who currently have an appointment on the AVImark Appointment Calendar. When using this option the appointment must fall within the time frame of the printing of reminders and will apply to First Reminders only.

- If appropriate, select Restrict to patient’s w/o appointments.

Reminders per page
If you are using the page formats used with laser printers that allow either three or four cards per page, AVImark allows you to specify how many reminders to print per page. If you choose “One”, AVImark will print either one-up tractor-feed cards or an MS Word document set up as a full size letter.

- Use the Reminders per page drop-down list and select the number of reminders to print per page.

E-Mail options
The AVImark e-mail reminder function allows you to send e-mail messages to those clients who have a valid e-mail address and own animals that are either due or past due for remindable services. You will probably do this in two steps by printing reminder documents for those clients who don’t have an e-mail address and then sending e-mail messages to the rest. However, you may not want to depend entirely upon the success of e-mail reminders, especially for clients who have not responded to their first message. In this case, by using these options you may force AVImark to send reminders to due and/or overdue patients, and even to those clients who have e-mail addresses. AVImark checks these boxes as a default setting but you may uncheck them if appropriate.

- If appropriate, uncheck the e-mail option(s) that you wish.

Reminder magazine options
AVImark gives you the ability to export your Reminder information to Healthy Pet®, Paw Print®, Pet Quarterly®, US NetCom®, Jabez Communications® or AVImark Online Reminders. Prior to using this feature you will need
to obtain a hospital identification number from the organization you will be working with. Unless specifically directed by the Healthy Pet®, Paw Print®, Pet Quarterly®, US NetCom®, Jabez® Organizations or AVImark Online Reminders do not put anything in the Clinic ID field.

- Use the **Reminder magazine options** drop-down list and select the correct organization.
- If you wish to use your ISP for sending reminder information to one of the reminder organizations select **Send via internet**.
- If a firewall is installed, select **Passive connection**.

**Edit and print reminders with Microsoft Word®**
AVImark gives you the ability to use Microsoft Word® documents as your Reminders. In addition, when printing one reminder card for a client who has more than one animal due for treatments during a given reminder cycle, you may specify the name of that document in the “Multi-patient document” field. Using this feature, you will need to select the one per page option. Should you choose to print multiple reminder post cards per page (either three or four), you must first indicate how many reminders per page you want to print. Then you will need to set up your post card document using Microsoft Word® Table support, in a manner similar to that used in the sample reminder documents THREE.DOC and FOUR.DOC, found on the AVImark bulletin board.

- If appropriate, select **Microsoft Word®**.
- If you wish to print consolidated Reminder, type the document name in the **Multi-patient Document** field.

**Edit and print Reminders with AVImark**
When using AVImark to edit and print Reminders, AVImark gives you the ability to create Reminder text for your first, second, third and consolidated reminders. In addition, AVImark allows you to have up to 10 alternate reminder texts. This feature allows you to choose alternate messages when printing reminders for a prior period or for a particular treatment.

- If appropriate, select **AVImark**.
- Select **First Reminder text** to display the First Reminder text window.

![First reminder - No. 1](image)

- Type the Reminder text you wish to have printed on the first reminder card. After each line of text, press ENTER. For example:
Dear Mr./Mrs. <last-name>,

This is an important reminder letting you know that <animal> is due for the following treatments. Please call <co-phone> for an appointment.

<list>
  <first-name> <last-name>
  <address>
  <city>, <st> <zip>
</list>

Click **Done** when finished.

If appropriate, repeat the procedure for the second and third Reminder cards.

To use one Reminder card for multiple patients, select **Consolidated reminder**.

Type the Reminder text you wish to have printed on the consolidated reminder card.

---

This is an important reminder letting you know that your pets are due for the following treatments. Please call <co-phone> for an appointment.

<list>
  <first-name> <last-name>
  <address>
  <city>, <st> <zip>
</list>

Click **Done** when finished.

To create an **Alternate Reminder** notice, select either **first**, **second**, or **third Reminder** text to display the Reminder text window.

Click **Next**. The appropriate Reminder text window - No. 2 should be displayed at the top of the window.

Type the text you wish to have printed on the Alternate Reminder card and click **Done**.
Font size and Left margin
When printing Reminders through AVImark you may specify the font size and a left margin.

- Specify the **Font size** you wish to use to print Reminders.
- Specify the **Left margin**. For example; (.75 for ¾ inch).

Appointment and Boarding Values
The Appointments Folder will be used to set the parameters governing your Appointment calendar format and Boarding schedule.

Calendar start and stop times
In these fields you will specify the time you wish to begin and stop seeing patients each day. AVImark accepts both 24-hour military time and standard 12-hour clock designations. For 12-hour format, use a lower case “a” or “p” to designate morning or afternoon times. For example: (8:00a).

- Specify the **Start time**.
- Specify the **Stop time**.

Increment
This field allows you to specify the Appointment Schedule increment between appointments.

- Specify the **Increment** between appointments in minutes.

Default room
You may specify the room in which you would like all new appointments to be scheduled.

- If appropriate, use the **Default room** drop-down list and select a **Default room**.

Sub-tab, View
The Calendar View is the default view you would like the Appointment Calendar to be in when it is opened. Selecting “Daily, Consolidated” will place a specific day’s appointments for all doctors in all rooms in a “stacked” manner on the Appointment Calendar. A more selective view of specific doctors and/or rooms can be accessed by using the drop-down menus on the Appointment Calendar. Selecting “Daily, by Doctor” will show the appointments for a specific day, with separate columns for each doctor in your hospital. Selecting “Daily, by Room” will show a day’s schedule for all rooms in the hospital, with separate columns for each room in your hospital. In this case, if an appointment was not scheduled for a specific facility, it will be displayed in a column called “Not Assigned”. Selecting “Weekly, by Room” will show a week’s schedule for all rooms in the hospital. Appointments appear as colored icons according to the colors assigned to each doctor. Using this view, there is a Quick Edit feature that will display a small Active Appointment window showing the details of any selected appointment.

- Select the **View** option you wish to have displayed when opening the Appointment Calendar.

Sub-tab, Options

*Print expanded schedule*
With this box checked, all times slots will be shown on the appointment schedule, regardless of whether any appointments have been made for any of the times. If this box is not checked, only the actual appointments will print on the schedule.

- If appropriate, select **Print expanded schedule**.
Post notes to Medical History
With this box checked, any appointment notes that were attached to an appointment will be entered into the Medical History of the patient when the patient is checked into the hospital. The notes will be entered using a code of “Appt$” as a Type N transaction. If the box is not checked, notes will be posted to the Subjective Tab of the Medical Condition Window.

  • If appropriate, select Post notes to medical History.

Always show ghosts
With this box checked, the Appointment Calendar will display all appointments that have been removed and marked as having been kept, cancelled or as no-shows. Deleted appointments will not be shown.

  • If appropriate, select Always show ghosts.

Notify When Client Has Had
Clients that are frequently marked as a No Show, Late, Rescheduled, and/or Canceling appointments can be flagged to display an alert when they are scheduling new appointments. You must specify one or more of the situations and how many times those instances can occur before the client is flagged with a warning. Once the specified number of occurrences has been reached, the next time a new appointment is created for that client, a warning with the number of instances this client has had will be displayed, as well as a confirmation asking if you would like to proceed with the appointment. Clicking “Yes” will allow the appointment to be created. Clicking “No” will prohibit the new appointment from being created.

  • If appropriate, select the desired situations.
  • Using the UP and DOWN ARROWS, specify the number of times the situation must occur prior to flagging the client with a warning.

Sub-tab, Colors
Colors may be selected for different parts and functions of the calendar. Colors for each of your staff are assigned in Users and Security. For more information on changing the default colors, refer to “CHAPTER 21: SECURITY ADMINISTRATION”.

  • If appropriate, click the Browse button next to the function you wish to change a color for.
  • If you wish to revert back to the AVImark default colors, click Default Colors.

Use Dr’s colors for blockoffs (Weekly by Room view)
Checking this option allows a block off to be displayed in the doctor’s chosen color (as specified in Users and Security) in the Weekly by Room view.

  • If appropriate, select Use Dr’s colors for Blockoffs.

SOAP Check-in code
When a patient is checked into either the Boarding or the Appointment Calendar when using the SOAP window, the code that is entered here will be entered into medical history. AVImark has set a default code of “VISIT” which you may change if you wish.

  • If appropriate, specify a new SOAP Check-in code.

Boarding Check-out time
This field allows you to specify your boarding “check-out time”, if any. Use the same 24-hour or 12-hour format as your appointment start and stop times.
• If appropriate, specify a Boarding Check-out time.

**Doctor Assigned**
This field allows you to specify the default doctor for boarding charges. In other words, fees collected for boarding will be reported in AVImark as having been “performed” by this doctor, unless, of course, it has been changed on the Hospital Schedule.

• If appropriate, use the Doctor Assigned drop-down list to specify the default doctor for boarding charges.

**Schedule Increment**
AVImark can display a schedule of activities based on treatments scheduled for patient visits in the hospital activity scheduler. The boarding Schedule Increment is the default number of minutes scheduled for these activities. For more information regarding hospital scheduling, refer to “CHAPTER 18: BOARDING CALENDAR”.

• Specify the Boarding Increment in minutes.

**Charge for Boarding**
This field allows you to choose how you will charge for Boarding. For a detailed discussion on the different “Charge for Boarding” options, refer to “CHAPTER 18: BOARDING CALENDAR”.

• Use the Charge for Boarding drop-down list and select how you wish to charge for boarding.

**Normal duration**
This field allows you to specify the normal duration of a Boarding reservation.

• Specify the Normal duration of a Boarding reservation.

**Maximum duration**
This field allows you to specify the maximum duration of a Boarding reservation. By setting this value low, for example 30 days, AVImark is able to display the calendar more quickly.

• Specify the Maximum duration of a Boarding reservation.

**Always show ghosts**
With this box checked, the Boarding Calendar will display all appointments that have been removed and marked as having been kept, cancelled or as no-shows. Deleted appointments will not be shown.

• If appropriate, select Always show ghosts.

**Colors**
Colors may be selected for different parts and functions of the calendar.

• If appropriate, click the Browse button next to the function you wish to change a color for.

• If you wish to revert back to the AVImark default colors, click Default Colors.

**Miscellaneous Hospital Values**
This folder is used to specify various values that determine the way AVImark works.
Default species
This field allows you to specify a default species when checking in new patients.

- If appropriate, use the Default species drop-down list and select a Default species.

Default doctor
AVImark will assign this doctor as the Preferred Doctor for all new clients. When you treat a patient belonging to a client that has a preferred doctor, AVImark will automatically assign that doctor for treatments being added into the Medical History area. If you do not want AVImark to assign Preferred Doctors for new clients, you will need to select “None assigned”. If the Auto-assign doctor by client option is NOT checked, AVImark will retain the same selected doctor as you enter Medical History, even from client to client. In this case, AVImark will ignore the preferred doctor.

- If appropriate, use the Default doctor drop-down list and select a Default doctor.

OTC Doctor
This option allows you to select a doctor you want to be assigned to clients for over the counter sales.

- If appropriate, use the OTC Doctor drop-down list and select an OTC Doctor.

You may want to set up a “client” account in AVImark specifically for over-the-counter sales. In fact, things will work more quickly if you set up one of these OTC clients for each month of the year. You will not need a patient added for these OTC clients, just the client area itself.

Rabies assignment
This field allows you to specify the species you would like AVImark to automatically increment the rabies tag number for each time you add a rabies vaccination in the Medical History Area of the patient.

- Using the Rabies assignment drop-down list, select the correct species, or select Always for all species.

Rabies prompt
This field allows you to specify which species you would like AVImark to automatically prompt you to enter a tag number for when a rabies vaccination treatment is added to the Medical History of the patient.
• Using the **Rabies prompt** drop-down list, select the correct species, or select **Always** for all species.

**Rabies certificates**
This field allows you to specify which species you would like AVImark to automatically print a rabies certificate for when a rabies vaccination is included on the invoice.

• Using the **Rabies certificates** drop-down list, select the correct species, or select **Always** for all species.

**Prompt before printing**
This option allows you to have AVImark prompt you before printing Rabies Certificates. By selecting this option, you are able to change printing options, such as Print Preview, number of copies, or the printer itself. This is done from the Print Document window, which will appear when printing the invoice.

• If applicable, select **Prompt before printing**.

**Start/Stop auditing at**
When using the Audit Trail feature of AVImark, these fields allow you to specify the start and stop auditing times. For more information on the AVImark Audit Trail feature, refer to “CHAPTER 20: PERIOD-TO-DATE REPORTS”.

• If appropriate, type a **Start** and **Stop auditing at** time. For example, (Start 12:00a, Stop 11:59p).

**Audit on weekends**
This option allows you to continue auditing on weekends when using the AVImark Audit Trail feature.

• If appropriate, select **Audit on weekends**.

**Last used on date**
This field is used to indicate the date that your inventory statistics were last updated. AVImark will automatically enter the date when you select “Yes” to update your inventory statistics at the beginning of each month.

**Chart memo**
The Chart memo area may be used to type a default memo or text to be included at the bottom of each patient chart below the Medical History section. This memo will be in addition to the “Enter chart notes” option on the Patient Chart window.

• If applicable, type a default **Chart memo**.

**Other options**
From this area of the Miscellaneous folder, AVImark allows you to specify different actions, warnings and prompts to be displayed when certain functions are performed. You may select as many options that you wish. The following is a list of the available options and their meaning:

• If appropriate, select the **Other options** you wish.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Options and their functions</td>
<td>Miscellaneous Tab</td>
</tr>
</tbody>
</table>

**Show alerts**
This option allows you to tell AVImark when you want the alert messages to be displayed.

• Using the **Show alerts** drop-down list select the alerts display option.
Specify System Information
The System folder consists of a series of sub-folders and fields where you may specify information about how your computer system/network is configured.

Sub-folder, System

<table>
<thead>
<tr>
<th>System</th>
<th>E-Mail</th>
<th>Modem</th>
<th>Cash Drawer</th>
<th>Instrument</th>
<th>Documents</th>
<th>Laboratory</th>
<th>X-Charge</th>
</tr>
</thead>
</table>

**AVImark version**
AVImark automatically detects what version you are using. Do not change this version number unless instructed by an AVImark support technician.

**Title**
By default the title “AVImark” is placed in this field. The AVImark application name will be shown on the Windows Task Bar while AVImark is running. If you wish, you may change this title.

- If appropriate, type a Title.

**Use Window’s colors**
This option allows you to use the Windows Display Properties Appearance colors that have been selected for Active and Inactive windows, Message boxes, Window text background, and so on.

- If appropriate, select Use Window’s colors.

**Military time format**
With this option selected, all aspects of the software dealing with time will be converted to Military time format.

- If appropriate, select Military time format.

**Detailed error messages**
With this option selected, AVImark will display a screen whenever you receive an error message that contains specific information concerning the steps taken prior to receiving the error.

- If appropriate, select Detailed error messages.

**Windows date format**
This option allows you to have the dates that appear in AVImark and on AVImark reports follow the date format specified in the Regional settings of your Control Panel within the Short date format field.

- If appropriate, select Windows date format.

**Directories**
AVImark requires you to designate the folders in which certain files are stored. As AVImark performs its various functions, it needs to access these files and therefore needs to know the location “path” of these files. When specifying the folder path names, do NOT include the local drive letter since they do not reside on each local workstation. For example: \MY DOCUMENTS, \FORMS, \TEXT, and \PHOTOS for each of these folders. The following is a list of the different folders in which certain files are stored:

**Documents**
AVImark allows you to organize your documents into subdirectories of the “Documents directory”.

For example, you could now have a directory structure for your documents such as:
AVImark will automatically attempt to locate documents that are attached to Treatments, Items, and Diagnoses, as well as any manually entered document name for which a directory has not been selected.

**Forms**

AVImark uses the Forms function of Microsoft Word®. With this feature you may attach an MS Word form document to any treatment. If you specify `FORMS`, this would mean your MS Word form files are stored in the “FORMS” folder on the C-Drive of your server computer.

**ID**

When using the AVImark Sidekick feature along with Microsoft Word® Forms, you may specify a Starting Form ID. This value is used as an auto-incrementing sequence number so as to give each form a unique name. Each Sidekick workstation should use its own unique “Starting form ID” value.

**Photographs**

This field allows you to specify a path to store your photographs into a single directory. For example: `\PHOTOS`.

**Directories**

You may specify your photographs be stored either into a single directory (as is currently the case) or into sub-directories by using the drop-down list to select a sub-directory. For more information on storing patient photos, refer to “CHAPTER 7: PATIENT AREA”.

**Journal files**

AVImark uses the Journal feature in conjunction with the Animal Care Training’s VETED Tablet. The VETED Tablet extensively uses Microsoft® Journal files for Client Education documents and consent forms.

**Text files**

AVImark has the ability to import Text files into the different Notes windows throughout AVImark. These files must be in the Text File format (*.txt). If you would like to keep your Text files separate from your other Word documents, you may specify the path to the Text files in this field.
Spreadsheets
Use this field to specify the destination path where AVImark will locate and store MS Excel spreadsheets. When attaching an XLS file to a Medical History entry AVImark will open to the directory specified here.

Backup to
This field shows the specified destination path when backing up your data. Regardless of what computer is being used for backing up purposes AVImark will default to the destination specified in the “Backup to field”.

QuickBooks®
When using QuickBooks in conjunction with AVImark, this field is where you will specify the folder in which AVImark will place the file that is created when exporting financial information to Quick Books. For more information on exporting to QuickBooks, refer to “CHAPTER 31: EXPORTING TO QUICKBOOKS®”.

Applications
AVImark has the ability to launch other application programs directly from the Client Information Display through the Applications Menu. For example: MS Excel, MS Word, QuickBooks, a website and so on. You must specify the name and path for each of these applications, if applicable, and you may enter up to ten different applications.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Program path</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVImark Site</td>
<td><a href="http://www.avimark.net">www.avimark.net</a></td>
</tr>
<tr>
<td>Open Office</td>
<td>C:\Program Files\OpenOffice.org 3\program\writer</td>
</tr>
</tbody>
</table>

- Type the **Name** of the program in the **Menu item** area. For example: (NOTEPAD).
- Type the **Path** of where the program resides in the **Program path** area. For example: (C:\WINDOWS\NOTEPAD.EXE).

Sub-folder, E-Mail

**Server name**
This is the name of your Internet Service Provider’s (ISP) Outgoing mail (SMTP) server. If you are not certain what this name is, you may refer to it in Microsoft® Outlook, Tools, Accounts, Mail, Properties, Servers, Outgoing mail (STMP).

- Type the **Server name** of your ISP Outgoing mail server.

**Reply E-Mail address**
This field specifies the default E-Mail address for incoming mail if there is no user specific e-mail address selected. If you need to refer to it, it may be found in Microsoft® Outlook, Tools, Accounts, Mail, Properties, Servers, Ingoing mail Server, Account name.

- Type the **Reply E-Mail address** for incoming mail.

**Authentication**
This field is provided for those clinics whose mail provider requires authentication. There is a User ID field and an E-Mail Password within this section. The User ID and password can be obtained from your E-Mail Service Provider.

- Enter the **User ID** and **E-Mail password** provided by your E-Mail Service Provider.
Sub-folder, Modem

*Modem on*
For AVImark to work properly, you must specify which serial port your modem (if you have one) is connected.

- Use the **Modem on** drop-down list to select which port your modem is using.

Sub-folder, Cash Drawer
If you are or will be using a cash drawer with the AVImark program you will need to enter the specifications for the cash drawer you are using. All of the specifications can be found in the paper work the cash drawer came with. If you are having trouble finding the information you can test the communication by “pinging” the computer using a DOS command to check the communication between the computer and the cash drawer. If you need further assistance, AVImark Technical Support can walk you through this process. As a shortcut, AVImark allows you to press Ctrl+F11 from the CID to open the cash drawer.

<table>
<thead>
<tr>
<th>System</th>
<th>E-Mail</th>
<th>Modem</th>
<th>Cash Drawer</th>
<th>Instrument</th>
<th>Documents</th>
<th>Laboratory</th>
<th>X-Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash drawer on</td>
<td>(none)</td>
<td>Baud Rate</td>
<td>9600</td>
<td>None</td>
<td>Data Bits</td>
<td>8</td>
<td>Stop Bits</td>
</tr>
</tbody>
</table>

*Cash drawer on*
AVImark will support most of the serial-attached cash drawers. That is, AVImark will open most computer-driven cash drawers that are attached to the computer via the system COM1 or COM2 serial ports.

- If appropriate, use the Cash drawer on drop-down list and select the correct serial port.

*Baud Rate*
Use the **Baud Rate** drop-down list and select the correct **Baud Rate**.

*Cash string*
The field is used to specify the characters that your cash drawer needs to receive to open.

- Type the cash drawer’s **Cash string** specifications.

*Data Bits*
Use the **Data Bits** drop-down list and select the correct **Data Bits**.

*Parity*
Use the **Parity** drop-down list and select the correct **Parity**.

*Stop Bits*
Use the **Stop Bits** drop-down list and select the correct **Stop Bits**.

*Open On Credit*
Use **Open On Credit** to open the cash drawer when accepting an MPS credit card payment.

*Use TCP/IP*
This option is used if you are using this naming code when connecting to the cash drawer.

- If appropriate, select **Use TCP/IP**.

Sub-folder, Instrument
The use of multiple lab instruments on the same computer is available through the use of this sub-folder. For more information on the different lab instruments and their settings, refer to “CHAPTER 33: LAB
### INSTRUMENTS

<table>
<thead>
<tr>
<th>System</th>
<th>E-Mail</th>
<th>Modern</th>
<th>Cash Drawer</th>
<th>Instrument</th>
<th>Documents</th>
<th>Laboratory</th>
<th>X-Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td>Abaxis HMT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Abaxis Chemistry</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CBC Hemavet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Hemagen</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- With the correct lab instrument highlighted, select the correct settings for that instrument.
- Continue with the same procedure for each instrument you will be using.

### Sub-folder, Documents

#### Office Suite Integration

AVImark gives you the ability to select which word processing program you will be using from each computer.

- Select either **Microsoft Word®** or **Star Office/Open Office®**.
- Use the **File name extension** drop-down list and select the correct **File name extension**. When selecting **Microsoft Word®**, select **DOC** from the drop-down list. If using **Star Office/Open Office®**, you may select any of the three file extensions.

#### Graphing

AVImark gives you the ability to graph and print analysis either through AVImark or Excel.

- Use the Graphing drop-down list and select either AVImark or Excel.

### Sub-folder, Laboratory

#### Antech®

This field is used to specify the path of the folder used to store the XML files you will download from the Zoasis Corporation website. For more information on Antech®, refer to “CHAPTER 33: LAB INSTRUMENTS”.

- Type the path where the XML files will be stored. For example: (\Antech).

#### VetConnect®

This field is used to specify the path of the folder used to store the RTW files you will download from the VetConnect® website. Also in this area, you will specify the Username and Password as specified by IDEXX® to allow access to the VetConnect® website to permit downloading of test results. For more information on VetConnect®, refer to “CHAPTER 33: LAB INSTRUMENTS”.

[Table of settings for INSTRUMENTS]

[Table of settings for Office Suite Integration]

[Table of settings for Graphing]

[Table of settings for Antech®]

[Table of settings for VetConnect®]
• Type the path where the RTW files will be stored.
• Enter the Username and Password as received from IDEXX®.

Sub-folder, X-Charge®
It is from this folder where you are able to select the appropriate PIN Pad device you want to use and enter the setup information. When using the HHP TT3101 or TT8810, the invoice total being charged to the credit or debit card will now display on the device’s screen for view by the client.

• If appropriate, click Pin Pad Device Setup.
Select the appropriate Pin Pad device, and enter the correct set up information.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Charge®/Capturing Signatures</td>
<td>X-Charge®, Signatures</td>
</tr>
</tbody>
</table>

Sub-folder, Verifone
If using the Verifone® PIN Pad device specify the correct COM port it is attached to.

• Click on the Verifone P1Npad 1000se on drop-down list to choose the appropriate COM port.

Set Advanced Hospital Options
It is from this folder that you may customize AVImark to serve the needs of your clinic and each individual user. All options fall into two basic categories: User and Site. User options affect how AVImark works for individual users. You can add multiple users for each option. For example, one user might like to see Client and Patient Alerts displayed on the CID, while other users would choose not to use this feature. AVImark will recognize who is logged in and work according to the options set for that user. Site options affect all users for each clinic or Site. For example, when a Site clinic would like to charge a different amount for a Prescription fee (other than what the home clinic is charging) they will have the ability to set their own fee accordingly.

• From the Advanced folder, click Advanced Options to display the Options Maintenance window.

Set options for users
• Click the + button next to the Option Category name to expand the category.
• Select the **Option** you wish to set a default value for.

• To set a Value for all users, click **Change** in the **Default Value** area to display the Change Option Value window.

• In the **Value** field, set the appropriate **Default Value**.

• To set a Default Value for an individual user(s), **right-click** in the **ID/User** area to display the shortcut menu. Click **New** to display the New User Option Value window.

![New User Option Value](image)

• Using the **User** drop-down list, select the correct **User** name.

• In the **Value** field, enter the appropriate **Value** for the selected user and click **OK**.

**Set options for Site**

• Click the + button next to the **Option Category** name to expand the category.

• Select the **Option** you wish to set a default value for.

• To set a Value for all Sites, click **Change** in the **Default Value** area to display the Change Option Value window.

• In the **Value** field, set the appropriate **Default Value**.

• To set a Default Value for an individual Site(s), **right-click** in the **Site** area to display the shortcut menu.

• Click **New** to display the New Site Option Value window.

• Using the **Site** drop-down list select the correct **Site**.

• In the **Value** field, enter the appropriate **Value** for the selected Site and click **OK**.

**Set security in Option Maintenance**

Securing an option may be accomplished from either the Option Maintenance area or Users and Security. For more information on securing functions through Users and Security, refer to “CHAPTER 21: SECURITY ADMINISTRATION”.

• From the Option Maintenance window, select the **Security** tab to display the security setting for the selected option.

• Use the **Category** drop-down list and select the **User Group** that will be allowed to perform the selected option.

• Click **Secure**. All User Groups having the ability to perform the selected option will be listed in the **Secured To** area.

---

**To learn more about:**
- Advanced Options/Setup

**Search the Help for:**
- Advanced Tab; Advanced Options
CHAPTER 2: SYSTEM TABLES

The System Tables area of the program consists of several different tables that contain lists of contents for use in other AVImark areas. The different system tables are listed on the left side of the AVImark System Tables Display and the contents of the table you choose appears on the right side of the display.

In this chapter you will learn about...
- Working with System Tables on page 29
- Abnormalities Table on page 31
- Additional Data Fields/Tables on page 31
- Allergy Table on page 31
- Antech® Profile Names on page 31
- Antech® Test Names on page 31
- Appointment Groups on page 31
- Appointment Type on page 31
- Audit Trail on page 31
- Body Subsystems Table on page 32
- Breed and Color Tables on page 32
- Chemistry Table on page 32
- Client Discount Classes Table on page 32
- Client/Patient Relations Table on page 32
- Clock Out Reasons Table on page 32
- Company Table on page 32
- Contract Prices on page 32
- County Table on page 33
- Discount Classes Table on page 33
- Discount Plan Table on page 33
- Facility Table on page 33
- Local Prefix Table on page 33
- Payment Types Table on page 33
- QuickBooks® Accounts Table on page 33
- Referral Selections Table on page 33
- Route Table on page 34
- Special Fees Table on page 34
- Species Table on page 34
- Tax Table on page 34
- Units of Measure Table on page 34
- Vaccine Table on page 34
- Variance Reasons Table on page 34
- VetConnect® Test Names Table on page 35
- Whiteboard Categories Table on page 35
- Work Lists Table on page 35
- Zip Code Table on page 35

Working with System Tables
The AVImark System Tables function allows you to add and/or change information in whatever table you
select. When making changes to a table or table entry, it is important that you NOT change any Codes already assigned. When a change has been made to System Tables, AVImark gives you the ability to Undo and/or Redo the changes. In addition, any change that is made to a line item, AVImark creates a History of Entry record or log of the entry to include; the Date, Time, User, and the action used to make the change. Another significant feature within System Tables is the “Find” field located at the bottom of the System Tables window. This allows you to find certain entries by typing in a few letters of the Code or Description and AVImark will display only those entries in the “Entries for” area. The entries contained in the “Entries for” area may also be sorted by code, description or manually rearranged to your desired sort order.

- On the CID, open the Work with menu. Click System Tables to display the System Tables window.

Make changes to a table or table entry
There may be times when you find it necessary to make a change to the description of a table or change an entry for that table.

- From the System Tables window, select the table you wish to change.
- Right-click and from the shortcut menu click Change to display the Change Table window.
- In the Table field, type the new description you wish to give the table. If there are several tables you wish to change, use the Next and/or Prior buttons to move through the table list.
- Click OK when finished.
- To change an entry for a table, select the correct table to display the Entries for that table.
- Select the correct entry from the Entries for area. Right-click and from the shortcut menu click Change to display the Change Entry window.
- Enter the necessary change. If there are several entries you wish to change, use the Next and/or Prior buttons to move through the entries list.
- Click OK when finished.

Undo/Redo a change
- On the Edit menu, click either Undo or Redo.

View history of entry
- With the correct Entry selected, open the View menu. Click Entry History to display the Entry History window.

Add a New Table and Table Entries
Most of the tables that you will be using in AVImark will already be in place and set up for you. However, you may add your own tables and/or lists of values from which you may later choose the appropriate value(s) when entering client and/or patient data. This capability is made possible by setting up your own data fields of a specific type that will allow you to choose the appropriate information. For more information about setting up additional data fields, refer to “CHAPTER 25: ADDITIONAL DATA FIELDS”.

- In the Table area, right-click and from the shortcut menu click New to display the New Table window.
- Specify a Code and Table name for the new table and click OK.
- In the Entries for area, right-click and from the shortcut menu click New to display the New Entry window.
- Specify a Code and Description for the entry and click OK. You may add as many entries as you wish to the table.

Identify the Different System Tables
The following is a list and description of the AVImark System Tables that are already in place and set up for you.
Abnormalities Table
The Abnormalities Table allows you to specify your own list of physical and physiological problem areas that you will use to describe and define a patient’s condition. These abnormalities are considered “Body Systems” and automatically appear in the Objective Folder of a patient’s Medical Condition window. You may also create “Body Subsystems” as well. For example, the retina would be a Subsystem to the “Eyes Body System”. These Body Subsystems are first created in the Body Subsystems Table. The code for this table must be “ABNORMAL”.

- To link a Body Subsystem, select the correct Body System (Abnormality).
- Right-click and from the shortcut menu click Subsystems to display the Body Sub-systems for window.
- Right-click and from the shortcut menu click New to display the New Sub-system window.
- Enter the correct Code for the subsystem as specified in the Body Subsystem Table and click Done.

Additional Data Fields/Tables
AVImark allows you to create Additional Data Fields for Clients, Patients, Medical Condition Records, and Whiteboard. For example, you may want to record the directions to a client’s home or additional contact numbers. For a complete discussion of these Additional Data Fields and Tables, refer to “CHAPTER 25: ADDITIONAL DATA FIELDS”. The code for the Additional Data Fields table must be “DATA”; and the code for the Additional Data Tables must be “TABLE”.

Allergy Table
The allergy table consists of common patient allergies. The code for this table must be “ALLERGY”. This allows you to select one of the pre-defined allergies into the patient area.

Antech® Profile Names
The Antech® Profile Names Table is used in conjunction with Antech® test results. There will be no user setup in this field. AVImark® will do this upon definition of fields when defining Antech® test results. When defining Data Fields with Antech®, each Antech® test or Profile will automatically insert the appropriate Antech® ID into the Antech®/Profile ID field within the Change Treatment window of the code where the Data Fields were defined. When Data Fields are defined for Profiles, the Antech® Profile ID and the Description of the Treatment will be added to the Antech® Profile Names table. The code for this table must be “ANTECHP”.

Antech® Test Names
The Antech® Test Names Table allows you to input Antech® Test Names that need to be abbreviated. This is used in conjunction with importing Antech® test results. Any test name more than fifteen characters will need to be abbreviated and entered into this table. For example, Alkaline Phosphate would be entered Alkaline Phos. When entering an Antech® Test Name entry, the “Code” will be the Antech® Extension (labeled as UnitCode Ext-ID on the Antech® xml file) for this test, as defined by Antech®. The “Description” will be the abbreviated Antech® test name. The code for this table must be “ANTECHT”.

Appointment Groups
The Appointment Groups table lists user groups that can be associated to specific users. This allows appointments to be displayed by user groups and not individual staff members.

Appointment Type
The Appointment Type table is used to identify appointment or block-off types by assigning colors. After creating the types you can then assign the appropriate type to the desired appointment or block-off, which will appear on the Calendar in the designated color.

Audit Trail
The Audit Trail table lists those functions that you may audit. It is the Audit Trail Report that reports the functions that were performed by those persons who are set up in the Users & Security function of AVImark. This list can not be modified. The code for this table must be “AUDIT”.
Body Subsystems Table
The Body Subsystems Table allows you to enter any number of entries that are to be considered by AVImark as being members of the body systems identified in the Abnormalities Table. These body sub-systems are then associated with a particular Abnormality. The code for this table must be “SUBSYS”.

Breed and Color Tables
The breed and color tables contain lists of breed and color codes and descriptions for all species. AVImark provides an Auto Add feature. When this option is checked, you will be allowed to add new entries to the table(s) as you enter new patients into AVImark. When adding a new entry to the Breed Table, you will notice a “Type” field. By entering a single letter or number value in this field, you may group selected breed types together. This becomes extremely useful when using the AVImark Information Search feature to search for multiple breed types. The codes for these tables must be “BREEDS”, and “COLORS”.

Chemistry Table
This table is used in conjunction with lab machine use with AVImark and relates to analytes. Each analyte measured has a formal abbreviated identifier. Through this table AVImark provides a means for expanding these abbreviations into more readable names, up to 15 characters in length. These names will be displayed as the “result name” when defining fields through lab machines. This table will have existing entries for use with your lab machines. Although descriptions may be changed, it is very important to NOT change the codes. New entries may be added to this table using only codes defined by the lab machine’s manufacturer. The code for this table must be “CHEM”.

Client Discount Classes Table
The Client Discount Classes table will maintain the list of client groups appropriate for receiving discounts. When setting up the discount rates for client groups in Hospital Setup you can choose a client class from this list. The code for this table must be “CLTDISC”.

Client/Patient Relations Table
AVImark allows the user to associate patients with a client other than their owner, for example, Equines with their trainer. The first part of the setup will be done in System Tables in the Client/Patient Relations category. In the change table entry field, the Code field does not need to be specific. The Relationship field needs to be the relationship of this person or business to the patient, such as trainer, stables, and so on. The Code field needs to be the code of the client that is the trainer or the stables, and so on. The “Auto-Post” field, when selected, will cause the items or treatments that are added to the associated client to be automatically posted to the Medical History of the associated patient (the patient that is associated with this trainer, stables or others). The code for this table must be “RELATION”.

Clock Out Reasons Table
This table is a list of typical reasons your hourly employees will be clocking out of the AVImark Time Clock function. When an employee clocks out, they will need to choose from a list to indicate their reason for leaving. The code for this table must be “CLOCK”.

Company Table
The company table is a list of Company Numbers and corresponding Company Names to be used if you are operating more than one business at your location. For example, you might use this function if you want to invoice/bill/remind/report your grooming business using a different Company name. You may use any 2 digit number from 02 through 99. DO NOT use the number 01 as the Company Number. This is the AVImark default number for each client unless changed. In addition, AVImark gives you the ability to select different colors for each company. This allows for easy identification when the company is displayed on the CID. The code for this table must be “COMPANY”.

Contract Prices
This table contains a list of the contract price groups. A single character code will need to be entered and a description name. These contract price groups can be linked to individual inventory items for break pricing. The contracted price is specified on the individual item in the Inventory List.
**County Table**
The County Table is used for the purpose of defining rabies certificate forms that must be printed for different counties. The County Table is a list of counties within your immediate area, each with a corresponding rabies certificate document name. When creating the table entry, the Code value is the name of the county and the Description is the name of the MS Word document you would like printed as the rabies certificate for clients that reside in this county. The code for this table must be “COUNTY”.

**Discount Classes Table**
This table will maintain the list of various Treatment and Inventory Classes appropriate for receiving discounts. When setting up the discount rates for Treatment and Item Classes in Hospital Setup you can choose a class from this list. The code for this table must be “DISCLSS”.

**Discount Plan Table**
AVImark provides the means to put a patient on a “Health Maintenance Plan” that includes provisions for automatic discounting for specific treatments, and courtesy discounting on all others (with possible exceptions). In addition, you could also set up a reminder template to automatically remind for plan renewal at the end of the time period covered by the plan. This function allows the hospital to charge the customer up front for a treatment program for the patient and then automatically track the patient’s progress through the plan, giving appropriate discounts along the way. Provision is made here in System Tables for any number of discount plans to be defined by the hospital. Any client may have each of their pets on a different plan. However, any given patient may only be qualified for one plan at a time. For more information on how to set up discount plans refer to “CHAPTER 24: DISCOUNT PLANS”. The code for this table must be “PLANS”.

**Facility Table**
This table allows you to define the rooms in which you treat patients. When you make an appointment for a patient, you may choose the facility that will be used for the appointment duration. You will be able to use a drop-down menu to assign the patient to an appropriate treatment room (facility). Then, when the appointment schedule is viewed or printed, the treatment facility will be indicated. The order in which they appear in this Table from top to bottom is the order in which they will appear on the appointment calendar from left to right. The code for this table must be “FACILITY”.

**Local Prefix Table**
In AVImark there is a feature called Phone Dialer, which allows you to use your Analog phone system and computer to dial the selected clients phone number for you. Before using this feature you must have your local prefixes defined in the Local Prefix Table. The code for this table must be “LOCALPRE”.

**Payment Types Table**
AVImark allows you to define up to 10 payment types. Once defined, these payment types can be entered in the same way that other payments are entered. Each entry in this table represents a new payment type. For instance, you might define a payment type called, “Friendly Bank Debit Card”. In addition, you may need to associate an Action Code with each new payment type defined. These Action Codes tell AVImark the nature of the payment type. The following Action Codes may be used: A - This payment should be treated as a credit card payment. C - This payment should be treated as a cash payment, giving the appropriate cash discount if it applies. If you give cash discounts, you should use this Action Code for payment types that are similar to check payments, such as Debit cards. The code for this table must be “PAYMENTS”.

**QuickBooks® Accounts Table**
QuickBooks®, by default, has several predefined asset accounts that AVImark exports transaction totals to. For AVImark to know what these accounts are, AVImark maintains this System Table which has several predefined entries. You may change the Description values for the entries in this table, but NOT the codes. For more information on how to set up AVImark to export to QuickBooks®, refer to “CHAPTER 31: EXPORTING TO QUICKBOOKS®”. The code for this table must be “QBOOKS”.

**Referral Selections Table**
AVImark lets you define your own referrals, other than clients, to be added to client files. Any referral you would like to be displayed in the selection list, simply add them to this table. This allows you to choose
referrals, other than clients from a drop-down menu to prevent misspellings and duplications. You may also prevent users from typing their own referrals for clients by checking the “Must Choose referrals” option in Hospital Setup. The code for this table must be “REFER”.

**Route Table**
This table is associated with the Whiteboard Schedule tab where you can choose how a scheduled treatment/item is to be administered or performed. This table is used to define the different types. The code for this table must be “ROUTE”.

**Special Fees Table**
AVImark allows you to define your own list of “add-on” fees that can be added to the retail price of specific inventory items of your choice. When you would like a certain item to have this fee “structure”, open the “Change Item” window for the particular item and enter the Fee Code as defined in the Special Fees Table. The code for this table must be “FEES”.

**Species Table**
This table allows you to specify the different species cared for within your hospital. In addition, when entering species for this table, AVImark has a unique way of letting you charge for treatments based on the weight of the patient. This function is called “Weight-based Pricing” and by using it you should eliminate the need to have duplicate treatments with different prices for different patient weight ranges. If you wish to use this function, you will need to enter values in the Weight and Increment fields of the Table Entry window. Using this function, AVImark will add to the price of any treatment a user-defined percentage of that price. This is based on how much the current weight of the patient is, different from the “base” species weight as defined here in the Species Table. This user-defined percentage is called the Weight Surcharge and may be specified for any treatment. Within the report card field indicate the default report card to be printed from the Medical Condition Window for the selected species.

If you intend to use the Medical Condition Record portion of AVImark you have the ability to print a Report Card document which can be species specific. Enter the document name you would like to use when printing a report card for the selected species. The code for this table must be “SPECIES”.

**Tax Table**
AVImark lets you assign one or more state and local tax rates for each zip code so that, for a given client, transactions would be taxed accordingly. This will help when your business is located where more than one set of tax rates may apply, depending upon which client is doing business. If you sell taxable items to a client whose Zip Code is either not in the Zip Code Table or does not have a Tax Area linked to it, the client will be charged whatever tax rates you have assigned in Hospital Setup. The code for this table must be “TAX”.

**Units of Measure Table**
This table allows you to specify the units of measure that you use when dispensing inventory items. These values will be displayed from a drop-down list wherever a unit of measure is indicated. The code for this table must be “MEASURE”.

**Vaccine Table**
This table is used to maintain the information that is printed on the vaccination certificates you provide to your clients whenever a rabies vaccination (or other vaccine) is given to a patient. In this table you should specify the rabies and any other vaccine currently in use. If you are currently using more than one, AVImark will prompt you for the correct one at the time you are entering the vaccination treatment. The code for this table must be “VACCINE”.

**Variance Reasons Table**
This table is used to track controlled substance quantities. You are able to specify reasons why you may have used more of the substance than what was actually administered to the patient, such as spilling, breaking, or leaking. You will notice some example reasons listed in this table, but these may be removed or simply added to. The variance information can then be tracked in the Enter Medical History window Variance field. By adding this variance code along with the discarded amount, a Variance Report may be printed in the Inventory List.
**VetConnect® Test Names Table**
The VetConnect® Test Names Table is used in conjunction with VetConnect® test results. There will be no user setup in this field. AVImark will do this upon definition of fields when defining VetConnect® test results. When defining Data Fields with VetConnect®, each VetConnect® test or Profile will automatically insert the appropriate VetConnect® ID into the VetConnect® Test ID field within the Change Treatment window of the treatment which Data Fields were defined. When Data Fields are defined for Profiles, the VetConnect® Profile ID and the Description of the Treatment the data fields are being defined for will be added to the VetConnect® Test Names Table. The code for this table must be “VETCONN”.

**Whiteboard Categories Table**
This table is used to define categories that can be assigned to treatments, items and diagnosis, which will allow you to group and organize activities on the “Whiteboard”. Treatments, items or diagnoses can have the same assigned Whiteboard Category. The code for this table must be “WBOARD”.

**Work Lists Table**
AVImark lets you define a table of activities that you perform at your hospital. For example; update medical records, feeding, take blood sample, record vital signs, and so on. You may assign any patient to have any number of activities performed. At any time, you may choose to view or print a list of activities a given patient should have performed before check-out. When setting up your Work List Table, you may assign only one Work List Code to each Work List entry, although more than one job can have the same Work List Code. Furthermore, AVImark lets you assign one or more Work List Codes to any service so that, when you perform the service, the patient is automatically put on one or more Work Lists. The code for this table must be “LISTS”.

**Zip Code Table**
As new clients with unknown zip codes are added, AVImark will automatically add the new zip codes to your Zip Code table. If, when you added the new client, you entered the city, state and area code information for the new client, AVImark will add these values to the new zip code entry in the Zip Code table. You may also define what county each zip code refers to, by doing this you will be able to use the County Table for those instances where a certain county in your area requires a specific Rabies Certificate form. In addition, you are able to specify a “Tax Area” that determines state and local tax rates that will be charged to customers living in this Zip Code. If all of your clients pay the same tax rates, you may ignore this feature. If an invoice includes taxable items or services for a client whose Zip Code is either not in the Zip Code Table or does not have a Tax Area linked to it, the client will instead be charged whatever tax rates you have assigned in Hospital Setup. The Zip Code field is for clinics in the state of Kansas, Georgia, Ohio and Washington.
CHAPTER 3: TREATMENT LIST

The Treatment List contains all of your services that you perform for your patients. In setting up your Treatment List you will need to create Treatment categories, assign charges, create doctor’s instructions, and so on. The AVLmark Treatment List window identifies Treatment categories, treatments within each category and a Selected Treatment section.

In this chapter you will learn about...

» Setting up Treatment Categories on page 37
» Adding a Treatment Category on page 38
» Undeleting Treatments on page 39
» Marking up Treatment Prices on page 39
» The Mark up Analysis window on page 41
» Adding a Treatment on page 42
» Working with Attachments on page 48
» Adding Additional Data Fields on page 53
» Advanced Tab Values on page 53
» Contract Prices Tab Values on page 55

» Documents Tab Values on page 55
» Whiteboard Tab Values on page 56
» Laboratory Tab Values on page 56
» Treatment Right-Click Menu on page 56
» View and print the Who got list on page 58
» Undelete a deleted treatment on page 59
» Print the Treatment List on page 59
» Sort the Treatment List report on page 60
» Print a Travel Sheet on page 60

Setting up Treatment Categories

When you start using AVLmark you will probably want to add, remove, and/or change each Treatment Category to customize its different characteristics to suit your clinic.

• To work with the Treatment List, open the Work with menu and click Treatments.
Adding a Treatment Category

• Point in the Treatment Categories list window. **Right-click** and from the shortcut menu click **New** to display the Change Treatment window.

• Enter the appropriate information into each field and click **Done** to add or change the category.

Category
This is the descriptive name given to each category to identify it in most AVImark functions.

• Type the name you wish to give the new category.

*If you would like your categories to be in numerical order, change each category name by typing a number in front of a category name. For example: 01Dentistry, 02Large Animal Surgery.*

Report Codes
Report codes are user-defined letter characters used for grouping performed treatments together on certain reports (Treatment Control Log, Patients by Treatments, Income by Treatment, Transaction Summary, and Sales Summary). You can have up to 7 codes for each category. Some codes are pre-programmed for the more common reports. They are:

* Lab services (L)
* Surgery (S)
* Injections (I)
* Prescriptions (P)
* Vaccinations (V)

• If appropriate, choose or type a Report code for the new category.

Markup Percentage
The Markup percentage is the default percentage used to mark up the prices of the treatments in this category.

• If appropriate, type or choose the Markup Percentage (as a decimal value or whole number) for this category. You can always type a different Markup percentage at the time you initiate the actual mark up process.
Account number
To interface with QuickBooks®, you will need to enter the income account number that you set up in QuickBooks® as the account in which to record the income generated from treatments within this category. If specified, this account number is used as the account name for QuickBooks® instead of the Treatment Category name.

- If appropriate, type the income account number that you have set up in QuickBooks®.

Report name
The Category Report name must be given for use in the End-of-Period reports. This name can be different or the same as what was typed in the Name field.

- Type a Category Report name.

Whiteboard
This field represents the Whiteboard categories that are set up in “System Tables”. They are used to group and organize treatments on the ‘Whiteboard’.

- Use the Whiteboard drop-down list and select the Whiteboard category you wish to assign to this category.

Company
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple items.

- If appropriate enter the desired company number for reporting purposes.

Removing a Treatment Category

- Select the Treatment Category you wish to remove. **Right-click** and from the shortcut menu click **Remove**.

- You will need to click Yes to confirm.

**Removing a Treatment category also removes all treatments within that category.**

To learn more about:  
Using Report codes

Search the Help for:  
Report codes

Undeleting Treatments
AVImark gives you the ability to undelete Treatment Categories or individual treatments from within the category.

- Point in the Treatment Categories window. **Right-click** and from the shortcut menu click **Undelete** to display the Undelete Treatment Categories window.

- Use the SPACEBAR or **right-click** and from the shortcut menu click **Select** on the categories and/or individual treatments you wish to undelete.

Marking up Treatment Prices
The Markup Percentage is set up on each Treatment category. This is the default percentage that AVImark will use to mark up the treatment prices (unless otherwise directed). AVImark lets you mark up your treatment prices in three ways; by category; all categories, or by individual treatments.
Marking up treatments in one or all categories

- Select the Treatment category you wish to mark up.
- Right-click and from the shortcut menu click Markup to display the Mark up Treatment Prices window.
- Use the Mark up drop-down list and select either This category or All categories.
- Use the By drop-down list and select by Category to mark up prices by the default percentage specified for your categories, or type a percentage you wish to mark up this category by (use whole numbers).

Marking up individual treatments

- From the Treatment List for window, select the treatment you wish to mark up.
- Right-click and from the shortcut menu click Markup to display the Treatment Mark up window.
- Under Increase select to increase Price of This Treatment.
- Use the By drop-down list and select by Category to mark up prices by the default percentage specified for your categories, or type a percentage you wish to mark up this category by (use whole numbers).

Rounding prices

You may round off marked up prices larger than a certain amount to the nearest increment. Furthermore, you may then subtract a specified amount from the result of the mark up to arrive at the final price.

For example: Let's say you would like to mark up all prices in the selected category by 5% and at the same time round off all prices over $10.00 to the nearest 10 cents, all prices over $25.00 to the nearest $1.00 minus 5 cents, and finally all prices over $100.00 to the nearest $10.00, minus 5 cents. See Figure 3, “Mark up Treatment Prices Window”.

- In this example, the first thing you would do is enter 5 in the By % field.
- In the Rounding Prices dialogue box, click on the top line in the “If greater than” column. Specify
10.00 in this field and 0.10 in the “Round to” column.

- Next, on the middle row, specify 25.00 in the left column, 1.00 in the center column and 0.05 in the right column.

- Finally, on the third row, specify 100.00 in the left column, 10.00 in the center column and 0.05 in the right column.

- To review the proposed mark up results before finalizing the mark up process, ensure the Review before mark up box is checked and click Continue.

- By using the appropriate rounding Advanced Options in Hospital Setup you can have AVImark default to specific rounding options when the Mark Up window is opened.

The Mark up Analysis window
In the Mark up Analysis window you can review the proposed mark up results before actually marking up your prices. Once you click Continue from this window, AVImark will mark up prices as directed.

Additional columns can be displayed in the Markup Analysis window by setting the appropriate default Hospital Setup Advanced Option.

- From the CID select Wrench speed bar icon.

- In the search field type sales and select the option Show Sales Data By Default and set the value to True.

The Markup Analysis window will now display the Fiscal Income Fiscal Sold, Projected Income, Income Difference and Income Difference Percent. The sales data amounts will be figured at the bottom of the analysis window.

- In the Markup Analysis window select View, Show Sales Data from the menu area to hide or display
the 5 additional income columns.

In the Markup Analysis window you can customize the view by arranging columns and using the Show/Hide Group Panel options from the View menu.

**Saving and Printing Markup Values**

In the Analysis window you will have the ability to save the markup values to a .dat file and also open previously saved files.

<table>
<thead>
<tr>
<th>Description</th>
<th>Price</th>
<th>Act Mark</th>
<th>New Price</th>
<th>Fiscal Income</th>
<th>Fiscal Sold</th>
<th>Projected Income</th>
<th>Income Diff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cardiac - Fax</td>
<td>41.00</td>
<td>0</td>
<td>51.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cardiology - Phone/Fax</td>
<td>60.00</td>
<td>0</td>
<td>75.00</td>
<td>114.00</td>
<td>2.00</td>
<td>142.50</td>
<td>25.00</td>
</tr>
<tr>
<td>Emergency, Eye A</td>
<td>26.00</td>
<td>0</td>
<td>31.00</td>
<td>26.00</td>
<td>1.00</td>
<td>31.50</td>
<td>6.50</td>
</tr>
<tr>
<td>Emergency, Eye B</td>
<td>30.00</td>
<td>0</td>
<td>37.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Emergency, Eye C</td>
<td>35.00</td>
<td>0</td>
<td>44.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Examination</td>
<td>24.00</td>
<td>0</td>
<td>30.00</td>
<td>240.00</td>
<td>16.00</td>
<td>300.00</td>
<td>60.00</td>
</tr>
<tr>
<td>Examination - 2nd Opinion</td>
<td>32.00</td>
<td>0</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Examination 2nd Opinion - 2y</td>
<td>20.00</td>
<td>0</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Examination w/Vaccinations</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Examination, 2nd Animal</td>
<td>16.00</td>
<td>0</td>
<td>20.00</td>
<td>14.40</td>
<td>1.00</td>
<td>18.00</td>
<td>5.50</td>
</tr>
<tr>
<td>Examination, Comprehensive</td>
<td>32.00</td>
<td>0</td>
<td>40.00</td>
<td>28.80</td>
<td>1.60</td>
<td>36.00</td>
<td>7.20</td>
</tr>
<tr>
<td>Examination, Comprehensive</td>
<td>20.00</td>
<td>0</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Health Certificate</td>
<td>6.00</td>
<td>0</td>
<td>7.50</td>
<td>5.40</td>
<td>1.00</td>
<td>6.75</td>
<td>1.25</td>
</tr>
<tr>
<td>Preoperative ECG - Fax Card</td>
<td>25.00</td>
<td>0</td>
<td>31.50</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Rachet</td>
<td>16.00</td>
<td>0</td>
<td>20.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Office Visit - Geriatric</td>
<td>20.00</td>
<td>0</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Office Visit - Annual</td>
<td>35.00</td>
<td>0</td>
<td>44.00</td>
<td>60.00</td>
<td>3.00</td>
<td>75.43</td>
<td>15.43</td>
</tr>
<tr>
<td>Office Visit - New Client</td>
<td>20.00</td>
<td>0</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

457.80  20.00  610.18  122.60  176.72

- In the Markup Analysis window select **File, Open** from the menu to open a previously saved .dat file that contains markup pricing information.
- To save markup values currently displayed in the Analysis window select **File, Save As** from the menu area. Enter a file name, location and click Save.
- To print the markup analysis values select **File, Print** from the menu.

**To learn more about:**

Marking up Prices

**Search the Help for:**

Marking Up

**Adding a Treatment**

The right half of the Treatment List Window displays the Treatment List for the category currently selected. Working in this window, you are able to add new treatments and/or specify information about each of the existing services you perform.

- Select the correct Treatment Category to add the treatment to.
- **Point** in the Treatment List Records for section. **Right-click** and from the shortcut menu click **New** to display the New Treatment window.
**Treatment Tab Values**

**Find**
Use the Find menu button to quickly locate a field.

- Click the **Find** button.
- From the drop-down list select the field you are searching for and click **OK**. AVImark will then place the cursor in the selected field.

**Code**
You may use up to 8 characters, either numbers, letters, (or a combination of both) for a treatment or Treatment Group. AVImark will not allow you to use the same Treatment Code for an inventory item, diagnoses or another treatment that has already been entered.

- Type a code for the treatment.

**Description**
This is the description that will appear on all Period reports and in the Medical History of those patients receiving the treatment.

- Type the description you wish to assign the treatment.

**Charge**
Type the amount you wish to charge the client for this treatment.

**Action Codes**
Action Codes cause AVImark to perform certain functions including various add-on fees, patient sex codes, patient conditions, taxing, drug labels, and so on.

- If applicable, use the **Action Codes** drop-down list and select the appropriate Action codes.
The following table lists each Action Code and its meaning:

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Automatic drug label prompt</td>
<td>Prompts the drug label window to display when the service is entered into medical history.</td>
</tr>
<tr>
<td>B</td>
<td>Automatic test result prompt</td>
<td>Prompts the additional data field window allowing you to enter the patient’s test results.</td>
</tr>
<tr>
<td>C</td>
<td>Controlled Substance</td>
<td>Marks this service as a controlled drug and includes it on the controlled substance report.</td>
</tr>
<tr>
<td>D</td>
<td>Treatment causes death</td>
<td>Automatically marks the patient as deceased when the service is entered into medical history.</td>
</tr>
<tr>
<td>E</td>
<td>Print one document/patient</td>
<td>Prompts a document for each patient that has received the same service in medical history for a client.</td>
</tr>
<tr>
<td>F</td>
<td>Include on travel sheet</td>
<td>Includes this service on the travel sheet that can be printed through AVImark.</td>
</tr>
<tr>
<td>G</td>
<td>Treatment Group</td>
<td>Makes this service a parent treatment group allowing you to link components to this code.</td>
</tr>
<tr>
<td>H</td>
<td>Handling fee</td>
<td>Includes the handling fee with the price of the service.</td>
</tr>
<tr>
<td>I</td>
<td>Integer pricing</td>
<td>Rounds the price of a service that has a partial quantity to the price of the nearest whole number.</td>
</tr>
<tr>
<td>K</td>
<td>Prompt to include in group</td>
<td>When included within a treatment group this action code will prompt you if you would like to enter the service in medical history.</td>
</tr>
<tr>
<td>L</td>
<td>Subject to local sales tax</td>
<td>Includes the local/PST tax to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>M</td>
<td>Intramuscular injection fee</td>
<td>Includes the intramuscular fee to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>N</td>
<td>Don’t print on patient chart</td>
<td>Suppresses the printing this service on the patient’s printed chart.</td>
</tr>
<tr>
<td>P</td>
<td>Prescription fee</td>
<td>Includes the prescription fee to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>Q</td>
<td>Don’t post to invoice</td>
<td>Will not include this service on the printed invoice. This service will be entered in medical history and displayed as already posted.</td>
</tr>
<tr>
<td>R</td>
<td>Rabies vaccination</td>
<td>Indicates this service as a rabies vaccination. This action code will also prompt for the vaccine information window.</td>
</tr>
<tr>
<td>S</td>
<td>Subject to state sales tax</td>
<td>Includes the state/GST tax to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>T</td>
<td>Subject to state and local sales tax</td>
<td>Includes both state &amp; local/PST &amp; GST tax to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>U</td>
<td>Intravenous injection fee</td>
<td>Includes the intravenous fee to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>V</td>
<td>Vaccination</td>
<td>Indicates that this service is a vaccination, this will also include these services on the vacs tab at the bottom of the CID screen.</td>
</tr>
<tr>
<td>W</td>
<td>Auto prompt for vital signs</td>
<td>Automatically prompts for the Medical Condition Record (SOAP) to display when this service is entered into medical history.</td>
</tr>
<tr>
<td>X</td>
<td>Causes sex alteration</td>
<td>Automatically updates the patient’s sex to spayed, neutered or gelded depending on the previous sex and species of the patient.</td>
</tr>
<tr>
<td>Y</td>
<td>Assign certificate number</td>
<td>Automatically assigns a certificate number when this service is entered into the patient’s medical history.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Dietary item</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>Surcharge by item cost</td>
<td></td>
</tr>
<tr>
<td>&amp;</td>
<td>Surcharge by item price</td>
<td></td>
</tr>
<tr>
<td>)</td>
<td>Integer qty surcharge</td>
<td></td>
</tr>
<tr>
<td>$</td>
<td>Include price on chart</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Obsolete treatment</td>
<td></td>
</tr>
<tr>
<td>@</td>
<td>Auto prompt for document</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Don’t print form/document</td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>Auto prompt for notes</td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>Schedule follow-up at posting</td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>Show warning if quantity is equal to 1</td>
<td></td>
</tr>
<tr>
<td>&gt;</td>
<td>Don’t print notes on chart</td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>Control refills</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>Don’t use additional fees</td>
<td></td>
</tr>
<tr>
<td>%</td>
<td>Auto copy notes into medical history</td>
<td></td>
</tr>
<tr>
<td>~</td>
<td>Auto hide notes in medical history</td>
<td></td>
</tr>
<tr>
<td>[</td>
<td>Auto prompt for the microchip number</td>
<td></td>
</tr>
<tr>
<td>{</td>
<td>Auto prompt for the locator number</td>
<td></td>
</tr>
<tr>
<td>}</td>
<td>Don’t add to Whiteboard</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Don’t post from Whiteboard</td>
<td></td>
</tr>
<tr>
<td>&lt;</td>
<td>Include on the E-Travel sheet</td>
<td></td>
</tr>
</tbody>
</table>

- **Z** Dietary item: Includes this service on the dietary tab at the bottom of the CID screen.
- **+** Surcharge by item cost: Includes the cost of the linked item to the price of the parent service.
- **&** Surcharge by item price: Includes the price of the linked item to the price of the parent service.
- **(** Integer qty surcharge: If a partial amount is used of a linked inventory item AVImark will round the quantity to the price of a whole amount and add it to the price of the service it is linked to.
- **$** Include price on chart: This action code will include the price of the service on the printed patient chart.
- **-** Obsolete treatment: Marks a service as obsolete and grays it out on the list. When trying to add this service to medical history you will be warned that it is an obsolete service.
- **@** Auto prompt for document: Prompts to print the linked document. Without this action code AVImark will automatically print the liked document with the invoice.
- **#** Don’t print form/document: Suppresses the printing of the linked form or document.
- ***’** Auto prompt for notes: When entered into medical history it will automatically prompt for a notes window to enter information about the service.
- **?** Schedule follow-up at posting: This action code will display the follow-up window when posting instead of when the service is entered into medical history.
- **!’** Show warning if quantity is equal to 1: This action code will display a warning if the service entered in medical history has a quantity equal to one.
- **>** Don’t print notes on chart: Will not include the entered medical history notes on the printed patient chart.
- **(’** Control refills: Allows you to control refills on this service if a drug label is being printed.
- **=’** Don’t use additional fees: Does not allow the additional fees (intra-muscular, intravenous, prescription, etc) to be added to the price of the service.
- **%’** Auto copy notes into medical history: Copies entered notes on the treatment automatically into a notes window in medical history.
- **~’** Auto hide notes in medical history: Will not display the entered medical history notes on the CID screen.
- **[’** Auto prompt for the microchip number: Automatically prompts for the patient’s microchip number and will enter the number into the patient’s area of the CID screen.
- **{’** Auto prompt for the locator number: This action code will prompt for a number to be used with ePetRecords.
- **}’** Don’t add to Whiteboard: Will not include this service on the whiteboard automatically when entered into medical history.
- **1’** Don’t post from Whiteboard: When posting services from the whiteboard this action code will not post the service to medical history.
- **<’** Include on the E-Travel sheet: Includes this service on the electronic travel sheet.
Show Notes in Medical History

This action code allows you to view specific notes with the option selected of “Show all with note action” in medical history.

Pet ID Card Treatment

Prompts a Pet ID card, if accepted the prompts and exports the information to a file. If you would like to utilize this action code please contact the Pet ID department at 877-677-7384, option 6.

Dental Assessment

Automatically prompts the dental chart to display when the service is entered into medical history.

Report Codes

Report codes are user-defined letter characters used for grouping performed treatments together on certain reports (Treatment Control Log, Patients by Treatment, Income by Treatment, Transaction Summary, and Sales Summary). You may use up to 3 codes for each treatment. There are some codes that are pre-programmed for use with the most common reports. They are:

- Lab services (L)
- Surgery (S)
- Injections (I)
- Prescriptions (P)
- Vaccinations (V)

List Codes

Any given treatment may be assigned up to 3 Work List codes. When you perform the treatment, the patient is automatically put on one or more Work Lists. These codes are defined in the Work Lists Table of System Tables. For more information on Work Lists codes, refer to “CHAPTER 2: SYSTEM TABLES”.

- If appropriate, use the List Codes drop-down list and select the appropriate Work Lists code(s).
- Cost

The Cost of the treatment will be included on the Income by Treatment Report, Sales and Transaction Summary and the Transaction Journal. The Cost cannot be marked up and will not be included on any graphs.

- Type the cost for this treatment.

Markup Percent

A markup percentage can be added directly to the treatment that AVImark will use when a Markup is performed. This percentage will take precedence over the category markup percentage.

- Type the markup percentage for this treatment.

Appointment Time

The Appointment Time field is used to allot the number of minutes on the AVImark Appointment Calendar for an appointment for this treatment.

- If appropriate, use the UP and DOWN ARROWS and select the number of minutes you wish to allot for this treatment.

Sex(es)

You may restrict certain treatments to patients of a certain sex.

- If appropriate, use the Sex(es) drop-down list and select the appropriate Sex code(s).

Discount Class

AVImark uses the Discount Class field to determine which treatments are to be discounted to which client class. You may set up an unlimited number of client classes as well as treatment and inventory classes.
• If applicable, use the **Discount Class** drop-down list and select the appropriate discount class.

**Species 1 & Species 2**
You may specify up to 2 different species for the treatment. If you attempt to enter the treatment into Medical History of a patient whose species is other than what is selected here, the treatment will NOT be entered and you will receive a warning message.

• If appropriate, use the **Species** drop-down list and select the appropriate species limitation for the treatment.

> The Species limitation fields DO NOT apply for Treatment Groups.

**Abbreviation**
The **Abbreviation** field allows a shortened description of the treatment to be displayed when this Treatment is included on the Whiteboard. This field will hold up to fifteen characters. This description will only be used to display within the Whiteboard. When posted to the Medical History from the Whiteboard, the normal description will be used.

• If appropriate, type a shortened description of the treatment.

**Photo**
AVImark lets you link any .bmp; .jpeg; or .tif image to the treatment to be printed on the client invoice attached to the doctor’s instructions for the treatment. When this treatment is included on the client invoice, this photo will be printed at the bottom half of the invoice along with take-home instructions. However, if there are no take-home instructions linked with the treatment the photo will not be printed on the invoice.

• If appropriate, use the **Photo** field browse button to open the folder of your saved photo files.

**Invoice**
AVImark allows you to specify an alternate name of the treatment that will be printed on the client invoice, estimate, and/or statement.

• If necessary, type an alternate **Name** for the treatment.

**Form**
AVImark allows you to designate a default Microsoft Word form that is to be used for the treatment.

• If appropriate, use the **Form** field browse button to open the folder of your MS Word forms.

**Doctor**
AVImark allows you to specify a default doctor that will automatically be selected when you enter the treatment in the Medical History area of the patient.

• If appropriate, use the drop-down list and select the default doctor for the treatment.

**Journal**
AVImark allows you to specify a default MS Journal file to be used for the treatment.

• If appropriate, use the **Journal** field browse button to open the folder of your MS Journal files.

**Category**
This field allows you to move treatments from one category to another.

• If appropriate, use the drop-down list and select the correct category.

**Comments**
AVImark allows you to enter Comments about the nature of the treatment and/or procedures involved in
performing it. In addition, you may select to have the Comments printed on the client invoice.

- If necessary, type the appropriate comments in the area provided.
- If you wish to have the comments printed on the client invoice, select **Print comments on invoice**.

**Doctor’s notes**

AVImark allows you to enter Doctor’s notes about the nature of this treatment and/or the procedures involved in performing it. By using the **Percent (%)** Action Code on the treatment, you can have the notes posted to the patient’s Medical History. These notes will not appear on the client invoice.

- If necessary, type the appropriate Doctor’s notes in the area provided.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typing notes or comments</td>
<td>Comments (select Treatments Tab); Doctors Notes</td>
</tr>
<tr>
<td>Using merge words in your documents</td>
<td>Merge words</td>
</tr>
<tr>
<td>Using the Note Glossary</td>
<td>Note Glossary</td>
</tr>
</tbody>
</table>

**Working with Attachments**

If working with a new treatment you must click **Done** before working with the Attachments area. There are three major treatment Attachments – Doctor’s Instructions, Associated Treatments and Items, and More Stuff. These attachments will be added from the Change Treatment window.

- From your Treatment List, select the correct treatment.
- **Right-click** and from the shortcut menu click **Change** to display the Change Treatment window.

**Attachments: Add Doctor’s Instructions**

Take-home instructions can be attached to any treatment and printed automatically on the client invoice. When creating Doctor’s Instruction, you may use any AVImark note feature options. For detailed information on the AVImark note feature options, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”.

- In the **Attachments** area of the Change Treatment window, click **Doctor’s Instructions** to display the Doctor’s Instructions Note window.

- Type the appropriate take-home Doctor’s Instructions and click **Done**.
- These instructions can be viewed or modified from the Medical History area. Once the service has been entered select **right-click Instructions**.
If you have several treatments with similar Doctor’s Instructions, you may “duplicate” the instructions without having to retype them. Instead of typing the instructions, type the Treatment Code of the “parent” treatment enclosed in asterisk (*220*). When using tag-a-long instructions, ensure the first asterisk is at the left margin with no spaces.

**Treatment/Item Association Tab**
AVImark allows you to link or “associate” other treatments, inventory items, and/or diagnosis codes to any treatment. With this feature you may enter multiple treatments into the patient’s Medical History by setting up either a Treatment Group or Linked Treatments. You may also control inventory usage for any service by setting up Inventory Usage.

To access Associated Treatment/Item window from the Treatment List, highlight a code then **right-click** Change or double left-click on the code to open the Change Item window, and then click on the Associated Entries tab. Column Customization can be setup by using **right-click** View, Columns. This window also allows treatments and items to be sorted by using drag and drop. You can easily re-arrange the order of the codes the way you want them to be listed in Medical History then on to the client Invoice.
Treatment List

- Linked Treatment and Inventory Used codes can be selected in the Associated Treatment Item window by using the Icon in the top left corner or by using the **right-click**, New or Choose options.
- If the treatment has linked treatments or items the appropriate association options will be displayed.

**NOTE:** The Treatment List, Inventory List, Diagnosis List, Problem List, and Advanced Options, tabs will change to the color green when information is within that specific tab. This makes it easy to tell, at a glance, if information has been entered for that area.

**Link Associated Inventory and Specify Usage**
You may link any inventory with your treatments to relieve on-hand quantities whenever the treatment is entered into the Medical History of the patient. After the treatment has been entered into the patient’s Medical History and later posted to the client’s invoice, AVImark will update inventory on-hand quantities appropriately.

- On the Associated Entries tab **right-click** to Choose and click **Items** to display the Inventory list window.
- From the Inventory list, select the appropriate items by clicking on the item itself. This will place the item in the Selected Items area.
- If necessary, you may change the quantity usage of each item by clicking on the item additional times or by changing the quantity in the Selected Items area.
- Click **Done** Associated Entries tab.

**Allow override**
AVImark gives you the ability to change the default inventory usage each time the treatment is performed. When you enter the treatment into the Medical History of a patient, AVImark will open the Inventory Used window on the CID and let you change the default quantities or items you previously assigned to the treatment.

- On the Associated Entries tab, select **Allow override** and click **Done**.

---

You may also override the inventory usage from the CID after the treatment is entered into the patient’s Medical History by selecting the “Inventory Used” box from the “Attachments list” in the Medical History area. You may update the usage either before or after the treatment has been posted. However, if the adjustment is done AFTER the treatment is posted, inventory on-hand quantities will not be relieved automatically. You will have to make the adjustment manually. This may be useful if controlled substance levels need to be adjusted after the treatment was entered and posted.

**Treatment Pick List Window**
A Pick List window has been created in AVImark and is designed to list entries linked to the parent treatment being added to Medical History. From this window the user can pick which linked entries are to be posted.

**Auto-Prompting for Pick List**
- Locate the desired service in the Treatment List and open the Change Treatment window.
- From the “Associated Entries” tab link the desired entries and check the option “Prompt for Linked Entries”.
- With this option checked the Pick List window will automatically open at the time the parent treatment is added into Medical History. Tag-a-longs will also be included in the Pick List window.
Utilizing the Pick List Window

- Add the service in Medical History that has linked entries and is set to prompt for linked entries.
- In the Pick List window choose the entries to post to Medical History by clicking on the entries, pressing the Spacebar or using right-click Select. For the number of times you left-click on an associated entry or press the Spacebar, the dispensing quantity will increase for that entry.

- The selected entries to be posted will appear at the bottom of the Pick List window.
- When ready to post the selected entries click OK.
Treatment List

- To access the Pick List window from Medical History select the parent treatment and use right-click Choose, Pick List Entries.

**Print on invoice**
AVImark allows you to print the inventory usage for the treatments performed on the client invoice.
- On the Associated Entries tab, select **Print on invoice**.

**Add an inventory usage surcharge**
- With certain Action codes for a treatment, you may add a surcharge to the price of the treatment. The surcharge amount will either be the Average Cost or the Retail Price of any inventory item used. This allows you to set a “base” price to the treatment to cover labor and other overhead plus a surcharge depending on how much inventory is used.
- To add the **Retail Price** of inventory used to the price of the treatment, specify the **Ampersand (&)** as one of the Action codes for the treatment.
- To add the **Average Cost** of inventory used to the price of the treatment, specify the **plus sign (+)** as one of the Action codes for the treatment.

**Link Associated Treatments/Diagnosis/Problems**
You may link associated treatments, diagnosis, and/or problems with the selected treatment. Also called “Tag-a-long” treatments, these treatments, diagnosis, or problems are entered into the Medical History of the patient at the time the original (parent) treatment is added. There is no built-in discounting capability with linked treatments as there is with Treatment Groups.
- On the Associated Entries tab, **right-click**, **Choose** and click **Treatments**, **Diagnosis** or **Problems** to display the appropriate list.
- Add treatments and/or diagnosis using the same procedures as discussed in the topic, “Attachments: Associate Treatments/Items on page 52”.

**Create a Treatment Group**
Treatment Groups serve two purposes. First they allow you to enter several treatments and items into the Medical History of the patient by entering only one code. Second, they allow discounts on the treatments and items included in the group. In addition, AVImark gives you the ability to link multiple groups together. One or more Treatment Groups can be linked to an “overall parent” Treatment Group which allows a single, combined group to be added to a patient’s Medical History. When several Treatment Groups are linked to a collective “parent group”, the individual prices of all group components will be prorated from the group price set for the parent group (if Use Normal prices is not selected.)

Your Treatment List may be better organized if you keep all of your Treatment Groups in a Treatment category called “Treatment Groups”. All Treatment Groups, wherever they are in your Treatment List, will be displayed in red. In addition, the Treatment Group description itself will not be recorded in the Medical History area, only the components of the group.
• Create a new treatment, preferably within the Treatment Groups category, and assign a Code and Description. For assistance in adding this treatment, refer to the topic, “Add a Treatment” on page 42.

• TAB to the Action Codes field and if not already there, select the G Action code.

• When the G action code is added the Associated Entries Tab will be automatically renamed Grouped Entries

• Click Done to add the new Treatment.

Add Treatment Group components
If adding a new treatment you must first save the treatment before working with the Associated Entries tab.

• In the Change Treatment window click the Associated Entries tab

• Add Treatments, inventory, and/or diagnosis using the same procedures as discussed in the topic, “Associated Entries” on page 51.

• To edit the quantity of each component, double-click or right-click, change on the component.

Include Tag-a-longs?
“Tag-a-long” treatments are formally Linked Treatments. You cannot add Linked Treatments to a Treatment Group. However, a treatment in your Group Components window may have Linked Treatments associated to it.

• If applicable, select Include Tag-a-longs? to allow any linked treatments that belong to any of the treatments within the Group Components window to be included in the Treatment Group.

Charge normal prices
Treatment Groups may be priced the same as or lower than the sum of the price of the components that make up the group.

• To charge normal prices for the components in the group, select Charge normal prices.

• To discount the prices of the Group Components, enter a price in the Change Treatment window that is lower than the total as indicated in the Group Components window. On the invoice, the components will be prorated to match the total group price.

To learn more about: Search the Help for:
Linking Treatments, Inventory, Diagnosis Associated Treatments
Link Inventory and Specify Usage Inventory Usage
Create Treatment Groups Treatment Groups

Adding Additional Data Fields
AVImark allows you to define additional data fields for any treatment in your Treatment list to give you a formal way of recording certain medical-related data, lab data, physiological signs, or any other specific data for a particular treatment. For detailed instructions on how to set up Additional Data Fields, refer to “CHAPTER 25: ADDITIONAL DATA FIELDS”.

Advanced Tab Values
Vaccine
The Vaccine field allows you to select a default vaccine for the treatment to be automatically chosen when the treatment is performed (typically rabies vaccinations). Vaccine codes are entered in the Vaccine Table of System Tables. For more information on setting up the Vaccine Table, refer to “CHAPTER 2: SYSTEM TABLES”.

• If appropriate, use the drop-down list and select the correct vaccine for the treatment.
Remind as
In AVImark, reminding for treatments and inventory items is primarily controlled by Reminder Templates. “Remind as” allows you to use the reminder setup of another treatment.

- Enter up to 3 Treatment codes that you wish the patient to be reminded for when this treatment is performed. In this way, you do not need to set up a Reminder Template for this treatment.

Weight Surcharge
The Weight Surcharge percentage value allows you to cause the amount you charge for a treatment to increase depending on the normal weight you have specified for each species in the Species Table of System Tables and the weight of the patient you are currently treating.

- If applicable, use the Weight Surcharge field UP and DOWN ARROWS to specify a percentage.

Follow-up
The Follow-up field allows you to specify the values that will determine how patients receiving the selected treatment will be handled by the AVImark Follow-up function. For a detailed discussion on the AVImark Follow-up feature, refer to “CHAPTER 27: THE FOLLOW-UP LIST”.

- If appropriate, type in the field the specific number of days, after which receiving the treatment, you want the patient to be included on the Follow-up list.

Follow-up Critical?
This option allows you to identify the follow-up to be of critical importance.

- If appropriate, select Follow-up Critical?
Subject
The Subject field defaults to the Treatment description. You may assign a different subject or reason if you wish.

- If appropriate, assign a different subject or reason.

Company
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple items.

- If appropriate enter the desired company number for reporting purposes.

Contract Prices Tab Values
This tab allows contract prices to be defined for Treatments. Before contract prices can be defined, descriptions for the prices must be created. These descriptions can be created from either the Contract Prices Tab or from the Contract Pricing Table within System Tables. For detailed information on adding new Contract Pricing entries to System Tables, refer to “CHAPTER 2: SYSTEM TABLES”.

- To create a new description from the Contract Prices window, right-click and from the shortcut menu click New to display the New Treatment Contract Price window.

  ![New Treatment Contract Price Window]

- In the Description field, click the New button to display the New Contract Price Code Entry window.

  ![New Contract Price Code Entry Window]

- Type a single character code in the Code Field.
- Type the description for the new entry in the Description field and click OK.

Documents Tab Values
AVImark allows you to associate a Microsoft Word document or Star Office document with a treatment. You can print this document at the time it is first entered into the Medical History of the patient or at the time the invoice is printed, depending on what Action Code you enter for the treatment.

- To enter the document name, right-click and from the shortcut menu click New to display the
- New Treatment Species Entry window.
- Use the Species drop-down list and select the appropriate species.
- Use the Document field browse button to open the folder of your MS Word Documents.
• Select the appropriate document and click OK.

By default, the document will print when the invoice is printed for the client. If you specify the At sign (@) Action Code for this treatment, AVImark will print the document at the time the service is entered into the Medical History area of the patient instead of when the invoice is printed.

Whiteboard Tab Values
The Whiteboard tab of the Change Treatment window allows you to specify the applicable values that will be used in grouping patients and treatments together on the Whiteboard. For detailed information on the AVImark Whiteboard feature, refer to “CHAPTER 19: WHITEBOARD”.

Whiteboard
This field allows you to select the Whiteboard category you wish to assign to this specific treatment. These categories are set up in the Whiteboard Categories Table within System Tables.

• Use the drop-down list and select the appropriate Whiteboard category.

Include Tag-a-longs on Whiteboard
This option allows you to include tag-a-longs when adding a Treatment Group to the Whiteboard Schedule tab.

Frequency
This field holds the default value for the frequency (number of times this service is to be administered daily) when this code is added to Whiteboard.

• Use the UP and DOWN ARROWS or type in the number to enter the default value for the Frequency.

• In the second field specify the frequency of times per day or hour interval.

Laboratory Tab Values
From the Laboratory tab of the Change Treatment window information related to lab machines and this treatment will be defined.

• In the DICOM sub-tab is related information to a new interface with Sound Technologies and the ability to work with DICOM images in AVImark.

• The Instrument Types sub-tab displays which instrument was used to define result fields linked to the selected treatment.

• The Labs sub-tab contains information when the treatment is associated with the IDEXX VetLab Station. From this tab you will select right-click New and select the appropriate lab company in order to make an IVLS association with this treatment.

Treatment Right-Click Menu
Within the Treatment List window there are several other features found in the shortcut menu. Click the right mouse button (called right-click) to display the shortcut menu.

Add a duplicate treatment
AVImark lets you add a new treatment to your list that is a duplicate of one that you already have entered. This will be very useful if you are adding several treatments that have the same characteristics.

• From your Treatment List, select the treatment you wish to duplicate.

• Right-click and from the shortcut menu click Another to display a duplicate Change Treatment window.

• Enter a new Treatment Code for the duplicate treatment as well as any other necessary changes and click Done.
Select
- You may choose treatments to be added to Medical History, Estimates, Whiteboard, Appointment
  Calendar and Treatment Groups.
- With the correct treatment selected right-click Select.
- The treatment will be displayed in the Selected window to the left.

Edit
Use the Edit menu to select treatments or to undo or redo changes to a treatment.

View
From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this
treatment, Preview or Hide text associated with the treatment or you can choose how to sort the window. If you
have customized the display by arranging and adding or removing columns you can print the display by using
the Print option from the View menu

Entry History
Use this option to view a history of changes made to the selected treatment.
- Select a treatment and choose right-click View, Entry History.
- View date and time change was made, logged in user who made the change and a description of the
  change that was made.
- Click Done to close the window.

Move treatments to another category
You may easily move one or more treatments from one category to another.
- With the correct treatment selected right-click and from the shortcut menu click Move.
- You will need to click Yes to confirm and click the Treatment Category name you wish to move the
treatment to.

Print a treatment label
You may print labels similar to prescription labels for any treatment in the list. For a detailed discussion on
printing labels, refer to “CHAPTER 15: PRESCRIPTION LABELS”.
- From the right-click shortcut menu, click Drug Label to display the AVImark® Drug Label window.
- Enter the appropriate information you wish to appear on the label and click Print.

Display and print graphs
For any given treatment, you may display one or more graphs showing production, profit, trends, and so on.
You may display and print graphs using either AVImark’s Graphing feature or Excel. This option is selected in
the Advanced area of Hospital Setup.
- From the right-click shortcut menu, point to Graph and click the graph you wish to display.

Instructions
You may attach take-home instructions to any treatment to be printed automatically on the client invoice.
- With the correct treatment selected, right-click from the shortcut menu and click Instructions to
display the Doctor’s Instructions window.
- Type the take-home instructions. All the available AVImark note feature options are available from this
  window.
- Click Done to save the Doctor’s Instructions.
AVImark User Manual

Treatment List

Markup
Use this option to mark up the selected treatment. To learn more about marking up treatments refer to “MARK UP TREATMENT PRICES” 39 page 42.

Price History
You are able to track the price history of your services. Anytime the price of a treatment is changed the Date, Time, User that made the change, Action of the change, and the Old and New prices will be stored for that code. The Action of the price change refers to whether the price was changed manually, or changed using the Mark up feature. This information can be printed using the print option in the top left hand corner of the Price History window.

• With the correct treatment selected, right-click and from the shortcut menu click Price history to display the Treatment Price History window.

Set up a treatment reminder
AVImark allows you to set up a Reminder Template for any treatment. For a detailed discussion on setting up Reminder Templates, refer to “CHAPTER 11: REMINDERS”.

• With the correct treatment selected right-click and from the shortcut menu click Reminder.
• You will need to click Yes to create one and display the Reminder Template.
• Specify the various conditions for the reminder and click Done.

View and print the Whogot list
The AVImark Whogot list is a sorted list of all patients and their owners that have received a specified treatment, inventory item, or diagnosis. Use the Whogot list to view, sort, print, or go to the CID of any patient receiving the chosen treatment, item or diagnosis in a specified number of months.

• With the appropriate treatment selected, right-click and from the shortcut menu click Whogot to display the Treated Patients window.
• Click Print or to preview the report onscreen select Preview and click Print.
• Click **Done** to return to the Treated Patients window.

• Select the individual patients from the list you wish to print by clicking on the patient name and press the SPACEBAR.

• Click **Print** to display the Print Whogot window.

![Print Whogot window]

• If applicable, use the **Criteria** menu to sort and/or limit the number of patients selected. Use the **Print to** drop-down list and select the correct Printer.

• Using the **Months to show** field, enter the number of months to display or use the drop-down calendar to specify the period you wish to print for.

• If applicable, double-click in the **Document** field to select a Document from among your MS Word documents.

• Select **Include notes** to include the notes about the treatment performed for each patient on the list.

• To omit the prescription messages, check the **Exclude scripts** checkbox.

• If applicable, click on **Restrict to last query** to limit the printing of documents to only those patients chosen when you ran the last information search.

**Undelete a deleted treatment**

AVImark gives you the ability to undelete any treatments that may have been deleted.

• In the Treatment list window, **right-click** and from the shortcut menu click **Undelete** to display the Undelete Treatments window.

• If applicable, select the **Undelete to a Lost and Found category** to place the revived treatments in a category named L & F with the date and time they were revived.

• Click on the treatment you wish to undelete. Use the SPACEBAR or **right-click** and from the shortcut menu click **Select**. The treatment will appear bolded when selected.

• After all treatments have been selected, click **Undelete**.

**Print the Treatment List**

• On the Treatment List window, open the **Print** menu. Point to **Reports** and click **Treatment List** to display the Print Treatment List window.

• Use the **Category** drop-down list and select the individual category to print or select **All Categories**.

• To include linked inventory and treatments as well as take-home instructions on the report, select the **Print details** option.

• To print a 13-month production report with usage and sales totals, select the **Production totals** option.
Sort the Treatment List report
By default, AVImark will sort the treatments within each category by Code, Price or Description. If the “Category” box is unchecked, AVImark will simply print all treatments in the order in which selected.

Print a Travel Sheet
The Travel Sheet is a customized list of commonly used treatments that you use during the visit with the patient. By default, only those treatments with the “F” Action code will be included on the Travel Sheet.

- On the Treatment List window, open the Print menu. Point to Reports and click Travel sheet to display the Print Travel sheet window.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Pricing</td>
<td>Contract Prices</td>
</tr>
<tr>
<td>Whogot List</td>
<td>Whogot</td>
</tr>
<tr>
<td>Treatment Reports</td>
<td>Travel Sheet; Print Treatment List</td>
</tr>
</tbody>
</table>
CHAPTER 4: INVENTORY LIST

The Inventory List contains all of your items that you sell to your clients or use in treating your patients. In setting up your Inventory List you will need to create Inventory Categories, assign prices, set up your Vendor list, and so on. The AVImark Inventory List identifies Inventory Categories, items within each category and a Selected Items section.

In this chapter you will learn about...

» Setting up Your Inventory Categories on page 61
» Category and Item colors on page 63
» Inventory Categories Shortcut Menu on page 63
» Removing an Inventory Category on page 63
» Moving to Treatments on page 63
» Undeleting Inventory Items on page 64
» Add an Inventory Item on page 64
» Advanced Tab Values on page 70
» Contract Prices Tab Values on page 71
» Documents Tab Values on page 71
» Pharmacy Tab Values on page 72
» Purchasing Tab Values on page 73
» Sales Tab Values on page 74
» Whiteboard Tab Values on page 74
» Inventory Report and Documents on page 75
» View and the Whogot list on page 82
» Update Inventory Sales on page 84
» Add Vendors on page 84
» Create Purchase Orders on page 85
» Purge Orders on page 87
» AVP for Canadian Clinics on page 87
» Needs List on page 88
» Intelligent Inventory on page 91

Setting up Your Inventory Categories

To work with your Inventory List, open the Work with menu and click Inventory.

Add or change an Inventory Category

Point in the Inventory Categories list area. Right-click and from the shortcut menu click New to display the New Inventory Category window.
• Enter the appropriate information into each field and click **Done** to add or change the category.

**Category**
This is the descriptive name given to each category to identify it in most AVImark functions.

  • Type the name you wish to give the new category.

*If you would like your categories to be in numerical order, change each category name by typing a number in front of a category name. For example: 01Pharmacy, 02Supplies.*

**Report Codes**
Report codes are user-defined letter characters used for grouping specific items together on certain reports (Treatment Control Log, Patients by Treatment, Income by Treatment, Transaction Summary, and Sales Summary). You can have up to 7 codes for each category. Some codes are pre-programmed. They are:

  • Injections (I)
  • Lab Services (L)
  • Prescriptions (P)
  • Surgery (S)
  • Vaccinations (V)

  • If appropriate, use the drop-down list and select the correct Report code(s) for the new category.

*AVImark already has controlled substance tracking and is dependant upon the “C” action code on the appropriate item.*

**Markup Percentage**
The Markup percentage is the default percentage used to mark up the prices of items in this category.

  • If appropriate, type in the field to specify the Markup Percentage for this category. You can always type a different Markup percentage at the time you initiate the actual mark up process.

**Account number**
To interface with QuickBooks, you will need to enter the income account number that you set up in QuickBooks as the account in which to record the income generated from inventory within this category. If specified, this
account number is used as the account name for QuickBooks instead of the Inventory Category name.

- If appropriate, type in the field to specify the income account number that you have set up in QuickBooks.

**Report name**
The Category Report name must be given for use in the End-of-Period reports. This name can be different or the same as what was typed in the Name field.

- Type a Category Report name.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Reports</td>
<td>Inventory Reports</td>
</tr>
<tr>
<td>Using Report Codes</td>
<td>Inventory Report Codes</td>
</tr>
<tr>
<td>QuickBooks® Interface</td>
<td>QuickBooks®</td>
</tr>
</tbody>
</table>

**Whiteboard**
This field represents the Whiteboard categories that are set up in “System Tables”. They are used to group and organize items on the ‘Whiteboard’.

- Use the **Whiteboard** drop-down list and select the Whiteboard category you wish to assign to this category.

**Company**
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple items.

- If appropriate enter the desired company number for reporting purposes.

**Category and Item colors**
AVImark will highlight the category and item names in red, blue, or gray depending on the following criteria:

- If the On-hand Quantity of an item is equal to or less than its Order Point, the category name and item itself will be displayed in red.
- Items that are currently on an open order will be displayed in blue.
- Obsolete items (items that you want to keep on the list, but not for selection) are displayed in gray.

**Inventory Categories Shortcut Menu**
In the Inventory Categories list window, there are several things that you can do from the shortcut menu. Use the **right-click** option in the Inventory Categories list to see the shortcut menu.

**Removing an Inventory Category**
- Select the Inventory Category you wish to remove. **Right-click** and from the shortcut menu click **Remove**.
- You will need to click **Yes** to confirm.

> Removing an Inventory category also removes all items within that category.

**Moving to Treatments**
Use this feature to move an Inventory Category and all its items to the Treatment List. However, all of the notes, drug label messages, doctor’s instructions, and other values specifically for inventory, will NOT be moved.
It is highly recommended that you make a backup of your AVImark data before proceeding. Once the move procedure is completed, there is no undo option.

- Select the Inventory Category you wish to move. Right-click and from the shortcut menu click Move to Treatments.
- You will need to click OK to confirm.

Undeleting Inventory Items
AVImark gives you the ability to undelete Inventory Categories or individual items from within the category.

- Point in the Inventory Categories window. Right-click and from the shortcut menu click Undelete Categories to display the Undelete Item Categories window.
- Use the SPACEBAR or right-click and from the shortcut menu click Select to choose the categories and/or individual items you wish to undelete. Items that are selected will be bolded.

Add an Inventory Item
The right half of the Inventory List Window displays the Item List for the category currently selected. Working in this window, you are able to add new items and/or specify information about each of the existing items you use.

- Select the correct Inventory Category to add the items to.
- Point in the Items List for section. Right-click and from the shortcut menu click New to display the New Item window.

General Tab Values

- Find
  Use the Find menu button to quickly locate a field.
  - Click the Find button.
  - From the drop-down list select the field you are searching for and click OK. AVImark will then place the cursor in the selected field.
**Code**
You may use up to 8 characters, either numbers, letters, (or a combination of both) for an item. AVImark will not allow you to use the same Inventory Code for a treatment, diagnoses or another item that has already been entered.

- Type a code for the item.

**Description**
This is the description that will appear on all Period reports and in the Medical History of those patients receiving the item.

- Type the description you wish to assign the item.

**On Hand quantity**
This is the number of items as dispensed that you have on hand. For example, you are trying to specify the on hand quantity for some capsules for which the minimum you can order from the vendor is a bottle of 100. You have 3 bottles of 100 capsules plus 52 more in an open bottle. You would set the On Hand quantity to 352.

- Use the drop-down list to display the calculator and to enter the current on hand quantity.

**Location**
This field identifies the location code or where the item is located in your facility.

- If appropriate, type a location code for the item. For example, CAB1.

**Action codes**
Action codes cause AVImark to perform certain functions.

- If applicable, use the drop-down list and select the appropriate Action codes.

The following table lists each Action code and its meaning:

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Automatic drug label prompt</td>
<td>Prompts the drug label window to display when the service is entered into medical history.</td>
</tr>
<tr>
<td>C</td>
<td>Controlled Substance</td>
<td>Marks this service as a controlled drug and includes it on the controlled substance report.</td>
</tr>
<tr>
<td>D</td>
<td>Treatment causes death</td>
<td>Automatically marks the patient as deceased when the service is entered into medical history.</td>
</tr>
<tr>
<td>E</td>
<td>Print one document/patient</td>
<td>Prompts a document for each patient that has received the same service in medical history for a client.</td>
</tr>
<tr>
<td>F</td>
<td>Include on travel sheet</td>
<td>Includes this service on the travel sheet that can be printed through AVImark.</td>
</tr>
<tr>
<td>H</td>
<td>Handling fee</td>
<td>Includes the handling fee with the price of the service.</td>
</tr>
<tr>
<td>I</td>
<td>Integer pricing</td>
<td>Rounds the price of a service that has a partial quantity to the price of the nearest whole number.</td>
</tr>
<tr>
<td>K</td>
<td>Prompt to include in group</td>
<td>When included within a treatment group this action code will prompt you if you would like to enter the service in medical history.</td>
</tr>
<tr>
<td>L</td>
<td>Subject to local sales tax</td>
<td>Includes the local/PST tax to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>M</td>
<td>Intramuscular injection fee</td>
<td>Includes the intramuscular fee to the price of this service as defined in hospital setup.</td>
</tr>
<tr>
<td>N</td>
<td>Don’t print on patient chart</td>
<td>Suppresses the printing this service on the patient’s printed chart.</td>
</tr>
<tr>
<td>Action Code</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td><strong>P</strong></td>
<td>Prescription fee</td>
<td></td>
</tr>
<tr>
<td><strong>Q</strong></td>
<td>Don’t post to invoice</td>
<td></td>
</tr>
<tr>
<td><strong>R</strong></td>
<td>Rabies vaccination</td>
<td></td>
</tr>
<tr>
<td><strong>S</strong></td>
<td>Subject to state sales tax</td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td>Subject to state and local sales tax</td>
<td></td>
</tr>
<tr>
<td><strong>V</strong></td>
<td>Intravenous Injection Fee</td>
<td></td>
</tr>
<tr>
<td><strong>W</strong></td>
<td>Auto prompt for vital signs</td>
<td></td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Causes sex alteration</td>
<td></td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Assign certificate number</td>
<td></td>
</tr>
<tr>
<td><strong>Z</strong></td>
<td>Dietary item</td>
<td></td>
</tr>
<tr>
<td><strong>$</strong></td>
<td>Include price on chart</td>
<td></td>
</tr>
<tr>
<td><strong>-</strong></td>
<td>Obsolete treatment</td>
<td></td>
</tr>
<tr>
<td><strong>@</strong></td>
<td>Auto prompt for document</td>
<td></td>
</tr>
<tr>
<td><strong>#</strong></td>
<td>Don’t print form/document</td>
<td></td>
</tr>
<tr>
<td>*** / **</td>
<td>Auto prompt for notes</td>
<td></td>
</tr>
<tr>
<td><strong>?</strong></td>
<td>Schedule follow-up at posting</td>
<td></td>
</tr>
<tr>
<td><strong>!</strong></td>
<td>Show warning if quantity is equal to 1</td>
<td></td>
</tr>
<tr>
<td><strong>^</strong></td>
<td>Not for retail</td>
<td></td>
</tr>
<tr>
<td><strong>( / =</strong></td>
<td>Control refills</td>
<td></td>
</tr>
<tr>
<td><strong>%</strong></td>
<td>Auto copy notes into medical history</td>
<td></td>
</tr>
<tr>
<td><strong>~</strong></td>
<td>Auto hide notes in medical history</td>
<td></td>
</tr>
</tbody>
</table>

- **P**: Includes the prescription fee to the price of this service as defined in hospital setup.
- **Q**: Will not include this service on the printed invoice. This service will be entered in medical history and displayed as already posted.
- **R**: Indicates this service as a rabies vaccination. This action code will also prompt for the vaccine information window.
- **S**: Includes the state/GST tax to the price of this service as defined in hospital setup.
- **T**: Includes both state & local/PST & GST tax to the price of this service as defined in hospital setup.
- **V**: Includes the intravenous fee to the price of this service as defined in hospital setup.
- **W**: Automatically prompts for the Medical Condition Record (SOAP) to display when this service is entered into medical history.
- **X**: Automatically updates the patient’s sex to spayed, neutered or gelded depending on the previous sex and species of the patient.
- **Y**: Automatically assigns a certificate number when this service is entered into the patient’s medical history.
- **Z**: Includes this service on the dietary tab at the bottom of the CID screen.
- **$**: This action code will include the price of the service on the printed patient chart.
- **-**: Marks a service as obsolete and grays it out on the list. When trying to add this service to medical history you will be warned that it is an obsolete service.
- **@**: Prompts to print the linked document. Without this action code AVImark will automatically print the liked document with the invoice.
- **#**: Suppresses the printing of the linked form or document.
- *** / **: When entered into medical history it will automatically prompt for a notes window to enter information about the service.
- **?**: This action code will display the follow-up window when posting instead of when the service is entered into medical history.
- **!**: This action code will display a warning if the service entered in medical history has a quantity equal to one.
- **^**: Does not allow the staff members to sell this item.
- **( / =**: Allows you to control refills on this service if a drug label is being printed.
- **%=**: Does not allow the additional fees (intra-muscular, intravenous, prescription, etc) to be added to the price of the service.
- **%^**: Copies entered notes on the treatment automatically into a notes window in medical history.
- **~**: Will not display the entered medical history notes on the CID screen.
<table>
<thead>
<tr>
<th>Action Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[</td>
<td>Auto prompt for the microchip number</td>
</tr>
<tr>
<td>{</td>
<td>Auto prompt for the locator number</td>
</tr>
<tr>
<td>}</td>
<td>Don’t add to Whiteboard</td>
</tr>
<tr>
<td>1</td>
<td>Don’t post from Whiteboard</td>
</tr>
<tr>
<td>&lt;</td>
<td>Include on the E-Travel sheet</td>
</tr>
<tr>
<td>2</td>
<td>Show Notes in Medical History</td>
</tr>
<tr>
<td>5</td>
<td>Dental Assessment</td>
</tr>
</tbody>
</table>

**Price**
The field represents the amount you wish to charge a client for the item. AVImark also gives you the ability to use Integer pricing based on the use of the “I” Action code. When you sell or dispense a decimal quantity of the item (1.5 cc), AVImark will price the item as though you entered the next higher whole number. That is, what you would charge for the quantity of 2 cc.

- Type in the field the normal amount you wish to charge the client for the item.

**Unit Cost**
In this field you will specify the cost for the item. For example, say you have some dog food that is ordered by the case of 24. The cost for the package (24) is $18.25. The Unit Cost field should display $0.76 which is the Package Cost divided by 24.

- Type in the field the Unit Cost.

**Package Cost**
In this field you will specify the package cost for the item. For example, say you have some dog food that is ordered by the case of 24. The cost for the case of 24 is $18.25. Therefore, the Package Cost entered for this item will be $18.25.

- Type in the field the Package Cost for the item.

**Class (Discount)**
AVImark uses the Class field to determine which items are to be discounted to which client class. You may set up an unlimited number of client classes as well as treatment and inventory classes. For more information on discount classes, refer to Chapter 1 Hospital Setup, Sub-,Tab Discount.

- If applicable, use the Class drop-down list and select the appropriate discount class.

**Report Codes**
Report codes are user-defined letter characters used for grouping specific items together on certain reports (Treatment Control Log, Patients by Treatment, Income by Treatment, Transaction Summary, and Sales.)
Inventory List

Summary). You may use up to 3 codes for each item. There are some codes that are pre-programmed for use with the most common reports. They are:

- Lab services (L)
- Surgery (S)
- Injections (I)
- Prescriptions (P)
- Vaccinations (V)

- If appropriate, use the drop-down list and select the correct report code(s) for the item.

**Measure**

This field is used to specify how the item is dispensed. This list is set up in the Units of Measure Table in the AVImark System Tables. For more information on setting up your Unit of Measure Table, refer to “Chapter 2: SYSTEM TABLES”.

- Type an abbreviated unit of measure or use the drop-down list and select how the item is dispensed.

**Fee**

In addition to the add-on fees applied through the use of certain Action codes, AVImark also gives you the ability to define a customized list of fees that will be added to the price of the item. These fees are set up in the Special Fees Table in the AVImark System Tables. For more information on setting up the Special Fees Table, refer to “Chapter 2: SYSTEM TABLES”.

- If appropriate, use the drop-down list and select the special fee code for this item.

**Photo**

AVImark lets you link any .bmp; .jpeg; or .tif image to the item to be printed on the client invoice attached to the doctor’s instructions for the item. When this item is included on the client invoice, this photo will be printed at the bottom half of the invoice along with take-home instructions. However, if there are no take-home instructions linked with the item, the photo will not be printed.

- If appropriate, use the Photo field browse button to open the folder of your saved photo files.

**Category**

This field allows you to move inventory from one category to another.

- If appropriate, use the drop-down list and select the correct category.

**Expires/Expires after__days**

This field displays the expiration date of the current purchased “lot”. Both expiration fields can be used at the same time. If the manufacture expiration date is set for the item along with the number of days past dispensing of the drug, AVImark will print the date that is closest to the dispensing date.

- Using the Expires field drop-down calendar, enter the expiration date of the current purchased “lot” and/or specify the number of days this product will expire when the item is being dispensed.
UPC Code
This field allows you to enter a UPC number for the specific item. This can be done either by typing the code or swiping the UPC code label to input the number.

- If appropriate, enter the UPC number for the item.

MSDS (NDC, DIN)
This field identifies the location of the MSDS sheet for the item. If you have a “DEA” number entered in Hospital Setup on the Demographics tab, this field will automatically change to “NDC” number and is used primarily for Kentucky, Michigan, California, New York and Alabama hospitals. Refer to the item documentation to determine the correct NDC identification for each controlled substance. For Canadian users, the label “DIN” will show instead of the MSDS. For the KASPER, CURES, and ASAP reporting function to work, each controlled substance will also need to have a “C” Action Code assigned.

Break QTY/Price
This is the number and price of the item above which (or up to the second Quantity Break) you would charge the client. AVImark gives you two levels for setting up quantity break prices. When you set the price in this field, you are entering the price charged for the Quantity Break number, NOT the price for each individual item. Just to the right of the Quantity Price amount, AVImark will display the markup percentage for this break price.

- In the first column simply type the quantity or use the Up and Down Arrows to specify the quantity.

- In the second column type the break price or use the Up and Down Arrows to specify the price for the quantity break price (not for each item).

Mark up Break Price(s)
This option allows you to have AVImark mark up the quantity break prices whenever you mark up retail prices.

- If appropriate, select Mark up Break Prices.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up break pricing</td>
<td>Break pricing</td>
</tr>
<tr>
<td>Marking up break prices</td>
<td>Markup break prices</td>
</tr>
</tbody>
</table>

Mark up Percent
With inventory items, you can specify a mark up percentage for both the Inventory category and the item itself. When a mark up is done, AVImark will honor any item-specific percentages rather than the percentage set for the category.
Inventory List

• If appropriate, type in the field to specify the mark up percentage for the item using a whole number.

Mark up Unit Cost
If you use the purchase order function, AVImark will automatically maintain this amount as the highest cost you have ever paid for the item. This field will represent the cost that you want future mark ups to apply to. Furthermore, it is used as the basis for inventory surcharges added to treatments.
  • If appropriate, type in the field to specify the cost that is the same as or higher than the current Unit Cost.

Mark up Pkg Cost
If you use the purchase order function, AVImark will automatically maintain this amount as the highest cost you have ever paid for the item package. This field will represent the cost that you want future mark ups to apply to. Furthermore, it is used as the basis for inventory surcharges added to treatments.
  • If appropriate, type in the field to specify the cost that is the same as or higher than the current Package Cost.

Species 1 & Species 2
You may specify up to 2 different species for the item. If you attempt to enter the item into the Medical History of a patient whose species is other than what is selected here, the item will NOT be entered and you will receive a warning message.
  • If appropriate, use the drop-down list and select the appropriate species limitation for the item.

Doctor
AVImark allows you to specify a default doctor that will automatically be selected when you enter the item into the Medical History area of the patient.
  • If appropriate, use the drop-down list and select the default doctor for the item.

Sex(es)
You may restrict certain items to patients of a certain sex.
  • If appropriate, use the Sex(es) field drop-down list to select the appropriate Sex code(s).

Advanced Tab Values

Follow up
The Follow-up area allows you to specify values that will determine how patients receiving the selected items will be handled by the AVImark Follow-up function. For a detailed discussion on the AVImark Follow-up feature, refer to “Chapter 27: FOLLOW-UP LIST”.

Follow-up in...days
  • If appropriate, type in the field to specify the number of days, after which receiving the item, you want the patient to be due for a Follow-up.

Follow-up Critical
This option allows you to identify the follow-up to be of critical importance.
  • If appropriate, select Follow-up Critical.

Subject
The Subject field defaults to the Item description. You may assign a different subject or reason if you wish.
  • If appropriate, assign a different subject or reason.
Remind as
In AVImark, reminding for inventory items and treatments is primarily controlled by Reminder Templates. “Remind as” allows you to use the reminder setup of another item. Code and description drop-down lists are available for display and selection of all Treatment, Inventory, and Diagnosis codes containing reminder templates.

- If appropriate, use the drop-down list to select either the code or description of the treatment, item, or diagnosis that you wish the patient to be reminded for when this item is dispensed. In this way, you do not need to set up a Reminder Template for this item.

Company
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple items.

- If appropriate enter the desired company number for reporting purposes.

Contract Prices Tab Values
If adding a new item you must first save the item before setting up the contract prices information for the item. This tab allows contract prices to be defined for Inventory. Before contract prices can be defined, descriptions for the prices must be created. These descriptions can be created from either the Contract Prices Tab or from the Contract Pricing Table within System Tables. For detailed information on adding new Contract Pricing entries to System Tables, refer to “CHAPTER 2: SYSTEM TABLES”.

- To create a new description from the Contract Prices window, right-click and from the shortcut menu click New to display the New Item Contract Price window.

- In the Description field, click the New button to display the New Contract Price Code Entry window.

- Type a single character code in the Code Field.
- Type the description for the new entry in the Description field and click OK.

Documents Tab Values
If adding a new item you must first save the item before attaching documents to the item. AVImark allows you to associate a Microsoft Word document or Star Office document with an Inventory item. You can print this document at the time it is first entered into the Medical History of the patient or at the time the invoice is printed, depending on what Action Code you enter for the item.
To enter the document name, **right-click** and from the shortcut menu click **New** to display the New Item Species Entry window.

- Use the **Species** drop-down list and select the appropriate species.
- Use the **Document** field browse button to open the folder of your MS Word Documents.
- Select the appropriate document and click **OK**.

By default, the document will print when the invoice is printed for the client. If you specify the “at” symbol ( @ ) action code for this item, AVImark will print the document at the time the item is entered into the Medical History area of the patient instead of when the invoice is printed.

**Pharmacy Tab Values**

**Refill time/treatment link**

If you wish to track the number of refills that is allowed, you will need to specify the length of time (in months) that refills are allowed. You may also specify a Treatment Code in the next field to indicate that, if this treatment is performed on the patient, it is as though the refill count should be restarted at the beginning.

- To control refills, use the UP and DOWN ARROWS to indicate the number of **months** during which refills are allowed.
- To track refills starting with a certain Treatment code, enter the code in the next field.
- To select the **Minimum interval between refills...days**, use the UP and DOWN ARROWS to specify the minimum number of days between refills.

**Container__with__**

Certain inventory items may be designated as controlled substances based on the “C” Action Code, which may then be tracked and reported by AVImark. Recent requirements by AAHA specify that controlled substances must be tracked by what is called a Container Identification Number. These two fields are used for tracking controlled substances that have Container ID numbers.

- Use the **Container** field UP and DOWN ARROWS to specify the Container ID number.

In the **With** field, use the UP and DOWN ARROWS to enter the quantity of this item that remains in the current container.

**Strength (California)**

The state of California requires that CA drug labels show the drug strength and the number of refills on each label. This field will automatically appear if the state of California is entered within the demographics tab of hospital setup. To properly label each prescription AVImark meets this requirement by including strength of the drug and the number of refills on all dispensed prescription medication. For clinics not in California that wish to use this field you must set the Hospital Advanced Option, **Display Drug Strength** to True.
**Purchasing Tab Values**

If adding a new item you must first save the item before setting up the purchasing information for the item. Each item has its own purchasing and sales information. Some of this information, such as “On Order” and “Monthly Sales”, is maintained by AVImark. Other values must be defined for the purchase ordering features of AVImark to work.

**On Order**

This is the quantity of this item that is currently in an Open Order. AVImark sets this number for you when you create a Purchase Order.

**Order Qty**

This is the quantity of this item (as dispensed in your units of measure) that you want to order at one time. The Order Quantity must always be either equal to or a multiple of the Order Pack. When you create the order AVImark will order a sufficient quantity, in order to bring the On Hand quantity ABOVE the Order Point. If the on hand quantity is less than the order point AVImark will first order a multiple of the order pack to bring the on hand amount to the order point. Then it will add the quantity needed to bring the on hand above the order point.

- Use the UP and DOWN ARROWS to specify the appropriate Order Quantity, equal to or a multiple of the Order Pack or simply type in the desired amount.

**Order Point**

This is the quantity that you want to maintain on hand.

- Use the UP and DOWN ARROWS to specify the minimum quantity that you want to keep on hand or simply type in the desired amount.

**Order Pack**

The Order Pack is the quantity of the item that is shipped in the manufacturer’s package. It is also called the “Case lot” quantity. For example, MEDS1 are shipped from the manufacturer in bottles of 100 tablets. Even though you dispense the item one tablet at a time, the Order Pack would be 100.

- Use the UP and DOWN ARROWS to specify the quantity of this item as dispensed per manufacturer’s package or simply type in the desired amount.

**Allocated Qty**

In this field, AVImark tracks the quantities of an item entered into the Medical History of a patient, but not posted to accounting. With this feature, when the item needs to be ordered, AVImark will consider its Allocated Quantity to determine the quantity needed in order to bring the On Hand quantity above the Order Point.

**Mfg Code**

This field displays the manufacturer’s item number.

- Type the manufacturer’s item number.

**Average Unit Cost**

When setting up a new item, you can leave this field blank and AVImark will automatically set it to what was specified for the current “Unit Cost” field. AVImark maintains the item cost as the average price paid from any vendor and will include shipping, taxes, and any other costs incurred when the item was ordered. AVImark uses this cost to calculate stock levels on the Inventory Report.

**Average Pkg Cost**

When setting up a new item, you can leave this field blank and AVImark will automatically set it to what was specified for the current “Package Cost” field. AVImark maintains the item cost as the average price paid from any vendor and will include shipping, taxes and any other costs incurred when the item was ordered. AVImark uses this cost to calculate stock levels on the Inventory Report.
Inventory List

Last P/O
This field represents the Purchase Order number of the last order that was created.

Vendor
This field allows you to enter and display the vendor information from where the item is purchased. When a vendor is selected for an item, that vendor’s name, address, phone number, fax number, contact’s name, email address, and website will now be displayed beneath the vendor drop-down list.

- Use the Vendor drop-down list to select the correct Vendor for the item.

Purchase history
This field displays the Purchase Order history for the item. This area allows entries corresponding with Purchase Orders, to be viewed in a READ ONLY view.

- To view the history of an entry, select the appropriate entry.
- Right-click and from the shortcut menu click Order Details.

Sales Tab Values
For each inventory item, AVImark tracks sales information including units sold by month and year-to-date sales.

<table>
<thead>
<tr>
<th>MTD Sold/Sales</th>
<th>YTD Sold/Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>72.00</td>
</tr>
</tbody>
</table>

MTD Sold/Sales
This value is maintained by AVImark as the month-to-date units sold and total sales.

YTD Sold/Sales
This value is maintained by AVImark as the year-to-date units sold and total sales.

Sales, Last 12 months
You may view the demand statistics for each month of the year.

Whiteboard Tab Values
The Whiteboard tab of the Change Item window allows you to specify the applicable values that will be used in grouping patients and inventory together on the Whiteboard. For detailed information on the AVImark Whiteboard feature, refer to “CHAPTER 19: WHITEBOARD”.

Whiteboard
This field allows you to select the Whiteboard category you wish to assign to this specific item. These categories are set up in the Whiteboard Categories Table within System Tables.

- Use the drop-down list and select the appropriate Whiteboard category.

Frequency
This field holds the default value for the frequency (number of times this service is to be administered daily)
when this code is added to Whiteboard.

- Type in the field to enter the default value for the Frequency.

**Inventory List Shortcut Menu**

Within the Inventory List window there are other features found in the shortcut menu. Use the **right-click** option to see the shortcut menu.

**Add a duplicate item**

AVImark allows you to add a new item to your list that is a duplicate of one that you have already entered. This will be useful if you are adding several items that have the same characteristics.

- From your Item List, select the item you wish to duplicate.
- **Right-click** and from the shortcut menu click **Another** to display a duplicate New Item window.
- Enter a new **Inventory Code** for the duplicate item as well as any other necessary changes and click **Done**.

**Select**

Select items to be added to medical history, a Need List or a Purchase Order.

- With the correct item selected, **right-click** and from the shortcut menu click **Select** or press the **Spacebar**.
- Items will be added to the **Selected** area.

**Edit Changes**

Use the Edit menu to select items or to undo or redo changes to an item.

**View**

From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this item, Preview or Hide text associated with the item or you can choose how to sort the window. If you have customized the display by arranging and adding or removing columns you can print the display by using the Print option from the View menu.

**Entry History**

Use this option to view a history of changes made to the selected item.

- Select an item and choose **right-click View, Entry History**.
- View date and time change was made, logged in user who made the change and a description of the change that was made.
- Click **Done** to close the window.

**Move items into another category**

You can easily move items from one category to another.

- With the correct item(s) selected, **right-click** and from the shortcut menu click **Move**.
- You will need to click **Yes** to confirm the move.
- Click the appropriate category name to move the item to.

**Add items to the Need List**

The Need List is like a shopping list of items that need to be ordered. You may create one or more Need Lists these lists can be created either before or after items are selected.
**Inventory List**

**Before items are selected:**
- From your Inventory List window, open the **Need List** menu. Click **New** to display the Create Need List window.
- Type a **Name** for this Need List and click **Continue** to display the new Need List.
- Click **Done** to close the new Need List.
- Select the items you wish to add to the new Need List. Use the SPACEBAR or F10 to place the items in the **Selected Items** area.
- Open the **Need List** menu and click **Choose** to display the Choose Need List window.
- Select the correct Need list and click **Continue**.
- You will need to click **Yes** to confirm adding the items and display the Need List.
- Click **Done**.

**After items are selected:**
- Select the items you wish to add to the new Need List. Use the SPACEBAR or F10 to place the items in the **Selected Items** area.
- Open the **Need List** menu and click **New** to display the Create Need List window.
- Type a **Name** for this Need List and click **Continue** to display the new Need List. The items previously selected will be added to the new list.

Once items are selected for a Needs List it will appear in green in the inventory list.

**Drug label**
AVImark allows you to print prescription labels for any item in the list.
- From the **right-click** shortcut menu, click **Drug Label** to display the AVImark Drug Label window.
- Enter the appropriate information you wish to appear on the label and click **Print**.

**Display and print graphs**
For any given item, you may display one or more graphs showing production, profit, trends, etc. You may display and print graphs using either AVImark’s Graphing feature or Excel. This option is selected in the Advanced area of Hospital Setup.
- From the **right-click** shortcut menu, point to **Graph** and click the graph you wish to display.

**Instructions**
You may attach take-home instructions to any item to be printed automatically on the client invoice. If you have several items in your list that have similar Doctor’s Instructions, AVImark gives you the ability to include tag-a-long (duplicate) instructions without having to type them again for every similar item. In addition, you may select Doctor’s Instructions that you have saved in your Note Glossary. For detailed information on tag-a-long instructions and the AVImark Note Glossary, refer to “CHAPTER 30: NOTE GLOSSARY”. With the correct item selected, **right-click** and from the shortcut menu click **Instructions** to display the Doctor’s Instructions window.
- Type the take-home Doctor’s instructions. All the available AVImark note feature options are available from this window.
- To include a tag-a-long instruction, type the **Item Code** of the “parent” item enclosed in asterisks. For example, (*220*).
Tag-a-long Instructions must be instructions from another inventory item, not a diagnosis or treatments.

- Click **Done** to save the Doctor’s Instructions.
- These instructions can be viewed or modified from the Medical History area. Once the item has been entered select **right-click Instructions**.

**Mark up**

AVImark allows you to mark up three specific inventory values; current prices, mark up percentages, and mark up costs for individual items. You may mark up your item prices in three ways; by category, all items, or by individual item. The Mark up Percentage is set up on each item.

This is the default percentage that AVImark will use to mark up the item prices (unless otherwise directed). You may also specify a Mark up Percentage on individual items. Item-specific Mark up Percentages will override the Mark up Percentage of the category during the mark up process.

- To mark up items in one category, select the category you wish to mark up prices for.
- Point to the Item List window and **right-click** to display the shortcut menu.
- Click **Mark Up** to display the Inventory Mark up window.
  
  - By default, the Inventory Mark up window will increase **Current Price** of items in **This Category**.
  - The default **Calculation** will **Multiply** the **Mark up Cost** by the **Mark up Percentage**.

**Rounding prices**

You may round off marked up prices larger than a certain amount to the nearest increment. Furthermore, you may then subtract a specified amount from the result of the mark up to arrive at the final price.

For example: **Say you would like to mark up all prices in the selected category by 5% and at the same time round off all prices over $10.00 to the nearest 10 cents, all prices over $25.00 to the nearest $1.00 minus 5 cents, and finally all prices over $100.00 to the nearest $10.00, minus 5 cents.**

- In this example, the first thing you would do is enter 5 in the **By %** field.
In the Rounding Prices dialogue box, click on the top line in the “If greater than” column. Specify 10.00 in this field and 0.10 in the “Round to” column.

Next, on the middle row, specify 25.00 in the left column, 1.00 in the center column and 0.05 in the right column.

Finally, on the third row, specify 100.00 in the left column, 10.00 in the center column and 0.05 in the right column.

- To review the proposed mark up results before finalizing the mark up process, ensure the Review before mark up box is checked and click Continue.
- By utilizing the Hospital Advanced Options for rounding you can have AVImark default to the specified rounding information.

The Mark up Analysis window

In the Mark up Analysis window you can review the proposed mark up results before actually marking up your prices. Once you click Continue from this window, AVImark will mark up prices as directed.

Additional columns can be displayed in the Markup Analysis window by setting the appropriate default Hospital Setup Advanced Option.

- From the CID select the Wrench speed bar icon.
- In the search field type sales and select the option Show Sales Data By Default and set the value to True.

The Markup Analysis window will now display the Fiscal Income Fiscal Sold, Projected Income, Income Difference and Income Difference Percent. The sales data amounts will be figured at the bottom of the analysis window.

- In the Markup Analysis window select View, Show Sales Data from the menu area to hide or display the 5 additional income columns.

In the Markup Analysis window you can customize the view by arranging columns and using the Show/Hide Group Panel options from the View menu.
Save and Print Markup Values
In the Analysis window you will have the ability to save the markup values to a .dat file and also open previously saved files.

- In the Markup Analysis window select File, Open from the menu to open a previously saved .dat file that contains markup pricing information.
- To save markup values currently displayed in the Analysis window select File, Save As from the menu area. Enter a file name, location and click Save.
- To print the markup analysis values select File, Print from the menu.

Mixture items
This option allows you to link items to the parent code. The number of items that can be linked is unlimited. When the parent code is added to a patient’s Medical History, the linked items will be deducted from their individual on-hand quantities, but they will not be directly added into Medical History. The linked items can be viewed by clicking on the Inventory Used attachment to the right of the Medical History area. The linked items’ quantity will be a multiple of the parent code’s quantity. The linked items do not have the ability to Surcharge by the linked items cost or price.

- In the Mixture for window, right-click and from the shortcut menu click New to display the New Item Usage window.

To learn more about: Marking up prices
Search the Help for: Markup

Notes
You may use this feature to add notes about the item. These notes do not appear anywhere else and are not printed on the invoice. However, all of the other AVImark note feature options are available within the note.
window. For detailed information on adding notes, refer to “CHAPTER 30: NOTE GLOSSARY”.

P/O History
With this feature you are able to view, change and print the purchase history for any item. You can also return items to a vendor from this purchase history window.

- With the correct item selected, right-click and from the shortcut menu click P/O History to display the Purchase Order History window.
- To change information about an item, select the correct item.
- Right-click and from the shortcut menu click Change to display the Change P/O History window.
- Make any necessary changes and click Done.
- To return an item to the vendor, select the correct item from the Purchase Order History window.
- Right-click and from the shortcut menu click Return to display the Change P/O History window.
- The quantity field will be displayed as a negative quantity. Make any necessary changes and click Done.
- To print the purchase history, open the Print menu to display the Print Purchase Order History window.

Price History
You can track the price history of your items. When the price of an item has been changed, the Date, Time, User that made the change, the Action of the change, and the Old and New price will be recorded. The Action of the price change refers to whether the price was changed manually, changed using purchase orders, or changed using the mark up feature.

- With the correct item selected from the Inventory list, right-click and from the shortcut menu click Price History to display the Item Price History window.
- To print the report, open the Print menu and click Report.
- To preview the report onscreen, select Preview and on the Print menu click Report.

Set up an item reminder
AVImark allows you to set up a reminder template for any item. For a detailed discussion on setting up Reminder Templates, refer to “CHAPTER 11: REMINDERS”.

- With the correct item selected right-click and from the shortcut menu click Reminder.
- You will need to click Yes to create one and display the Reminder Template.
- Specify the various conditions for the reminder and click Done.

Undelete a deleted item
AVImark gives you the ability to undelete any item that may have been deleted.

- In the Inventory List window, right-click and from the shortcut menu click Undelete to display the Undelete Inventory Items window.
- If applicable, select the Undelete to a Lost and Found category to place the revived items in a category named L & F with the date and time they were revived.
- Click on the item you wish to undelete. Use the SPACEBAR or right-click and from the shortcut menu click Select. The item will appear bolded when selected.
- After all items have been selected, click Undelete.
Variance
The Variance option gives you the ability to report controlled substances that are unused for whatever reason appropriate (i.e. spilled, lost, unfit, etc.).

Variances are recorded when you enter items into the Medical History of the patient, thus, making the entry specific for that patient. Any changes made to the items on-hand quantity, whether it is increased, decreased, removed, etc., will also be recorded in the Variance Entries window. You may also enter variances through the Variance Maintenance window. Variance entries will print on the Controlled Substance Report. To input a variance on an item, you must set up entries in the Variance Table of the AVImark System Tables. For detailed information on setting up your Variance Table, refer to “CHAPTER 2: SYSTEM TABLES”.

- With the correct item selected, right-click and from the shortcut menu click Variance to display the Variance Entries window.
- Right-click and from the shortcut menu click New to display the New Variance Entry window.
- The Code for the selected item will already be displayed. TAB to have the Description field entered for you.
- Use the Change field UP and DOWN ARROWS to enter the appropriate amount.
- TAB to the Reason field and use the drop-down list to select the appropriate reason.
- Use the Doctor drop-down list and select the name of the user who is making the entry.
- If appropriate, use the Patient field browse button to select a specific patient for the variance.
- The Date and Time fields will be entered automatically but may be changed if applicable.
- If necessary, enter any Notes that may be applicable for this entry and click OK to save.
When tracking partial quantities of a given substance that is deemed unusable, you will want to “dispense” those quantities into the Medical History area of a “waste” patient record. In other words, create a new client record named “Controlled Substances Waste”, and add “patient” records, each with a name that signifies the month and year of the waste disposal. For example: September-09, October-09, November-09, and so on. You would also need to set this “client” up as having 100% discounting applied so as not to report inaccurate income, production, or A/R numbers. Then, during a given month, you would dispose of the controlled substance waste by entering the waste quantities into the Medical History area of the appropriate patient, posting the entry, canceling the payment window and closing the invoice.

To learn more about: Search the Help for:
Track controlled substance Controlled substance; Tracked controlled substances

View and print the Whogot list
The AVImark Whogot list is a sorted list of all patients and their owners that have received a specified treatment, inventory item, problem, or diagnosis. Use the Whogot list to view, sort, print, or go to the CID of any patient receiving the chosen treatment, item or diagnosis in a specified number of months.

- With the appropriate item selected, right-click and from the shortcut menu click Whogot to display the Treated Patients window.
- If applicable, use the Criteria menu to sort and/or limit the number of patients selected.
- Click Done to return to the Treated Patients window.
- Select the individual patients from the list you wish to print by clicking on the patient name and press the SPACEBAR.
- Click Print to display the Print Whogot window.
Use the **Print to** drop-down list and select the correct Printer.

Using the **Months to show** field, enter the number of months to display or use the drop-down calendar to specify the period you wish to print for.

If applicable, double-click in the **Document** field to select a Document from among your MS Word documents.

Select **Include notes** to include the notes about the item selected for each patient on the list.

To omit the prescription messages, check the **Exclude scripts** checkbox.

If applicable, click on **Restrict to last query** to limit the printing of documents to only those patients chosen when you ran the last information search.

Click **Print** or to preview the report onscreen select **Preview** and click **Print**.

### Inventory Reports and Documents

From the File menu of the Inventory List window, you may view and/or print a variety of reports and documents.

#### Inventory Report

The Inventory Report should be printed out at the beginning of each year. If not, AVImark will display a warning informing the user that the report has not yet been printed. The warning will persist until the report is physically printed. A specific start-of-year date can be specified in Hospital Setup, Advanced.

- On the **File** menu, point to **Print** and click **Inventory Report** to display the Inventory Report window.
- Using the **Organize by** area, select how you wish to organize the report.
- Select a **Sort by** option.
- If appropriate, select how the report will be restricted.
- If appropriate, select any **Options** that may be necessary and click **Print**. To preview the report onscreen, select **Preview** and select **Print**.

#### Travel Sheet

The Travel Sheet is a customized list of commonly used items that you use during the visit with the patient. By
default, only those items with the “F” Action code will be included on the Travel Sheet.

- On the **File** menu, point to **Print** and click **Travel sheet** to display the Print Travel sheet window.

**Vendor List**
This report allows you to view and print a list of your vendors.

**Purchase Order History**
Once inventory has been purchased and receipted into stock, AVImark will track past purchase orders.

**Inventory Summary**
AVImark will print a sales summary report showing monthly and yearly production values along with last years production and growth percentage. Profit values are also given.

**Reorder Report**
This report allows you to print a list of all Inventory items that have On-hand quantities equal to or below the Order Point.

**Update Inventory Sales**
The Update Sales option in Inventory gives you the capability to update monthly Inventory totals. These monthly totals are automatically generated at the beginning of each month for the previous month, when the message regarding “Updating Inventory Statistics” is prompted and allowed to process. If these statistics are not allowed to process at the beginning of the month, but for example, at the middle of the month, all sales for the previous month and the current month will be lumped together. Should this happen, running the Update Sales feature will reorganize these statistics to their appropriate month.

- From your Inventory List, open the **File** menu and click **Update Sales** to display the Update Inventory Sales window.

  ![Update Inventory Sales window](image)

  - Click **Update**. You will need to click **Yes** to confirm.
  - Click **OK** when updating is complete.

**Add Vendors**
Before associating a vendor to a specific item or before creating orders you must first set up the list of vendors.

- From the Inventory List select **File** (menu), **Vendors**.
- Select **right-click New** to add a vendor.
- Enter a **Code** and vendor **Name**.
- In the **Contact** field enter the main contact person.
- Enter your **Account** number and the vendor address information.
- Click in the appropriate fields to enter the desired information.
- In the **Comments** field enter desired notes or additional information about the vendor. This information will be included on the Vendor report.
Create Purchase Orders

AVImark has an extensive ordering capability feature designed to handle your normal ordering needs. You may manually select the items that you wish or AVImark can automatically place items reaching their “Order Point” on the order. The process consist of three steps; building the order, printing and/or releasing the order, and receipting the order once received.

Order an individual item

- From your Inventory List, select the item that you wish to order.
- On the File menu point to Order and click New to display the Build Purchase Order window.
- AVImark automatically assigns a Purchase Order number of “ymmd” plus a two digit number representing the number of purchase orders you have created today. However, you may assign your own preferred numbering sequence consisting of 8 characters or less.
- By default, AVImark will set the new order to This item only then click continue.

Order multiple items

- From your Inventory List, select the items you wish to order by clicking on the item and using the SPACEBAR to place the item in the Selected Item area.
- On the File menu, point to Order and click New to display the Build Purchase Order window.
- AVImark automatically assigns a Purchase Order number of “ymmd” plus a two digit number
representing the number of purchase orders you have created today. However, you may assign your own preferred numbering sequence consisting of 8 characters or less.

- By default, AVImark will set the new order to **Selected items**.
- Click **Continue** to display the Purchase Order.

**Order items that have reached their Order Point**
- On the File menu, point to **Order** and click **New** to display the Build Purchase Order window.
- Select the **Consider…** option that you wish.
- Click **Continue** to display the Purchase Order.

**Print and/or Release the order**
AVImark gives you the ability to simply print an order, allowing you to make further changes if necessary, or release a completed order. When you release a purchase order, you are telling AVImark that no further changes are necessary and that the order is ready to be released to the vendor. Once the order has been released, no further changes can be made.

- To make a change to an item on the order, select the item and **right-click** to display the shortcut menu.
- Click **Change** to display the Change P/O Item window.
- Make the necessary changes and click **Done**.
- To print the order, open the **Order** menu and click **Print**.
- To preview the order onscreen, select **Preview** and from the **Order** menu, click **Print**.
- To release the order, open the **Order** menu and click **Release**. This will print the order and change the order status to an “Open Order”.

**Receipting an order**
As orders are filled from each of the various vendors and shipped, you will want to receipt the orders into stock. AVImark lets you receipt the order and specify which items were received. Of the received items you are able to indicate which ones reflect a change in price, specify what vendor the items were received from, and apply any shipping charges and taxes that have been charged to you. In addition, AVImark will create a “back order” for those items that were not received and you can receipt them if and when they do come in. If the items never show up, you may just purge the order.

- From your Inventory List open the **Order** menu and click **Choose** to display the Choose Order window.

- Select the correct order from the list and click **Done** to display that Purchase Order.

**Receipt a partial order:**

- To receipt a partial order, select the top order from the list that has been received.
- To make a change to the item, (cost, amount received, and so on) **right-click** and from the shortcut menu click **Change** to display the Change P/O Item window.
- Make the necessary change(s) and click **Done** to return to the Purchase Order.
• **Right-click** and from the shortcut menu click **Receive**. The received value for the item will be set to the number ordered, divided by its Order Pack value.

• Repeat the same procedure for each item that has been received.

• On the Purchase Order window, open the **Order** menu and click **Receive** to display the Purchase Order Receipting window. It is from this window where you will enter the Vendor, Invoice number, any shipping charges, taxes, and/or other cost associated with the item.

• Click **Continue** to finish receipting the item(s) and to place the status of the order to “Back Order”.

**Receipt a complete order:**

• Select the correct order from the list and click **Done** to display the Purchase Order.

• On the **Order** menu, click **Receive**.

• You will receive a prompt that the quantity for each item has been set to the quantity ordered. Click **Yes**.

• To make a change to any of the items, (cost, amount received, and so on) **right-click** and from the shortcut menu click **Change** to display the Change P/O Item window.

• Make the necessary change(s) and click **Done** to return to the Purchase Order.

• On the **Order** menu, click **Receive** to display the Purchase Order Receipting window.

• Enter the Vendor, Invoice number, any shipping charges, taxes, and/or other cost associated with the order and click **Continue**. AVImark will automatically update the on-hand quantities, honor any price mark up percentages specified, and so on.

**Purge Orders**

AVImark gives you the ability to purge orders that are outdated or otherwise no longer appropriate.

• On the order in question, open the **Order** menu and click **Purge**. Click **Yes** to confirm.

**AVP for Canadian Clinics**

AVImark integrates with Associated Veterinary Purchasing (AVP) which will allow Canadian AVImark clinics that are AVP customers the ability to place an order through AVImark.

**Setup**

To use the AVP integration specifications must be defined in Hospital Setup Advanced area.

• From the CID open the Advanced Options by clicking on the Hammer, Wrench and Screwdriver icon.

• In the Search field type AVP.

• The AVP Billing Code is assigned by AVP and will be unique to each clinic.

• The AVP FTP Address automatically defaults to the AVP FTP address.

• Click the Directory option to enter the name of the new AVP folder that you have created in the AVImark folder.

• The FTP Password and FTP User Name will both be automatically setup.

• AVP will provide a password and user name to be entered in the Password and User Name fields.

**Adding AVP Vendor**

After defining the AVP specifications the AVP vendor needs to be added to the Vendor list.

• From the Inventory List choose File, Vendors from the menu.

• The Code and Name of the vendor must be AVP.
Attaching AVP Number
After defining the options in Hospital Setup a new field will be available in the Change Item window.

- In the Inventory List select the correct item and choose Change from the right-click menu.
- From the Advanced tab enter the billing code of the item in the AVP Number field.

Placing an Order
When placing an order for AVP you will need to select AVP as the vendor or assign the AVP vendor to all appropriate items.

- When the AVP vendor is selected a Ship To field will be displayed in the Purchase Order window.
- The Ship To field will default to the clinics location; however clicking on this drop-down list will display all possible locations, which are downloaded from the AVP webserver.

Releasing an Order
As each purchase order is released the product code(s) will be verified and the inventory status will be checked for sufficient and/or insufficient quantities. If the item is not in stock you will receive a message showing the current available quantity giving you the option to change the quantity on the order, remove the item or select a substitute.

Once the order is released AVImark exports the purchase data to a file that is uploaded via FTP to AVP. If the file is sent successfully an e-mail notification will be sent to orders@avpbc.com with the filename as the subject. The order will then be processed and the order can be received as normal.

Needs List
Creating a Need List gives your clinic the ability to make lists of items that need to be ordered. There is no limit as to how many Need Lists can be created.

- From the Inventory List select File, Need List, New from the menu.
- Enter in the name of the Need List that you are creating then select Continue.
- After selecting Continue the Need List will open. Select Done.

Adding Items to a Need List
- Select File, Need List, Choose and select the list you would like to add items to.
- Selecting items to order from the Inventory List to the Need List can be done in two different ways:
  - Highlight the items you would like to order and select right-click, Add to Need List (F7).
A prompt will follow asking you if you would like to add the item to the Need List. By selecting Yes the item will be added to the Need List.

OR

- Select the items you would like to order by using your space bar. After selecting all the items to order, highlight in the Selected Items box and choose right-click, Add to Need List.
- Select Yes at the prompt to add the items to the Need List.

To assist in distinguishing whether an item in the Inventory List is On Order or currently on a Need List AVImark will display Need List items in GREEN when viewing the inventory window.

**Creating Purchase Order from Need List**

After the Need List is created, you will be able to create a Purchase Order from the List.

- From the Inventory menu area select File, Need List, Choose.
- Select which Need List you would like to work from and select Continue.

- To order from the Need List, highlight the items you would like to order and use your space bar to select the items. This will put the items you wish to order in the Selected Box at the bottom of the
window.

- When all items you wish to order is selected choose **Order, New** from the menu.

This will start the Purchase Order for the items on the Need List. You can then continue with the purchase order as normal. Once the items are received they will be removed from the Needs List.

**Work With VPR® Formulary**

With the VPR® Formulary you can access drug formulary information and provide drug information sheets to your clients along with their pets prescriptions.

**Setup**

- After installing the VPR® software specify the path in Advanced Options. From the CID select the **Hammer, Wrench** and **Screwdriver** speed bar button. In the **Search** field type **VPR**, select the **VPR® Folder** option and click **Change** to specify the location of the VPR® software.

- In the **Search** field type **active** and under **Veterinary Pharmacy Reference®** select **Active** and set the value to **True**.

- To register the appropriate dll files open the CID, hold down the **Shift + Ctrl** keys, select **Utilities, Register** from the menu and click **VPR®ClassCodeGen.dll**.

Additional VPR® settings can also be defined in the Hospital Advanced Options. Listed are just a couple of the options.

- In the **Search** field type **VPR®** and select the option **Print VPR® Drug Info Sheets when printing Drug Labels**. Setting this option to **True** will print the sheets along with the drug label for an item that has a VPR® code assigned.

- In the **Search** field type **interaction**. Select **Check History for Drug Interactions** to have AVImark search for VPR® associated codes in Medical History; choose **Check History for Drug Interactions at Entry?** to initiate the drug interaction when adding a VPR® treatment or item in Medical History; and choose **Check History for Drug Interactions Days Back** to specify the number of days the Interactions Matrix will search Medical History for drug interactions.

**Accessing VPR®**

The VPR® Formulary can be easily accessed from different areas within AVImark.

- From the CID select the **Utilities** menu and click **Formulary**.
• In the Patient area of the CID from the right-click shortcut menu select Formulary.

• In the Medical History area of the CID from the right-click shortcut menu select Formulary.

• From the Medical History Inventory Used window right-click and from the menu select Formulary.

• By opening the Drug Label window in Medical History access the formulary by selecting the Formulary menu option.

• Open the Inventory List, select an item and from the right-click menu select Formulary to access the VPR® Formulary.

• In the Inventory List select an item, open the Change Item window and click the Formulary menu option to access the VPR®.

• In the Treatment List select a treatment and from the right-click menu click Formulary.

• In the Treatment List select a treatment and open the Change Treatment window. Click the Associated Treatments/Items option and under the Inventory Used tab highlight an entry and from the right-click menu select Formulary to access the VPR®.

Assigning VPR® Drug Codes to Items
When assigning a VPR® code to an item this will allow drug formulary information to be automatically displayed when the VPR® Formulary is opened from that item.
• In the Inventory List select the appropriate item and from the right-click menu select Change.
• Click the Advanced tab and from the Link to VPR® drop-down list select the drug you wish to associate with this item. Click OK once the appropriate drug has been associated.

Using the Formulary
• From Medical History select an item and choose Formulary from the right-click menu. If this item does not have an associated VPR® code you can select a code from the Dosage Calculator tab. AVImark will display a message allowing you to place this VPR® code in the VPR® field of the Change Item window for this item.
• From Medical History select an item that has a VPR® associated code and choose Formulary from the right-click menu. This will display that drug information but another VPR® code can be chosen from the Select Drug drop-down list

To learn more about:  VPR® Formulary
Search the Help for:  VPR® Formulary

Intelligent Inventory
Intelligent Inventory is designed to improve receiving accuracy. Ordering performed outside the AVImark system (Phone, Fax, Internet, etc.). The distributor passes order information they receive to Intelligent Inventory and AVImark retrieves the info and displays it in the system to make it available for receiving into the AVImark Inventory List.

Creating Your Intelligent Inventory Account
Clinics wishing to utilize the Intelligent Inventory integration within AVImark will need to do the following:
• Register for an account at http://www.intelligentinventory.com to obtain your Gateway Account ID and credentials for using the site and connecting to the Gateway to retrieve purchase orders.
• You will also need to have your account numbers your accounts with participating distributors.
Important Note: Please be aware of the distinction between your Gateway account ID (the ID that identifies you to Intelligent Inventory) and your distributor account ID (the ID that identifies you to Butler/IVESCO/MVS/etc).

Setup
- Install the IIGateway Service on the AVImark server:
  - Run the IntelligentInventory.exe self extractor (found in the AVImark folder) to extract the contents into the AVImark folder. This will create an IntelligentInventory subfolder within AVImark containing 12 files.
  - Run the “Run Me.bat” file (found in the IntelligentInventory subfolder) to install the IIGatewaySvc.
- From the Services > Intelligent Inventory menu (on the AVImark CID), run the “Get Inventory Items” utility.
- Enter username/pw/gateway account number credentials provided by Impromed into Intelligent Inventory Configuration found in Services > Intelligent Inventory menu.
- While still in the Configuration window you can edit the distributor information with the proper Distributor Account Numbers (as assigned by your distributor). You can edit existing displayed distributor information by selecting the appropriate line, and using the E button, or add new ones by using the + button.
- Start the IIGateway Service found in Windows Services (Start > Services)
- Set the designated workstation to “set auto process computer” found in AVImark Services > Intelligent Inventory.

Advanced Options
- Auto Process Incoming Purchase Orders – When set to True: This option will allow all Purchase Orders to be imported to the AVImark Inventory Purchase Order list automatically, provided all distributor items contained on that Purchase Order are mapped to an AVImark item.
- Computer GUID to Auto Process Intelligent Inventory POs – This will display the computer GUID for the workstation designated by having run the “Set Auto Process Computer”
- Days Before Next Auto Catalog Update (0=do not auto run) – The number entered here will update the distributor’s inventory automatically at the given day interval, unless the interval is zero.
- Last Catalog Update - Date the last update took place
- Run Purchase Order Monitor

Services Menu on CID
- Get Inventory Items – This option will update the distributor’s inventory. This option performs the manual retrieval of data that occurs automatically when the Catalog Update takes place.
- Review Purchase Orders - Opens the window displaying all available Purchase Orders containing items needing to be mapped to AVImark items and Imported.
- Web Site - Launches the Intelligent Inventory site from within AVImark.
- Set Auto Process Computer - Using this option on an AVImark workstation, will designate that workstation as the computer to be used for processing communications between AVImark and Intelligent Inventory.
- Configure
  - PIMS Account Number
  - Gateway User Name
○ Gateway Password
○ Practice ID – This will be a globally unique, unalterable, identifier that will be automatically generated upon setup.
○ Distributor Information

Additions to Inventory List
There are three areas within AVImark where users can cross reference or “map” distributor item codes to existing AVImark item codes.

- Inventory List menu – RX Cross Reference > Intelligent Inventory
• Directly from the Change Item window
• From the Import Purchase Orders window

Items displayed in bright yellow indicate the item has not yet been cross referenced with an AVImark item code. Purchase Orders beginning with N indicate a New Order, and those beginning with U indicate an update to an existing Purchase Order. If you attempt to Import a purchase order with a U prefix and haven’t yet released the equivalent N order yet, you will receive this warning: Warning. Could not update this PO. Be sure released PO exists. When you Import the New and corresponding updated order, they will be merged as one order in the AVImark Purchase Order window for receiving.

Feature Use
Once your distributor item codes are associated to AVImark item codes, you are ready to begin automatically importing Intelligent Inventory Purchas Orders so you can receive the items into your AVImark Inventory List. Upon opening AVImark on the workstation set as the “Auto Process” computer, users could be prompted with a Catalog items prompt. This workstation will also display an Intelligent Inventory Monitor window in the lower right corner of the screen indicating the number of purchase orders ready for review.

Purchase orders that contain a complete list of AVImark/Intelligent Inventory cross referenced items will be automatically imported to the AVImark Inventory List where they can be received/receipted as a typical AVImark generated purchase order.
To find this list, open the Inventory List, and select File > Order > Choose.

This will display the list of imported purchase orders.

- To receive the items into your AVImark Inventory List, either right-click > select, or double-left click the appropriate order.
- You should now be in the Purchase Order window displaying the details of the order to be received.
- Select Order > Receive
- You will be presented with the following message:

```
Received quantity for each item has been set to the quantity ordered. Enter actual received quantities and new cost, then click Order, then Receive again to place the order in stock.
```

- Press OK and make any necessary adjustments.
- Select Order > Receive again to complete the receipting process.
- Press Continue at the Purchase Order Receipting window.
- You will now be back to the Purchase Order list window to process any additional purchase orders.

The received items will be updated in the AVImark Inventory to indicate the item was received. These areas include:

- On Hand Qty
- Purchase History
- Last PO
- Average Cost information
- BarCode information
- NDC information
One area that will not be updated is Expiration Date information.

For Intelligent Inventory purchase orders that contain an item or items that have not yet been cross referenced with AVImark items, orders can still be imported and received. To perform this cross reference and import the purchase order select Services > Intelligent Inventory > Review PurchaseOrders.

Once you make your cross reference assignments, you can proceed with Importing your order, and receiving it into your AVImark Inventory List when the order arrives.
CHAPTER 5: CLIENT INFORMATION DISPLAY

The Client Information Display (CID) is the primary working area of the AVImark System. Using this display in conjunction with the related menu items and Speed Bar buttons, you may access every function within AVImark. Each area of the CID is discussed in detail in separate chapters of the manual; therefore, this chapter will cover a brief overview of the different areas.

CID Menus

Near the top of the CID, drop-down menus allow you to quickly use primary AVImark functions not directly displayed on the CID. They are:

- Clients menu
- Work with menu
- Applications menu
- View menu
- Utilities menu

In this chapter you will learn about...

- CID Speed Bar Buttons on page 102
- Client Area on page 102
- Medical History Area on page 103
- Medical View Tabs on page 103
Help menu

Clients Menu
This menu will allow you to:
- Add a New client to your files
- Change client information
- Remove (delete) a client from your files
- Choose (select) a client from your files
- Close the current client file
- View the patients in a list format by selecting List Patients
- Refresh all client, accounting, patient and medical history data entered from another workstation
- View a list of patients with reservations or those that are checked in from the Whiteboard.
- Access the Work List and choose the one associated with this patient or the list you need to work with.
- Quit to close AVImark

Work With Menu
This menu will allow you to use various primary AVImark functions, including:
- Appointments
- Boarding Calendar
- Care Credit
- Diagnosis List
- Estimates
- Follow-up List
- Glossary
- Hospital Setup
- Inventory
- Information Search
- Practice Analysis
- Problem List
- Q & A
- Reminders
- Reports
- Statements
- System Tables
- Treatments
- Users and Security
Applications Menu
You may use this menu to open other application programs on your computer such as MS Word and MS Excel. Other applications listed here will be those which you have specified in Hospital Setup, System, Applications. This menu also includes several auxiliary programs included with the AVImark program. Prior to using any of the auxiliary programs in the Applications menu, we recommend you contact AVImark Technical Support Staff.

Utilities Menu
The utilities menu is used to:
- Log on as a user
- Access the user time card
- Print the time card report
- Back up AVImark files
- MS-DOS prompt
- Set or change the posting date
- Printers set up
- Rebuild index
- Access built in Utility programs
- Update AVImark
- Cash Drawer
- Sidekick
- QuickBooks
- Restore from backup
- Run Instrument Import

Help Menu
You may use the Help menu to learn how to use the AVImark On-line Help function and to view the Q&A Maintenance window. The Help Menu also has an option for Tech Notes. This option will display a list of categorized topics that when selected will display a list of frequently asked questions pertaining to the topic.
CID Speed Bar Buttons
The Speed Bar buttons provides quick access which allows you to perform other AVImark primary functions related to the current working client and patient. These buttons consist of the following:

- Client selection
- Add notes
- Add records
- Appointment calendar
- Boarding calendar
- Whiteboard
- Client account
- Post charges
- Patient chart
- Reports
- Treatment list
- Inventory list
- Diagnosis list
- Information search
- Calculator
- Microsoft auto-dialer
- Census notes
- Advanced Options
- Diagnostic Imaging Atlas

To learn more about: Search the Help for:
CID speed bar button Speed buttons

Client Area
The client area of the CID displays information about the current working client. In the client area window, there are several things you can do from the shortcut menu. Use the right-click option in the Client area window to see the shortcut menu.

Patient Area
The Patient area of the CID displays information about the current working patient belonging to the client you have selected. Other patients belonging to the client are listed as Name tabs located at the bottom of the CID in alphabetical order. In the Patient area window, there are several things you can do from the shortcut menu. Use the right-click option in the Patient area window to see the shortcut menu.
Medical History Area

The Medical History area of the CID displays the Medical History entries for the selected patient. In the Medical History Area window, there are several things you can do from the shortcut menu. Click the right mouse button (called right-click) in the Medical History Area window to display the shortcut menu. For a detailed discussion on the Medical History area, refer to “CHAPTER 8: ENTERING MEDICAL HISTORY”.

Medical View Tabs

At the bottom of the Medical History area displays several Medical View tabs which allow you to view the patient’s Medical History sorted (limited) in different ways.

If you can not see all of the displayed Medical View Tabs, use the scroll arrows at the right side of the Medical View Tab area to open other tabs.
CHAPTER 6: CLIENT AREA

When viewing the Client Area of the CID (Client Information Display), the current working client is displayed along with the patient belonging to the client that was treated last.

In this chapter you will learn about...

- Open a Client’s File on page 105
- Use the Client Selection Window on page 105
- Change Client Information on page 106
- Close a Client’s File on page 106
- Add a New Client to Your Files on page 106
- Scrolling through Client Files on page 112
- Delete a Client from Your Files on page 112
- View or Add Notes about the Client on page 112
- Add Client Alerts on page 112
- Add File Attachments on page 113
- Enter Special Invoice Instructions on page 114
- Attach Client Photos on page 114
- E-mailing Clients on page 115
- Handle Over-the-Counter Sales on page 116
- Enter a POA (Payment on Account) on page 116
- Making Change on page 116
- View/Print the Client’s Accounting on page 117
- Add Notes to Accounting on page 118
- Age the Client’s Account on page 118
- View Client Stats on page 118
- Work with a Closed Invoice on page 118
- View and Change an Open Invoice on page 118
- Create a Pre-Invoice on page 119
- Undelete Accounting on page 119
- View an Accounting Entry History on page 120
- Return a Check and Add a Fee on page 120
- Dial the Client’s Phone Number on page 120
- Print Client Labels on page 120
- Reprint an A/R Statement on page 120

Open a Client’s File
With any client’s information display window open, you may Select (open) up to nine other client’s files at the same time. If the client you are looking for is someone you have been working with recently (i.e. one of 10 recently worked with) their name will be displayed just below the Client area as a Name Tab.

- Select the correct name tab to reopen a client’s file.

Use the Client Selection Window
The Client Selection Window allows you to search for a client by typing part of, or the entire client name, phone number, patient name, rabies tag number, etc.

- On the CID, open the Clients menu. Click Choose.
- Click on the magnifying glass speed bar button.
- Press the Esc key.

Display all clients within AVImark
- On the CID, open the Clients menu. Click Choose.
- On the Client Selection window click Show.
- To search for only active clients uncheck the Include Active option. The advanced option, Default: Include Inactive During Client Selection will allow you to have AVImark default to having this option checked or unchecked.

Locate clients and patients
- Place the cursor in the correct field and type either all or part of the client’s name, account number,
folder number, phone number, work number or the cell phone number and click Continue.

- Select the correct name and click Continue to display the CID for that client.

Displaying clients and patients by partial names

- In the Client field, type a partial last name, a comma and a partial patient’s name. Everything to the right of the comma will be moved to the Patient field.
- Click Continue and all clients and patients matching the criteria will be displayed.
- Select the correct name and click Continue to display the CID for that client.

Locate by rabies tag number, Patient Tattoo or microchip number, or Record Number

- In the Tag no. field, enter the patient’s rabies tag number, and click Continue.
- In the Patient ID field, enter the patient’s tattoo or microchip number and click Continue.
- Use the Patient Record Number field to enter the patient’s associated test result import number assigned by an AVImark integration partner. This number can be obtained and displayed on the patient’s CID by setting the Advanced Option, Display Patient Record Number, to True.
- Select the correct name and click Continue to display the CID for that client.

Change Client Information

With a client’s file displayed, you may change any of the information by opening the Change Client window.

- In the client area, right-click and from the shortcut menu click Change.

Close a Client’s File

- In the Client area, right-click and from the shortcut menu click Close.

Add a New Client to Your Files

You may enter as many clients and patients to your files as you wish. There is no limit to the number of client
records in AVImark.

- In the Client area, right-click and from the shortcut menu click New to display the New Client Information window.
- Enter the information about the new client. When all information has been entered, click Done.

**Last**
This field is the client’s last name only.

**First**
If the client is a business or institution, type the name of the company and use the first name field to show the contact person’s name. You will not want AVImark to print the first name (contact person) on invoices or statements. Ensure you include a Client Code B in the codes field for this client.

**Title**
This field indicates the title for the client, for example; Mr. and Mrs. If the client is a business leave this field blank.

**Address**
This field is the client’s street address. You may also enter a second address line by typing in the blank field just below the address field.

**Zip**
The zip/postal code field will be filled in automatically by AVImark as the default value which you have specified in Hospital Setup, Demographics. To choose a zip code, click in this field and select the appropriate zip code from the displayed drop-down list.

![New Client Information window](image)

When a client zip code is changed on the CID the client area code is also changed due to the area code linked to
that specific zip in System Tables, Zip Code table. There is an Advanced Option named “Automatically Update Client’s Area Code Based on Zip Code” that can be set to True or False. Upon updating the default setting is True to keep the original functionality in place, but users that do not want the client area code to be updated to match the zip code table can set this option to False.

**Phone**
This field is the client’s Area Code and phone number. If the number you type is identical to that of another client, AVImark will warn you.

**Fax no**
If applicable, this field indicates the client’s fax number to include the area code.

**City**
When you choose a zip code or a city, the associated city name will automatically be entered in this field.

**State**
When you choose a zip code or a city, the associated state will automatically be entered in this field.

**Work**
This field is the client’s business phone number including the Area code.

**Cell**
This field indicates the client’s cell phone number when applicable.

**County**
AVImark has the ability to select a special Rabies Certificate document for that particular county, based on information you provide in the County System Table.

**E-mail**
This field displays the client’s e-mail address.

**Preferred Contact Method**
This field contains a drop down menu list of insurance contact methods to select as preferred method for this client.

**History Zip**
Entering a zip code in this field will force AVImark to charge the client the appropriate tax rate for this area, for treatments and/or items entered into Medical History.

**SSN**
This field will contain question marks as security in allowing the clients SSN to be hidden from view. Clicking in this field will display the client’s SSN if one has been entered.

**D/L no.**
This field displays the client’s driver’s license number when applicable.

**Photo**
Click the search button to locate a client photo. From the Image Editor window save the picture to the client’s folder to have it appear on the CID screen.

**Employer**
This field displays the client’s employer when applicable.
**Spouse**
This field indicates the full name of the client’s co-owner. AVImark allows several drop-down options for the title of the other contact in the Client Area. These choices include Spouse, Significant Other, Relative, Friend and Other. When a name has been entered in this field, in conjunction with the Q Action Code, you may search for a client based on the spouse’s name rather than the last name.

**Preferred doctor**
You may identify a preferred doctor which will be automatically chosen as the attending doctor when you access the client’s file.

**Reference**
AVImark allows you to identify a referral source for newly added clients and is able to send correspondence of your choice to any AVImark client who has referred a new client during a specified period of time.

*Referral source is NOT one of the clients within AVImark*

- In the **Referral** field, type the name of the person, advertisement, promotional, etc., or use the drop down menu to select the referral choice.

*Referral source IS one of the clients within AVImark*

- In the **Referral** field click the search button to display the Client Selection window.
- Find the appropriate client and click Continue to have the clients account number and last name displayed in the Reference field.

**Client Business Referral Field**
This field will display the referral selections listed in the Referral Selections Table in System Tables. If the advanced option “Selected Referral Required” is set to False you can type anything in the Client or Business Referral field and if it is set to True you can only select from the drop-down menu.

- The Advanced Option of “Referral Required to Complete Client Information” can be set to True and when adding a new client you will be required to select a referral source and the message “You Must Add a Referral” will be displayed before completing the new client setup.
- If you wish to have users select a referral source from the drop-down list and not manually type in a source set the Advanced Option of “Selected Referral Required” to True and they will be required to choose a source from the Referral Selections list.

**Added**
This field displays the added date of the client. AVImark will enter this information for you. To change information in this field press the Tab key or double-click on it and enter or choose the desired date.

**Added By**
AVImark will automatically enter the initials of the person currently logged in. If no one is currently logged in, the field will remain blank. You may also use this field to indicate who made changes to the client’s information.

**Codes**
This field contains the Client Code(s) that are appropriate for this client. The default value of A indicates a normal **Active** client. You may specify up to 8 codes. The table listed below identifies the different Client Codes, the meaning and a description.

The following table lists each Action Code and its meaning:

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Active client</td>
<td>Normal, active client</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>B</td>
<td>Client is a business</td>
<td>A client with this Client Code is considered a business or institution. Documents for this client will be printed as such.</td>
</tr>
<tr>
<td>C</td>
<td>Credit is pre-approved</td>
<td>A client having this Client Code will be “Pre-Approved” for credit to be extended and a message will be displayed to this effect on the CID.</td>
</tr>
<tr>
<td>E</td>
<td>Tax exempt</td>
<td>A client having this Client Code will be exempt from being charged sales tax.</td>
</tr>
<tr>
<td>F</td>
<td>No billing fee</td>
<td>A client having this code will not be charged a handling fee on statements.</td>
</tr>
<tr>
<td>G</td>
<td>Always print reminders</td>
<td>When printing reminder cards or letters, clients having this code will only receive a printed reminder document even though they have a valid e-mail address.</td>
</tr>
<tr>
<td>H</td>
<td>Don’t print balance due on invoice</td>
<td>Don’t print the client’s balance due amount on the invoice.</td>
</tr>
<tr>
<td>I</td>
<td>Inactive client</td>
<td>A client having this Client Code is considered no longer active). This client’s transactions will not appear on the A/R Summary Report, will not receive statements and any animals belonging to the client will not be reminded for vaccinations, exams or inventory items.</td>
</tr>
<tr>
<td>L</td>
<td>Exempt from local tax</td>
<td>A client having this Client Code will be exempt from local tax.</td>
</tr>
<tr>
<td>M</td>
<td>Supress messages from statement</td>
<td>An A/R statement printed for a client having this Client Code will include a message as though the client were “Current” on their account, no matter how overdue the client is.</td>
</tr>
<tr>
<td>P</td>
<td>Organize statement by patient</td>
<td>AVImark allows you to indicate that a particular client’s statement is to be organized by patient, rather than by invoice.</td>
</tr>
<tr>
<td>Q</td>
<td>Spouse field is last name of significant other</td>
<td>Use this Action Code to cause AVImark to search for a client based on the client’s spouse’s name rather than last name.</td>
</tr>
<tr>
<td>S</td>
<td>Supress printing of statements</td>
<td>This client will receive no A/R statements.</td>
</tr>
<tr>
<td>T</td>
<td>Exempt from state tax</td>
<td>A client having this code will be exempt from state tax.</td>
</tr>
<tr>
<td>W</td>
<td>Waive late charges</td>
<td>A client having this Client Code will be waived from being charged any service charge no matter how delinquent the account balance.</td>
</tr>
<tr>
<td>X</td>
<td>Cash only client (bad debt)</td>
<td>AVImark will automatically create an alert for clients with this code, identifying they are a bad debt client.</td>
</tr>
<tr>
<td>Z</td>
<td>Prevent this client from being purged</td>
<td>When trying to remove a client record having this Client Code a warning message will appear and an audible alert will sound. If using the Purge, Utilities option this client will not be purged.</td>
</tr>
<tr>
<td>*</td>
<td>Summary format statement</td>
<td>Prints an abbreviated form of the statement (Top Sheet).</td>
</tr>
</tbody>
</table>

**Suspend Reminders**
You may temporarily suspend reminders for all patients belonging to this client by checking this option.

**Folder**
You may identify a folder number where you keep hard copies of medical records and patient charts for this client’s patients. AVImark will warn you if the folder number you have assigned has currently been used by another client.
AVImark User Manual

Client Area

CO.
AVImark lets you specify Client Company Numbers in the event you have more than one business concern and thereby wish to separate your billing and reports accordingly. The default value will be set to whatever value has been specified in Hospital Setup. This value is normally set to 01. Only one company number may be assigned to any given client.

Contract Price
From this drop down list select a contract price code. These contract price groups are set up in System Tables.

Suspend Until
You may temporarily suspend reminders for all patients belonging to the client until a certain date by clicking on the drop down arrow and choosing a date.

Class
If applicable choose the Discount Class Name appropriate for this client.

Statement Site
This field is only visible on systems having multiple sites set up. It allows you to specify which site the client last visited and will aid in printing statements for each site.

Quality
This field contains the client rating value assigned by AVImark when using Monitor Client Quality. The quality value for a client can also be set manually by entering a number from one to ten, with ten being the highest rating. To always maintain the value specified in the Rating field check the Set option.

Scrolling through Client Files
You may move quickly from client to client either alphabetically or numerically by Client Account Number.

Alphabetically
Using the keyboard, press and hold the CTRL key and use the Arrow Down to move down and Arrow Up to move up through the alphabet, beginning from the current client you are on.

Numerically by account number
Using the keyboard, press and hold the CTRL key and use the Page Down to move down and Page Up to move up though the client list numerically.

Delete a Client from Your Files
• From the Client area, right-click and from the shortcut menu click Remove.
• You will need to click Yes to confirm the deletion.

View or Add Notes about the Client
AVImark allows you to create unlimited notes or memos about the client. You may also import text files (files with an extension of .txt) and/or copy and paste note templates from the Note Glossary into any AVImark note window. For detailed information on adding, importing and creating note templates, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”.
• In the Client area, right-click and from the shortcut menu click Notes.
Add Client Alerts
You may choose to have an alert message window appear when you first open a client’s file to warn you about anything you decide to type in the window.

- In the Client area, **right-click** and from the shortcut menu click **Alert**.
- Type your message and click **Continue**.
- To remove an alert, click **Remove**. You will need to click **Yes** to confirm.

Add File Attachments
AVImark gives you the option of attaching multiple files to clients, such as documents, images, Excel files, and so on.

- From the Client area, **right-click** and from the shortcut menu click **File Attachments** to display the Client File Attachments window.
- Within the File Attachment window, **right-click** and from the shortcut menu click **New**.
- Use the browse option at the end of the Filename field to search for the file you would like to attach.
Select the file name you would like to attach and then click OK.

After all necessary files have been selected click Done.

**View as Gallery**

AVImark allows you to view photos when multiple photos are attached to the client.

- Open the View menu and click View as Gallery.

**Add Notes**

Notes can be added to any file.

- the correct file selected right-click and from the shortcut menu click Notes.
- Type the notes pertaining to the file and click Done.

**Preview Notes Attached to the File**

- Open the View menu and then click Preview Text.
- Select the Show Preview Text option and select the Notes.
AVImark User Manual

Client Area

- Select OK.

**Enter Special Invoice Instructions**
AVImark will print any miscellaneous memos or instructions on the invoice.

- In the Client area, **right-click** and from the shortcut menu click **Instructions**.
- Type the instructions for the client and click **Done**.

**Attach Client Photos**
AVImark allows you to link photos (jpg, bmp, tif or DICOM format) to the Client area of the CID. These images will be saved in the `\PHOTOS` directory on your server.

- In the Client area, **right-click** and from the shortcut menu click **Photo** to display the AVImark Image Editor.
- In the AVImark Image Editor, open the **File** menu and click **Open** to display the Open window.
- Select the correct image name and click **Open** to display the image in the AVImark Image Editor.
- Click **OK** to display the image in the Attachments of the Client area.

**Copy photos from a camera assigned directory**
- From the client area, **right-click** and from the shortcut menu click **Photo**.
- In the AVImark Image Editor, open the **File** menu and click **Get Image**.
  If your camera is not listed select File, Open from the menu and choose the appropriate drive where the camera is installed.
- Locate the appropriate image.
- Double-click the image name or single click once and click **Ok**.

- In the AVImark Image Editor, open the **File** menu and click **Save as**.
- With the correct file name in the **File name** field, click **Save**.
Click **Ok** to save the image.

**E-mailing Clients**
AVImark allows you the ability to email photos, reminders, attachments, etc. directly from within the program. A client’s valid e-mail address must be entered into the E-mail field in order to e-mail information.

- You may send an e-mail message to the client by choosing **right-click, Send e-mail**. The Send e-mail window will open with the client’s email address specified.
- Enter an e-mail address you would like to send a carbon copy to within the **CC** field.
- Enter the subject in the **Subject** field.
- Within the **Attachment** field click on the browse button and search for the document, image, etc. and double-left click to attach.
- The **Reply To** field allows you to select a different e-mail address that the reply e-mails will be sent to. Use the drop down to select a specific user’s e-mail address entered in User’s and Security.
- Select the **Post copy to medical history** option will post a copy of the e-mail to the selected patient’s medical history.
- Select if you would like to send the e-mail in plain text or HTML content.
- Enter the body text within the text area of the e-mail window.
- Make sure you are on a computer that has your internet connection established before attempting e-mail. Click **Send** to begin sending the message.

**Handle Over-the-Counter Sales**
Situations may arise where you may need to handle a **walk-in over-the-counter sale for which there is no specific patient involved**.

- Add a new client to your files named something similar to **February 2009 OTC**. Create a client file such as this for each month of the year.
- In the Client area, **right-click** and from the shortcut menu click **Invoice**.
- In the Invoice window, **right-click** and from the shortcut menu click **Choose** to display the Inventory List.
- Select the item(s) being sold to the client from the Inventory list and click **Done**.
- In the Invoice window, **right-click** to display the shortcut menu. Point to **New** and select the appropriate payment type.
- Click **Done** on the **Enter Payment** window.
- Click **Print** to print the invoice.

**Enter a POA (Payment on Account)**
AVImark allows you to accept a payment from a client on their outstanding balance.

**Print an Invoice showing the POA**

- In the client area, **right-click** and from the shortcut menu click **Invoice**.
- In the Invoice window, **right-click** to display the shortcut menu. Point to **New** and select the appropriate payment type.
- Click **Done** on the **Enter Payment** window.
- Click **Print** to print the invoice.

**Invoice not needed when taking a POA**
In the client area, right-click and from the shortcut menu click **Account** to display the Accounting window.

In Accounting window, right-click and from the shortcut menu click **New** to display the **New Transaction** window.

Use the **Type** drop-down list and select the correct payment type.

Using the **Amount** field, enter the payment amount and click **Done**.

You will need to click either **Yes** or **No** at the **Confirm** prompt.

Click **Done** on the Accounting window.

**Making Change**

If the payment is by cash or for some other reason the customer makes a payment greater than the amount owed, a **Change Maker** window opens. The **Apply to balance** amount will be set to the client’s balance due. The difference between the **Amount tendered** and the **Apply to balance** will be shown in **Their change** field.

Click **Continue** on the **Change Maker** and the change will be entered into Accounting as a Cash Refund.

Click **Cancel** on the **Change Maker** and the difference will be applied to the account for future charges.

**View/Print the Client’s Accounting**

The client’s Accounting window shows all invoices as well as miscellaneous account adjustments, payments on the account, etc.
**AVImark User Manual**

**Client Area**

- In the Client area, **right-click** and from the shortcut menu click **Account** to display the Accounting window.

- Open the **Print** menu and click **History** to display the Print Account History window.

- Using the **Print To** drop down list, select the correct the printer.

- Specify the number of months of accounting history in the **Months shown** field, or use the **or since** and **through** drop down calendar and select the period to print for.

- Using the **Sort by date** field, select how you wish to sort.

- If appropriate, select **Print Signatures**.

- To view the report on screen, select **Preview** and click **Print**.

**Add Notes to Accounting**

AVImark allows notes to be entered for any Accounting Transaction record. Though still accessible as a selection in the payment type menu, **Notation type** is no longer necessary and should not be used.

- In the Client’s Account window, **right-click** and from the shortcut menu click **Notes** to display the Account Transaction Notes window.
• Type the notes pertaining to the entry and click Done.

**Age the Client’s Account**
This feature will display the correct information in the fields at the top right corner of the Client Account window.
• In the Client’s Account window, click Age account.

**View Client Stats**
Allows you to view year-to-date and last-year payment sales figures for the client:
• In the Client’s Account window, click Client stats.

**Work with a Closed Invoice**
AVImark will not allow you to make changes to an invoice that has been closed with the exception of changing the amount of the charges and/or the description.

**View and Change an Open Invoice**
You may view and/or change the contents of an “open” invoice in the client’s Accounting window. You may do this in either “Summary” or the “Detailed” view.
• In the Client’s Account window, right-click and from the shortcut menu click Invoice to display the Open Invoice.
• To change a transaction on the Open Invoice, select the correct entry.
• Right-click and from the shortcut menu click Change to display the Change Transaction window.
• Enter the appropriate change(s) and click Done.

**Transfer an Invoice**
AVImark will let you transfer the amount of an invoice (as an Account Adjustment) to another client’s accounting records.
• In the Client’s Account window, select the correct invoice.
• Right-click and from the shortcut menu click Transfer to display the Transfer window.
• In the Transfer to field, type the account number of the client you wish to transfer the invoice amount to.
• You will need to click Yes to confirm the Transfer.
• Click Done.

**Create a Pre-Invoice**
A Pre-Invoice may be created for clients to view expected charges prior to being posted to accounting. This will include unposted services, items, taxes, fees, and discounts. In addition, any charges the client currently has on an open invoice will also be displayed. These charges will be combined to be included on the Pre-Invoice. The printed copy of the Pre-Invoice may include a watermark indicating this is not a closed invoice. This option must be set in Hospital Setup, Invoicing. When the Pre-Invoice is printed or closed it will not post to accounting; all charges will remain unposted in the patient’s Medical History until posted into Accounting.
• In the Client area, right-click and from the shortcut menu click Pre-Invoice to display the Pre-Invoice.

**Undelete Accounting**
AVImark gives you the ability to undelete accounting that has been previously deleted.
• In the detailed view of the client’s account window, **right-click** and from the shortcut menu click **Undelete** to display the Undelete Accounting window.

• You will need to click **Yes** at the prompt.

• **Right-click** to display the shortcut menu. Select the appropriate option. They are:
  - Select
  - Select All
  - Select by Deleted Client

• With the correct entries highlighted, click **Undelete**.

**View an Accounting Entry History**
AVImark gives you the ability to view a history record of entries in the clients Accounting window. Some information that will be recorded will be when the service was posted to accounting, when a payment was entered directly into Accounting, changes made to a payment or transaction, removing or undeleting services in accounting, etc.

• In the Client area **right-click** and from the shortcut menu click **Account**.

• Click once on the desired entry to highlight it.

• **Right-click** and from the shortcut menu select **Entry History** to view the history record for that entry.

**Return a Check and Add a Fee**
AVImark allows you to return a check and add a fee.

• In the Client area, **right-click** and from the shortcut menu click **Account**.

• From the Accounting window select the check payment which will be returned.

• **Right-click** and click **Return check**. You will need to click **Yes** to confirm.

• Click **Yes** to the prompt if a fee is to be added.

**Dial the Client’s Phone Number**
AVImark gives you the ability to quickly dial the client’s residence phone. If the client’s phone prefix is not
included in the **Prefix Table** of System Tables, AVImark will dial 1+ the client’s area code, then the number itself. In the Client area, **right-click** and from the shortcut menu click **Dial** to display the Phone Dialer.

**Print Client Labels**
AVImark allows you to print mailing or other client ID labels.

- In the Client area, **right-click** and from the shortcut menu click **Label** to display the **Print Mailing Label** window.

  ![Print Mailing Label Window](image)

  - Using the **Print** **to** drop down list, select the correct printer.
  - Enter the quantity of labels to print in the **Copies** field.
  - Using the **Style** drop down list, select the label style you are using.
  - Click **Print**.

**Reprint an A/R Statement**
AVImark gives you the ability to reprint an A/R Statement from the Client area.

- In the Client area, **right-click** and from the shortcut menu click **Reprint Statement** to display the **Accounts Receivable** window. Using the **Print** **to** drop down list, select the correct printer. Click **Print**.
CHAPTER 7: PATIENT AREA

Patients belonging to this client are listed alphabetically as name tabs at the bottom of the CID. These tabs will be displayed with a font color which matches the information appropriate for the patient. For example; a deceased patient name tab will be de-highlighted, patients due for reminders are displayed in red, and patients having transactions that are not yet posted to the client’s account are displayed in blue.

Choosing Patients
AVImark allows you to quickly move from one patient to another belonging to this client.

- Click the name tab of the patient you wish to work with from the bottom of the CID.

Add/Change Patient(s) Information

- In the patient area, right-click and from the shortcut menu click New to display the New Patient Information window.
- Enter the information about the new patient. When all information has been entered, click Done.

Patient name

This field is the patient’s name.

- Type the patient’s name.

Species

This field displays the species of the patient.

- Using the drop down menu, select the species.
Breed

AVImark gives you several options for entering the patient’s breed. You may type a few letters of the breed and AVImark will display a list of those breeds containing those letters and then choose the desired breed. Or you can click on the drop down list to display the breed list in its entirety and choose the appropriate breed.

Because of possible misspellings of breed names when typing them into the Breed field, AVImark has incorporated an “Allow Auto-Add” feature. With this feature non-active, a user, when typing the breed name, must spell the name correctly and it must be in the Breed Table to allow them to continue with adding the new patient. Activated, a user may type the breed name and if misspelled and/or the breed name was not found in the Breed Table, the user will have the option of adding it to the table. For more information on the “Allow Auto-Add” feature, refer to “CHAPTER 2: SYSTEM TABLES”.

- Using one of the methods as discussed above, select the breed type for this patient.

Color

Entering the color designation can be performed using the same procedures as the breed.

- Enter a color for the patient.

Mix

This field allows you to indicate that the breed is mixed.

- Select this box when the patient is of mixed breed.

Age

When the patient’s birth date is entered, the age will be set automatically. Entering the patient age will change the birth date appropriately, as will the birthday when you enter an age of the patient. Enter the age in days, (e.g. 23d), weeks (e.g. 13w), months (e.g. 8m), or years (e.g. 11 or 11y).
Sex

The background of the patient area will appear pink or blue to represent the sex of the patient. The following table lists each sexual status code and its meaning.

- Click in the Sex field to display the drop down list of patient sex codes.
- Select the appropriate sex code for this patient.

<table>
<thead>
<tr>
<th>CODE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Unaltered Female</td>
</tr>
<tr>
<td>M</td>
<td>Unaltered Male</td>
</tr>
<tr>
<td>S</td>
<td>Altered Female</td>
</tr>
<tr>
<td>N</td>
<td>Altered Male</td>
</tr>
<tr>
<td>S</td>
<td>Stallion</td>
</tr>
<tr>
<td>M</td>
<td>Mare</td>
</tr>
<tr>
<td>G</td>
<td>Gelding</td>
</tr>
</tbody>
</table>

Birthday

- Using the drop down calendar, enter the birth date. You may also type the patient’s birthday. Ensure to use slashes between the month and year.

It is especially important that you are accurate with the birth date since the reminder system of AVImark is sensitive of this information.

Unknown

This check box is used when you need to enter an approximate birth date of the patient. This will let AVImark know the patient’s age is an estimated date.

- If appropriate, select this box to indicate an approximate birth date.

Weight

This field displays the patient’s weight and unit of measure.

- Type the weight of the patient. Tab to the next field to enter the unit of measure.

Codes

Patient codes identify a certain status about the patient. You may specify up to 5 codes for a patient.

- Click in the Codes field to display the drop down list of Patient codes.
- Select the patient code(s) appropriate for this patient. The following is a list of the Patient Code and their meaning.

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Deceased</td>
<td>Patient is currently deceased.</td>
</tr>
<tr>
<td>H</td>
<td>Hold Reminders</td>
<td>Suppresses printing reminders for this patient only.</td>
</tr>
<tr>
<td>I</td>
<td>Inactive Patient</td>
<td>Patient is currently inactive. This will also suppress the reminders for this patient.</td>
</tr>
<tr>
<td>E</td>
<td>Tax Exempt</td>
<td>Causes this patient to be tax exempt.</td>
</tr>
<tr>
<td>M</td>
<td>Moved or Missing</td>
<td>Indicates patient is moved or missing. This will suppress the reminders for this patient.</td>
</tr>
</tbody>
</table>
Certificate

Each time a treatment with a Y action code is entered into Medical History AVImark allows you to record a certificate number.

- Type a number other than 0. Each time this specific treatment is entered into Medical History, AVImark will automatically increment to the next certificate number.

Rabies

This field displays the current rabies tag number.

- Type the patient’s current tag number.

Locator

With an account set up with ePetRecords®, AVImark provides the ability to allow access of secure, on-line medical records to other veterinarians and the pet owner.

Microchip

This field displays the microchip or tattoo number up to 15 characters. This number will print on the AVImark vaccination certificate.

- If appropriate, type the microchip number.

Code

If the patient is currently enrolled in an AVImark Health Plan, the plan name will be displayed. You are not allowed to type any information into this field. Once the plan is selected for the patient, AVImark will fill in this field.

Photos

AVImark allows you to link photo images (jpg, bmp, tif or DICOM format) with the client, patient and medical history records.
Copy photos from a camera

- From the patient area, **right-click** and from the shortcut menu click **Photo**.
- In the AVImark Image Editor, open the **File** menu and click **Get Image**. If your camera is not listed select File, Open from the menu and choose the appropriate drive where the camera is installed.
- Locate the appropriate image.
- Double-click the image name or click once and select **OK**.
- In the AVImark Image Editor, open the **File** menu and click **Save as**.
- With the correct file name in the **File name** field, click **Save**.
- Click **OK** to save the image.

Copy photos into \PHOTOS\Client number\Patient name.

- In Hospital Setup, System tab, set the **in sub-directories** field to **By Client, then patient**.
- In the Attachments area in the lower right corner of the CID, select the **Photograph** box to display the AVImark Image Editor.
- On the AVImark Image Editor, open the **File** menu. Click **Open** to display the Open window.
- Using the **Look in** drop-down list, locate the drive and directory where the camera’s images are kept.
- Select the correct image and click **Open**.
- On the AVImark Image Editor, open the **File** menu. Click **Save as** to display the Save as window.
- Click **OK** to save the image.

Class (Discount)

AVImark uses this name to automatically discount the charges that are entered for a specific patient. With a Class Discount code entered here, this will override any Class Discount set up on the client.

- If appropriate, enter a class discount code.

Folder

This value will be displayed in parentheses, just to the right of the patient’s name on the CID.

- Type the folder number.

Reminded

This is the date when a reminder is printed for this patient. AVImark will automatically fill this date in; however, you may also type a date if you print a reminder card for this patient only.

Added

This is the date the patient was added to your files. AVImark will automatically insert the current date. You may change this date by clicking on the drop down list to choose the appropriate date from the calendar. AVImark will ask you to confirm the change.

Suspend until

You may temporarily suspend the reminders for this patient.

- Using the drop down calendar, select the date to suspend reminders to.
Allergy

Entering an allergy for the patient will display a Patient Alert with the appropriate information when the patient is selected.

- Using the drop down menu, select appropriate allergies. To add allergies to this list from the CID select Work with, System Tables and add allergies to the Allergy Table.
- If the appropriate allergy is not listed simply type the allergy in the field.

Deceased

AVImark will fill this date in for you when the Patient is marked as deceased.

```
To learn more about:                      Search the Help for:
Add New Patients                      Add Patient
Patient photos                         Patient Photos
Image Editor                           Image editor
Health plan                           Discount plans; Health plans
```

Patient Insurance Tab

This tab works in conjunction with the VetEnvoy Insurance eClaim and eQuote integration.

```
To learn more about:                      Search the Help for:
VetEnvoy Insurance Integration          VetEnvoy
```

Vaccination Reminder History

After creating the patient the Vaccination History window will be displayed. Only those reminders you have chosen to appear in this window will be displayed.

- From this window enter the dates of the patient’s last vaccinations.
- To not have this window automatically displayed, uncheck the option Show This Window When Pa-
Viewing a Patient Chart
From the CID screen, view the Patient Chart print window using the clipboard speed bar option at the top.

Printing a Patient Chart
Right-click on the patient area and select chart.
Print Using Chart Terms

The chart length or term is been separated.

Report Code

A drop down list to select from the AVImark canned report code list.

Weight History for Chart Terms/Date Range

Check this box to use the exact same dates as selected above. To print Weight History for a different time-frame than the chart length, enter a From Date to specify the amount of weight history that needs to be reported.

Print History for Site

Click on the drop-down list to select the site you are printing the Chart for.

Include the following.....

To set user-defined default settings by user, select the “Save Settings on Close” box when printing. Then every time that user logs-in AVImark will automatically check the appropriate options to print on the chart. Setting a default for all users check “Save Settings for All Users”. Checking this option, along with “Save Settings on Close”, every user will have the same chart settings.

Attachments

AVImark gives the option to print actual file attachments with the chart instead of just listing the path of where the file is located.

Attachments Link Only

Will only print the path of the attachment showing where it’s stored.
Client, Patient and Medical History Alerts

Have been separated to allow alerts to be selected and printed individually. All alerts now print with the “caution” \( \Delta \) symbol and all Medical Alerts print in bold.

Client Cell

Includes client cell phone number.

Client Email

Includes client email address.

Client, Patient and Medical History More Stuff

More Stuff options have been separated to allow information to print separately for each area instead of all together. Each option should be selected individually to print on the chart.

Client, Patient and Medical History Notes

Notes have been separated to also print individually accordingly to the option(s) chosen.

Dental Charts

Now print after the Patient Chart and shows the Medical History entry that had the chart attached by listing ‘Dental Chart\(\)time\(\)day’ on the chart print out.

DICOM info

This option is not yet functional.

Display Quantities of One

Will allow quantities of 1 or below entered in Medical History to print on the patient chart.

Doctors Instructions

The treatment Doctors Instructions will print on the chart directly under the associated entry.

Follow-Ups

Follow-ups that are currently due and those that are overdue will be included on the Chart.

Soap Client Instructions

Will now print on the chart; they are located in the Plan Area of the Medical Condition Record. These notes will appear on the chart under the entry the SOAP record is attached to.

Additional Chart Advanced Option

From the CID select the Advanced Options speed bar button.

Display Patient Record Number

This is for clinics using the advanced option “Display Patient Record Number” on the Patient area of the CID. This option will need to be set to True and it will allow the record number to be printed on the Patient Chart. This feature was implemented for clinics using lab integrations that require proper associations for imported studies. Having this number print will make it easier to match up the printed results and patient charts.
In the search field type display and select the option Display Patient Record Number.

Change the Value to True and AVImark will display patient ID numbers on the CID screen to the right of the Patient area.

**Work with the Reminders Folder**

At the right side of the Patient Area, reminders which are appropriate for the patient will be displayed in a Reminders folder. Each reminder will be listed along with its due date. Any reminders that are displayed in red indicate they are past due, those due within the next 30 days will be displayed in blue, those reminders which are current will be displayed in black and those reminders that are patient specific will default to being displayed in green or the user defined color.

<table>
<thead>
<tr>
<th>EXAM</th>
<th>Annual Health Exam</th>
<th>02-25-06</th>
</tr>
</thead>
<tbody>
<tr>
<td>BORDVC</td>
<td>Canine Bordetella Vaccine</td>
<td>06-20-08</td>
</tr>
<tr>
<td>00</td>
<td>Rabies 1 yr Canine Combo</td>
<td>06-20-08</td>
</tr>
</tbody>
</table>

**Restore Default Reminders**

AVImark lets you add all the reminder templates specified in your Treatment List to a particular animal. This has the effect of re-applying those reminders which are appropriate for this species.

- In the Reminder folder, right-click and from the shortcut menu click Defaults. This will prompt you to discard current reminders for the patient and add default reminders.

**Post Reminder Treatment from the folder**

AVImark allows you to post treatments which are listed in the reminder folder into Medical History. This will update the reminders and Medical History for this patient.

- In the Reminders folder, select the correct treatment. Right-click and from the shortcut menu click Post. You will need to click Yes to post the reminder to Medical History.
Postpone Reminders from the Reminders folder

You may postpone the reminder dates for any treatments within the Reminder folder.

- In the Reminders folder, right-click and from the shortcut menu click Postpone.
- Using the drop down list, specify how you wish to postpone the reminder by selecting At Age, In or an On date.
- Type the appropriate value for the postponed time.
- Using the drop down list, select, Days, Weeks, Months, or Years where appropriate.
- Click OK. You will be prompted whether to postpone each reminder from the Reminder folder.

Add a new reminder template for this patient

AVImark lets you specify the conditions under which you want to remind for any treatment and/or inventory item you select. You do this in what are called Reminder Templates, which are normally set up for each treatment and applied to all patients at once. In addition, AVImark allows you to add or change a reminder from the reminder folder. Adjusting the reminder from the folder now makes the reminder specific for this patient.

- In the Reminder folder, right-click and from the shortcut menu click New to display the Patient Reminder Template.
• Set up the template appropriate for this patient and click Done.

**Change a patient reminder template**

When a given reminder is appropriate for certain patients, but due to special circumstances you need to change the reminder template and how it applies to this particular patient.

• In the Reminder folder, **right-click** and from the shortcut menu click **Change** to display the Patient Reminder Template.

• Adjust the template appropriate for this patient and click **Done**.

*When you change the Due date, a Due date set by user checked box will appear to the right of the date indicating that AVImark’s calculation has been overridden. The date will display in green on the Reminder folder indicating it is a patient specific reminder. If you need to return to the original date, just uncheck the box.*

**Prevent reminder override**

When a reminder template has been modified for a particular patient, AVImark allows you to prevent any changes to the modification, even though the template’s normal specifications have changed in your Treatment List.

• In the Reminder folder, **right-click** and from the shortcut menu click **Change** to display the Patient Reminder Template.

• On the reminder template select the **Advanced Tab**.

• Uncheck the **Allow override from template** box and click **Done**.

**Set up a Patient Follow-up**

The Follow-up listing is a list of patients who need to be called back after a short period of time. When a follow-up becomes past due, the Follow-up folder tab will be displayed in red.

• With the correct patient selected, select the Follow-up folder tab.
• **Right-click** and from the shortcut menu click **New** to display the Change Follow-up window.

• Using the **Subject** field, type the subject matter for the follow-up.

• Using the **Doctor** drop down list, select the **Doctor**.

• If appropriate, select the **Critical** box.

• Using the **Due Date** drop down calendar, select the **Due Date** or specify in how many days the follow-up becomes due.

• If appropriate, use the **Repeat every** fields and specify how often the follow-up should be repeated.

• Using the **Comments** section, specify any memos or notes and click **Done**.

---

**Specify a Patient Estimate**

You may specify one or more estimates for a patient by choosing one from the canned estimates as it is or modify it, and/or build estimates from scratch for the selected patient. AVImark also allows you to customize the name of the Estimate tab as well as additional areas that reference the Estimates such as the Work with menu and the Canned and Patient Specific Estimate windows. This can be done from the Option Maintenance area of Hospital Setup. Because of the extensive estimate handling capabilities, Estimates will be explained more in detail in “CHAPTER 16: ESTIMATES”.

**Set up Ownership/Split-Billing**

AVImark gives you the capability to divide charges entered for a patient among any number of clients. The Percent Ownership field in the Change Ownership window will display the existing owner’s percentage of ownership of the patient or be blank for you to enter the new owner’s percentage of ownership. In addition, the Ownership tab will allow the patient’s ownership history to be displayed. If a patient’s record has ever been moved from one client to another, using the move functions that are available, the previous owner(s) as well as the date that patient was moved will be recorded. All previous owner entries will be displayed in a gray color representing their ghosted ownership. This allows easy tracking of a patient’s owner history and the dates that correspond to the previous owners.

<table>
<thead>
<tr>
<th>Client No</th>
<th>Name</th>
<th>Ownership</th>
</tr>
</thead>
<tbody>
<tr>
<td>236</td>
<td>Kostial, Jeff</td>
<td>50%</td>
</tr>
<tr>
<td>456</td>
<td>Carter, Wynn</td>
<td>50%</td>
</tr>
<tr>
<td>170</td>
<td>Cunningham, Karen</td>
<td>100%</td>
</tr>
<tr>
<td>150</td>
<td>*** Confidential ***</td>
<td>100%</td>
</tr>
</tbody>
</table>

---

• With the correct patient displayed, select the **Ownership** folder tab.

• **Right-click** and from the shortcut menu click **New** to display the Change Ownership window.

• In the **Client No** field, type the client number for the client to which split billing is to be applied.
• Using the Percent Ownership field, type the ownership percentage as a whole number. AVImark will calculate the percentages of ownership and will warn you if the percentages entered do not equal one hundred percent.

• If there is a time when you would like to hide a particular owner on the CID screen, this can now be done by using the Public checkbox. This option defaults to being checked in the New Owner window. Un-checking the Public option in the New/Change Ownership tab will prevent the owners full name from being listed. Owners that are not public will be displayed in the tab by the client account number and the ownership percentage amount. The clients name will be kept confidential by showing as asterisk in the ownership tab on the CID. Both current and previous owners can be marked public or not.

• If you would like to “de-activate” a previous owner select the Previous Owner box. This will display the previous owner grayed out within the Ownership Tab. Once an owner has been marked Previous Owner it is not possible to “reactivate” the same owner again from the Change Ownership window. To setup the owner again the client must be entered again with a new Start date to be associated with the patient as having part ownership.

• If appropriate, select Has Ultimate Authority.

• If applicable, type any notes appropriate for the entry. All the AVImark® notes feature options are available from this window.

• Click OK.

Work with the Schedule Folder
From the patient’s Schedule folder, you may add new appointments, review and make certain changes to the scheduling status of a patient. AVImark has extensive boarding and appointment handling functions described in detail in “CHAPTER 17: APPOINTMENT CALENDAR” and “CHAPTER 18: BOARDING CALENDAR”.

Add, change or remove appointments and reservations
• With the correct patient displayed, select the Schedule folder tab.

• Right-click and from the shortcut menu click New to display the New Appointment window.
• On the New Appointment window, use the Date drop down calendar and select the date.
• In the Time field, use the UP and DOWN arrows to set the correct appointment time.
• Select the correct Doctor from the Doctor drop-down list.
• Enter any Notes, Treatments/Items and/or Problems associated with this appointment and click Done.

Check the Patient in
• From the Schedule folder tab of the correct patient, right-click and from the shortcut menu click Check-in to check the patient in.
• If the Whiteboard does not display, right-click on the Schedule folder to display the shortcut menu and click Whiteboard. For detailed information regarding the Whiteboard, refer to “CHAPTER 19: WHITEBOARD”.
Add Patient Notes
AVImark allows you to create unlimited notes or memos about the patient. You may also import text files (files with an extension of .txt) and/or copy and paste note templates from the Note Glossary into any AVImark note window. For detailed information on adding, importing and creating note templates, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”.

- In the Patient area, right-click and from the shortcut menu click Notes.

Delete a Patient
You may delete a patient including all Medical History related to the patient.

- From the patient area, right-click and from the shortcut menu click Remove.
- You will need to click Yes to confirm.

Undelete a Patient
AVImark allows you to retrieve Patient, Medical History and Accounting information that has been deleted from your files.

- From the patient area, right-click and from the shortcut menu click Undelete to display the Undelete Patients window.
- You will need to click Yes to confirm searching for deleted patients.
- Select the patient(s) you wish to undelete by highlighting the patient name and use the SPACEBAR to select (bold). You may also right-click and from the shortcut menu click Select All to undelete all patients listed.
- Select the patient information; Medical History, Reminders, Follow-ups, Split-billing, Appointments, and Boarding you would like to undelete using the same procedures for selecting patients.
- When all the appropriate information has been selected (bolded) click Undelete.

Move a Patient to another Owner
This feature allows you to move a patient and its Medical History to a different client file.

- From the patient area, right-click and from the shortcut menu click Move.
- You will need to click Yes to confirm the move. This will display the Client Selection window.
- Enter the new client information and click Continue to display the CID for the new client.
- Click Yes to confirm the move from one client to the other.

Access Patient Lab Information
By accessing the Patient Lab Information you can view test result history for a selected patient as well as export that data to Excel®. This is a Ready-Only window and allows you to view the result history based on test and organized by date.

- From the Patient area right-click and from the shortcut menu click Patient Lab Information.
• Individual test name tabs will be created for each test type that exists for the patient.
• Test information data for the selected Test Type tab can be exported to Excel® by selecting File, Create Excel from the menu area.

Print Patient ID Collar
This feature allows you to print a patient collar for pets which are boarded, hospitalized or checked-in by appointment. For this option to work you will need to print the labels to the Pet Detect CT-400, which can be purchased from PetDetect®.

• From the patient area, right-click and from the shortcut menu click Print Collar.
• Choose the collar size and the printer. Select what you would like to have printed on the collar.
• Click on Details to include specific client and patient information on the collar. To print the patients name in a large bold print on the collar check the Enlarge Name option.

View Patient Problem History
AVImark’s Problem History feature allows you to view open or closed problems for the specific patient. A problem can be opened directly in the Problem Histories window, from the Medical History or from the SOAP (Medical Condition) window.

• From the patient area, right-click and from the shortcut menu click Problems.
• Right-click and from the shortcut menu select the desired option.
• Open to display the Problem List window and choose a problem to add.
• New to add a problem to the history by entering the code of the problem.
• Change to change information about an open problem.
• Remove to remove a problem from the history.
• Close to close a problem once it is resolved.
• Use the Edit shortcut menu to undo or redo changes and to select entries.
• From the View shortcut menu option you can refresh the screen, customize columns, view an entry history, preview or hide text and group columns.
• View History will return you to the CID with the Medical History entry linked to the open problem automatically highlighted.
• Whogot allows you to view and/or print a list of all patients who have been diagnosed with this problem.
• Review the Document associated with the selected problem.
• Select Protocol associated with the selected problem.
• Uses the Notes option to view and/or add diagnostic protocols for this problem.

Printing Documents for Patients
You may print any MS Word document from the selected patient.

• From the patient area, right-click and from the shortcut menu click Document to display the Print Document window.
In the Document field, **right-click** and from the shortcut menu click **Choose** to display the Open window.

Select the file name you wish to print and click **Open** to return to the Print Document window.

Use the **Copies** field to specify the number of copies to print.

Use the **Print to** drop down list and select the correct printer.

Click **Print** or select **Preview** and click **Print** to preview the document on screen.

**Creating a Patient Alert**

This feature allows you to have an alert message appear when you first select the patient that the alert has been set up for.

- From the patient area, **right-click** and from the shortcut menu click **Alerts** to display the ATTENTION! window.
• Type the message you wish to have displayed on the alert.
• If the alert is of a critical nature, select the Medical alert box and click Continue.

To learn more about: Search the Help for:
Print a document
Patient alerts
Print patient document
Patient alerts

Add File Attachments
AVImark gives you the ability to attach multiple files to a patient such as; documents, images, spreadsheets, and so on.
• From the patient area, right-click and from the shortcut menu click File Attachments to display the Patient File Attachments for window.
• In the File Attachment window, right-click and from the shortcut menu click New to display the New Patient File Attachment window.
• In the Filename field, click to display the Open window.
• Select the file name you wish to attach and click Open to return to the New Patient File Attachment window.
• Click OK.
• Attach multiple files using the same procedures.

View as Gallery
AVImark allows you to view photos as a gallery when multiple photos are attached to the patient.
• From the Patient File Attachment window, open the View menu. Click View As Gallery.
Add Notes

Notes can be added to any file; however, Gallery view must not be selected.

- Select the file you wish to add notes to. **Right-click** and from the shortcut menu click Notes to display the File Attachment Notes window.
• Type the notes pertaining to the file and click Done.

**Preview notes attached to the file**
• From the Patient File Attachment window, open the View menu. Click Preview Text to display the Columns window.
• Select the Show Preview Text option and select Notes.
• Click OK to return to the Patient File Attachment window.
• When finished click Done.

**Add Invoice Instructions**
You may enter Patient Instructions to be printed on the invoice.
• From the patient area, right-click and from the shortcut menu click Instructions to display the Invoice Instructions window.
• Type the instructions pertaining to the patient and then click Done.

**Viewing Patient Photos**
AVImark lets you display an album style listing of all photos attached to the patient.
• In the patient area, right-click and from the shortcut menu point to Photo.
• Click My Photo to view or work with the photo that has been linked with the patient or click Photo Album to display a tabloid of all photos linked with the patient.

**Print Patient Labels**
You may print patient ID labels for any or all patients belonging to a client.

• In the patient area, right-click and from the shortcut menu click Label to display the Print Patient ID Label window.
• Use the Copies field to indicate how many labels you wish to print.
• Using the Print to drop down list select the correct printer.
• Select for each patient if you wish to print a label for each of the client’s patients.
• Click Print.
Define a Patient Work List
AVImark lets you define a Work List of jobs that would typically be assigned to appropriate staff to perform depending upon their abilities. For example: Update medical records; feeding; blood samples; recording vital signs, and so on. This list of jobs is up to you and may be defined in your System Tables. The Work List window is a free floating window that works along side the CID. Also if the Work List is left open and a patient is open on the CID, if the patient is on the Work List AVImark will automatically select the patient on the Work List.

Accessing the Work List
The Work Lists can be accessed by using one of two methods:

- From the CID menu area select Clients, Work Lists. You can then choose the list you want AVImark to display. The shortcut keys Ctrl+Alt+F10 can also be used to open the lists.
- Or in the Patient area, right-click to display the shortcut menu, and point to Lists and click the appropriate Work List name.

Toggling Between Lists
Once a Work List is open you can easily toggle between the lists you have defined.

- In the Work List click on the Work List drop-down arrow and select the list you wish to display.
- Or in the list press Shift+Tab until the Work List field is highlighted. In this field simply type a few characters of the list name you want to display and AVImark will display the list and the associated entries.

Manually assign a patient to Work List
You may manually assign a patient to any number of Work Lists so that a staff member may view or print a list of patients on the list(s) that is their job to perform.

- In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List name.
- From the Work List window, right-click and from the shortcut menu click New to include the patient on the list.

Automatically link a patient to a Work List
AVImark allows you to assign up to three Work Lists Codes to any treatment so that when you perform the treatment, the patient is automatically added to one or more Work Lists. For more information on assigning Work List codes, refer to “CHAPTER 3: TREATMENT LIST”.

Enter/View Work List Notes

- With the correct patient highlighted in the Work List window, right-click and from the shortcut menu click Notes to display the Notes window.
- Enter the notes about the job as related to the patient and click Done.
- To view notes in the Work List window, open the View menu and click Preview Text.
- Click the Notes option and click in the Show Preview Text box.
- After clicking OK AVImark will display the notes directly on the screen.

Use the Work List

- In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List.
- With the correct patient highlighted right-click and from the shortcut menu click Accept to display the CID for that patient. The Status for the selected patient will be set to In progress.
- After the work is completed, select the correct patient from the list.
- Right-click and from the shortcut menu click Remove to remove the patient from the Work List.
- You will need to click Yes to confirm.

Posting Work List Entries

After a patient has been accepted on the Work List and you have attached notes you might find it beneficial to post the entry to the patients Medical History. This will store the attached notes in Medical History which helps in keeping efficient notes.

- Open the appropriate Work List and select the correct patient.
- Right-click and from the shortcut menu click Post to remove the entry from the Work List and post the notes to the patients Medical History.

After closing the list and opening the patients file on the CID you will see the notes entry displayed in the pets Medical History.

Renew a patient on the Work List

When a patient has been accepted or removed from the Work List, the patient may be renewed/added back to the list.

If the patient has been accepted:

- Select the correct patient from the Work List.
- Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.
If the patient has been removed:

- From the Work List window, open the Work List menu and click Show ghost to display the removed patient.
- Select the correct patient from the Work List.
- Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.

Go to the selected patient

You may access any patient that is displayed on the Work List.

- Select the correct patient from the Work List.
- Right-click and from the shortcut menu click Open Patient to display the CID for that patient.

Transfer a patient to another list

You may transfer a patient from one Work List to another.

- With the correct patient selected in the Work List window, right-click to see the shortcut menu and point to Change.
- Click on the Work List drop-down arrow and select the Work List you wish to move the patient to.
- After clicking OK AVImark will transfer the selected patient to the Work List you had selected.

Additional Work List Options

The Work List can be customized to fit your needs by utilizing the customizable features and many features have been added to give flexibility when working in a Work List.

- In the desired Work List you can customize the displayed columns by selecting View, Columns from the right-click menu. Use this option to display or remove columns on the list.
- To select multiple entries highlight an entry and press the Shift key to select consecutive entries or use the Ctrl key to select random entries. You can then Remove, Accept, Post or Renew those entries by selecting the desired option from the right-click menu.
- To open the selected patients account open the right-click menu and point to Open Patient.

Add Patient to Work List at Check-In

By utilizing an Advanced Option AVImark will allow you to add a patient to a Work List at the time they are checked in.

Set up

Before you set the Advanced Option you will need to open Work With, System Tables and locate the Work List table. Open the Change window of the appropriate Work List entry and make note of the code.

- From the CID select the Hospital Advanced Options speed bar icon.
- In the Search field type work and select the entry Add Patient to Work List Code.
- Once the entry is selected click Change under the Values tab.
- In the Value field type the code of the Work List you want to add the patient to at the time they are checked in.

Once the pet is checked in they will automatically be added to this Work List.
Work Lists More Stuff

AVImark gives you the ability to create Additional Data Fields that can be utilized in the Change Work List window.

Setup

The additional data fields must be defined in System Tables.

- From the CID menu area select **Work with, System Tables**.
- Under the Table area click on the **Additional Data Fields** table and click once on the **Additional Work List Fields** entry.
- To begin creating additional data fields right-click and select **More Stuff Fields** from the menu.
- Enter the desired fields and click **OK** to save them and then click **Done** to close the window.

To have a blank field for typing information you will want to use the type of Phrase when defining the data field.

Using Additional Fields

After the fields have been defined they will appear in the Change Work List window.

- From the CID, **Patient** area open the desired **Work List**
- In the Work List highlight an entry, right-click and select **Change** from the menu.
- The additional field will appear at the bottom of the Change window ready for you to enter the desired information.

By utilizing the Columns feature you can display the defined Additional Data Field as a column on the Work List.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Work List</td>
<td>Work List Table</td>
</tr>
</tbody>
</table>

Export/Import Patients

This feature allows you to export client, patient, medical history, and reminder data for existing clients and patients to either a removable media such as diskette, CD, zip cartridges or to an internet-based site, called the AVImark Data Safe.

With either method, your data may be encrypted so that it is unreadable except by the AVImark provided data import feature. Your information is also protected by a password that is provided to you at the time the data export takes place. Only another AVImark clinic will be able to import the information into their data base using the automatically generated User ID and password displayed immediately following the preparation of the file for export. When the importing clinic imports the file into their AVImark program they will have the option of importing the patient information to the currently selected client’s file or to a new client file.

Export client and patient records

- In the Patient area, right-click to see the shortcut menu. Point to **Export** and click either **Export patient(s)** or **GlobalVetLink®**.

  *The GlobalVetLink® option will create an xml file to be imported by the GlobalVetLink® Company. This company offers online travel certificate information. GlobalVetLink® is only available to clinics in the state of Florida.*

- From the **AVImark Data Export** window, select the **Options** you wish to export.
- In the **Destination** area, select where you wish to export to.
AVImark User Manual

Patient Area

- Click **Continue** to export and to display the **User ID** and **Password** which will be necessary during the import process.

Import client and patient records

- In the Patient area, **right-click** and from the shortcut menu click **Import patient(s)** to display the AVImark Import Data window.
- Enter the **User ID** and **Password** that was provided during the export.
- Select the appropriate import **Options**.
- Select from what **Source** to import and click **Continue**.

Use an E-Travel Sheet

AVImark gives you the ability to create and use an electronic Travel Sheet for patients.

- In the patient area, **right-click** and from the shortcut menu click **e-Travel sheet**.
- To display all codes in addition to those with the **F** action code, select **Show all entries**.
- Using the **Treatment**, **Inventory** and **Diagnosis** tabs, select the desired codes to add to the selected box.
- Click **Close** to save the codes for the patient.
- Click **Post** to add the codes to the patient’s Medical History.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export/Import patients</td>
<td>Data export</td>
</tr>
<tr>
<td>GlobalVetLink®</td>
<td>GlobalVet</td>
</tr>
<tr>
<td>E-Travel Sheet</td>
<td>E-Travel sheet</td>
</tr>
</tbody>
</table>
CHAPTER 8: ENTERING MEDICAL HISTORY

Just below the Patient area of the CID is displayed the most recent medical history of the patient that is currently selected.

In this chapter you will learn about...

- Sorting Medical History on page 147
- Use the Medical History Search Box on page 149
- Working with the Attachments Window on page 149
- Entering Medical History on page 150
- Change Medical History Information on page 154
- Adding Medical History Notes on page 154
- Deleting and Undeleting Medical History on page 155
- Printing a Rabies Certificate on page 156
- Declining Medical History Entries on page 156
- Discounting Medical History Entries on page 156
- Printing an MS Word Document on page 156
- Printing Prescription Labels on page 157
- Refilling Prescriptions on page 157
- Adding File Attachments on page 157
- Entering Medical History Forms on page 157
- Using History Mode on page 158
- Specifying Inventory Used on page 158
- Moving Medical History on page 158
- Changing Medical History Sequence on page 159
- Linking an Image to an Entry on page 159
- Entering Vaccination Information on page 160
- Using the WhoGot List on page 160

Sorting Medical History

All Medical History entered for a patient is displayed in the default Chronological view. You may sort your Treatments/Inventory to the appropriate Medical View tabs which appear at the bottom of the Medical History section of the CID. By adding key words or letters, action codes and/or certain report codes, the Medical History will be sorted to the correct tab.

Chronological

Displays all medical history sorted by date performed.
Diagnosis
Display medical history entries that are part of your Diagnosis List.

Dietary
Display items that have either a Z as one of their Action codes, belong to a category name which includes the words Diet or Food.

Injections
Inventory items that have the word Inject in the category name or that have either a V or an M as one of their Action codes. Treatments which have the word Inject in the category name or have either a U or an M as one of their Action codes or an I as one of their Report codes/category report codes, will also be included.

Lab
Display treatments that have the word Laboratory in the category name or have an L as one of their report codes/category report codes.

RX
Display items or treatments that have the letters PHARM or PRESCRIPT as part of the category name or have a P as one of their action codes or P as one of their report codes.

Reminder
Display items or treatments performed that have a reminder template defined.

Surgery
Display services that have the letters SURGER in the category name or have an S as one of the report codes/category report codes.

Vaccinations
Display services that have the word Vaccination in the category name or have a V as one of their action codes.

X-Ray
Display treatments that have the words XRay, X-Ray, or Radio in the category name.

SOAP
Display treatments for which Medical Condition data has been recorded.

Photos
Display items or treatments for which a photograph has been linked.

Notes
Display items or treatments which notes have been linked.

Public
Display items or treatments which have notes marked as Public in the Enter Medical History window.
Problems
Displays problems that have been entered in the patient’s medical history.

Attachments
Displays medical history entries that have associated File Attachments.

Dental
Displays medical history entries that have a dental chart attached.

Requisitions
Displays medical history entries that have a lab requisition attached.

Radiographs
Displays medical history entries containing a radiograph attachment.

Use the Medical History Search Box
When you place the cursor in this box and begin to type, AVImark will limit and display only those treatments and/or inventory items that have been entered that begin with the letters typed.

<table>
<thead>
<tr>
<th>Medical History</th>
<th>Date</th>
<th>Time</th>
<th>Dr.</th>
<th>Type</th>
<th>Code</th>
<th>Description</th>
<th>Qty</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>07-13-07</td>
<td>10:57a</td>
<td>DLM</td>
<td>T</td>
<td>(m)</td>
<td>EXAM0</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>35.75</td>
</tr>
<tr>
<td>07-17-06</td>
<td>1:21p</td>
<td>DLM</td>
<td>T</td>
<td>EXAM0</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>10-13-05</td>
<td>11:55a</td>
<td>DM</td>
<td>T</td>
<td>918</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>30.00</td>
<td></td>
</tr>
<tr>
<td>02-25-05</td>
<td>2:43p</td>
<td>DM</td>
<td>T</td>
<td>EXAM0</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>32.17</td>
<td></td>
</tr>
<tr>
<td>12-06-04</td>
<td>9:35a</td>
<td>DM</td>
<td>T</td>
<td>(m)</td>
<td>EXAM0</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>32.17</td>
</tr>
<tr>
<td>04-11-03</td>
<td>8:43a</td>
<td>DM</td>
<td>S</td>
<td>651</td>
<td>Hospital/Exam/Treatment</td>
<td>1</td>
<td>30.00</td>
<td></td>
</tr>
<tr>
<td>04-12-02</td>
<td>9:18a</td>
<td>DM</td>
<td>S</td>
<td>EXAM</td>
<td>Annual Health Exam</td>
<td>1</td>
<td>30.00</td>
<td></td>
</tr>
</tbody>
</table>

Working with the Attachments Window
If there have been photos, notes, conditions, vaccinations, inventory used or any file attachments specified for the selected entry, those check boxes will be marked accordingly in the Attachment window at the right side of the Medical History area. To display the information attached to the entry simply select the appropriate attachment listed.

Dental Chart
Create or view a Dental Chart for the selected entry.

Form
Display or create a new form template.

Inventory Used
Display or add inventory used with the service.

Medical Condition
Display or create a new Medical Condition record.

More Stuff
Display or enter Additional Data field information.
AVImark User Manual

Entering Medical History

Notes
Display existing notes or enter new notes.

Photograph
Display an enlarged view of a photo linked with a service.

Attachments
When in the Medical History area, this will open the History File Attachment window to display all photos, Word documents and spread sheets that have been attached to the selected entry.

Vaccination
Display or enter new vaccine information for a treatment.

Tests
View or import test results for the selected entry.

DICOM
Send DICOM Imaging requests or view images by accessing the Sound Technologies viewer.

Entering Medical History
You may use the Enter Medical History window to enter the information about the treatment you wish to add to the Medical History Area of the patient. Typically you would need to only type the treatment, item, diagnosis or problem code and AVImark would fill in all the other information for you. However, on occasion you may need to make changes to the quantity, price you want to charge or to other default values.

Using the Medical History Window
• In the Medical History area, right-click and from the shortcut menu click New to display the Enter Medical History window.

Date
The date the treatment was performed. This date will automatically display today’s date or duplicate the date for the last treatment entered.

Patient
This field is the name of the patient for which to enter the entry into Medical History. AVImark will show the patient currently displayed on the CID.

Code
The treatment, inventory, diagnosis or problem code you wish to enter.

**Description**

AVImark will automatically enter the description according to the code which you have entered. You may however, edit the description:

**Quantity**

This field specifies the quantity of treatments or items dispensed. AVImark defaults to a quantity of 1; however, you are able to specify any number to 2 decimal places, for example; 2.67.

**Amount**

AVImark enters the amount for the service as specified in your treatment and inventory lists. You may change the price manually if needed.

**Photos**

This field allows you to link a photo related to the medical history entry.

**Co**

The Company number automatically defaults to the client company number, but may be changed manually if needed.

**At**

This is the time that the service was performed. This will be set by AVImark as the current time of day but may be changed manually if necessary.

**Type**

Denotes the kind of service performed. Although you are able to manually enter the value in this field, it is recommended that you do not alter the setting for a given treatment or item.

<table>
<thead>
<tr>
<th>CODE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Non-Taxable Treatment</td>
</tr>
<tr>
<td>T</td>
<td>Taxable Treatment</td>
</tr>
<tr>
<td>L</td>
<td>Local Taxed Treatment</td>
</tr>
<tr>
<td>E</td>
<td>State Taxed Treatment</td>
</tr>
<tr>
<td>I</td>
<td>Non-Taxable Inventory</td>
</tr>
<tr>
<td>X</td>
<td>Taxable Item</td>
</tr>
<tr>
<td>C</td>
<td>Local Taxed Inventory</td>
</tr>
<tr>
<td>M</td>
<td>State Taxed Inventory</td>
</tr>
<tr>
<td>D</td>
<td>Diagnosis</td>
</tr>
<tr>
<td>P</td>
<td>Problem</td>
</tr>
<tr>
<td>O</td>
<td>Other</td>
</tr>
<tr>
<td>N</td>
<td>Appointment/Follow-up/Work List Notes</td>
</tr>
<tr>
<td>V</td>
<td>Check-In Visit</td>
</tr>
<tr>
<td>J</td>
<td>Journal</td>
</tr>
</tbody>
</table>

**Public**

This box is defaulted to being checked for you. However, you may uncheck this field if those services are not to
be displayed on a Patient Chart that is marked as Public.

Doctor
This is the doctor’s ID who performed the service.

Form
This field allows you to attach an MS Word form to the Medical History entry.
- Double click in this field to attach a form to the entry.

Xls
You may attach an Excel spreadsheet file to any entry in Medical History.
- Double click in this field to attach an Excel spreadsheet.

Problem
AVImark allows you to associate the medical history entry with whatever problem the patient is being treated for. For detailed discussion on the Problem list, refer to "CHAPTER 13: PROBLEM LIST".
- Using the drop down menu select the appropriate Open problem.

Decline
This field is used to mark a recommended service as Declined in which the client has refused.

Admitted
This field is used to identify the doctor that admits the patient into the hospital.
- If appropriate, use the drop down menu to select an Admitted Doctor.

Variance
When dispensing a controlled substance, AVImark allows you to specify the amount, if any, that was spilled, broken, leaked, and so on. There are 2 fields provided for this entry; the first for the amount lost, and the second for the code for the reason of loss.
- When applicable, enter the amount and code of the controlled substance which was lost.

By
AVImark automatically enters the ID of the employee who is currently logged in. In the case where employees are not entered as users in Users and Security, you will need to manually enter this information.

Site
The site field, if being used, will allow the person entering the medical history to select the site at which they are currently entering the medical history from. Single site clinics will not be using the Site fields found in the AVImark program.

Journal
AVImark allows you to attach a Windows Journal file to any Medical History entry.
- Double click in this field to attach a Journal file.

Zip
This field is for clinics in the state of Kansas, Ohio, Georgia, and Washington. Due to different tax laws, this field provides the user with the ability to apply tax, not by what county the clinic is located, but by the area the services are performed in or items are purchased by the client, or by where the client is from.

- Type the zip code for where the services were actually performed.

Add New Medical History

You may add as many Medical History entries for the selected patient into the Medical History Area of the CID as you wish. There are several ways to enter Medical History entries:

Adding Medical History Entries One at a Time

- In the Medical History area, right-click and from the shortcut menu click New to display the
- Enter Medical History window.
- Enter the Code of the treatment, item, diagnosis or problem.
- Using the TAB key, tab to the Description, Quantity and Amount fields which may be changed if you wish.
- Click Done to enter the service into Medical history.

Add Medical History Entries Using the Search Method

AVImark will find the service for you when the code is not known.

- From the Medical History area, right-click and from the shortcut menu click New.
- TAB to the Description field and type at least 3 letters for the Treatment, Item or Diagnosis you are looking for.
- Double click the Treatment, Item or Diagnosis.
- Tab to the Quantity and Amount fields which may be changed if you wish.
- Click Done to enter the service into Medical history.
Add Medical History entries using the Choose method

You may select treatments, inventory items, problems, and/or diagnoses by first opening the Treatment List, Inventory List, Problem List or Diagnoses List window.

- In the Medical History area, **right-click** and from the shortcut menu point to **Choose** and click **Treatments, Items, Diagnosis** or **Problems**.
- Select the correct treatment(s), item(s), problem(s) or diagnosis you wish and click **Done**.

Enter Treatments for Multiple Patients

AVImark lets you enter as many treatments, inventory items and diagnoses as you wish for multiple patients that you have selected.

- In the Patient area, **right-click** and from the shortcut menu click **Choose** to display the Choose Patient window.
- Select a patient and using the keyboard press and hold the CTRL key while selecting other patients to highlight them.
- With the correct patients selected, **right-click** and from the shortcut menu point to **Choose** and click **Treatments, Items or Diagnosis** to display the correct list.
- Select the correct treatment(s), item(s) or diagnosis you wish and click **Done** to add to the patient(s) Medical History.

Change Medical History Information

You may change the information for any Medical History entry. Any field within the Enter Medical History window may be changed with the exception of the code field.

- With the correct entry selected **right-click** and from the shortcut menu click **Change** to display the Enter Medical History window.
- After you have made the changes click **Done**.

Changes made after the entry has been posted to accounting will NOT be reflected on the client’s accounting records.

To learn more about: Search the Help for:

- Entering Medical History
- Add Medical History; Add New Medical History

Adding Medical History Notes

For a detailed discussion on viewing and adding notes, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A.”

- With the desired entry selected **right-click** and from the shortcut menu click **Notes**.
- To attach notes to this entry select **Enter Notes**.
- From the Notes **right-click** shortcut menu select **Show All** to view all notes, including prescriptions, directly in the Medical History.
- From the Notes shortcut menu select **Show All but RX** to view all notes except prescriptions.
- Selecting **Public Only** will display only notes that have been marked as public.
- To cause the notes to not be displayed on the Medical History area select **Show None**.
- **Show All with Note Action** will display those instructions that have been added to the entry either from the Treatment or Inventory List, and contain the action code of 2.
View and/or Add Medical History Doctor Instructions

When entering a Treatment, Item, Problem or Diagnosis into the Medical History of a patient, Doctor’s Instructions that are linked to those codes can be viewed and modified from the CID.

- With the correct entry selected **right-click** and from the shortcut menu click **Doctor’s Instructions**.
- After you have made the changes click **Done**.

Deleting and Undeleting Medical History

AVImark gives you the ability to remove and or undelete medical history entries.

Remove selected medical history

- Select the medical history entry. **Right-click** and from the shortcut menu click **Remove**.
- You will need to click **Yes** to confirm.

Undelete medical history

- In the medical history area, **right-click** and from the shortcut menu click **Undelete** to display the Undelete Medical History window.
- You will need to click **Yes** to search for deleted history.

Select the entry(s) to be undeleted. **Right-click** and from the shortcut menu click **Select** for the individual entry or click **Select All** to select all entries.
Entering Medical History

• Click Undelete.

Purge Data Files
AVImark gives you the ability to delete (purge) Medical History records older than a specified date, allowing you to completely remove old, unwanted Medical History records from your files. However, we strongly recommend that you DO NOT attempt this without the help of our Support Staff.

Printing a Rabies Certificate
Although the certificate would normally be printed automatically at the time you print the client’s invoice, AVImark gives you the ability to print or even reprint a Rabies certificate from the Medical History area.

• Select the rabies vaccination in medical history. Right-click and from the shortcut menu click Certificate to display the Print Document window.

Declining Medical History Entries
AVImark allows you to identify a recommended treatment that has been declined by the client. These services will appear in medical history as de-highlighted, with the description of the treatment preceded by DECLINED.

• Select the correct medical history entry. Right-click and from the shortcut menu click Declined.
• You will need to click Yes to confirm.

Un-decline a declined service
• Select the declined entry. Right-click and from the shortcut menu click Un-decline.
• You will need to click Yes to confirm.

Discounting Medical History Entries
You may specify a discount for any entry in medical history that has not yet been posted to the client’s account.

• Select the medical history entry that is to be discounted. If there are several entries to be discounted, hold down the Left Mouse button and move the mouse pointer over the entries you wish to discount.
• Right-click and from the shortcut menu click Discount to display the Apply Discount window.
• Select the Retain previously overridden prices option if you would like the discount to be added to any other discount this client is receiving. Select the Restore normal price option if you would like to apply the discount to the already discounted price per client discount class.
• As a whole number, type the discount percentage you would like to apply. For example, type 10 to indicate 10%.
• Click Continue.

Printing an MS Word Document
You may print any MS Word document from the medical history area. If there are any merge words in the text of the document, information about the selected patient and client will be inserted into the document.

• In the medical history area, right-click and from the shortcut menu click Document to display the Print Document window.
• Double click in the Document field to display the Open window.
• Double click on the file name you wish to use.
• In the Print to field, specify the printer to print to and click Print. To display the document on screen, select Preview and click Print.
Printing Prescription Labels
You may print a prescription label for any medical history entry.

- Select the correct medical history entry. **Right-click** and from the shortcut menu click **Drug Label** to display the Drug Label window.
- Type the information you want to appear on the label and click **Print**.

Refilling Prescriptions
You may refill prescriptions from the patient’s medical history. However, at least 1 day needs to have passed since the original prescription was filled.

- Select the correct medical history entry. **Right-click** and from the shortcut menu click **Refill** to display the Enter Medical History window.
- Enter or change the quantity and/or provider if appropriate and click **Done** to display the original drug label.
- Enter any changes necessary on the drug label and click **Print**.

Adding File Attachments
AVImark gives you the option to attach multiple files to medical history entries, such as documents, images, spreadsheets, and so on.

- In the Medical History area, **right-click** and from the shortcut menu click **File Attachments** to display the File Attachment window.
- **Right-click** and from the shortcut menu click **New** to display the New History File Attachment window.
- Use the browse option at the end of the **Filename** field to search for the file you would like to attach.
- Select the file name you would like to attach and click **OK**.
- Attach multiple files using the same procedures.

Entering Medical History Forms
AVImark allows you to use Microsoft Word forms to extend the Medical History record keeping capability. In addition, any forms entered into a patient’s medical history through the use of this feature may be printed following the client invoice.

- Select the correct Medical History entry. **Right-click** and from the shortcut menu point to **Form** and click **Edit**.
- If no form was previously entered for the selected Medical History entry, click **Yes** at the prompt to display the Open window.
- Select the correct form and click **Open**.
- Enter the information desired on the selected form and then **Save** the document.
- To print the form from the Medical History entry, **right-click** and from the shortcut menu point to
Using History Mode
You are able to enter medical history that happened at some time in the past in such a way that the client will not be charged for the entries. In addition, History Mode allows you to maintain the accuracy of the reminding capability of AVImark.

- In the Medical History area, right-click and from the shortcut menu click History mode.
- Right-click and from the shortcut menu click New to display the Enter Medical History window.
- Enter the Code of the Treatment or Inventory item.
- Using the TAB key, tab to the Description, Quantity and Amount fields which may be changed if you wish.
- Click Done to enter the service into Medical history.
- To exit History Mode, right-click and from the shortcut menu click History.

Specifying Inventory Used
You may specify inventory usage for any treatment in medical history. Normally, you would have already specified the inventory items used by each treatment when you set up your Treatment List so that when these treatments are performed, the correct inventory item quantities will be relieved.

Specify Inventory Used to a selected treatment
- Select the correct treatment in Medical History. Right-click and from the shortcut menu point to Inventory and click Inventory used to display the Inventory Used window.
- Click Yes at the prompt to display the Inventory List window.
- Select the inventory item(s) to enter into the Inventory Used window and click Done.

Add items and/or change quantities when inventory is already specified for the treatment
- Select the correct treatment in Medical History. Click Inventory Used in the Attachments area of Medical History to display the Inventory Used window.
- Select the correct item in the Inventory Used window. Right-click and from the shortcut menu click Change to change the item or click Choose to display the Inventory List window.
- Click Done.

Moving Medical History
You may move a selected medical history entry from one patient to another.

- Select the correct Medical History entry to be moved. Right-click and from the shortcut menu point to Move and click To patient. You will need to click Yes to confirm.
- In the Client Selection window, type the client and patient's name you would like to move the entry to and click Continue to open the patient’s record.
- Click Yes to confirm the move.

Drag and drop Medical History to other patients
AVImark allows you to move Medical History entries by dragging history to the patient’s tab listed at the bottom of the CID, or if the List Patients view is used, you may drag history to the list of patients in the center of
the CID. If multiple clients are open on the CID, you may drag history from one client to another by dragging onto the client tab, and then to the appropriate patient name.

- Select the correct Medical History entry and hold the left mouse button down until you see an attachment at the end of the mouse pointer.
- Drag the attachment to the correct patient tab at the bottom of the CID and continue to hold the mouse button until the record of the patient opens.

OR

- Drag the attachment to the correct client’s tab and continue to hold the mouse button until that client’s record opens.
- Drag the attachment to the correct patient tab at the bottom of the CID.
- Release the mouse button to display the options to either Move Service(s) or Copy Service(s).
- Click Move Service(s) to move the entry, all included notes, inventory used, SOAP records, and so on.
- Click Copy Service(s) to add the service as if it were a new entry.

To learn more about: Using History Mode

Search the Help for: History mode

Inventory used

Inventory Usage

Changing Medical History Sequence

You may change the sequence of Medical History entries in one of three methods. These are entries that either have not yet been posted to accounting or do not have a corresponding account entry.

- Select the correct Medical History entry. Right-click and from the shortcut menu point to Move and click either Up (-) or Down (+). You will need to click Yes to confirm.

OR

- Select the correct Medical History entry and use the (-) and (+) keyboard keys.

OR

- Select the correct Medical History entry. Hold the left mouse button down until you see an attachment at the end of the mouse pointer and then drag the entry to the desired location.

Linking an Image to an Entry

- Select the correct treatment from Medical History. Right-click and from the shortcut menu click Photo to display the AVImark Image Editor.
- Within the Image Editor window select Get Image from the File menu to copy the image from a camera.
- Select the appropriate image and click OK.
- To copy the image from another director select File, Open.
- Select the appropriate image and click Open.
- To attach the photo to this entry select File, Save as.
- Enter the desired photo name and click Ok to save the image in the desired location.

To learn more about: Photos

Search the Help for: Link Photo; Medical history photo

AVImark Image Editor

Image Editor
Entering Vaccination Information
Typically vaccination information is entered at the time the vaccination is entered into medical history. This vaccination information is originally entered in the Vaccine System Tables. When you enter rabies or any other vaccination for a patient into Medical History, the Vaccination Information window will appear immediately, provided the rabies treatment has an R Action Code and other vaccinations have the V Action Code.

- Enter the correct vaccine into Medical History to display the Vaccine Information window.
- If appropriate, make any necessary changes.
- If appropriate, use the Vacc ID field to enter the Rabies tag number.
- In the Vaccine field, use the drop down list and select the correct vaccine and click Done.

Using the WhoGot List
You may use the Whogot list to view, sort, print, or go to the CID of any patient receiving the selected treatment, item or diagnosis.

- With the correct Medical History entry selected, right-click and from the shortcut menu select click WhoGot to display the Treated Patients window.
CHAPTER 9: CLIENT INVOICE

In this chapter you will learn about...

» Post Charges to the Client’s Account on page 161
» Choose not to print the client invoice on page 162
» Invoice Posting Date on page 162
» Entering a Payment on page 162
» Using a Cash Drawer on page 163
» Display and Print an Invoice/Receipt on page 164
» Modifying the invoice on page 164
» Using the calculator on page 164
» Reprinting an Invoice on page 164
» Return an Item on page 165
» Payments with X-Charge® on page 165
» X-Charge Partial Approval Implementation on page 166
» Payments with MPS on page 166
» MPS Partial Approval Implementation on page 167
» Handling Unprocessed Payments on page 168
» Transfer Invoices on page 168

Post Charges to the Client’s Account
Once the treatments performed and/or inventory items dispensed to the patient have been entered into the Medical History Area of the CID, these services/items will appear in blue and should be posted to the client’s account. A new invoice will be opened with the charges listed and an opportunity to collect payment given.

- From the CID of the correct client, right-click and from the shortcut menu click Post to display the Posting Charges window.

- To post charges for only the current selected patient, select the current patient only box or left-click.
on the patients names to uncheck and prevent their charges from being posted.

- Click **Post** to display the Enter payment window.

**Choose not to print the client invoice**

You may post charges to the client’s account record without taking a payment or printing an invoice.

- Select the **Open Invoice** option.

**Invoice Posting Date**

AVImark gives you the option of changing the date of the posted entries to be included on another day’s end of period reports if needed.

**Temporarily change the posting date**

- Using the drop-down calendar, select the correct posting date.

![Set Posting Date](setpostingdate.png)

**Change the posting date for several invoices**

- There may be times when you need to input some amount of data for some date in the past or future. You may do this by choosing the Utilities menu and selecting **Posting Date**. Use the drop-down calendar to set the date and click **Continue**.

**Entering a Payment**

After the charges have been posted, the Enter payment window will be displayed.

![Enter payment](enterpayment.png)

- Use the **Type** drop-down menu to select the payment type.
- When a check payment is selected, type the check number in the **Ref #** field.
- If a Held check payment type is selected, use the drop-down calendar and select the date of **Deposit**.
• If necessary, enter/change the **Amount**.

• If appropriate, type the initials of the person entering the invoice information in the **Entered by** field.

• Click **Done** to display the Invoice window.

### Making Change

If the payment is by cash or for some other reason the customer makes a payment greater than the amount owed, AVImark allows you to make change using the Change maker.

• Click **Continue** to make change for the client. The change will be entered in the accounting window as a **Cash refund**.

• Click **Cancel** to Apply to the Balance.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Posting charges</td>
<td>Post Charges</td>
</tr>
<tr>
<td>Enter payments</td>
<td>Enter Payments; Enter payment window</td>
</tr>
<tr>
<td>Posting date</td>
<td>Utilities menu</td>
</tr>
</tbody>
</table>

### Using a Cash Drawer

With the cash drawer installed and a serial port assigned to it, AVImark will open the drawer when a payment is added. AVImark will open most computer-driven cash drawers that are attached to the computer via the system COM1 or COM2 serial ports. AVImark has been tested with the serial interface cash drawer sold by the **M-S Cash Drawer Corp. of Pasadena, CA**.
Display and Print an Invoice/Receipt

Once treatments have been performed on the patient(s) belonging to the client, these charges are posted to the client’s account record, and an invoice/receipt printed.

Modifying the invoice

- From the Invoice window, right-click and from the shortcut menu click **Change** to display the Change Transaction window.
- To remove an entry, right-click and from the shortcut menu click **Remove**. You will need to click **OK** to confirm the removal.
- Specify the number of copies of the invoice you want printed if different then the default setting.
- Select **Include notes** if there are any medical history notes to be included on the invoice.
- Click **Print** or to preview the invoice onscreen, select **Preview** and click **Print**.

Using the calculator

You may display and use a calculator tool from within the Invoice window.

- On the **Tools** menu, click **Calculator** to open and close the calculator.

Reprinting an Invoice

You may reprint an invoice if needed.

- From the Client’s Account window, select the invoice you wish to reprint.
• Right-click and from the shortcut menu click **Reprint**.

**Return an Item**

• Enter the item to be returned into medical history using a negative quantity.
• Right-click and from the shortcut menu click **Post** to display the Posting Charges window.
• Click **Post** on the Posting Charges window to display the invoice.
• Right-click to display the shortcut menu. Point to **New** and select the refund payment type.
• Enter a negative amount in the Amount field and click **Done**.

---

**To have the refund display on the invoice as a refund, you will want to remove the payment description from the field below the payment Type and enter in the sort of refund given. (cash refund)**

---

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Drawer</td>
<td>Cash Drawer</td>
</tr>
<tr>
<td>Return an item</td>
<td>Returned Items</td>
</tr>
</tbody>
</table>

---

**Payments with X-Charge®**

You may enter credit card transactions directly through AVImark by using X-Charge®, Integrated Credit Card Processing. With the X-Charge® software installed, an X-Charge® window will be displayed each time a credit card payment is selected from the New Transaction screen. The information required in this window can be manually entered or automatically entered by swiping the card. Once the transaction has been authorized, the normal AVImark invoice will print and contain a statement confirming the client has agreed to pay the amount. Following the statement, a signature line will appear for the client to sign.

**Capturing signatures for credit card payments**

As of version 175, a digital signature capture devise (HHP TT3101) can be used to capture the client’s signature and store it in AVImark. Another signature capture device is the Topaz T-LBK462-HSB. A digital signature can be accepted from the client, printed on the detailed AVImark invoice, and stored within AVImark for future reference.

• From the New Transaction window, select the appropriate credit/debit card payment and click **Done** to display the X-Charge® window.

---

**X-Charge® Window**

- **Amount**: 222.78
- **Card No.**: SWIPE OR ENTER CARD NUMBER
- **Expiration (MMYY)**
- **Address**
- **Zip Code**
- **CV Code**

• Swipe the card or type the credit card number in the **Card No.** field.
• Select **Credit Card** to display an area for the client to sign and accept the signature.
• From the X-Charge® processing window click **Done**.
Debit Card payments

- Swipe the card or enter the debit card number in the **Card No.** field.
- Select **Debit Card** to display the number pad on the HHP TT3101 devise for the client to enter the debit PIN.
- From the X-Charge® processing window click **Done**.

X-Charge Partial Approval Implementation

When taking a Mastercard payment including debit, only approved for for a partial payment, the AVImark user will be alerted that a secondary form of payment is required to fulfill the payment amount.

Selecting Yes will present a new AVImark Enter Payment window allowing you to select the secondary form of payment to complete the transaction. Both payments will be displayed on the AVImark Invoice as well as the available card balance, if balance information is returned by X-Charge.

Selecting Yes will present a new AVImark Enter Payment window allowing you to select the secondary form of payment to complete the transaction. Both payments will be displayed on the AVImark Invoice as well as the available card balance, if balance information is returned by X-Charge.

- If a debit Mastercard payment is taken there will be no signature line displayed on the invoice.
- Selecting Cancel will remove/void the payment completely. This option is recommended, in keeping with the mandate, to be used when a secondary form of payment is not available or has been declined.
- Selecting No will only place the partially approved payment amount into Accounting and on the Invoice with the remaining amount showing unpaid to the clinic.

Payments with MPS

McAllister Payment Solutions® is a secure credit card processing system and has worked hard to ensure that all aspects of the MPS credit card processing features are PA-DSS compliant. Credit card numbers should not be stored in a client note field and if you have done this in the past please contact Technical Support for assistance in properly removing these numbers.
Processing a Credit Card

McAllister Payment Solutions offers credit and debit card processing services, fully integrated into your AVImark system. The MPS processing services will provide an online reporting tool allowing you to review your transaction volumes at any time.

- From the New Transaction window, select the appropriate credit/debit card payment and click **Done** to display the McAllister Payment Solutions window.
- Swipe the credit card.
- If it is necessary to hand-key a card, selecting the **Hand Key** button will display an additional window allowing the user to enter the appropriate information.
- Swiping a card will immediately begin the card processing. Once the card is processed, you will be returned to the main Invoice window where a detailed invoice can be printed for the client and a duplicate can be printed for the client’s signature which will be stored at the clinic.

MPS Partial Approval Implementation

When taking a Mastercard payment including debit, only approved for for a partial payment, the AVImark user will be alerted that a secondary form of payment is required to fulfill the payment amount.

- Selecting **Yes** will present a new AVImark Enter Payment window allowing you to select the secondary form of payment to complete the transaction. Both payments will be displayed on the AVImark Invoice.
- Selecting **Cancel** will remove/void the payment completely from the invoice. This option is recommended in keeping with the mandate, to be used when a secondary form of payment is not available or has been declined.
- Selecting **No** will only place the partially approved payment amount into Accounting and on the invoice with the remaining amount showing unpaid to the clinic.
- The AVImark Invoice will print the card balance on the receipt
- In the case the card does not have a remaining balance the invoice will read- **Balance Not Available**

Authorization Reversal

An authorization reversal is a real-time transaction initiated when the customer decides that they do not want to proceed with the transaction, or if the merchant cannot complete the transaction for any reason. Authorization reversals free up the customer’s available balance on their debit, prepaid or gift card.

Printing Signature Slip Receipts

A small ticker-tape receipt can be printed to a Dymo® LabelWriter. This signature slip-receipt can be activated by setting the Hospital Setup…Advanced Option Print Signature Slip on Credit Care Transactions to **True**. When a credit card transaction is added to an invoice and processed through MPS, the signature slip-receipt will be automatically printed when the card processing is complete and you are returned to the main invoice window. You can then select to print the regular invoice that will be given to the client.

When adding and processing a credit card transaction that is not part of an invoice, a message will be displayed asking if an invoice is needed for this transaction. The signature slip-receipt will print immediately following the response selected for this message.
AVImark’s recommended label printers can be used to print this signature slip-receipt. The printer used to print the signature slip-receipt can be selected within Utilities, Printer Setup, Receipt.

The dimensions used for the signature slip-receipt paper cannot be modified at this time. The appropriate size of this continuous feed paper can be viewed and/or purchased through Veterinary Wholesale Supplies. This receipt paper can be used with the AVImark recommended Dymo® printers. Please visit www.veterinarywholesale-supply.com to purchase the continuous feed receipt paper for your Dymo® printer.

**Paperless Credit Card Signatures**

It is possible to have paperless credit card signature receipts through MPS by accepting digital signatures from your clients. Using a Topaz T-LBK462-HSB signature capture device, a digital signature can be accepted from the client, printed on the detailed AVImark invoice, and stored within AVImark for future reference. Having a digital signature stored which can be accessed at any time prevents any type of paper-trail for credit card transactions.

Setting the Advanced Option, Enable the Topaz Signature Capture Device, to True will allow a signature to be prompted for once a card has been swiped or hand-keyed.

Once the client has authorized the transaction with their signature, the processing will be completed. This signature will be saved by client within a sub-folder of the AVImark directory named Signature.

**Handling Unprocessed Payments**

**Deposit Slip Report**

When a MPS credit card window is manually closed to prevent the payment from being logged, AVImark places a line in Accounting to show as UNPROCESSED. Payments will display as UNPROCESSED on the Deposit Slip report.

**From AVImark Accounting window**

AVImark now allows the ability to remove UNPROCESSED from an Accounting Transaction line. Hospital Administrators can secure this by assigning the security function ACT07 to the administrative group that has authority to enter UNPROCESSED payments into Accounting. (Users authorized to ACT13) Once UNPROCESSED has been added into Accounting, in the case that the payment type needs to be changed, AVImark allows the user to manually change this transaction line by doing right-click Change and selecting Cash, Check or another card.

Once the transaction IS processed AVImark allows the following:

- Allows the UNPROCESSED line to be changed.
- Changes the color of the entry in Accounting from green to black.
- Records the change in Accounting Entry History of the payment to show that it was originally unprocessed and someone processed the transaction manually.
- Displays correctly on the Deposit slip so the payment isn’t allowed to show as UNPROCESSED.

**Transfer Invoices**

When transferring invoices from one client to another the entire invoice can be transferred or just the invoice total.

- From the original clients accounting window highlight the invoice that needs to be transferred.
- From the right-click shortcut menu select Transfer.
- Enter the client account number the invoice is being transferred to.
• Select **Adjustments Only** to transfer only the balances of the invoice as an account adjustment.
• Click **Done** to transfer the invoice balance.

OR

• From the original clients accounting window highlight the invoice that needs to be transferred.
• From the right-click shortcut menu select **Transfer**.

• Enter the client account number the invoice is being transferred to.
• Select **Move Entries** to move all transactions associated to the selected invoice.
• To maintain the original patient name when the invoice is move to another client select **Hold Patient Name**.
• The option **Clear Patient Name** allows the accounting entries to be moved to the new client without having them assigned to a particular patient.
• Selecting the **Retrieve Patient Name** option will allow the Medical History entries associated to the invoice line-items to be searched and discovered. Once these associated entries are discovered, the new patient that is now linked to those history entries will be auto-assigned to the invoice line-items.
• After selecting the desired option click **Done** to complete the invoice transfer.

When an invoice is transferred from the original client an entry will appear in the Account History indicating the invoice was transferred and will contain the client account number it was transferred to. For the client the invoice was transferred to an entry will also appear in their accounting indicating the invoice was transferred with the invoice number.
CHAPTER 10: ACCOUNTS RECEIVABLE

In this chapter you will learn about...

» Printing Statements on page 171
» Undo Statements on page 172
» Reprint Statements on page 173
» Print the A/R Summary Report on page 173
» Printing Collection Letters on page 174

Printing Statements

• On the CID, open the **Work with** menu. Click **Statements** to display the Accounts Receivable window. Once the appropriate information has been entered click **Print**.

![Accounts Receivable window](image)

**Print to**

Select the printer to print statements to by using the drop-down list.

**Sort by**

AVImark allows you to sort statements when printing. You may sort by:

○ Name
○ Zip
○ Account
○ Balance

• Use the drop-down list and select the sort by method.

**For client**

You are able to print a statement for a single client.

• If appropriate, type the Client Account number to print a single statement.
Start client

AVImark allows you to choose a starting point when the printing process was interrupted or stopped.
  • Type the Client Account number of the last statement that printed.

Company number
You may print statements for any group of clients by Company number.
  • Type the Company number to print for a certain company.

Client codes
AVImark allows you to print statements by Client Code.
  • Enter the Client code to print for clients with a certain code.

Open Invoices
AVImark needs to know how you wish to handle invoices that have not yet been closed. You may choose:
  ○ Close Automatically
  ○ Leave All Open
  ○ Prompt To Close
  • Using the drop-down list select how you wish to handle statements when printing.

Apply service charge
AVImark will apply service charges according to the specifications you have indicated in Hospital Setup, Advanced tab, Statements, Fees.
  • Select the box to apply a service charge.

If you wish for AVImark to only apply the service charge on the original balance even when the balance becomes past due, you will need to set up an additional option.
  • From the CID select the Wrench speed bar icon.
  • In the search field type accrues and select the option Service Charge Accrues From Service Previous Charges and set it to False.

With the option set to False AVImark will not add the service charge to the balance that has accrued service charges it will only be applied to the original balance.

Print as of
You may choose a date you want to start printing as of. AVImark will print itemized charges from this date, back to the last date and time statements were printed.
  • Use the drop-down calendar and select the date to print as of.

Balance >
You may specify a dollar amount to print statements for. Clients, whose balance is less than what is indicated, will not receive a statement. AVImark has a default setting of $1.00.
  • Type the dollar amount you wish to print statements for.

Undo Statements
AVImark gives you a way to Undo the last time you ran statements. Choosing this option removes the last time service charges were added to overdue accounts. It also removes any Balance Brought Forward records in cli-
ent’s accounts. Furthermore, AVImark resets the date for which statements will be itemized to the previous time statements were run.

- From the Accounts Receivable window, open the Statements menu and click Undo.
- Click Yes at the prompt to continue.
- Click OK at the results window to return to the Accounts Receivable window.

**Reprint Statements**

AVImark allows you to reprint copies of your statements just as though it were the date you printed statements last. However, AVImark will NOT add any duplicate service charges or billing fees. Furthermore, AVImark will not include detailed charges on the statements that have occurred SINCE the last time you printed statements.

- If desired, select the Reprint statements box.

Once you print statements, AVImark will check the Reprint Statements box for you automatically for the next 15 days to keep you from accidentally charging duplicate service charges on client’s accounts.

**Print the A/R Summary Report**

- You may print the Aged accounts summary report for any period of time. To print the A/R Summary, select the A/R Summary tab from the top of the Accounts Receivable window. Once the appropriate information has been entered click Print.

![Accounts Receivable window](image)

**Print to**

- Using the drop-down list select the printer to print to.

**As of**

You may specify the date to print as of.

- Using the drop-down calendar select the date to print as of.

**Company number**

You may print the summary for any group of clients by Company number.

- Type the Company number to print for a certain company.
Sort by

AVImark allows you to sort the A/R summary when printing. You may sort by:

- Client name
- Zip code
- Account no.
- Balance due

  - Use the drop-down list and select the sort by method.

Doctor

AVImark allows you to print the summary by doctor. Clients with a credit will not be listed on the individual doctor’s report. Selecting the Consolidated option will print the A/R Summary for all doctors.

  - Using the drop-down list select the doctor.

Credit Balances

AVImark will include a list of all active clients with credit balances when the A/R Summary prints. This option is checked by default.

Inactive Clients

You may include a list of all inactive clients with a balance when the summary is printed.

  - If applicable select this box.

Preview

You may view the A/R Summary on screen.

  - Select the Preview box and click Print.

Printing Collection Letters

AVImark lets you specify and print the appropriate MS Word documents for each group of clients who have overdue outstanding balances.

  - Once the appropriate information has been entered click Print.
• Using the drop-down list select the printer to print to.

As of
You may specify the date to print as of.
  • Using the drop-down calendar select the date to print as of.

Sort by
AVImark allows you to sort the A/R summary when printing. You may sort by:
  ◦ Client name
  ◦ Zip code
  ◦ Account no.
  • Use the drop-down list and select the sort by method.

Print letters for
AVImark allows you to print an appropriate MS Word document for any client that is 30, 60, 90, or 120 days overdue on their account.
  • Select one or more of the boxes you wish to print a letter for.
  • Double-click in each of the red document boxes for which you have checked.

Restrict to
You may print the collection letters using certain restrictions.
  • If applicable, type the information for any specific restriction(s).

Only if no payment
Using this option, AVImark will only print collection letters for clients who have not made a payment within the last 30 days.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print statements</td>
<td>Printing statements</td>
</tr>
<tr>
<td>Undo statements</td>
<td>Undo statements</td>
</tr>
<tr>
<td>Reprint statements</td>
<td>Reprinting statements</td>
</tr>
<tr>
<td>A/R Summary report</td>
<td>A/R summary</td>
</tr>
<tr>
<td>Print Collection Letters</td>
<td>Collection letters</td>
</tr>
</tbody>
</table>
CHAPTER 11: REMINDERS

AVImark lets you specify the conditions under which you want to remind for any treatment and/or inventory item you select.

In this chapter you will learn about...

» Creating a Reminder on page 177
» Remind As on page 178
» Printing Reminder Templates on page 180
» Applying Reminders Globally on page 181
» Creating Patient Specific Reminders on page 181
» Changing a Patient Reminder Template on page 182
» Purging Reminders on page 182
» Printing Reminders/Reminder Analysis on page 182
» Printing Reminders using AVImark or MS Word® on page 185
» E-Mailing Reminders on page 186

Creating a Reminder

• From the Treatment/Inventory List, select the treatment or item you would like to remind for.
• **Right-click** and from the shortcut menu click **Reminder** to display the Reminder Template.
• You will need to click **Yes** to confirm.
To assist in the setup of various values that determine how AVImark reminds for each treatment, you may want to use the step-through function called the Reminder Setup Wizard. Select the Wizard button at the beginning of each template setup to use.

**Code/Description**

AVImark will insert the Treatment code and Description for you when you choose to create or update a Reminder Template.

**Species**

You may choose 2 species. If the reminder applies to all species, you will not need to select a species.

- Use the **Species** drop down list and select the correct species.

**Show in Vaccine History**

- Check this option to have the reminder displayed in the patient’s Vaccine History window.

**Remind every**

This allows you to specify the interval of time in which the patient should receive the treatment.

- Type the number in the first box and then using the drop down menu select the periodicity. (For example 1, Year).

**Remind if never treated**

This field will be used in conjunction with the Start/Stop reminding fields. If this box is not checked, a patient who has never received the treatment will NOT receive a reminder for it until the treatment has been put into the patient’s medical history.

- If appropriate, select this box to remind patients as they come due the first time in their life, based on the patient’s age.

**Start/Stop reminding**

You may specify when you want reminders to start and stop for this treatment. If you do not want to remind for the treatment until it has been performed at least once on any given patient, do not check the **Remind if never treated** box and do not specify a **Start reminding** age, just leave the fields blank.

- If appropriate, use the second field and the drop down list from the third field to specify the **Start reminding** age. Typically, the **Stop reminding** field would be left blank.

**Patient to be treated**

This allows you to specify the number of times a patient should have the treatment done in its lifetime.

- Type the number value and click **Done** to finish the template.

**Remind As**

The Remind As feature has been greatly enhanced by now allowing unlimited Remind As associations and also enabling the ability to view services that are set to remind as the selected template.

**Reminded by Tab in Reminder Template**

For setting up more complicated treatment series, you may contact our experienced Technical Support staff at 877-838-9273, option 1.
From the Reminder Template you can now view which treatments, items, diagnosis or problem entries are set to Remind As the selected template.

- From the appropriate list select **right-click, Reminder** on the entry. (i.e. Inventory List, Treatment List)
- Click on the **Reminded By** tab to display services that are set to Remind As this selected template. Once a Remind As is set on the service the entry will automatically be added to the Reminded By tab for the appropriate template.

![Reminder Template](image)

- To add a Remind As directly from the Reminder Template window choose **right-click, New** while in the Reminded By tab.
  - Enter the **Code** of the service this template is used to remind for.
  - Or tab to the **Description** field and begin typing the description and select the service this template is used to remind for.

![New Remind As](image)

- Select **right-click, Remove** to remove the associated entry from the template.

**Remind As Tab in Change Window**

A new Remind As tab has been added to the Change Treatment, Item, Diagnosis and Problem windows. This will allow an unlimited number of remind as entries to be set for a treatment, item, diagnosis or problem.

**Adding a Remind As**

- From the appropriate list (i.e. Treatment) **right-click, Change** on the service and select the **Remind As**
Reminders

To associate a reminder with this treatment, choose right-click, New and from the drop-down list select the Remind As reminder for this treatment.

Click OK to associate the remind as.

NOTE: Before Remind As will reflect within a patient’s reminder window you will first need to rebuild medical history indexes and apply the reminder templates.

Printing Reminder Templates

In order for us to assist you with setting up your reminders in the most efficient way, we recommend that, before you apply your reminder templates, you print them and FAX them to us for review. Templates may be faxed to 573-223-4306.

- From the Treatment List, open the Reminder menu and click Print templates to display the Print Reminder Templates window.
- Using the Print to drop down list select the correct printer.
- If applicable, use the Restrict to drop down list and select the species you wish to Restrict to.
- Click Print. To preview the templates on screen, select Preview and click Print.

Applying a Reminder on a Single Treatment

AVImark gives you the ability to update reminders for all your patients to include the current specifications for the selected treatment.

- From the treatment list, select the treatment that you want to apply the reminder for.
- Right-click and from the shortcut menu click Reminder to display the reminder template.
• Click **Apply** at the bottom of the reminder template to display the Applying Reminders to Patients window.

![Applying Reminders to Patients window](image)

• Select the option which applies to the reminder you are applying. They are:
  - Add this Reminder
  - Add entire Series
  - Remove This Reminder
  - Change Existing Reminder

• Click **Apply** to begin the scheduling process.

**Applying Reminders Globally**
In addition to having the ability to update reminders individually, AVImark allows you to Update/Apply all your reminders which you have added or changed at one time.

• From the Treatment List, open the **Reminders** menu and click **Apply**.

• You will need to click **Yes** to confirm.

![Start Applying window](image)

• Click **Continue** to start the scheduling process.

**Creating Patient Specific Reminders**
AVImark lets you specify the conditions under which you want to remind for any treatment and/or inventory item you select. You do this in what are called Reminder Templates, which are normally set up for each treatment and applied to all patients at once. In addition, AVImark allows you to add or change a reminder from the Patient Area reminder folder. Adjusting the reminder from the folder now makes the reminder specific for this patient.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up a reminder</td>
<td>Reminder template</td>
</tr>
<tr>
<td>Printing reminder templates</td>
<td>Reminder template overview</td>
</tr>
<tr>
<td>Applying reminders</td>
<td>Applying reminders</td>
</tr>
</tbody>
</table>

![Reminder Templates and Applying Reminders](image)
AVImark User Manual
Reminders

• From the CID Patient Area Reminder folder, **right-click** and from the shortcut menu click **New** to display the Patient Reminder Template.

• Set up the template appropriate for this patient and click **Done**.

**Changing a Patient Reminder Template**
When a given reminder is appropriate for certain patients, but due to special circumstances you need to change the reminder template and how it applies to this particular patient.

• In the Reminder folder, **right-click** and from the shortcut menu click **Change** to display the Patient Reminder Template.

• Adjust the template appropriate for this patient and click **Done**.

---

**When you change the Due date, a Due date set by user check box will appear to the right of the date indicating that AVImark’s calculation has been overridden. The date will display in green on the Reminder folder indicating it is a patient specific reminder. If you need to return to the original date just uncheck the box.**

**Purging Reminders**
AVImark allows you to purge patient reminders that are due prior to a specific date.

• On the CID, open the **Utilities** menu. Click **Purge Files** to display the Purge System Files window.

• You will need to click **Yes** to confirm.

• Select the **Remove ALL patient reminders** option.

• Select **Keep reminders due after** and use the drop down calendar to select the date.

• Click **Purge**. When the purge process is complete, AVImark will automatically close.

**Printing Reminders/Reminder Analysis**
When you choose to print all reminders, AVImark will perform the reminder analysis using the values and limitations you have set up in the Reminder Analysis Window. Reminders will be printed for those patients selected as coming due or are overdue for any of the periodic treatments, items or diagnoses you have specified.

• On the CID, open the **Work with** menu. Click **Reminders** to display the Work with Reminders window.

**Print To**

• Use the **Print to** drop down list and select the correct printer.

**Starting date/For**
AVImark lets you find patients who are due for remindable treatments during a reminder window of time which you define by setting a start date, then specifying a number of days.

• Using the **Starting date** drop down calendar, select the **start** date and then enter the number of days in the **For** field.
Company
You may limit the printing of reminders to a certain company number.

- If appropriate, type the company number.

Include
This field allows you to tell AVImark what information to include on the analysis report.

- Select the **Reminder details** option to include a list of clients/patients that are due for reminders as well as a summary of the analysis.

- Select the **Response information** option to include response data for the period being analyzed.

- Select the **Print summary** only option to limit the report to a summary of clients/patients due for reminders.

Sort By
This allows you to sort the reminder documents.

- Select the appropriate **Sort by** option.
Reminders

Restrict To Species
You may limit reminders to a selected species.

- If appropriate, use the Species drop down list and select a species.

Start at Account no.
In the event the printing process was interrupted or you are unable to complete the printing once started, you may specify a client account number for the last reminder card that printed and begin printing again.

- If appropriate, type the clients account number to commence printing from that account number forward.

Last information search
Allows you to restrict the printing of reminders using the results of the last information search you ran.

- If applicable, select this option.

Limiting reminders
You may use the check boxes in the Print column to limit past due reminders. If you do not want to send second and/or third reminders, you must uncheck both the second and third reminder check boxes. Do not uncheck the first box, you must send at least the first reminder for the period specified in the analysis window.

Mailing labels
You may choose to print mailing labels for your reminder post cards.

- After the reminder cards have printed select Mailing labels.
- Using the Style drop down menu select the label style.
- Using the Print menu, select Reminders again to print the labels.

Merge file
AVImark lets you merge reminder information, creating a text file that contains client and patient reminder information. Once merged, this file can be located within the AVImark folder.

- If appropriate, select the Merge file option and type a name you would like to give this merge file.
- Using the Print menu, select Reminders to merge the file.

Reminder Organizations
Healthy Pet®, Pet Quarterly®, Paw Print®, US NetCom®, Jabez Communications Group®, or AVImark

AVImark allows you to send the appropriate reminder file(s) to your chosen organization. If you have specified an organization and Clinic ID number in Hospital Setup, Advanced AVImark will automatically insert that number in the Merge file field for you and display the Healthy Pet®, Paw Print®, Pet Quarterly®, AVImark or Netcom® Button.

- Ensure your internet connection has been established.
- As discussed previously, specify the date range that is appropriate for the reminder period.
- Select the Healthy Pet®, Pet Quarterly®, Paw Print®, US NetCom®, Jabez Communications Group® or AVImark to send the results to that organization.
MSS Online Reminders®

MSS Online Reminders is a service provided by McAllister Software Systems through the AVImark program. Once this feature is activated and your Clinic ID has been assigned, the Merge File section of Work with Reminders area will contain an AVImark button. Selecting this button will export all appropriate reminders based on the time frame and reminder selections. Once the export is complete, you will be auto-logged into our reminder site where you will have the ability to select the details of your reminder or marketing cards and submit your order. For more information on this service please call 877-838-9273 option 2, sub-option 3 to contact an AVImark Sales representative.

Remind For

You may specify which treatments and/or items to include and/or exclude.

- Select the treatment to include or exclude and use the < or > buttons to move the treatment. To move all at once use the << or >> buttons.

Excl. patient specific

You may exclude Patient specific reminders when excluding other remindable treatments or items.

- If appropriate, select this option.

Printing Reminders

After specifying the appropriate options you are then ready to print the reminders.

- From the Print menu select Just One to print just one reminder card for the patient currently open on the CID screen.
- From the Print menu select Reminders to begin printing the reminder cards.

Print Analysis

The analysis report will list those patients who are due for a reminder for the time frame specified. To include detailed information on the report select the desired option under the Analysis window on the Work with Reminders window.

- From the Print menu select Analysis to print the report

To learn more about: Remind For
Reminder Analysis
Save/Email the Reminder Analysis
Print Just One Reminder

Search the Help for: Reminder Analysis
Print-Work with Reminders
Printing Reminders

Printing Reminders using AVImark or MS Word®

AVImark allows you to use the regular AVImark Notes window to create reminder text to be printed on post card documents or you may use MS Word® to create your reminder documents. For detailed information on creating reminder text, refer to.

Use AVImark

If you have selected to use AVImark to create your reminders, the reminder names will automatically be inserted in the First, Second and or Third Document fields.

Use MS Word®

- Double click in the First, Second and or Third Document field to display the Open window.
Reminders

• Double click on the document name you intend to use. The same document name must be used for First, Second and/or Third reminder text.

Consolidated

AVImark allows you to print one reminder document per household rather than one per patient. If you intend to print consolidated reminders using MS Word, you must have the Reminders per page option in Hospital Setup set to One.

E-Mailing Reminders

AVImark allows you to send reminder messages via e-mail to those clients who have valid e-mail addresses and own animals that are either due or past due for remindable services. You will do this in two steps; by printing reminders for those clients who do not have an e-mail address, and then sending e-mail messages to those that do.

• For those clients with no e-mail address, print reminders using the instructions as previously discussed.

• After printing, open the E-mail menu. Point to Message and click First reminder, Second reminder, and/or Third reminder to display the E-mail message window.

• Type the reminder message you wish to send (you may use all the normal notes window functions when creating the message) and click Done.

• On the E-mail menu, click Send.

To prevent a reminder card from being printed for a client already receiving a reminder via e-mail, you must specify the appropriate e-mail reminder options in Hospital Setup.

To learn more about: E-mailing Reminders

Search the Help for: E-mail Reminders
CHAPTER 12: DIAGNOSIS LIST

When a particular medical condition or disease is observed in a patient, you may wish to document your findings in AVImark from the CID of the correct patient. You may do this by selecting the appropriate diagnosis from the AVImark Diagnosis List and including it in the Medical History Area of the correct patient. You may also choose the diagnosis as part of the Medical Condition (S.O.A.P.) function.

In this chapter you will learn about...

» Add a New Diagnosis Category on page 187
» Add a New Diagnosis on page 188
» Undo and Redo Options on page 192
» Use Diagnosis List Shortcut Menu on page 193
» Create Doctor’s Instructions on page 195
» Include Tag-A-Long Instruction on page 195
» Specify Doctor’s Notes on page 195
» Enter Recommendations on page 195
» Sort Your Diagnosis List on page 196
» Enter a Treatment Protocol on page 196
» Enter Diagnosis Notes on page 196
» Sort the Selected Diagnosis on page 196
» Customizing Column on page 197
» Using the Speed Bar Button on page 197
» Changing Multiple Entries on page 197
» Previewing Text on page 197

When you start using AVImark you will probably want to add, delete and change the Diagnosis List to customize its different characteristics to suit your clinic.

- On the CID, open the Work with menu and click Diagnosis List to display the Diagnosis List Maintenance window.

Add a New Diagnosis Category
- From the Category section of the Diagnosis List Maintenance window, right-click and from the shortcut menu click New to display the New Diagnosis Category window.
Category
This is the descriptive name given to each category to identify it in most AVImark functions.

- Type the name you wish to give the new category.

Whiteboard
This field represents the Whiteboard categories that are set up in “System Tables”. They are used to group and organize diagnoses on the ‘Whiteboard’.

- Use the Whiteboard drop-down list and select the Whiteboard category you wish to assign to this category.

Account number
To interface with QuickBooks®, you will need to enter the income account number that you set up in QuickBooks® as the account in which to record the income generated from diagnoses within this category.

- If appropriate, type the income account number that you have set up in QuickBooks®.

Company
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple diagnoses.

- If appropriate enter the desired company number for reporting purposes.
- Enter the desired information and click OK.

Add a New Diagnosis
- With the correct category selected, point in the Records for section.
- Right-click and from the shortcut menu click New to display the New Diagnosis window.
- Once all information has been entered click OK.
Diagnosis Tab Values

Code

You may use up to 8 characters, using numbers, letters or a combination of both. AVImark will not allow you to use a code that has already been assigned somewhere else in the program.

- Type the Diagnosis Code.

Description

This is the description that will appear on the patient charts and reports that concern the medical history of the patient.

- Type the Diagnosis Description.

Action Codes

These codes cause AVImark to perform a certain function.

- If applicable, use the drop-down list and select the Action code(s) for this diagnosis. You may select up to 6 different codes for each diagnosis.

The following lists the Action Codes and their meaning:

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Automatic drug label prompt</td>
<td>Prompts the drug label window to display when the diagnosis is entered into medical history.</td>
</tr>
<tr>
<td>Diagnosis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>D</strong></td>
<td>Diagnosis causes death</td>
<td>Automatically marks the patient as deceased when the diagnosis is entered into medical history.</td>
</tr>
<tr>
<td><strong>E</strong></td>
<td>Print one document/patient</td>
<td>Prompts a document for each patient that has received the same diagnosis in medical history for a client.</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td>Include on travel sheet</td>
<td>Includes this service on the travel sheet that can be printed through AVImark.</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td>Include on Invoice</td>
<td>Includes this diagnosis on the printed invoice.</td>
</tr>
<tr>
<td><strong>K</strong></td>
<td>Prompt to include in group</td>
<td>When included within a treatment group this action code will prompt you if you would like to enter the diagnosis in medical history.</td>
</tr>
<tr>
<td><strong>O</strong></td>
<td>Don’t include on Health Summary</td>
<td>Prevents the diagnosis from being printed on the Health Summary area of the patient chart.</td>
</tr>
<tr>
<td><strong>Q</strong></td>
<td>Don’t post to invoice</td>
<td>Will not include this diagnosis on the printed invoice. This diagnosis will be entered in medical history and displayed as already posted.</td>
</tr>
<tr>
<td><strong>W</strong></td>
<td>Auto prompt for vital signs</td>
<td>Automatically prompts for the Medical Condition Record (SOAP) to display when this diagnosis is entered into medical history.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Causes sex alteration</td>
<td>Automatically updates the patient’s sex to spayed, neutered or gelded depending on the previous sex and species of the patient.</td>
</tr>
<tr>
<td><strong>Z</strong></td>
<td>Dietary item</td>
<td>Includes this diagnosis on the dietary tab at the bottom of the CID screen.</td>
</tr>
<tr>
<td><strong>-</strong></td>
<td>Obsolete diagnosis</td>
<td>Marks a diagnosis as obsolete and grays it out on the list. When trying to add this service to medical history you will be warned that it is an obsolete diagnosis.</td>
</tr>
<tr>
<td><strong>@</strong></td>
<td>Auto prompt for document</td>
<td>Prompts to print the linked document. Without this action code AVImark will automatically print the linked document with the invoice.</td>
</tr>
<tr>
<td>*<strong>`</strong></td>
<td>Auto prompt for notes</td>
<td>When entered into medical history it will automatically prompt for a notes window to enter information about the diagnosis.</td>
</tr>
<tr>
<td><strong>?</strong></td>
<td>Schedule follow-up at posting</td>
<td>This action code will display the follow-up window when posting instead of when the diagnosis is entered into medical history.</td>
</tr>
<tr>
<td><strong>&gt;</strong></td>
<td>Don’t print notes on chart</td>
<td>Will not include the entered medical history notes on the printed patient chart.</td>
</tr>
<tr>
<td><strong>%</strong></td>
<td>Auto copy notes into medical history</td>
<td>Copies entered notes on the diagnosis automatically into a notes window in medical history.</td>
</tr>
<tr>
<td><strong>~</strong></td>
<td>Auto hide notes in medical history</td>
<td>Will not display the entered medical history notes on the CID screen.</td>
</tr>
<tr>
<td><strong>[</strong></td>
<td>Auto prompt for the microchip number</td>
<td>Automatically prompts for the patient’s microchip number and will enter the number into the patient’s area of the CID screen.</td>
</tr>
<tr>
<td><strong>#</strong></td>
<td>Don’t print form/document</td>
<td>Suppresses the printing of the linked form or document.</td>
</tr>
<tr>
<td><strong>{</strong></td>
<td>Auto prompt for the locator number</td>
<td>This action code will prompt for a number to be used with ePetRecords®.</td>
</tr>
<tr>
<td>**}`</td>
<td>Don’t post from Whiteboard</td>
<td>When posting diagnoses from the whiteboard this action code will not post the diagnosis to medical history.</td>
</tr>
<tr>
<td></td>
<td>Include on the E-Travel sheet</td>
<td>Includes this diagnosis on the electronic travel sheet.</td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>Show Notes in Medical History</td>
<td>This action codes allows you to view specific notes with the option selected of “Show all with note action” in medical history.</td>
</tr>
<tr>
<td>5</td>
<td>Dental Assessment</td>
<td>Automatically prompts the dental chart to display when the diagnosis is entered into medical history.</td>
</tr>
</tbody>
</table>

**Work List Codes**

Any given diagnosis may be assigned up to 3 Work List codes. When the diagnosis is recorded in the Medical History for the patient, that patient will automatically be placed on the specified list(s).

- If appropriate, use the drop-down list to specify the Work List code(s).

**Remind As**

AVImark lets you remind for any diagnoses in the same way you remind for services and inventory items. Accordingly, if several diagnoses have similar reminding characteristics you only have to set up a template for one of them and then choose that diagnoses code in this field and the description of that entry will be displayed.

- Using the drop-down list select the code from the reminders that exist. If you do not know the code of the diagnosis with a reminder you may use the second field drop-down list for a list of descriptions to choose from.

**Photo**

AVImark allows you to link any .bmp; .jpg; or .tif image to the diagnosis to be printed on the client invoice. If there are no take-home instructions linked with the diagnosis, the photo will not be printed.

- Select the browse button in the **Photo** field to display the **Open** window.
- Double-click on the photo you wish to attach.

**Form**

AVImark allows you to designate a default Form that is to be used for any diagnosis.

- Select the browse button in the **Form** field to display the **Open** window.
- Double-click on the form you wish to attach.

**Protocol**

You may specify an MS Word document that serves the purpose of defining a treatment protocol.

- Select the browse button in the **Protocol** field to display the **Open** window.
- Double-click on the document you wish to attach.

**Search Words**

AVImark allows you to specify search words that you will be able to search for to find this diagnosis either from the **Enter Medical History** window, **Whiteboard Activity Entry** window, or Medical Condition Record by typing any of these Search words in the description field or from the **Diagnosis List Maintenance** window using the **Find** field.

- Type the search word(s), separated by commas, in the **Search Words** field or use the browse button and type the search word(s) in the **Add Search Words** window.
Category

AVImark automatically displays the category this diagnosis belongs to. You may also change and/or move the diagnosis to a different category.

• Using the drop-down list select the category you wish to move the diagnosis to.
• If the diagnosis has already been saved, you may also right-click on the diagnosis and from the shortcut menu click Move.
• You will need to click Yes to confirm and select the category to move to.

Species 1 and Species 2

You may specify which species (if any) this diagnosis is appropriate for. If no species needs to be specified for this diagnosis, simply leave these fields set to (none) and the diagnosis will be considered appropriate for any species.

• If appropriate, use the drop-down list to select the species.

Follow-up

You may specify the values that will determine how patients receiving the selected diagnosis will be handled by the AVImark Follow-up function. AVImark will log the client and patient onto the Follow-up List whenever this diagnosis is recorded in the Medical History area.

• Using the UP and DOWN ARROWS, specify the number of days.

Critical

You may indicate whether the follow-up callback is considered of an urgent nature.

• If appropriate, select this box.

Subject

Entering a follow-up for the diagnosis will automatically place the diagnosis name in this field. You may if you wish to, assign a different Subject or reason for a call back to this Follow-up.

• To change the Subject to something other than the default diagnosis name, remove the default name from this field and type the description you want to change it to.

Company

Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate. This same number can be assigned to multiple items.

• If appropriate enter the desired company number for reporting purposes.

Undo and Redo Options

AVImark allows you to Undo and/or Redo any changes that have been made in the Diagnosis List.

• Open the Edit menu and click Undo or Redo.

Document Tab Values

AVImark allows you to associate an MS Word® document or Star Office® document with a diagnosis. These documents can also be species specific. You can print this document at the time it is entered into the medical history of the patient by using the @ Action Code or at the time the invoice is printed.

• To enter the document name, right-click and from the shortcut menu click New to display the New Diagnosis Species Entry window.
• Use the **Species** drop-down list and select the appropriate species for the document.
• Select the browse button in the **Document** field to display the **Open** window.
• Select the appropriate document and click **OK**.
• Repeat the same procedures for the multiple species.

**Use Diagnosis List Shortcut Menu**
In the Diagnosis List window there are other features found in the shortcut menu. Click the right mouse button (called **right-click**) to see the shortcut menu.

**Add a duplicate diagnosis**
AVImark allows you to add a new diagnosis to your list that is a duplicate of one that you have already entered. This will be useful if you are adding several diagnoses that have the same characteristics.

• From your Diagnosis List, select the diagnosis you wish to duplicate.
• **Right-click** and from the shortcut menu click **Another** to display a duplicate New Diagnosis window.
• Enter a new **Diagnosis Code** for the duplicate diagnosis as well as any other necessary changes and click **Done**.

**Select**
Select diagnosis to be added to medical history, an Estimate, a SOAP Record or Whiteboard.

• With the correct diagnosis selected, **right-click** and from the shortcut menu click **Select** or press the **Spacebar**.
• Diagnosis will be added to the **Selected** area.

**Edit Changes**
Use the Edit menu to select diagnosis or to undo or redo changes to an diagnosis.

**View**
From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this diagnosis, Preview or Hide text associated with the diagnosis or you can choose how to sort the window.

**Entry History**
Use this option to view a history of changes made to the selected diagnosis.

• Select a diagnosis and choose **right-click View, Entry History**.
• View date and time change was made, logged in user who made the change and a description of the change that was made.
• Click **Done** to close the window.

**Move diagnosis to another category**
You can easily move diagnosis from one category to another.

• With the correct diagnosis(es) selected, **right-click** and from the shortcut menu click **Move**.
• You will need to click **Yes** to confirm the move.
• Click the appropriate category name to move the diagnosis to.
Doctor’s Notes

Use the doctor’s notes window to enter doctor’s protocol for handling this diagnosis. These notes will not print. To view these notes you must return to the Diagnosis List and view the notes on the specific diagnosis.

- With the correct diagnosis selected, right-click and from the shortcut menu click Doctor’s Notes.
- Enter the appropriate notes and click Done.

Instructions

You may attach take-home instructions to any item to be printed automatically on the client invoice. To learn more about instructions refer below to the next topic “Create Doctor’s Instructions”.

Recommendations

You may use this notes window to enter information regarding the treatment of this diagnosis. To learn more about entering recommendations refer to the topic “Enter Recommendations” on page 189.

Reminder

AVImark allows you to set up a reminder template for any item. For a detailed discussion on setting up Reminder Templates, refer to “CHAPTER 11: REMINDERS”.

- With the correct diagnosis selected right-click and from the shortcut menu click Reminder.
- You will need to click Yes to create one and display the Reminder Template.
- Specify the various conditions for the reminder and click Done.

Treatment Protocol

Use this menu option to attach recommended treatment protocols. To learn more about treatment protocols refer to the topic “Enter a Treatment Protocol” on page 189.

Whogot

The AVImark Whogot list is a sorted list of all patients and their owners that have received a specified diagnosis. Use the Whogot list to view, sort, print, or go to the CID of any patient receiving the chosen diagnosis in a specified number of months.

- With the appropriate item selected, right-click and from the shortcut menu click Whogot to display the Treated Patients window.
- If applicable, use the Criteria menu to sort and/or limit the number of patients selected.
- Click Done to return to the Treated Patients window.
- Select the individual patients from the list you wish to print by clicking on the patient name and press the SPACEBAR.
- Click Print to display the Print Whogot window.
- Use the Print to drop-down list and select the correct Printer.
- Using the Months to show field, enter the number of months to display or use the drop-down calendar to specify the period you wish to print for.
- If applicable, double-click in the Document field to select a Document from among your MS Word documents.
- Select Include notes to include the notes about the diagnosis selected for each patient on the list.
- To omit the prescription messages, check the Exclude scripts checkbox.
- If applicable, click on Restrict to last query to limit the printing of documents to only those patients
chosen when you ran the last information search.

- Click Print or to preview the report onscreen select Preview and click Print.

**Create Doctor’s Instructions**

You may attach take-home instructions to any diagnosis to be printed automatically on the client invoice. For more information on entering doctor’s instructions, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”.

- Choose the correct diagnosis. **Right-click** and from the shortcut menu click **Instructions** to display the Invoice Instructions window.
- Type the doctor’s take-home instructions. All of the AVImark note feature options are available in this window.
- Click **Done** to save the instructions.

**Include Tag-A-Long Instructions**

- If you have several diagnoses in your list that would normally have similar Doctor’s Instructions, you may “duplicate” the instructions without having to type them all over again for every similar diagnosis. For detailed information on using tag-a-long instructions, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”. Type the Doctor’s Instructions in the normal way for one of the diagnoses.
- Select any other diagnosis that you want to use the same instructions for. **Right-click** and from the shortcut menu click **Instructions**.
- Type the Diagnosis Code of the *parent* diagnosis enclosed in asterisks (e.g. *ZB4542*) and click **Done** to save.

**Specify Doctor’s Notes**

- AVImark lets you specify your own observations, notes and memos about any of the diagnoses for future reference. These notes will not be displayed on the patient chart or the invoice unless you assign the % Action Code. For detailed information on entering notes, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”. With the correct diagnosis selected **right-click** and from the shortcut menu click **Doctor’s Notes** to display the Doctor’s Notes window.
- Enter the doctor’s notes using all the normal AVImark note feature options and click **Done**.

**Enter Recommendations**

You may use this notes window to enter information regarding the treatment of this diagnosis. These recommendations are displayed by AVImark for your reference when using the AVImark Medical Condition function.

- With the correct diagnosis selected **right-click** and from the shortcut menu click **Recommendations** to
display the Recommendations window.

- Enter the recommendations using all the normal AVImark note feature options and click Done.

**Sort Your Diagnosis List**

You may sort the list of diagnosis on a category basis by Code, Description, or by Action Code.

- Choose the correct category you wish to sort.
- Sort the records for that category by clicking on **Code**, **Description**, or **Action Codes** in the title bar. You may also move the diagnosis by highlighting it and while holding down on the left mouse button, drag to the specified location.

**Remind for a Diagnosis**

AVImark allows you to remind for any diagnosis in the same manner you remind for treatments and/or inventory items.

- With the correct diagnosis selected **right-click** and from the shortcut menu click **Reminder** to display the Reminder Template window. If a template is not found you will need to click **Yes** to create one.
- Set up the reminding characteristics in the same manner as you do with services.

**Enter a Treatment Protocol**

AVImark allows you to enter a recommended treatment Protocol for any diagnosis.

- With the correct diagnosis selected **right-click** and from the shortcut menu click **Treatment Protocol** to display the Treatment Protocol window.
- From the Treatment Protocol window, **right-click** and from the shortcut menu point to **Choose** and click either **Treatments** or **Items** to display the appropriate list.
- Select the appropriate treatment and/or inventory item and click **Done**.
- Click **Recommendations** to enter notes concerning the treatment and click **Done**.

**Enter Diagnosis Notes**

- You may enter unlimited notes regarding a diagnosis in the Medical History area. For detailed information on entering notes, refer to “CHAPTER 30: NOTE GLOSSARY AND Q & A”. With the appropriate Medical History entry selected, **right-click** to display the shortcut menu.
- Point to **Notes** and click **Enter Notes**.
- Enter the notes using all the normal AVImark note feature options and click **Done**.

**Sort the Selected Diagnosis**

AVImark allows you to sort selected diagnosis entries before they are entered into a patient’s Medical History.
• From the **Selected** area in the Diagnosis List Maintenance window, **right-click** and from the shortcut menu use the **Up** or **Down** arrows to arrange the diagnosis.

**Customizing Columns**
The Columns in the Diagnosis List Maintenance window can be arranged in the order you would like them to appear. For detailed information on customizing columns, refer to “**CHAPTER 32: CUSTOMIZING COLUMNS**”.

**Using the Speed Bar Buttons**
Just beneath the Records for the Diagnosis List are two Speed-bar icons. If you rest the mouse arrow on a speed-bar button, a ‘hint’ window will open describing its function.

• **Page icon** – Use this button to add a **New** diagnosis to the list.

• **Page with Checkmark icon** – Use this button to **Change** a diagnosis entry.

**Changing Multiple Entries**
AVImark allows you to change multiple entries within the Diagnosis List.

• Using the SHIFT and ARROW keys, select the appropriate entries. **Right-click** and from the shortcut menu click **Change** to display the Change window of the first selected entry.

• Make the necessary changes and click **OK**.

**Previewing Text**
You may display notes, instructions and recommendations in the Diagnosis List window.

• Within the Records for section, **right-click** to display the shortcut menu. Point to **View** and click **Preview Text** to display a **Columns** window.

• Select **Show Preview Text** and from the grid choose the option you would like to display.

• Click **OK**.

---

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Diagnosis</td>
<td>Diagnosis; Table of Contents – Diagnosis List</td>
</tr>
</tbody>
</table>
CHAPTER 13: PROBLEM LIST

The Problem List identifies problems that patients may encounter during their lifetime. You may have as many categories and problems entries as you wish. A patient problem may be added directly to the patient’s Medical History and the problem will be displayed in bold GREEN indicating it is a Problem and has not been posted to accounting. From Medical History, these problems may then be SOAP-ed; included within the Medical History section of a Patient Chart; added to Whiteboard as a scheduled activity; have attached photos, documents, forms, and file attachments.

Creating your Problem List
When you start using AVLmark you might want to add, delete and change the Problem List to customize its different characteristics to suit your clinic. To work with the Problem List, use the Work with menu and select Problem list.

Creating your Problem List on page 199
Adding a Duplicate Problem on page 201
Selecting Problems on page 202
Editing Changes on page 202
Sorting and Printing the Problem List on page 203
Attaching Diagnostic Protocols on page 204
Changing Quantity Values on page 204
Entering Rule-Outs on page 204
Customizing Columns on page 205
Using Problem List Speed Bar Buttons on page 205
Changing Multiple Entries on page 205
Previewing Text in the Problem List on page 205
Add a New Problem Category

- From the Category section, right-click and from the shortcut menu click New to display the New Problem Category window.
- Enter the appropriate information and click OK.

Category
This is the descriptive name given to each category to identify it in most AVImark functions.
- Type the name you wish to give the new category.

Whiteboard
This field represents the Whiteboard categories that are set up in “System Tables”. They are used to group and organize problems on the ‘Whiteboard’.
- Use the Whiteboard drop-down list and select the Whiteboard category you wish to assign to this category.

Account number
To interface with QuickBooks, you will need to enter the income account number that you set up in QuickBooks as the account in which to record the income generated from problems within this category.
- If appropriate, type the income account number that you have set up in QuickBooks.

Company
Having the ability to assign company numbers to individual codes as well as entire categories allows detailed reporting by company to be much more accurate.
- If appropriate enter the desired company number for reporting purposes.

Add and work with a new Problem

- With the correct category selected, point in the Problems for section.
- Right-click and from the shortcut menu click New to display the New Problem window.
Problem Tab Values

- Using the **Category** drop-down menu, select the category you wish to move the problem to.
- Enter a **Code**.
- Type the problem **Description**.
- If applicable, use the **Action Codes** drop-down list and select the correct Action Code(s).

<table>
<thead>
<tr>
<th>CODE</th>
<th>NAME</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Print one document/patient</td>
<td>Prompts a document for each patient that has received the same problem in medical history for a client.</td>
</tr>
<tr>
<td>Q</td>
<td>Don’t post to invoice</td>
<td>Will not include this problem on the printed invoice. This diagnosis will be entered in medical history and displayed as already posted.</td>
</tr>
<tr>
<td>*</td>
<td>Auto prompt for notes</td>
<td>When entered into medical history it will automatically prompt for a notes window to enter information about the problem.</td>
</tr>
<tr>
<td>@</td>
<td>Auto prompt for document</td>
<td>Prompts to print the linked document. Without this action code AVImark will automatically print the linked document with the invoice.</td>
</tr>
<tr>
<td>%</td>
<td>Auto copy notes into medical history</td>
<td>Copies entered notes on the problem automatically into a notes window in medical history.</td>
</tr>
<tr>
<td>#</td>
<td>Don’t print form/document</td>
<td>Suppresses the printing of the linked form or document.</td>
</tr>
<tr>
<td>}</td>
<td>Don’t post to Whiteboard</td>
<td>Will not include this service on the whiteboard automatically when entered into medical history.</td>
</tr>
<tr>
<td>5</td>
<td>Dental Assessment</td>
<td>Automatically prompts the dental chart to display when the problem is entered into medical history.</td>
</tr>
<tr>
<td>&lt;</td>
<td>E-Travel Sheet</td>
<td>Include on E-Travel Sheet, action code to display the selected problem on the E-Travel sheet.</td>
</tr>
</tbody>
</table>

- If applicable, use the **Species** drop-down list and select the correct Species.
- If applicable, use the **Whiteboard** drop-down list and select the appropriate category.
- For detailed reporting by company number, enter the appropriate number for this problem.

Document Tab Values

- If you wish to assign a document(s) to the problem, select the Documents tab.
- Use the **button in the Document field to view your documents.**
- If applicable choose the appropriate species for the document.
- Select the appropriate document(s) and click **OK**

Adding a Duplicate Problem

AVImark allows you to add a new problem to your list that is a duplicate of one that you have already entered. This will be useful if you are adding several problems that have the same characteristics.

- From your Problem List, select the problem you wish to duplicate.
- Right-click and from the shortcut menu click **Another** to display a duplicate New Problem window.
- Enter a new **Problem Code** for the duplicate item as well as any other necessary changes and click **Done**.
Selecting Problems
Select problems to be added to medical history, Appointments, Estimates, SOAP records or to the Whiteboard.

- With the correct problem selected, right-click and from the shortcut menu click Select or press the Spacebar.
- Problems will be added to the Selected area.

Editing Changes
Use the Edit menu to select problems or to undo or redo changes to an problem.

View
From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this problem, Preview or Hide text associated with the problem or you can choose how to sort the window.

Entry History
Use this option to view a history of changes made to the selected problem.

- Select a problem and choose right-click View, Entry History.
- View date and time change was made, logged in user who made the change and a description of the change that was made.
- Click Done to close the window.

Move a problem from one category to another
If appropriate you may move the problem to a different category.

- Select a problem and choose right-click, Move.
- You will need to click Yes to confirm the move.
- Click the appropriate category name to move the item to.

Enter problem notes
You may enter notes regarding a specific problem using all of the available AVImark note feature options.

- With the correct problem selected, right-click and from the shortcut menu click Notes to display the Notes window.
- Type the appropriate notes for this problem. All of the AVImark notes feature options are available in this window.
- Click Done to save the notes.

Set up a problem reminder
AVImark allows you to set up a reminder template for any problem. For a detailed discussion on setting up Reminder Templates, refer to “CHAPTER 11: REMINDERS”.

- With the correct problem selected right-click and from the shortcut menu click Reminder.
- You will need to click Yes to create one and display the Reminder Template.
- Specify the various conditions for the reminder and click Done.

Diagnostic Protocols
Use this menu to associate treatment protocols to determine the cause of the selected problem. To learn more about associating diagnostic protocols, refer to the topic “Attach Diagnostic Protocols” on page 196.
Rule-outs

Use this menu to choose possible rule-outs that could be causing the problem. To learn how to choose rule-outs for the selected problem refer to the topic, “Enter Rule-Outs” on page 196.

View and print the Whogot list

The AVImark Whogot list is a sorted list of all patients and their owners that have received a specified problem. Use the Whogot list to view, sort, print, or go to the CID of any patient receiving the chosen problem in a specified number of months.

- With the appropriate problem selected, right-click and from the shortcut menu click Whogot to display the Treated Patients window.
- If applicable, use the Criteria menu to sort and/or limit the number of patients selected.
- Click Done to return to the Treated Patients window.
- Select the individual patients from the list you wish to print by clicking on the patient name and press the SPACEBAR.
- Click Print to display the Print Whogot window.
- Use the Print to drop-down list and select the correct Printer.
- Using the Months to show field, enter the number of months to display or use the drop-down calendar to specify the period you wish to print for.
- If applicable, double-click in the Document field to select a Document from among your MS Word documents.
- Select Include notes to include the notes about the item selected for each patient on the list.
- To omit the prescription messages, check the Exclude scripts checkbox.
- If applicable, click on Restrict to last query to limit the printing of documents to only those patients chosen when you ran the last information search.
- Click Print or to preview the report onscreen select Preview and click Print.

Sorting and Printing the Problem List

Sort the Problem List

You may sort the list of problems on a category basis by Code or Description.

- Choose the correct category you wish to sort.
- Sort the records for that category by clicking on Code or Description in the title bar. You may also move the diagnosis by highlighting it and while holding down the left mouse button, drag to the desired location.

Print the Problem List

The Problem List Report shows a list of problems, sorted by category and any associated Microsoft Word document attached to the problem.

- From the Problem List window, open the File menu and click Print to display the Print Problem List window.
- Use the Category drop-down list to select the category you would like to print.
- Select the Print details options to include any associated diagnostic protocols, rule-outs, diagnostic protocol recommendations and any notes.
- Select the Sort By option you would like.
• If applicable, use the **Restrict to Species** drop-down list to restrict to a certain species.

• Click **Print** or to preview the report on screen, click **Preview**.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail Problem List Report</td>
<td>E-mailing Reports</td>
</tr>
<tr>
<td>Attach Documents</td>
<td>Associating documents</td>
</tr>
</tbody>
</table>

**Attaching Diagnostic Protocols**

A diagnostic protocol is composed of the treatments and/or inventory items that will be performed and/or administered to determine the cause of the problem. A diagnostic protocol may be attached to a Problem by choosing the treatments and/or items from the Treatment or Inventory List.

• With the correct problem selected, right-click and from the shortcut menu click **Diagnostic Protocol** to display the Diagnostic Protocol window.

• From the Diagnostic Protocol window, right-click to display the shortcut menu. Point to **Choose** and click either **Treatments** or **Items** to display the list window.

• Select the appropriate treatments and/or items and click **Done** to enter the selection into the Diagnostic Protocol window.

• Click **Recommendations** to enter any further diagnostic procedures and click **Done**.

**Changing Quantity Values**

When you add treatments or items into the Diagnostic Protocol window, you may define Quantity values for these treatments/items. The **Quantity** value normally refers to the number of inventory items the patient needs to receive.

• Within the Diagnostic Protocol window, select the treatment/item to change.

• Right-click and from the shortcut menu click **Change** to display the Change Diagnostic Protocol window.

• Type in the field to change the quantity as needed.

• Click **OK** when finished.

**Entering Rule-Outs**

Rule-outs are the one or more diagnoses (diseases) that could be causing the problem. When a problem is entered into a Medical Condition (SOAP) record, AVImark allows you to review and accept these Rule-outs in the SOAP record.
Choose the particular problem. Right-click and from the shortcut menu click **Rule-outs** to display the Rule-outs window.

Within the Rule-outs window, right-click to display the shortcut menu. Point to **Choose** and click **Diagnosis** to display the Diagnosis List Maintenance window.

Select the appropriate diagnosis and click **Done** to enter the diagnosis into the Rule-outs window.

---

**Customizing Columns**

The Columns in the Problem List window can be arranged in the order you would like them to appear. For detailed discussion on customizing columns, refer to **“CHAPTER 32: CUSTOMIZING COLUMNS”**.

**Using Problem List Speed Bar Buttons**

Just beneath the Problems for the Problem List, are two Speed-bar icons. If you rest the mouse arrow on a speed-bar button, a “hint” window will open describing its function.

- **Page** Icon – Use this button to add a **New** problem to the list.
- **Page with Checkmark** icon – Use this button to **Change** a problem entry.

**Changing Multiple Entries**

AVImark allows you to change multiple entries within the Problem List.

- Using the SHIFT and ARROW keys, select the appropriate entries. Right-click and from the shortcut menu click **Change** to display the Change window of the first selected entry.

- Make the necessary changes and click **OK**.

**Previewing Text in the Problem List**

You may display notes and recommendations in the Problem List window.

- Select **Show Preview Text** and the option you would like
CHAPTER 14: MEDICAL CONDITION RECORD

AVImark allows you to link a Medical Condition Record with any treatment in the Medical History Area. Data entered in this window will then appear on the printed patient's chart.

Medical Condition Options
The Medical Condition window consists of several different scrollable sections but the four main sections are: Problems, Assessment, Plan and Attachments.

Open the Medical Condition window
• Select the correct treatment in medical history. Right-click and from the shortcut menu click Med condition to display the Medical Condition window.

• You will need to click Yes to confirm.

Create the Medical Condition Record automatically

In this chapter you will learn about...
» Medical Condition Options on page 207
» Work with the Objective Area on page 211
» Work with Client Instructions on page 211
» Work with the Assessment Area on page 211
» Work with the Plan Area on page 212
» Work with Attachments on page 213
» Print Patient Report Card on page 213
» Create Additional Data Fields on page 214
» Print Medical Condition Record on page 214
» Graph Vital Signs Data on page 214
AVImark allows you to automatically create a Medical Condition Record when a treatment is entered into Medical History and also when a patient is checked into the hospital. You will need to be certain that the treatment(s) you are entering into Medical History contain the W Action code.

- Select the Advanced tab in Hospital Setup and click Advanced Options.
- In the search field type Show Medical Condition Record and set the default value to True.
- In the search field type Post visit to Medical History and set the default value to True and click Done.

**Vitals Only Option**

For hospitals that only use the weight and vitals section of a SOAP record, it is possible to simply abbreviate the SOAP record by selecting the Vitals Only option. With the Vitals Only option checked the SOAP window will default to the abbreviated size when opened and can not be manually resized. Also, while the option remains checked only the vital signs will print on the patient chart. If the Vitals Only option is unchecked it will default to the normal size when opened and will retain its size if you manually resize it.

**Identifying a Patient’s Problem**

You may review and print the diagnostic protocol for each problem including notes, recommendations and/or related documents. You may also review the different rule-outs (diagnoses) suggested for the problem.

**Choose a problem from the Problem List**

- Within the Presenting Problem(s) field, right-click and from the shortcut menu click Choose Problem to display the Problem List window.
- From the Problem List window, select a Category and then select the Problem(s).
- Click Done.
- You will need to click Yes to confirm adding the problem to the patient’s Problem History.
- Type any notes/further description of the problem in the Chief complaint and client communication field.

**Review Patient Problem History**

In the Problem History area AVImark will display past problems, open and closed, for this patient. This area reflects the patient’s Problem History that is accessed from the CID, Patient Area. It also has the same functionality. From here you can Open, Remove and Close Problems. A problem that has already been opened and possibly closed can be added to the Presenting Problems area. For more information on Patient Problem History refer to “View Patient Problem History” on page 135.

- Within the Problem History area, right-click and from the shortcut menu click Add To Problems.
- A message will be displayed asking if you wish to add the problem to the medical history. Select Yes to confirm this action.
- The problem will be added to the Medical History and be displayed in the Presenting Problems area for this specific Medical Condition Record.
Review Diagnostic Protocols
If the problem you have selected has an associated diagnostic protocol and/or rule-out(s) attached, you may review them while in the Medical Condition record.

- Select the problem from within the Medical Condition record. **Right-click** and from the shortcut menu click **Review Protocol** to display the Diagnostic Protocol window.
- To view any associated recommendation notes click the **Recommendations** button at the bottom of this window.
- To review any notes related to each treatment within the protocol window, select the appropriate treatment.
- **Right-click** and from the shortcut menu click **Notes**.

Additional protocols may also be added in this window while in the Medical Condition window.

- In the Diagnostic Protocols window select **right-click New** from the shortcut menu.
- Enter the Code or tab to the Description field, enter the description and choose the appropriate service or item from the displayed list.
- Specify any other necessary information and click **OK**.
- Repeat this process if necessary. Click **Done** on the Diagnostic Protocols window once the desired protocols have been added.

**OR**

- In the Diagnostic Protocols window select **right-click Choose** from the shortcut menu.
- Choose the desired list and select the appropriate services or items and click **Done** on the list.
- Click **Done** on the Diagnostic Protocols window once the desired protocols have been added.
Review Rule-Outs

- With the correct problem selected right-click and from the shortcut menu click Review rule-outs to display the Rule-outs window.

  To review any notes related to each rule-out, select the appropriate rule-out.

- Right-click and from the shortcut menu click Notes.

Additional rule outs may also be added in this window while in the Medical Condition window.

- In the Rule Outs window select right-click New from the shortcut menu.
- Enter the Code or tab to the Description field, enter the description and choose the appropriate diagnosis from the displayed list.
- Specify any other necessary information and click OK.
- Repeat this process if necessary. Click Done on the Rule Outs window once the desired rule outs have been added.

  OR

- In the Rule Outs window select right-click Choose from the shortcut menu.
- Choose the Diagnosis List, select the appropriate diagnosis and click Done on the list.
- Click Done on the Rule Outs window once the desired rule outs have been added.

Review an MS Word Document

You may view and/or print any documents attached to the problem you have selected from the Problem List.

- With the correct problem selected on the Presenting Problems area, right-click and from the shortcut menu click Review document to display the attached MS Word document.

Accept the Diagnostic protocols into the Plan area

- With the correct problem selected on the Presenting Problems area, right-click and from the shortcut menu click Accept Protocol to accept and display the protocols on the Plan area.
Accept the rule-outs into the Assessment area

- With the correct problem selected on the Presenting Problems area, right-click and from the shortcut menu click **Accept Rule-outs** to accept and display the rule-outs in the Assessment area.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Last diagnosed</th>
<th>By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z0571</td>
<td>ARTHRITIS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZF1262</td>
<td>FRACTURE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZT0376</td>
<td>TENDONITIS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z38817</td>
<td>SWELLING</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Work with the Objective Area

The Objective area is used to indicate specific problems the animal is having based on direct examination. In the Objective area you may enter miscellaneous notes relating to examination procedures and findings. This information will be saved and printed along with the other observations and memos on the Medical Condition chart and the Patient chart. You will see a list of Abnormality check boxes that correspond to the Abnormality table entries that you have defined in System Tables. When you check any one of these boxes, a window will open to enter associated notes, as well as the check boxes for any body subsystems that you have defined for this abnormality. Next to the abnormalities is a phrase field where a default phrase will appear or any text may be typed in this field.

Work with Client Instructions

This area allows instructions that are intended for the client to be kept separate from other notes that are recorded in the Medical Condition Record. This note area contains the same right-click options as other note window and can also be included on an MS Word document by using the appropriate merge words.

Work with the Assessment Area

The Assessment area is used to identify the diagnoses you would like to rule out as well as the final diagnoses of the problem the patient is having. The Assessment section consists of the Rule-outs that identifies the diagnoses that you will rule out and the Diagnoses that identify the final diagnosis.

Choose rule-outs from the Assessment area

- In the Assessment area, right-click and from the shortcut menu click **Choose Rule-out** to display the Diagnosis List window.
  - Select the correct category and then the specific diagnosis.
  - Click **Done**.

Attach notes to the rule-outs

- With the correct rule-out selected right-click and from the shortcut menu click **Rule-out Notes** to display the notes window.
  - Type the notes and click **Done**.

Reject rule-outs

- With the correct rule-out selected right-click and from the shortcut menu click **Reject Rule-out**.
  - To reactivate the rule-out, right-click and from the shortcut menu click **Reactivate Rule-out**.

Accept rule-out as final diagnosis

- With the correct rule-out selected right-click and from the shortcut menu click **Accept as Diagnosis**.
  - You will need to click **Yes** to confirm and to display the accepted rule-out as a different color in the
Assessment area. This will automatically post the accepted diagnosis to the patient’s Medical History.

Remove a diagnosis from the Assessment area
- With the correct diagnosis selected right-click and from the shortcut menu click Remove Diagnosis.
- You will need to click Yes to confirm removing the diagnosis from the Assessment area.
- Click Yes to remove from the patient’s Medical History.

Choose diagnosis from the Assessment area
- Within the Assessment area, right-click and from the shortcut menu click Choose Diagnosis to display the Diagnosis List window.
- Select the correct category and then the specific diagnosis.
- Click Done.

Attach notes to the diagnosis
- With the correct diagnosis selected right-click and from the shortcut menu click Diagnosis notes to display the notes window.
- Type the notes and click Done.

Enter the diagnosis into Medical History
- With the correct diagnosis selected right-click and from the shortcut menu click Post.

Review the recommended Treatment protocol for the diagnosis
- With the correct diagnosis selected right-click and from the shortcut menu click Review Protocol to display the Treatment Protocol window.

Accept the Treatment protocol
Accepting the Treatment protocol causes the protocol to be recorded and identified as a Therapeutic procedure in the Plan area.
- With the correct diagnosis selected right-click and from the shortcut menu click Accept Protocol.

Work with the Plan Area
The Plan area is used to gather and define the treatments that will be performed to diagnose the problem (Diagnostics) and what treatments will be performed to treat the patient (Therapeutic). When diagnostic protocols and treatment protocols are accepted they will automatically be added to the Plan area.

NOTE: By pressing CTRL+Tab you can change from selecting treatments to inventory items.

Enter treatments or inventory from the Plan area
Treatments and items can be manually added to the Plan area by using a few methods.
- From the Plan area right-click and from the shortcut menu select Choose Entry or press F7.
- Inside this window select the Treatment or Inventory tab and AVImark will display the appropriate entries.
- Under the Selected area on the left side of the screen choose whether the services will be added as Diagnostic or Therapeutic protocols.
- Highlight the desired treatment or item and press the Spacebar and AVImark will place the entry under the Selected window.
- Click Done and AVImark will add the services to the Plan tab.

OR
- From the Plan area right-click to display the shortcut menu. Point to Choose Therapeutic entry
or Choose Diagnostic entry and click either Treatments or Inventory to display the Treatment/Inventory List window.

• Select the correct treatment(s) and/or item(s) and click Done.

**Post entries to Medical History**
When treatments/items are posted to medical history from the Plan area, they will then appear in light gray indicating that it has already been posted. If the treatment had more than one (1) specified in the To Do column, this number will be reduced by one each time it is entered into Medical History.

• Select the appropriate treatment and/or item. Right-click and from the shortcut menu click Post.

**Create an Estimate**
You have the ability to print an estimate for the treatments that are in the Plan area.

• From Plan area, right-click to display the shortcut menu. Point to Create estimate and click either Diagnostic only, Therapeutic only, or Both plans.

• You will need to click Yes to confirm and display the Estimate Detail window.

• To select treatments, items, diagnosis and/or add canned estimates from the Estimate Detail window, right-click and from the shortcut menu click Treatment, Item, Diagnosis and/or Estimate.

• Double-click in the Document field to display the Open window.

• Double-click the correct document and click Print.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Condition Records</td>
<td>Medical Condition Record</td>
</tr>
<tr>
<td>Subjective Folder</td>
<td>Subjective area</td>
</tr>
<tr>
<td>Objective Folder</td>
<td>Objective area</td>
</tr>
<tr>
<td>Assessment Folder</td>
<td>Assessment area</td>
</tr>
<tr>
<td>Plan Folder</td>
<td>Plan area</td>
</tr>
<tr>
<td>SOAP Attachments</td>
<td>Attachments area</td>
</tr>
</tbody>
</table>

**Work with Attachments**
From the patient’s medical history multiple files can be attached to one entry. If the selected entry has file attachments they will be displayed here. From this area multiple files such as documents, forms, photos, etc, can be attached.

• In the Attachments area, right-click and select New from the shortcut menu.

• Click the Filename search button to choose the desired photo, document, form, etc.

• Click OK to add the file. Any attachment that is added here can also be accessed from the patient’s Medical History File Attachments.

**Print Patient Report Card**
To print a patient report card you must first create the form in MS Word. When creating this form use the
appropriate medical condition record merge words.

A default document can be setup to work in two different ways:

1. Entering a document name in the Advanced Options, under “Default Report Card Document”, will set the specified document to be used for all report cards despite the species.

2. From System Tables a different document per species can be entered to be printed for the specific species.
   - From the Medical Condition Record click the Report Card option at the bottom of the window.
   - If a specific default document is specified in either the System Tables or Advanced Options the document name will automatically display or choose the desired form and click Open.
   - If appropriate, modifications can be made to the form.
   - The report card will then be saved to the Attachment directory and linked to the Medical Condition and Medical History File Attachment areas.

Create Additional Data Fields
AVImark allows you to create additional data fields for four of the main areas in the Medical Condition window. These additional data fields are created in the Additional Data Fields System Table in much the same way as you would create additional data fields for client or patient information.

- On the CID, open the Work with menu and click System Tables to display the System Tables window.
- Select the Additional Data Fields table and then the correct Entries for folder.
- Right-click and from the shortcut menu click More Stuff Fields to display the Define More Stuff window.
- Add the data fields you would like to create and click Done.

Open the Additional Data Field
- From the Medical Condition Record window, select the file menu Med Condition.
- Click More stuff and choose the area you where want to add More Stuff values.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Data Fields</td>
<td>SOAP Additional Fields</td>
</tr>
</tbody>
</table>

Print Medical Condition Record
The medical condition record can be printed or emailed.

- In the Medical Condition Record select Print from the File menu.
- From here click Print to print the entire medical record.
- To email the medical record click Preview from the Print Medical Condition window.
- In the Report Preview window select File, Email from the menu.
- Enter the appropriate information and click Send.

Graph Vital Signs Data
You may use Microsoft Excel to prepare, view, and/or print graphs of any of the vital signs data. This feature is dependent upon your having Microsoft Excel resident in your computer.

- Open the Medical Condition Record window for the selected Medical History entry.
- Select the data field you want to graph.
- On the Med Condition menu, click Graph values to display the Graphing window.
- Using the Style drop-down list, select either Line, Bar or Area and click Print.
CHAPTER 15: PRESCRIPTION LABELS

AVImark allows you to print prescription labels for any item or treatment in the Medical History area of the CID, OR by choosing an item in your Inventory and/or Treatment List. AVImark will print the doctor’s name that prescribes the item, the client’s name, the current date, the name and species of the patient, the prescription message, name of the item prescribed, expiration date as well as the quantity dispensed and the units of measure.

<table>
<thead>
<tr>
<th>In this chapter you will learn about...</th>
</tr>
</thead>
<tbody>
<tr>
<td>» Printing a Prescription Label on page 215</td>
</tr>
<tr>
<td>» Use the Drug Label Wizard on page 216</td>
</tr>
<tr>
<td>» Type and Save a New message on page 216</td>
</tr>
<tr>
<td>» Automatically Display Saved Messages on page 216</td>
</tr>
<tr>
<td>» Choose a Linked/Saved Message on page 216</td>
</tr>
<tr>
<td>» Choose from all Saved Messages on page 216</td>
</tr>
<tr>
<td>» Delete a Saved Message on page 217</td>
</tr>
<tr>
<td>» Refill Prescriptions on page 217</td>
</tr>
<tr>
<td>» DVM Dispensary Services’ MyVetsMeds® on page 218</td>
</tr>
<tr>
<td>» VetCentric™ Home Delivery Interface on page 219</td>
</tr>
</tbody>
</table>

Printing a Prescription Label
You may print a prescription label for any item that has been dispensed to a patient or print a label by choosing an item/treatment from your Inventory/Treatment List.

- Select the correct item from Medical History or from your Inventory/Treatment List.

- **Right-click** and from the shortcut menu click **Drug label** to display the Drug label window.
- Specify the correct message and click **Print**.

Note: The **Place Home Delivery Order** information will be utilized for a future AVImark integration.
Use the Drug Label Wizard
AVImark will help you create the message that appears on the label.

- From the Drug label window, click the **Wizard** menu to display the Prescription Label Wizard.

  ![Prescription Label Wizard](image)

- Use the entry fields and drop-down lists to specify the quantities and units of measure and click **Done**.
- From the Drug label window, click **Print**.

Type and Save a New message
AVImark allows you to type a new drug label message and save for further use.

- From the drug label window, type the message that you want to be printed. You may use any of the AVImark merge words in the message.
- Use the entry fields and drop-down lists to specify the quantities and units of measure.
- Click in the **Label Name** field and type a unique name up to 15 characters.
- **Right-click** and from the shortcut menu click **Save**.
- You will need to click **OK** to confirm that the message has been saved.

Automatically Display Saved Messages
Once you have saved one or more messages for an item, when you open the Drug Label Assistant window, the message displayed will be that message that is being used most frequently. You have the option of accepting this as the appropriate message, choosing a different message that has previously been saved for this item or typing a brand new message for the label.

Choose a Linked/Saved Message
Rather than typing a new message, you may instead choose one of those that have already been entered and saved for this item.

- From the Drug Label Assistant window, click **Next** to display the messages linked to this item.

  OR

- From the Drug Label Assistant window, **right-click** and from the shortcut menu click **Choose** to display the Select Label Message window.
- From the **Labels for** section, select the appropriate label name and click **Done**.

Choose from all Saved Messages
When choosing an appropriate message for an item, AVImark also allows you to pick from the entire list of all saved messages. Once the right name has been chosen, you are then able to save and link it to the selected item or just print the label.

- From the Select Label Message window, select the **Show all** box to display a list of all saved messages.
• Choose the appropriate label name and click **Done**.
• If you wish to link this message with this item, **right-click** and from the shortcut menu click **Save**.

**Delete a Saved Message**
AVImark allows you to delete any saved message.
• From the Drug Label Assistant window, **right-click** and from the shortcut menu click **Choose** to display the Select Label Message window.
• Choose the label name you wish to delete. **Right-click** and from the shortcut menu click **Remove**. You will need to click **Yes** to confirm.

**Refill Prescriptions**
AVImark allows you to refill prescriptions from the Medical History of a patient. There are a few values that you will need to specify in order for AVImark to track the number of refills allowed for each item, what the date and interval limitations are for the refills, and whether refills are allowed dependant upon specific services which may have been performed on the patient.

**Specify the refill control fields**
• From your Inventory List, select the item you wish to control the number of refills.
• Double left-click on the item to display the Change Item window.
• From the Action Code drop-down list, select the **Left Parenthesis** “(“ from the list.
• Within the **Refill for** field, specify the number of months that refills for this item are allowed.
• If appropriate, use the **if performed** field to specify the **Treatment Code** for a treatment, that if performed, would reset the refill number allowed to what was originally specified.
• Enter the number of days between allowable refills, in the **Minimum interval between refills** field and click **Done**.

**Refill procedures**
• With the correct item selected in the patient’s Medical History area, **right-click** and from the shortcut menu click **Refill** to display the Enter Medical History window.
• If appropriate, change the quantity and/or provider and click **Done** to display the Drug Label window.
• AVImark will indicate the current refill count in the Drug Label window. If you wish to start over on the refill count, select the **Start a new prescription** box.
• Click **Print** to reprint the original label text.

**Printing Unique RX Refill Numbers**
For clinics in Nevada they are required to print unique RX numbers for refills.
• From the CID select the **Hammer**, **Screwdriver** and **Wrench** speed bar icon.

• In the **search** field type **sequence** and select the option **Nevada Refill Sequencing** and set the value to **True**.

• You will also select the option **Sequence Number** and set the value to **True**.

As refills are entered into Medical History, AVImark will look back to the original sequence number assigned when the item was administered and assign the letter R to the end of the number.

**Printing Lot Number on Drug Label**

The state of Florida now requires a Lot Number to be stored and printed on each Drug Label.

• From the CID select the **Hammer**, **Screwdriver** and **Wrench** speed bar icon.

• In the **search** field type **lot** and select the option **Inventory Lot Number** and set the value to **True**.

• You will also select the option **Prompt to Update Lot Number When Lot Empty** and set the value to **True**.

A Lot Number field will now be available from the Pharmacy tab of the Change Item window allowing you to enter the Lot Number and the amount in the Lot. As the item is dispensed AVImark will subtract the amount from the Lot amount field. When the Lot amount reaches 0, AVImark will display a message prompt allowing you to click Yes and have AVImark refill the Lot amount field using the item Order Pack, minus the amount just dispensed.

---

**DVM Dispensary Services’ MyVetsMeds®**

Integration is available with the MyVetsMeds® online ordering and home delivery services veterinary practices are providing to their clients. This integration allows veterinarians who use MyVetsMeds® to send the veterinarian’s dispensing authorization and instructions to MyVetsMeds® directly from within AVImark.

To use the MyVetsMeds® integration feature, contact them to obtain your Clinic ID and Password. Then specify your Clinic ID and Password within the Advanced Options. A new MyVetsMeds® button will then displayed on the AVImark drug label window. Selecting this button will automatically forward the client, patient and dispensing information to MyVetsMeds® where it will then be processed for home delivery directly to your clients pet in your name.

---

**To learn more about:**
- Drug labels
- Refill procedures

**Search the Help for:**
- Prescription labels
- Refill prescriptions
AVImark has teamed up with VetCentric™, Inc. to provide our mutual Veterinary Practices the ability to offer home delivery of FDA- and EPA-approved pharmaceuticals, compounded medications, and therapeutic and wellness diets, for their clients. This integration will allow our users the option of filling prescriptions “in-house”, sending the prescription to VetCentric for convenient home delivery or a combination of the two.

To use this feature, you must have AVImark version 2010.4.1 or higher and have an active VetCentric™ account. If you are not currently a VetCentric™ customer and would like to take advantage of this feature, call a VetCentric™ specialist toll-free at 1-866-868-2368. Select option 2, and then option 4, Monday through Friday between 8:30 a.m. and 5:30 p.m. EST.

If you have an account with VetCentric™ and would like more information on activating your VetCentric™ Home Delivery account for use with AVImark, you can choose from the following:

- E-mail your request to avimark@vetcentric.com
- Contact VetCentric™’s Practice Management Software specialist, Rob Fitch at 410-412-1457

AVImark Setup

Your clinic’s VetCentric™ account information will need to be entered into AVImark Advanced Options. This can be accomplished by the following the below steps:

- Type “VetCentric” in the search field of Advanced Options.
- Expand the VetCentric tree.
- Set the default value for each of the following fields using information provided by VetCentric.
  - Password
  - Secret Key
  - Username
  - Vet ID
- You may wish to assign your Default Pharmacy Company. Setting this option to VetCentric™, will allow VetCentric™ to automatically be selected when creating your home delivery order from within the
AVImark Drug Label window.

To achieve this:

- While still in Advanced Options, type “pharmacy” in the search field.
  - Select VetCentric™ as your Default Pharmacy Company
- An option has been added to set the default Fill Preference for prescriptions. You can set this value by searching for **Default Order Type**.
  - InClinic – will keep the Home Delivery option from being automatically checked in the drug label window.
  - FirstInRemainingOut – will automatically default to the **First Fill in, Refills out** selection in the drug label window.
  - AllFillsOut – will automatically default to the **All Fills Out** selection in the drug label window.

**Doctor Information (Users and Security)**

Each doctor generating VetCentric™ prescriptions will need to have additional user information to accommodate prescription reporting requirements. The following new fields have been added in the AVImark Change User window found in Users and Security:

- **License State Field** - This field is to be filled with the state in which the doctor is licensed and will coincide with the doctor’s License Field.
- **License Exp** - The expiration date of the doctor’s license.
- **DEA Exp** - The expiration date of the DEA number assigned to this doctor.
- **First and Last Name Fields** - The name of the doctor will need to be modified from the single “Name” field, to now reflect the first name and last name in the corresponding fields.

**Special NOTE:** The First and Last Name fields will only need to be manually modified during early Beta Testing stages. When released officially, the AVImark update process will make the first and last name modifications automatically.

**AVImark/VetCentric Code Association**

There will need to be VetCentric™ item associations to AVImark items in order to have the proper VetCentric™ items selected for home delivery when an AVImark prescription item is entered. There are several ways to accomplish this.

**Option 1**

- By opening the Inventory List select VetCentric, Setup from the menu. You will be presented with the VetCentric™ Wizard.
• Setup by matching drug labeled items with VetCentric™ equivalent. This will load your AVImark Item Codes and Descriptions with associated drug labels and allow you to select the VetCentric™ item from a drop-down list that most appropriately matches your AVImark item.

• Setup by selecting categories needed and importing as new items. This will load all the VetCentric™ categories and allow you to select which categories you wish to have automatically added to your AVImark Inventory List.

**Important NOTE:** When you add new AVImark items by VetCentric™ category, item descriptions will be abbreviated in a manner to allow fully identifiable information while taking into consideration the AVImark item description character limitation. Each VetCentric™ item added by category will display a description beginning with an asterisk (*). This distinction will allow a user to search a list including or excluding VetCentric™ items when adding prescriptions to Medical History.

Option 2

You can directly map a VetCentric™ item to your AVImark items from within your AVImark Inventory List.

• Open the Change Item window for the selected AVImark item.

• Select the Pharmacy tab.

• In the area labeled Pharmacy Company Codes choose right-click, New.

• Select VetCentric from the Company pull down menu.

• Select the VetCentric™ item that represents the AVImark item equivalent.
Option 3

The mapping of a VetCentric™ item to an AVImark item can also be completed “on the fly” directly from within the AVImark Drug Label window at the time of item being entered into Medical History.

Feature Use

Opening the Drug Label for a VetCentric™ associated AVImark item in Medical History will display a Drug Label with many new options. The Drug Label window will allow you to both print a drug label to affix to your direct dispensed prescription and/or enter Home Delivery Order information to have the prescription sent to VetCentric™ online pharmacy to have it filled and delivered by them. One of the great features of this enhancement is the ability to perform a “first fill” from in-house and send the balance of the prescription and/or refills to be performed via VetCentric™.

Below is a list of the VetCentric™ options that will are available in the Drug Label window of a VetCentric™ associated item.

- Place Home Delivery Order – Option indicating intention to place Home Delivery Order.
- VetCentric Item Description
- Fill Preference is how you wish to have prescription filled. 1st fill in – indicates intention to fill first from in-house and all subsequent fills from VetCentric. All fills out – indicates you wish to have all fills of this prescription filled by VetCentric. A default value can be set for the Fill Preference in Advanced Options.
- Wait on Client Action – will upload the prescription information to the VetCentric Medicine Cabinet allowing the client to log into the site, or call VetCentric, at their discretion to purchase the item as needed.
- Next Ship Date – is when you wish the first shipment to take place from VetCentric.
- Days Supply – indicates the number of days you wish to have supplied per delivery.
- Number of Refills – will allow you to indicate how many refills of this script can be obtained. PRN – indicates the prescription can be filled as needed until the prescription expiration date has been reached.
- Prescription Expires – indicates the date at which the prescription is no longer valid.
- Qty – indicates the number of the prescription item you are dispensing from the clinic and will be deducted from your clinic on-hand qty, as well as print on the drug label.
- Flavor – will be activated when a VetCentric item calling for a flavored suspension has been prescribed, allowing a user to select the desired suspension flavor.
- Prescription Auto Refill – indicates this prescription can be refilled automatically without refill authorization for the interval selected and can only be used with a Number of Refills greater than 0 or PRN option being selected. VetCentric offers free standard shipping with no minimum order amount on all products when Auto-Refill is activated.
- HD Pharmacist Instructions – Field for specific instructions from the user who prescribed the medication to the pharmacist.

- When the option to “1st fill in, refills out” is selected, a Print button will be available to print your Drug Label. If you have chosen the “All fills out” option, the Print button will not be available. If you have selected “1st fill in” you can Print the drug Label, then Press the VetCentric button to send your online pharmacy order.
- When a prescription is chosen to be filled by VetCentric™, and not directly dispensed from the clinic, the Medical History entry will become black in color with a qty and amount of 0.00, indicating that nothing was dispensed and of a “posted” status.
- An AVImark invoice that contains a VetCentric™ prescription will display that line entry indicating it
has been assigned to VetCentric. There will also be an informational message on the invoice with the VetCentric™ web-address and customer username, allowing the AVImark/VetCentric™ customer to log into the VetCentric™ website to make arrangements for prescription delivery and payment arrangements.

- AVImark will contact the VetCentric™ server daily for prescription updates on all open prescriptions. When a VetCentric™ assigned refill is dispensed a new AVImark Medical History entry is created indicating a refill took place.

- From the right-click, Integrations, VetCentric menu option in Medical History there are additional options.

- **Buy a Prescription Now** – will take you to the VetCentric secure site to allow the customer to place and pay for their Home Delivery Order before leaving your clinic.

- **Resend All Failed Pharmacy Orders** – will allow you to send Home Delivery orders that were not able to be uploaded at the time the Medical History order was generated.

- **Update VetCentric Prescriptions** – will poll the VetCentric site for any information on Home Delivery pharmacy orders filled, or any other status changes, and create AVImark Medical History entries accordingly.

- **Cancel Prescription** – will present you with a “Cancel Reason” window to enter the reason for cancellation. Once cancelled, the Medical History entry will display “Cancelled”.

When a VetCentric item is ordered through AVImark, specific information for that order will be included on the AVImark Invoice. This will allow the customer to take important material with them outlining details about the item ordered, as well as customer login information that will allow the customer to log into the VetCentric site and set up payment and delivery arrangements.
The AVImark line item on the invoice will be displayed as:

<table>
<thead>
<tr>
<th>Date</th>
<th>For</th>
<th>Qty</th>
<th>Description</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>11-02-09</td>
<td>Chary</td>
<td>1</td>
<td>Advantix Blue over 65 lbs Canine, 12 pk(VetCentric Order)</td>
<td>0.00</td>
</tr>
</tbody>
</table>

With a notation on the bottom of the Invoice stating:

NOTE: The AVImark client should have a valid email on file in the email field of the Client Information area for this feature. This email address will be assigned as the User ID for their VetCentric site access. If no email address was found in the AVImark Client area, the phone number will be used, and noted on the AVImark Invoice.
CHAPTER 16: ESTIMATES

In this chapter you will learn about...

» Set Up Your Estimates on page 225
» Create Estimates for Patients on page 228
» Save a Patient Estimate as a Canned Estimate on page 232
» Select a Canned Estimate for a Patient on page 232
» Print the Estimate on page 232
» Post an Estimate on page 234
» Customize Columns on page 234
» Sort the Estimate Entries on page 234
» Change Multiple Entries on page 234
» Preview Text in the Estimate List on page 235

Set Up Your Estimates
You may set up your estimate list by specifying estimate names along with the treatments, inventory items and/or diagnoses which make up each estimate. AVImark is delivered to you with a sample set of estimates which you may edit.

- On the CID, open the Work With menu. Click Estimates to display the Estimate List Maintenance window.
- In the Name section, right-click and from the shortcut menu click New to display the New Estimate window.
• Use the Name field to type the name for this estimate.

• In the Document field, use the Browse button and select the MS Word document from the Open window.

• Click OK to save the estimate.

Define the estimate details

• In the Estimate Detail area, right-click and from the shortcut menu click New to display the New Estimate Entry window.
Code
This will be the code of the treatment, item or diagnosis you wish to add to the estimate.

• Type the Code for the treatment, item or diagnosis you wish to add to the estimate.

Description
This will be the description of the treatment, item or diagnosis you wish to add to the estimate.

• Type part of the description to display a list of all treatments, items and/or diagnosis containing that portion of the description.
• Double-click on the correct code.

QTY
This field allows you to specify the appropriate quantity.

• Enter the appropriate quantity.

Repeat
You may add the number of times a patient should receive repeated treatments of an Estimate line-item. The line item will not be grayed out as being completed until all repeated treatments have been added. All Repeat treatments will need to remain unposted in order for the repeat count to be accurate.

• If appropriate, enter a quantity to repeat.

Total
AVImark lets you specify the price for a treatment or item on the estimate. To enter a price different than the normal item price, you must uncheck the Use Current Price box.

• Type the exact amount you wish to charge for the quantity of items specified, or select the Use Current Price box to charge the normal price of the item.

Variance
AVImark allows you to set a variance range by percentage, by dollar amount or by quantity.

• If appropriate, specify a variance. Use the drop down list to select By Percent, By Amount or By Quantity. If using By Percentage, enter the percent as a whole number.
• Click OK to add this item to the estimate detail for this estimate.

Use Estimate Maintenance List Shortcut Menu
Within the Estimate Maintenance List window there are other features found in the shortcut menu. Use the right-option to see the shortcut menu.

Add a duplicate estimate entry
AVImark allows you to add another entry, of the one selected, to the estimate.

• From your Estimate Maintenance window, under the Detail for area select the entry you wish to duplicate.
• Right-click and from the shortcut menu click Another to display a duplicate New Estimate Entry window.
• Make any changes necessary such as quantity, repeat, variance, etc and click Done.
Edit Changes

Use the Edit menu to select estimate entries or to undo or redo changes to an entry.

View

From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this estimate entry, Preview or Hide text associated with the estimate entry or you can choose how to sort the window. If you have customized the display by arranging and adding or removing columns you can print the display by using the Print option from the View menu.

Entry History

Use this option to view a history of changes made to the selected estimate entry.

- Select an entry and choose right-click View, Entry History.
- View date and time the change was made, the logged in user who made the change and a description of the change that was made.
- Click Done to close the window.

Move an entry from one estimate to another

If appropriate you may move the estimate entry to a different estimate.

- Select an entry and choose right-click Move.
- You will need to click Yes to confirm the move.
- Click the appropriate estimate name to move the entry to.

Choose

Use this option to add treatments, items, diagnosis or problems to the selected estimate.

- Select the appropriate estimate name and from the Detail for area select right-click Choose.
- Choose the desired list, select the desired entries and click Done to add them to the estimate.
- Repeat this process until the desired entries are associated with the estimate.

Enter estimate notes

You may enter notes regarding a specific estimate entry using all of the available AVImark note feature options.

- With the correct entry selected, right-click and from the shortcut menu click Notes to display the Notes window.
- Type the appropriate notes for this entry. All of the AVImark notes feature options are available in this window.
- Click Done to save the notes.

Create Estimates for Patients

When creating an estimate for a patient, you may choose one of the canned estimates either as is or you may modify it. You may also create and save a new one from the CID for the selected patient.

- With the correct patient displayed, select the Estimates folder tab.

AVImark allows you to customize the name of the Estimate tab as well as additional areas that reference the Estimates such as the Work With menu and the Canned and Patient Specific Estimate windows. This can be done from the Option Maintenance area of Hospital Setup.
Create a new estimate

- In the Estimate Folder, right-click and from the shortcut menu click **New** to display the New Estimate window.

- Use the **Name** field and type the name you wish to give the estimate.

- Using the **Doctor** drop down list, select the appropriate doctor.

- To select an estimate document for this patient, click the browse button in the Document field and select the correct document.

- If appropriate, use the **Expires In** field and enter the number of days when this Estimate will expire. The actual expiration date will be displayed after the **Expires On** field.

- When the estimate is created the created date will be displayed.

- When a Patient Estimate is created or chosen, the name of the user who is currently logged in will be displayed next to the **By** field.

- Click **OK**. The same window will be displayed, but an area for adding the Estimate line-items will now be available.
Select the treatments, items and/or diagnosis in the same manner as previously discussed in the topic, “Define the estimate details” on pa226215.

To make a change to an entry, double-click the entry to display the Change Patient Estimate Entry window.

Click OK to save the new patient estimate.

Use Patient Specific Estimate Shortcut Menu

Within the Estimate Maintenance List window there are other features found in the shortcut menu. Click the right mouse button (called right-click) to see the shortcut menu.
Edit Changes

Use the Edit menu to select estimate entries or to undo or redo changes to an entry.

View

From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this estimate entry, Preview or Hide text associated with the estimate entry or you can choose how to sort the window. If you have customized the display by arranging and adding or removing columns you can print the display by using the Print option from the View menu.

Entry History

Use this option to view a history of changes made to the selected estimate entry.

- Select an entry and choose right-click View, Entry History.
- View date and time the change was made, the logged in user who made the change and a description of the change that was made.
- Click Done to close the window.

Choose

Use this option to add treatments, items, diagnosis or problems to the selected estimate.

- Select right-click Choose in the Patient Estimate window.
- Choose the desired list, select the desired entries and click Done to add them to the estimate.
- Repeat this process until the desired entries are associated with the estimate.

Enter estimate notes

You may enter notes regarding a specific estimate entry using all of the available AVImark note feature options.

- In the Patient Estimate window, right-click and from the shortcut menu click Notes to display the Notes window.
- Type the appropriate notes for this entry. All of the AVImark notes feature options are available in this window.
- Click Done to save the notes.

Print

Use this menu option to print the Estimate document.

- Within the Patient Estimate window, right-click and from the shortcut menu click Print.

Decline

If an individual estimate entry has been declined by a client but you would like to keep record that the service was recommended, use the decline option to mark the entry as such.

- Select the appropriate entry, right-click and from the shortcut menu choose Decline.
- The entry will be added to medical history as declined and it will also be recorded in the estimate as declined.

Post

Use this menu option to post individual estimate entries to the patient’s medical history.
With the appropriate entry selected, right-click and from the shortcut menu click Post.
The entry will be posted to the patient’s medical history and will appear gray in the Patient Estimate window.

Select

Use this menu option for selecting multiple entries that need to be posted.

• Click on the desired entry and from the right-click shortcut menu choose Select.
• A separate window will appear displaying those entries you have selected. As you continue to select entries they will appear in this window.
• If so desired, click Post to post only the selected entries to the patients medical history.

Save a Patient Estimate as a Canned Estimate

AVImark lets you save an estimate that you have set up for an individual patient into the canned estimate list for future use.

• Select the correct estimate from the Estimates folder tab. Right-click and from the shortcut menu click Save.
• You will need to click Yes to proceed with saving the estimate.

Select a Canned Estimate for a Patient

You may choose a canned estimate for the patient from the Estimates Folder tab.

• From the Estimates Folder tab, right-click and from the shortcut menu click Choose to display the Estimate List Maintenance window.
• Select the appropriate estimate for the patient and click Done to place the estimate into the patient’s Estimate Folder.

Print the Estimate

• From the patient’s Estimates Folder tab, select the correct estimate. Right-click and from the shortcut menu click Print to display the Print Estimate window.

• Using the Copies field, enter the number of copies to print.
• Use the Print to drop down list to select the correct printer.
• Click Print to print the estimate or select Preview and click Print to view the Estimate document on
Print an estimate document other than the default Estimate document

AVImark allows you to print an estimate document of your choice.

- In the Document field, right-click and from the shortcut menu click Choose to display the Open window.
- Select the correct document and click Open.

Edit the estimate document

- In the Document field, right-click and from the shortcut menu click Change to display the document for editing.
- After the necessary changes have been made, click the X in the upper right hand corner of the document to save and close the document.

Enter notes on the estimate

You may enter notes for line items on an Estimate either from the Estimate List Maintenance window or from the Estimates Details window in the patient’s Estimates Folder.

- Select the correct estimate entry. Right-click and from the shortcut menu click Notes to display the Estimate Notes window.
- To have the notes print on the estimate document, select the Public box.
- Type the appropriate notes and click Done.

On the Estimate document AVImark will also print comments linked to a treatment. This can be done from the Option Maintenance area of Hospital Setup and setting the option Include Treatment Comments to True.

Decline an Estimate

You may decline individual services or items in an estimate or you may decline an entire estimate.

Decline an individual service or item

- From the patient’s Estimates Folder, double-click the correct estimate to display the Estimate Detail Window.
- With the correct service and/or item selected right-click and from the shortcut menu click Decline. This will automatically place the entry into Medical History as DECLINED.

Decline multiple services and/or items

- From the patient’s Estimates Folder, double left click the correct estimate to display the Estimate Details window.
- Select one of the entries to be declined. Use the SPACEBAR to bold the entry. You will do this for each entry that is to be declined.
- Right-click and from the shortcut menu click Decline to automatically post the entries to Medical History as DECLINED.

Decline the entire estimate

- From the patient’s Estimates Folder, select the correct estimate to be declined.
Post an Estimate
AVImark allows you to post an estimate for a patient into Medical History.

Post an individual service or item
- From the patient’s Estimates Folder, double-click the correct estimate to display the Estimate Details window.
- Select one of the entries to be posted. Use the SPACEBAR to bold the entry. You will do this for each entry that is to be posted.
- After all entries you wish to post have been bolded, click Post.

Post the entire estimate
- From the patient’s Estimates Folder, select the correct estimate to be posted.
- Right-click and from the shortcut menu click Post.
- You will need to click Yes to confirm and continue with posting the estimate.

Show Ghost
AVImark allows you to display estimates that have been previously posted to a patient’s medical history.
- From the patient’s Estimates Folder, right-click and from the shortcut menu click Show ghost.

Customize Columns
AVImark allows you to arrange, resize, and/or add and remove the columns in the Estimate List Maintenance window. For a detailed discussion on customizing columns, refer to “CHAPTER 32: CUSTOMIZING COLUMNS”.

Sort the Estimate Entries
You may sort the entries in the Estimate Detail section of the Estimate List Maintenance window.
- Left click on the Column Heading you wish to Sort. Each click on the Column Heading will sort the list in either ascending or descending order.

Change Multiple Entries
AVImark allows you to change multiple entries within the estimate.

Select multiple random entries
- In the Estimate detail section, select one of the entries.
- Hold down the CTRL key and click on additional, random entries.
- With the required entries highlighted right-click and from the shortcut menu click Change to display the Change Estimate Entry window.
- Make the necessary changes and click OK.

Select multiple consecutive entries
- In the Estimate detail section, select one of the entries.
- Hold the SHIFT key and use the UP and DOWN ARROW keys to select multiple consecutive entries.
- With the required entries highlighted right-click and from the shortcut menu click Change to display the Change Estimate Entry window.
• Make the necessary changes and click OK.

**Preview Text in the Estimate List**
You may display notes that are attached to treatments and items in the Estimate List maintenance window.

• In The Estimate List Maintenance window, open the View menu. Click Show/Hide Preview.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save estimates</td>
<td>Estimates tab</td>
</tr>
<tr>
<td>E-mail estimates</td>
<td>Emailing reports</td>
</tr>
<tr>
<td>Add Entries to the Estimate</td>
<td>Defining estimate detail</td>
</tr>
</tbody>
</table>
CHAPTER 17: APPOINTMENT CALENDAR

The AVImark Appointment Calendar is designed to show, in a “day-at-a-glance” format, your appointments for whichever doctor and treatment room you select. The appointments are shown on an Appointment “notebook” with the times listed down the left side.

In this chapter you will learn about...

» Displaying the Appointment Calendar on page 237  
» Setting up the Appointment Calendar on page 241  
» Making Appointments on page 241  
» Link Appointments on page 242  
» Grouping Appointments on page 243  
» Use the Appointment Openings Feature on page 243  
» Working with the Appointment Window on page 244  
» Appointments for New Clients on page 246  
» Appointments for New Patients on page 247  
» Working with “Stacked” Appointments on page 247  
» Locating an Appointment on page 247  
» Adding Appointment Notes on page 247  
» Recurring Appointments on page 247  
» Sizing Appointment Rows and Columns on page 249  
» Checking In an Appointment on page 249  
» Confirming an Appointment on page 249  
» Deleting an Appointment on page 249  
» Return to the CID on page 250  
» Scheduling Next Appointment on page 250  
» Moving Appointments on page 250  
» Rescheduling Appointments on page 251  
» Printing the Appointment Schedule on page 251  
» Out of Office Schedule on page 252  
» Creating Block-off Exceptions on page 255

Displaying the Appointment Calendar

The AVImark Appointment Calendar enables you to view appointments by day, week, or month and it lets you see potential conflicts easily.

• On the CID, open the Work with menu. Click Appointments to display the Appointment Calendar window.

Change day, week and/or month

Day tabs for each of the days in the current week are available at the bottom of the calendar. However, this is not true for the Weekly, By Room view.

• Select one of the Day Tabs to display that day’s appointments.

  
Monday | Tuesday | Wednesday | Thursday | Friday | Saturday | Sunday

• Use the red, week arrows to display appointments for a different week.

  
← Week →

• Use the red, month arrows to display appointments for another month.

  
← Month →

Work With the Activity Level Column

On the right side of the Appointment Calendar is the Scheduled Activity Level column. The column displays a date column for each date in the current month and an activity column which acts as a sort of barometer to show how busy you are for each of the days.

• Click Refresh at the bottom of the column to reflect the current appointments.

• Select any day in the date column to display the appointments for that day.
Set Up the Start Time and Appointment Increments

The setup for your daily start time and appointment increment will need to be defined from the Advanced Options area of Hospital Setup.

Toolbar buttons

- Make a new appointment for the selected client, patient, doctor, facility and day.
- Print the appointment schedule for the selected doctor and day.
- Go to today’s date on the calendar.
- View the next or previous appointment opening.
- View the appointment navigator to work with appointments in the future.
- Make appointment notes for an existing appointment.
- Delete the selected appointment.
- Expand the calendar display or use the Activity Column.
- Lock or unlock the moving of appointments on the calendar.

The View menu

Using the View menu, you will be able to select the way the AVImark Appointment Calendar is displayed.

- Ghosts
  This option allows you to preview appointments that have previously been marked as No Shows, deleted as having been Cancelled and/or Kept.
○ Daily, Consolidated

Places the selected day’s appointments for all doctors in all facilities in a stacked manner.

○ Daily, by doctor

This option will show the appointments for all doctors for a specific day.
Appointment Calendar

- **Daily, by room**
  This option will show the appointments for all facilities for a specific day.

- **Weekly, by room**
  This option will show the appointments for an entire week for each facility. Appointments will be displayed as colored blocks dependent upon the doctor for whom each appointment is made.

- **Appointment List**
  This allows you to display a list of all appointments and/or ghost for a certain time frame. This may be restricted to specific doctors as well.

**Customize columns in the Appointment List**

You may arrange the columns in the appointment list in the order you would like them to appear. For a detailed discussion on customizing columns, refer to “CHAPTER 32: CUSTOMIZING COLUMNS”.
Sort the Appointment List

You may sort entries under each heading in the Appointment List window.

- Click the heading you wish to sort. Each click will sort the list in either ascending or descending order.

Preview text in the Appointment List

You may display notes attached to a patient’s appointment.

- From the Appointment List window, right-click and from the shortcut menu point to View and click Preview Text to display the Columns window.
- Select the Show Preview Text option.
- Click Notes and then click OK.

Use the Working With menu

At the top right corner of the display, AVImark displays the current working client and patient’s names.

- Click the button just to the right of the patient’s name to display a list of clients and patients you have been working with at this workstation.
- To select another patient belonging to this client, click Next Patient to display the Choose Patient window.

- Select the correct patient and click Done.

Setting up the Appointment Calendar

The AVImark Appointment Calendar has many options to make your individual preferences adaptable to the style of appointment handling best suited for your clinic. To set up the Appointment Calendar you will need to access the Advanced Options area of Hospital Setup.

Making Appointments

AVImark allows you to make appointments from the CID or from the Appointment Calendar.
From the CID

• With the correct patient displayed on the CID, open the Work with menu and click Appointments.

From the Calendar

• Right-click and from the shortcut menu click Choose to display the Client Selection window.
• Type the client information and click Continue to display the Choose Patient window.
• Select the correct patient and click Done.

Select the Appointment Date

AVImark gives you several options for selecting the correct appointment date.

• Choose the correct date by selecting the Day tab at the bottom of the calendar.

OR

• Use the Weekly, By Room view with the calendar expanded to see any day of the current week.

OR

• Appointments being made during the current month, select the correct day from the Activity column.

OR

• Use the Appointment Navigator by selecting the button to display the Calendar Navigator window.

Select the Appointment Time

• Select the row which displays the correct appointment time.
• Right-click and from the shortcut menu click New to display the New Appointment window.

Link Appointments

AVImark gives you the ability to link appointments for clients who own multiple patients as well as patients associated to a client using the Client/Patient Relations feature. You can now have appointments that are created for the same date, time, and room linked together to indicate that they all belong to or are associated to the same client. Once the appointment(s) are saved, all linked appointments will be listed/stacked with an icon indicating that they are linked. The L icon for the initial appointment created will be displayed in RED indicating that there are linked appointments to this original appointment. All linked appointments will display a BLUE L icon. Creating linked appointments will also allow a prompt to be displayed if changes made to one appoint-
Create the first appointment as discussed in the topic, “Make Appointments” on page 22831.

With the new appointment selected on the Appointment Calendar, right-click and from the shortcut menu click New Linked Appointment to display the Selected Patients window.

On the Selected Patients window, select the patient from the list you wish to link to the originally created appointment.

Use the SPACEBAR to place the patient into the Selected area and click Done to display the New Appointment window.

**Grouping Appointments**

When in the Daily by Doctor view you will be able to display the Doctor columns by user-defined groups. First the appointment groups must be created.

From the CID Work with menu select System Tables.

Highlight the Appointment Groups category and under the Entries section select New from the right-click shortcut menu.

Enter a Code and enter the group name in the Description field.

Click OK to add the group.

Continue to add the number of necessary groups and click Done to close System Tables.

Next the appointment groups will need to be associated with the appropriate staff members.

From the CID Work with menu select Users & Security.

Select the appropriate user group and staff member.

Right-click Change from the shortcut menu to open the Change User window.

Click on the Group drop-down list to select the appropriate appointment group for this user. A group will need to linked for each appropriate doctor or staff member that appears in the Daily, by Doctor view.

Click Ok to save your changes.

After the groups have been created and assigned to users appointments can be viewed by doctor groups.

In the Appointment Calendar you must be in the Daily, by Doctor view.

In the second drop-down field change the view from All to the desired appointment group. Only doctors within the selected group will be displayed.

**Use the Appointment Openings Feature**

AVImark can assist you in selecting a date and time for the appointment by using the button which will take you to the first available appointment within each time period or by using Appointment Openings feature.

On the calendar, open the View menu and click Openings to display the Appointment Openings window.

On the Appointment Openings window, you will notice the default date range from the current date through the first day of the month after next. If appropriate, use the drop-down calendar to select the date range you wish.

Use the drop-down menus and select the appropriate Doctor and Room.

If appropriate, use the button to select the Minimal Duration of the opening.
• Select the appropriate opening line and click **Done** to be returned to the Appointment Calendar for the period selected.

**Print the Appointment Openings report**

• On the Appointment Openings window, open the **File** menu and click **Print** to display the Print Appointment Openings window.
• Specify the **Date range**, **Doctor**, **Room** and **Minimum Duration** using the appropriate drop-down lists.
• Click **Print** or to preview the report onscreen, click **Preview**.

**Email the Appointment Openings report**

• On the Print Appointment Openings window, click **Preview** to display the Report Preview.
• Open the **File** menu and click **Email**.
• Enter the email address, the desired subject and text and click **Send**.

**Save the Appointment Openings report**

• On the Print Appointment Openings window, click **Preview** to display the Report Preview.
• Open the **File** menu and click **Save As**. The report can be saved as a PDF, HTML, RTF, TXT or NDR file.

**Exporting the Appointment Openings Report to Excel®**

• On the Print Appointment Openings window, use the **Print To** drop-down list and select **Excel®**.
• Click **Print** to display the report in Excel® format.

**Working with the Appointment Window**

Whether making a new appointment or changing values for an already existing appointment, the method for doing so will be the same.

• On the Appointment Calendar, open the **Appointment** menu and click either **New** or **Change** to display the New/Change Appointment window.
• The New Appointment window will display the current client and patient as well as the default doctor if one had been selected. To choose a different doctor, use the **Doctor** drop-down list and select the correct doctor.

**Select the Correct Room**

• If appropriate, use the **Room** drop-down list and select the correct room.

**Choose Treatments, Items, Diagnosis and/or Problems for the appointment**

You may select one or more treatments, inventory items diagnosis or problems to be scheduled for the appointment.

• In the TX, Items, DX and Problems area, **right-click** and from the shortcut menu point to **Choose** and click **Treatments, Inventory, Diagnosis and/or Problems** to display the appropriate list.
• Select the correct service or item and click **Done** to return to the New/Change Appointment window.

**Type**

The Type area can be used to customize the display color of the appointment by associating an appropriate type. For example you can choose whether it is an examination, surgery or vaccination appointment and assign a
color. These types can be defined in System Tables or directly from the New Appointment window.

- Click on the **Type** drop-down list to choose an appropriate type. The appointment will appear in the associated color.

OR

- Click on the **Page Plus Symbol** icon to create a type.
- Enter a **Code** and **Description** then choose the custom **Color**.
- Click **OK** to add the new type and have AVImark automatically select it for this appointment.

### Reminders

Reminders for the selected patient will be displayed in the New/Change window. You may also view those reminders which are coming due or are past due within 60 days of the appointment date.

- In the Reminders area, **right-click** and from the shortcut menu click **All Due 60 days**. This will place those reminders due in the **Treatments and Items** area.

### Make the next patient’s appointment

AVImark lets you make an appointment for other patients belonging to the client without leaving the New/Change Appointment window.

- Click the **Next Patient** button to display the Choose Patient window.
- Select the correct patient and click **Done** to return to the New/Change Appointment window.
- Click **Done** once all appointment information has been added or click **Remove** to remove the appointment.
Appointments for New Clients

AVImark allows you to quickly make an appointment for a potential client, without having to create a complete client/patient file. Use this feature to avoid unnecessary phone time and cluttering your files with first time, no shows whose files must then be deleted.

- On the Appointment Calendar, select the correct date, doctor, and time as you normally would for an appointment.
- Right-click and from the shortcut menu click New to display the New Appointment window.
- Click New Client. This will place your cursor in the Client field to allow you to enter the client’s name, phone, patient name, and species.
- Once all appointment information has been entered click Done. The new client’s appointment will display on the calendar with a New, Sunrise image.
- When the client arrives for their appointment, select their appointment on the calendar.
- Right-click and from the shortcut menu click Check-in.
- You will need to click Yes to confirm and display the New Client Information window.
- Enter the client information and click Done.
**Appointments for New Patients**
You are able to make an appointment for a new patient from the New Appointment window. This may be helpful when you would like to make an appointment for a new patient belonging to the selected client.

- On the Appointment Calendar, select the correct **date**, **doctor**, and **time** as you normally would for an appointment.
- **Right-click** and from the shortcut menu click **New** to display the New Appointment window.
- Click **New Patient** and enter the patient’s name and appropriate species.
- Click **Done** to return to the Appointment Calendar.

OR

- On the Appointment Calendar, select the correct **date**, **doctor**, and **time** as you normally would for an appointment.
- Select the **Working with Menu Arrow** at the top right corner of the calendar.
- Click **Next patient** to display the Choose Patient window.
- Select **new patient** and click **Done**.
- You will need to click **OK** to confirm adding a new patient.
- Enter the patient’s name and appropriate species and click **Done**.

**Working with “Stacked” Appointments**
There may be times when you wish to schedule more than one appointment for the same doctor at the same time or multiple appointments in the same room by different doctors. Depending upon the **view** that you have chosen to use, these concurrent appointments will be displayed as **stacked**, one upon the other.

- Select the appointment that is currently being displayed. **Right-click** and from the shortcut menu click **Bring To Front** to rotate through the other appointments.

**Locating an Appointment**
- With the correct patient selected on the CID, click the button to display the patient’s appointment on the calendar.

**Adding Appointment Notes**
You may specify unlimited notes for any appointment that has been added to the Appointment Calendar.

- With the correct appointment selected, **right-click** and from the shortcut menu click **Notes** to display the Appointment notes window.
- Type the appropriate notes for the appointment and click **Done**. You may use any of the AVImark notes features.

**Recurring Appointments**
AVImark allows you to recreate identical appointments on several different days along with all of the appropriate treatments and notes. In addition, you may wish to use a Pattern Option.

- With the correct appointment selected, **right-click** and from the shortcut menu click **Recurring Appointments** to display the Recurring Appointments window.
Select the appropriate day(s) from the calendar to Propagate to those dates and click **Done**.

**The Pattern Option**

- Click **Pattern** for recurring appointments that are Daily, Weekly, Monthly, or Yearly. All Pattern options must have the number of occurrences specified and an ending date of the last occurrence.

**Daily option**

- **Every 1 day(s)** - Specify how many days should pass before the appointment should recur for the number of occurrences specified.
- **Every Weekday** - Select the week day the appointment will be scheduled for the number of occurrences specified.

**Weekly option**

- **Recur Every 1 Week(s) on** - Specify how many weeks should pass before the next appointment occurs for the number of occurrences specified.
○ **Week day option** - Select the day of the week you want the appointment to recur for the number of occurrences specified.

*Monthly option*

○ **Day 1 of every 3 month(s)** - Specify the day of the month and then number of months that should pass before the appointment recurs.

○ **The First Sunday of every 1 month** - Select the First, Second, Third, Fourth, or Fifth Sunday through Saturday of the month and the number of months that should pass before the appointment recurs.

*Yearly option*

○ **Every January 1** - Specify the day of the year the appointment should recur.

○ **The First Sunday of January** - Select the First, Second, Third, Fourth, or Fifth Sunday through Saturday of a selected month the appointment should recur.

**Sizing Appointment Rows and Columns**

AVImark lets you enlarge the vertical space that an appointment row occupies, as well as the horizontal space that an appointment column occupies. This feature works in the Daily views of the calendar, not the Weekly, by room view.

**Appointment rows**

- Place the mouse pointer on the line below the time increment, in the time column.
- When the pointer becomes a double line, hold the left mouse button and move the line downward to enlarge the area the row occupies.

**Appointment columns**

- Place the mouse pointer on the line between the column headings at the top of the calendar display.
- When the pointer becomes a double line, hold the left mouse button and move the line left or right to re-size the column.

**Checking In an Appointment**

When an appointment is kept, you are able to remove the appointment from the calendar display and at the same time post any treatments selected for the appointment into the Medical History Area of the patient. Once the patient has been checked in they will appear on the Checked in tab of the Whiteboard. Any services attached to the appointment can be added to the Schedule tab of Whiteboard at the time of check in.

- Select the correct Appointment Reservation from the patient’s Schedule Folder tab.
- **Right-click** and from the shortcut menu click **Check-in**.

**Confirming an Appointment**

AVImark allows you to document the fact that you confirmed appointment dates and times with clients.

- With the correct appointment selected **right-click** and from the shortcut menu click **Change** to display the Change Appointment window.
- Select **Unconfirmed**, **Confirmed**, or **Left Message** and click **Done**.

**Deleting an Appointment**

- With the correct appointment selected **right-click** and from the shortcut menu click **Remove** to display the Remove Appointment window.
AVImark User Manual
Appointment Calendar

- Select the appropriate option and click Done.

Return to the CID
AVImark allows you to return to the CID for the selected patient from the Appointment Calendar.

- Right-click and from the shortcut menu click Patient.

Scheduling Next Appointment
Remembering to schedule the next or a follow-up appointment for a patient before that client and patient leaves is often difficult. To prevent this from happening or to assist in this situation there is a Hospital Setup option that will prompt for creating the next appointment.

- From the CID Hospital Setup Advanced Options Maintenance window search for Schedule Next Appointment Prompt.
- Setting the value to Check Out, CID Posting, Taking Payment or Closing Invoice will cause a prompt to be displayed at the selected timing asking if you wish to create the next appointment.
- Selecting Yes to the message will display the Appointment Calendar allowing a new appointment to be made.

Moving Appointments
AVImark allows you to move existing appointments to another time and date using either the drag-and-drop method or manually changing the date and time.

Drag-and-Drop method

- Place your cursor on the appointment to be moved.
- Holding the left mouse button down, drag the appointment to the new time and then release it.

Manual date and time change
You may change an appointment time and date from either the Appointment Calendar or the CID.

- From the Appointment Calendar, select the correct appointment.
- Right-click and from the shortcut menu click Change to display the Change Appointment window.
- Make the appropriate changes and click Done.
  OR
- On the CID, select the Schedule Folder tab.
• Double click on the correct appointment to display the Change Appointment window.
• Make the appropriate changes and click **Done**.

**Quick Edit window**

When using the Weekly, By Room view, AVImark allows you to manually change information.

• On the Appointment Calendar, select the correct appointment.
• **Right-click** and from the shortcut menu click **Quick Edit** to display the Active Appointment window.
• Make the appropriate changes and click **Apply**.

**Rescheduling Appointments**

• On the Appointment Calendar, select the correct appointment.
• **Right-click** and from the shortcut menu click **Reschedule Appointment**.
• With the desired date and time selected, **right-click** and from the shortcut menu click **Reschedule**.
• Make any necessary changes on the New Appointment window and click **Done**.

**Printing the Appointment Schedule**

• On the Appointment Calendar, open the **Print** menu and click **Print Appointments** to display the Printing Appointments window.

• Using the drop-down lists, select the correct **Doctor**, **Facility** and **Printer**.
• Select **Print Ghosts** to include kept, rescheduled, removed, cancelled and late appointments on the printed schedule.
• Select the corresponding boxes for the items you wish to print.
• If appropriate, double click in the Document name field to display the Open window.
• Select the appropriate document.
• Click **Print**, or to preview the schedule on screen select the **Preview** check box and click **Print**.
Email the Appointment Schedule

- From the Report Preview, open the File menu and click Email.
- Enter the email address, the desired subject and text and click Send.

Save the Appointment Schedule report

- From the Report Preview, open the File menu and click Save as. The report can be saved as a PDF, HTML, RTF, TXT or NDR file.

Export the Appointment Schedule report to Excel®

- From the Printing Appointments window, use the Print To drop-down list and select Excel® and click Print.

Out of Office Schedule

AVImark lets you specify a schedule of days and times for each staff person who plans to be out of the hospital. This will block off that portion of the Appointment Calendar display in a de-highlighted color appropriate for that provider to indicate appointments should not be made for those times.

- On the Appointment Calendar, open the Out of Office menu and click Schedule to display the Block-offs window.
- AVImark will display all scheduled block-offs and the Exceptions will appear at the bottom of the window.
- Use the Doctor drop-down list and select the staff member you are working with. Selecting (all) will apply for each staff member.
- From the right-click shortcut menu in the Blockoffs window click New to display the New Block-Off window.
• In the **From** and **To** fields, use the up and down arrows to choose the time period.

• Using the **Start** and **End** drop-down calendar, select the **Start** and **End** dates.

• Type the **Reason** for the block-Off.

• If you did not previously choose a staff member and it is necessary to select one now simply click on the **Doctor** drop-down to select the doctor or staff member or leave it set to (all) to apply the block-off to everyone.

• If the block-off applies to a specific room or facility click on the **Room** drop-down and choose the appropriate room.

• The **Type** area can be used to customize the display color of the block-off by associating an appropriate type. For example you can choose whether it is a meeting, vacation days, lunch block-off, etc. These types can be defined in System Tables or directly from the New Blockoff window.
  
  o Click on the **Type** drop-down list to choose an appropriate type. The block-off will appear in the associated color.

  OR

  o Click on the **Page Plus Symbol** icon to create a type.

  o Enter a **Code** and **Description** then choose the custom **Color**.

  o Click **OK** to add the new type and have AVImark automatically select it for this block-off.

**Apply weekly**

• If appropriate, select the **Apply weekly** option.

• Select the appropriate days of the week that the times specified apply to and click **Done**.

**Apply monthly**

In addition to out-of-office days and times that you have applied weekly, you are also able to add and apply other out-of-office schedules on a monthly basis.

• If appropriate, select the **Apply monthly** option.

• Select the days of the week for each week of the month and click **Done**.
The first week column will represent the first week in the month (Sunday through Saturday), even if there is only one day in the first week.

**Print Block-off Report**

A block-off report can be printed and it will list each doctor’s block-offs.

- In the Blockoffs window choose **File, Print** from the menu.
- Click **Print** to print the report or select **Preview** to view the report on screen.

**Block-Off notes**

AVImark lets you enter notes relating to any block-off on the appointment calendar. This is done from the calendar, not from the block-off setup window.

- On the Appointment Calendar, select the correct block-off.
- Right-click and from the shortcut menu click **Notes** to display the Notes window.

**Daily (ad hoc) block-offs**

You may block off days and times on an ad hoc basis from the appointment calendar. When using the Weekly, By Room view, you will see a status bar at the bottom of the calendar indicating the reason for the block-off.

- Select the correct date and time you wish to add the block-off for.
- Open the **Out-of-Office** menu and click **New Block-off** or right-click and from the shortcut menu click **New Block-Off** to display the Daily Block-Off window.
- In the From and To fields, use the up and down arrows to choose the time period.
- Type the **Reason** for the block-off and, if appropriate, use the drop-down lists to select the **Doctor** and/or **Room**.
• The **Type** area can be used to customize the display color of the block-off by associating an appropriate type. For example you can choose whether it is a meeting, vacation days, lunch block-off, etc. These types can be defined in System Tables or directly from the New Blockoff window.
  
  o Click on the **Type** drop-down list to choose an appropriate type.
  The block-off will appear in the associated color.
  
  OR
  
  o Click on the **Page Plus Symbol** icon to create a type.
  o Enter a **Code** and **Description** then choose the custom **Color**.
  o Click **OK** to add the new type and have AVImark automatically select it for this block-off.

• Use the calendar to select the other days this block-off applies to for this month.

• If appropriate, use the **Month Arrows** to apply this block-off to other months.

• If appropriate, select **Block-off is an alert** to display any notes previously entered for the block-off and click **Done**.

**Creating Block-off Exceptions**

Instead of removing the entire scheduled block-off, exceptions can be made for that staff member and room. Exceptions can be made directly from the calendar or in the Blockoffs window.

• Highlight the scheduled block-off in the Appointment Calendar, **right-click** and from the shortcut menu select **Remove**.

• In the **New Block-off Exception** window select the **Date**, **User** and **Room** the exception is for.

• Click **OK**. The block-off will be removed for only the time period specified and for only that doctor and room on the selected day.

OR

• From the Calendar menu select **Out-of-Office, Schedule**.

• Under the Blockoff Exceptions area of the Blockoffs window, **right-click** and from the shortcut menu select **New**.

• In the **New Block-off Exception** window select the Date, User and Room. Click **OK**.

• Multiple exceptions can be made for the selected block-off.

• Click **OK** on the Exceptions window after the exceptions have been created.
<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out of Office Schedule</td>
<td>Out of office</td>
</tr>
<tr>
<td>Daily Block-offs</td>
<td></td>
</tr>
<tr>
<td>Block-off Alerts</td>
<td></td>
</tr>
<tr>
<td>Block-off Notes</td>
<td></td>
</tr>
<tr>
<td>Block-off Exceptions</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 18: BOARDING CALENDAR

AVImark allows you to define your boarding and hospitalization facilities with regards to the number of occupants, species, weight range, boarding charges per weight range and whether you charge by day or by night with or without a check-out time. AVImark also lets you organize your different boarding facilities into “Facility Groups” which have similar capacity, function and charging rate characteristics. You may define unlimited Facility Groups and unlimited facilities in each group. Facilities and patient reservations are displayed on one screen and you have the ability to move patients as well as reservations from cage to cage. Facilities may be reserved for a patient for later check-in or patients may be checked-in to a facility as soon as they arrive. Once the patient is checked in they will appear in the Whiteboard. Services for checked-in patients may be added, viewed, printed, and posted to Medical History from the Whiteboard Schedule tab.

<table>
<thead>
<tr>
<th>In this chapter you will learn about...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charge for Boarding on page 257</td>
</tr>
<tr>
<td>Change Boarding Calendar Views on page 258</td>
</tr>
<tr>
<td>Add and Define Facility Groups on page 259</td>
</tr>
<tr>
<td>Add New Facilities on page 261</td>
</tr>
<tr>
<td>Make and/or Change a Reservation on page 261</td>
</tr>
<tr>
<td>Make a Reservation using the CSD on page 262</td>
</tr>
<tr>
<td>Make a Reservation for a New Patient on page 262</td>
</tr>
<tr>
<td>Work with the New Reservation Window on page 263</td>
</tr>
<tr>
<td>Check-In with a Reservation on page 264</td>
</tr>
<tr>
<td>Check-in an Out-Patient on page 265</td>
</tr>
<tr>
<td>Add Services to a Check-In on page 265</td>
</tr>
<tr>
<td>Change a Check-In on page 265</td>
</tr>
<tr>
<td>Delete a Reservation or Check-In on page 266</td>
</tr>
<tr>
<td>Check-Out on page 266</td>
</tr>
</tbody>
</table>

Charge for Boarding

AVImark needs to know whether you charge clients for boarding according to overnight stay or by day with or without a check-out time. You will need to specify how you will charge for boarding in Hospital Setup, Advanced Tab, Boarding. In addition, it is assumed that you have certain treatments in your Treatment List set up for boarding charges at different weight ranges with a price defined for each service; for example, “Boarding, less than 25 lbs” or “Board per day, 30-50 lbs”. AVImark gives you several options with regards to boarding charges.

Charging by overnight stay without a checkout time specified

If you charge by overnight stay WITHOUT a check out time specified, AVImark will simply add a boarding charge for every night the patient spends in the facility. If the patient is checked out before the end of the first day, AVImark will not charge for the stay.

Charging by overnight stay with a checkout time

If the patient is checked into a facility BEFORE the check out time and checked out BEFORE the check-out time on the SAME day, AVImark will not charge for the visit. If the patient is checked into a facility BEFORE the check out time and checked out at least an hour AFTER the check out time on the SAME day, AVImark will charge ½ of the normal boarding charge. If the patient is checked into a facility at any time on one day and checked out prior to an hour AFTER the check-out time on the NEXT day, AVImark will charge the normal boarding Charge. If the patient is checked into a facility at any time on one day and checked out at least an hour AFTER the check out time on the NEXT day, AVImark will charge 1 ½ times the normal Boarding charge.

Charging by overnight stay with a checkout time like a hotel

If the patient is checked into a facility BEFORE the check out time and checked out within an hour AFTER the
check out time on the SAME day, AVImark will not charge the client. If the patient is checked into a facility BEFORE the check out time and checked out at least 1 hour AFTER the check out time on the SAME day, AVImark will charge \( \frac{1}{2} \) the normal boarding charge. If the patient is checked into a facility at any time on one day and checked out prior to 1 hour AFTER the check out time on the NEXT day, AVImark will charge the normal boarding charge. If the patient is checked into a facility at any time on one day and checked out at least 1 hour AFTER the check out time on the NEXT day, AVImark will charge 2 times the normal boarding charge.

**Charging by day with checkout time**

If the patient is checked into a facility BEFORE the check out time and checked out prior to 1 hour AFTER the check out time on the SAME day, AVImark will add \( \frac{1}{2} \) the boarding charge. If the patient is checked into a facility BEFORE the check out time and checked out at least 1 hour AFTER the check out time on the SAME day, AVImark will add a boarding charge. If the patient is checked in on one day and out on the next day prior to 1 hour AFTER check out time, AVImark will add 1 \( \frac{1}{2} \) the boarding charges. If the patient is checked in on one day and out on the next day at least 1 hour AFTER check out time, AVImark will add 2 boarding charges.

**Weight-based pricing**

If you intend to use the AVImark Weight-based pricing feature to handle different rates for different weight ranges, you should only have one boarding service in your Treatment List. Adjust the Weight Percentage in such a way as to charge an appropriate amount for each patient weight.

**Change Boarding Calendar Views**

- AVImark gives you various ways of changing the appearance of the Boarding Calendar. From the Boarding Calendar, open the View menu.

**Ghosts**

Selecting the Ghosts view will allow you to see all past reservations (in gray) and how they have been classified: Kept, Canceled, or No Show. If a given reservation was deleted, it will not be displayed as a “ghost”.

**Patient names**

Selecting the Patient names view, AVImark will include the patient’s name in the reservation bar on the calendar.

**Choose facility**

This option allows you to locate an appropriate facility for the patient being boarded. AVImark will locate the first appropriate facility according to the way you have defined each Facility Group. For instance, if you came to the Boarding Calendar from the CID of an 80 lb. canine, AVImark will automatically move the cursor to the top-most facility for a canine of this weight. However, if you have moved the cursor around on the display to other facilities and/or facility groups, selecting “Choose facility” will always move the cursor back to an appropriate facility for this patient.

**Find next**

This option allows you to quickly move to the next scheduled reservation for the selected patient. If there is no other reservation made for that patient, AVImark will move to the next reservation for another patient belonging to the same client.

**Go to date/F10**

This option allows you to move quickly to another date. Each time you open the “Go to date” window it will default to the current date, allowing you to quickly return to that day’s schedule.
Refresh

The Refresh option is used to update the boarding information currently displayed in the window. Refreshing the Boarding Calendar prior to creating a new reservation ensures you are viewing the most current changes made by other staff members on other workstations to prevent overbooking. The AVImark program automatically updates or refreshes every five seconds. However, if you and another staff member are creating reservations at the same time, it is possible that the information entered on the other workstation may not be displayed quickly enough for you to notice it.

Toggle CID/Boarding

This feature will allow you to toggle back and forth between the Boarding Calendar and the patient’s CID.

1 Week, 2 Weeks, 3 Weeks

AVImark allows you to set the default display of the Boarding Calendar as 1, 2, or 3 weeks at-a-glance.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boarding Treatments with Prices</td>
<td>Facility groups; Boarding facilities</td>
</tr>
<tr>
<td>Boarding Calendar Options</td>
<td>Appointments tab</td>
</tr>
</tbody>
</table>

Add and Define Facility Groups

You will define your Facility Groups and set up the individual facilities of each group (cages, pens, runs, and so on) from the Boarding Calendar itself. Facilities added under each Facility Group will obey the definition defined for that facility group. For example, if you define a certain Facility Group as receiving only Canine patients, the automatic scheduling feature of AVImark will not automatically assign a Feline to any facility of this group. Likewise, if an “Occupancy” value for a Facility Group is set to 2, once all the facilities of this type are full, the automatic scheduling feature will try to assign a patient to another facility group. Of course you may over-ride this automatic scheduling manually by moving the patient’s reservation to one of your choice. Charges assessed when patients are checked in and out of a facility will obey whatever definition has been made for the Facility Group it belongs to.

- On the Boarding Calendar, open the **Work With** menu. Click **Facilities** to display the Facility List window.
• Point in the Facility Groups section. **Right-click** and from the shortcut menu click **New** to display the Change Facility Category window. You may use the TAB key to move from one field to another.

![New Facility Category window](image)

**Name**

• Type a **Name** for the new Facility Group.

**Description**

• Type a **descriptive** name for the Facility Group.

**Min/Max**

• Specify a **Min** and **Max** weight range for the Facility Group by using the UP and DOWN ARROWS.

**Occupancy**

• Using the UP and DOWN ARROWS, enter the maximum number of occupants this type facility will normally handle.

**Species**

• Type in one of the species names which will use this Facility Group.

**Weight**

When entering the weight, it is important that you assign weight ranges from the least to the greatest with the minimum weight being at the top of the list and the heaviest at the bottom. For example, if one of your boarding services were something like, “Boarding, less than 20 lbs.”, you would put it on the top line. The next line might be for a service called, “Boarding, 21-40 lbs.” and the third line might be “Boarding, 41-60 lbs.”, and so on.

*If you intend to use the AVImark weight-based pricing feature to handle different rates for different weight ranges, you should only have one boarding service in your Treatment List for each species.*
• Type the **Weight** for this entry. Enter as a whole number without specifying a unit of measure.

**Boarding, Hospitalization, Other**

You may add a different code for those patients who are *Boarding*, being *Hospitalized*, or *Other*. This will allow you to use different charges for different types of reservations. The user may select the type of reservation needed when the patient is checked into the Boarding Calendar. When a Check-in is attempted, a sub-list will appear with the options of *Boarding, Hospitalization*, and *Other*.

• Enter the Treatment Code for the weight range as specified in your Treatment List.
• When finished entering species, weight and boarding codes appropriate for this Facility Group, click **Done**.

**Add New Facilities**

For each Facility Group, you may add as many facilities into the Facility List section of the display as you wish.

• With the appropriate Facility Group selected, point in the **Facility List** section.
• **Right-click** and from the shortcut menu, click **New** to display the New Facility window.
• Type a **Name** and **Description** for the new facility.
• If appropriate, use the **Category** drop-down list to change the category and click **OK**.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boarding Facilities</td>
<td>Adding / Changing Facility Groups</td>
</tr>
</tbody>
</table>

**Make and/or Change a Reservation**

When a client calls to make an appointment for boarding, you will need to know which facilities are available. AVImark will help you by assigning the patient to the first available facility as set for its species and weight range in your Facility Group definitions.

**Make a reservation**

• With the correct patient selected on the CID, open the **Work with** menu. Click **Boarding Calendar** to display the Boarding Calendar with the client and patient’s names listed at the bottom right corner of the display.
• The cursor will be placed in a facility that is appropriate for the patient. If necessary, click another facility line in the date column for the day the client intends to bring the patient in.
• **Right-click** and from the shortcut menu, click **New** to display the New Reservation window.

<table>
<thead>
<tr>
<th><img src="images/New_Facility.png" alt="" /></th>
</tr>
</thead>
</table>
| **Name**
| **Description**
| **Category** Canine Only - > 30 lbs |

**Change a reservation**

• On the Boarding Calendar, click on an existing reservation to display the Reservation window.
• Make the appropriate changes and click **Apply**.
OR

• On the CID, click the Schedule Folder tab to display the Board Reservation entry.

• Double-click the correct board reservation entry to display the Reservation window.

• Make the appropriate changes and click Apply.

Make a Reservation using the CSD
AVImark allows you to make a boarding reservation from the Client Selection Display.

• On the Boarding Calendar, select an appropriate facility and reservation date.

• Use the ESC key to display the CSD.

• In the Patient field, type the name of the patient and click Continue.

• Double-click the correct client/patient from the list to display the Boarding Calendar and make the reservation for the selected date.

Make a Reservation for a New Patient
AVImark allows you to make boarding reservations for new patients not yet entered in your database. You will be able to set up information about the new patient prior to the visit and when the patient is checked in they will automatically be added. In addition, you may also set up information pertaining to a new client in the same fashion.

• On the Reservation window, click New Patient and/or New Client to display the New Client/Patient Information window.

• Enter the appropriate information and click Done to place the reservation on the calendar.
Work with the New Reservation Window
AVImark lets you work with a window that displays available vacancies for any date range. This window is useful for making future reservations when it is necessary that you know more information about which facility might be the most appropriate for a given patient. Furthermore, this window lets you view information about facilities without paging up and down through the calendar.

- On the Boarding Calendar, open the View menu. Click Choose Facility to display the New Reservation window.

In date/Out date/Duration
These fields are used to set the beginning and ending date of the reservation, as well as the duration of boarding. When you set an “In Date” and the “Duration”, AVImark will automatically enter the “Out Date” for you.

- Using the drop-down calendar, select the In Date.
- Using the drop-down calendar select the Out Date, or simply enter the number of days in the Duration field.

Client
This field indicates the current client displayed on the CID. AVImark automatically enters this information for you.
Patient
This field is the current selected patient. AVImark automatically enters this information for you.

Species
This field identifies the species of the current selected patient. AVImark automatically enters this information for you.

Weight
This is the present weight of the selected patient. AVImark will automatically enter this information for you.

Choose
AVImark allows you to select a different client/patient to make a reservation for. When using this option, the CSD will be displayed allowing you to select a client/patient.

- If appropriate, click Choose to make a reservation for another client/patient.

Next Patient
This option allows you to select a different patient belonging to the selected client.

- If appropriate, click Next Patient to display the Choose Patient window.
- Select the correct patient and click Done.

Add
This field will allow you to add a reservation to the Boarding Calendar.

- If appropriate, click Add to place a reservation on the calendar.

Choose Facility
The Choose Facility Tab allows you to view and/or choose an appropriate facility Category for the reservation.

- Select the appropriate facility Category.

Choose Day
The Choose Day Tab allows you to view the number of vacancies available for any day for each facility type. In addition, you may choose a specific day to set as the “In Date”.

Show this window automatically
This option will allow you to automatically open the New Reservation window each time you go to the Boarding Calendar from the CID.

- If appropriate, select Show this window automatically.

Check-In with a Reservation
When a patient arrives at your hospital you will need to perform the check-in procedure so that AVImark will know when to begin charging the client for the stay. In addition, if the appropriate Whiteboard option has been selected in Hospital setup, Advanced Options you will be taken to the Whiteboard where you may enter notes, treatments performed and items to be dispensed during the stay. For detailed instructions on how to set up and use the Whiteboard feature, refer to Chapter 19, “Whiteboard”.

- With the correct patient selected on the CID, open the Work with menu and click Boarding.
- Select the correct reservation. Right-click to display the shortcut menu. Point to Check-in/out and click Boarding/Hospitalization/Other as appropriate.
• With the correct patient selected on the CID, select the Schedule Folder tab.
• Select the correct reservation. Right-click to display the shortcut menu. Point to Check-in/out and click Boarding/Hospitalization/Other as appropriate.

**Check-in an Out-Patient**
If you have a patient that has been checked in as an out-patient, AVImark gives you the ability to check the patient into a facility if necessary.

• With the correct patient selected on the CID, open the Work with menu and click Boarding
• Select an appropriate facility on the correct day. Right-click and from the shortcut menu click New.

• Right-click to display the shortcut menu. Point to Check-in/out and click Boarding/Hospitalization/Other as appropriate.
• You will need to click Yes to confirm converting the patient from an Out-Patient to a boarding patient.

**Add Services to a Check-In**
Once a patient is checked-in, AVImark allows you to schedule services to be performed during their stay.

• On the Boarding Calendar, select the correct check-in.
• Right-click and from the shortcut menu, click Whiteboard to display the Whiteboard.
• On the Whiteboard select the Schedule tab.
• Right-click and from the shortcut menu click New or point to Choose and click Treatment/Item/Diagnosis as appropriate.

**Change a Check-In**
AVImark gives you several options when it becomes necessary to change check-in/out dates.

• On the Boarding Calendar, move the reservation to a different day using a drag-and-drop operation.

  OR

• With the correct patient selected on the CID, select the Schedule Folder tab.
• Select the correct reservation. Right-click and from the shortcut menu, click Change.
• Make the appropriate changes on the Reservation window and click Apply.

  OR

• On the Boarding Calendar, select the correct reservation.
• Make the appropriate changes on the Reservation window and click Apply.

  OR

*If the patient has already been checked in:*

• In the Patient area, right-click to see the shortcut menu. Point to Whiteboard and click Whiteboard.
• With the correct check-in entry selected, right-click and from the shortcut menu, click Change to display the Change Check-in window.
• Make the appropriate change and click OK.
Delete a Reservation or Check-In
AVImark allows you to delete any reservation.

- On the Boarding Calendar, select the correct reservation.
- Right-click and from the shortcut menu, click Remove to display the Remove Appointment window.

- Click the description that represents the reason for removing the reservation and click Done.

Check-Out
When the client arrives to check the patient out, you will first need to locate the patient on the Boarding Calendar and then use the check-out key to finish the procedure and charge the client for the right length of stay according to your specifications for that facility.

- With the correct check-in selected on the Boarding Calendar, right-click to see the shortcut menu. Point to Check-in/out and click Check-out.
CHAPTER 19: WHITEBOARD

The purpose of Whiteboard is to have Appointments, Reservations, Check-Ins and/or a schedule of services to be performed, all accessible from one screen. You can use the Whiteboard to view patients who will be arriving, check those patients in, and view those who are currently checked-in. The Whiteboard also allows you to schedule and post activities for those checked-in patients. You can also release and check patients out from Whiteboard. In addition, when a patient is checked into the clinic for an appointment that has services which need to be preformed, you can have those added directly to the Whiteboard.

In this chapter you will learn about...

» Accessing the Whiteboard on page 267
» Patient Check-In on page 267
» Add Services to the Schedule Tab on page 268
» View Patient Activities on page 268
» Post Services from the Schedule Tab on page 269
» Release a Patient on page 269
» Check a Patient Out on page 269
» Print Reservations, Census and Whiteboard Layout on page 269
» Print Scheduled Activities on page 270
» Link a Whiteboard Category to Treatments, Items, and/or Diagnosis on page 270
» Sort Whiteboard Entries on page 271
» Expand a Treatment Group on the Whiteboard on page 271
» Create Additional Data Fields for Whiteboard on page 271
» Access Additional Data Fields from the Whiteboard on page 272
» Print Reservations, Census and Whiteboard Layout on page 272
» Print Scheduled Activities on page 272
» Link a Whiteboard Category to Treatments, Items, and/or Diagnosis on page 272
» Sort Whiteboard Entries on page 273

Accessing the Whiteboard

• On the CID, open the Clients menu. Click Whiteboard.

AVImark allows you to toggle back and forth between the Whiteboard and the CID using ALT+F6. In addition you may work in other areas of AVImark while leaving the Whiteboard open. This will not work in Windows 7 or Vista.

Patient Check-In

From the Arriving tab you can quickly check a patient into a scheduled appointment or reservation. This feature is available on both the Appointment and Boarding tabs.

Appointment tab

• Select the correct patient entry. Right-click and from the shortcut menu, click Check-in.

• You will be prompted to remove appointment from calendar. Click either Yes or No.
Boarding tab

- Select the correct patient entry. **Right-click** point to **Check-in** and click **Boarding**, **Hospitalization** or **Other**.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whiteboard Tabs</td>
<td>Table of Contents – Whiteboard</td>
</tr>
<tr>
<td>Whiteboard Activity</td>
<td>Whiteboard Activities</td>
</tr>
</tbody>
</table>

**Add Services to the Schedule Tab**

Once the patient has been checked-in you may add activities to the patient during the visit.

- On the Schedule tab, **right-click** and from the shortcut menu click **New** to display the Select Patient window.
- From the Patient Drop-down select the correct patient and click **OK** to display the New Whiteboard Activity window.
- Type the **Code** for the activity. If the code is not known, **TAB** to the **Description** field and type at least the first two characters of the description to display a list of services to choose from.
- If choosing from the list, double-click the correct entry. The Code and Description fields will fill in automatically.
- Enter the other detailed information for this activity.
  - **Repeat** - This field indicates the number of times this activity needs to be performed.
  - **Frequency** - How many times per day the activity is to be performed.
  - **Frequency Intervals** - Specify the interval as how many times per day or an hourly interval.
  - **Quantity** - The amount to be administered each time.
  - **Rate** - The rate of measure in which to administer the service.
  - **Route** - The route through which to take when administering the treatment or item.
  - **Completed** - Mark as completed when the task is accomplished.
  - **User** - The user who will be administering the service.
  - **Start** - The start date for the activity.
  - **Time** - The time for the activity to begin.
  - **Post on Checkout** - Will be posted to the patient’s Medical History at check-out.
  - **Category** - To associate a category with the entry.
  - **Amount** - Uncheck **Use Current Price** to clear the amount field and enter a user defined price.
  - **Patient** - Allows you to select the patient if incorrect.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Whiteboard Category</td>
<td>Whiteboard</td>
</tr>
</tbody>
</table>

- **Client** - Contains the name of the client owning the patient.
- Click **OK** to add the entry. You may add as many activities as required. When finished adding activities, click **Cancel**.

**View Patient Activities**

The Whiteboard window gives you two areas in which you may view the scheduled activities for patients during their stay. This may be done from either the Schedule tab or the Checked-in tab. The Schedule tab will allow you to view all patients’ activities in one large list, and the Checked-in tab allows you to view individual patients’ activities.
• On the Checked-in tab, open the **View** menu. Click **Patient Activities** to display a patient activity area at the bottom of the window.

**Post Services from the Schedule Tab**
Post activities as they are administered to the patient from the list of activities on the Whiteboard window.

• From either the activities area of the Checked-in tab or from the Schedule tab, select the correct entry(s). When selecting activities to post to a patient’s Medical History from the Whiteboard Schedule tab, selecting a single activity multiple times will increase the quantity of the activity that will be posted.

---

*If more than one entry needs to be posted, you can select multiple entries by holding down the CTRL key as you click on each entry. Use the SHIFT key to select sequential entries. In addition, AVImark allows you to re-arrange the order of entries so they will be posted to Medical History in the order you wish. Use a drag-and-drop operation to change the position of the entries in the list prior to posting them.*

• With the correct entries selected **right-click** and from the shortcut menu, click **Post**.

**Release a Patient**
If you are using the Control Patient Check out feature you will have to release the patient before AVImark will allow them to be completely checked out.

• From the Checked-in tab, select the correct patient entry.

• **Right-click** and from the shortcut menu, click **Release**.

**Check a Patient Out**
Once a patient has been released for check out, you are able to check the patient out from Whiteboard.

• On the Checked-in tab select the correct patient for check out.

• **Right-click** and from the shortcut menu click **Status** to display the Check-in Status window.

• Click **Check out**.

**Print Reservations, Census and Whiteboard Layout**
AVImark gives you the ability to print the list of reservations and the Census, list of patients currently checked-in. Also from any tab you can print the layout of that selected Whiteboard tab.

**Appointment Reservations**

From the Whiteboard Arriving tab select the **Appointments** sub-tab.

• On the **File** menu, click **Print Census** to display the Printing Appointments window.

• Use the **Print to** drop-down list and select the correct printer.

• For a specific date range, select the Check-in Date Range **option and use the** From and To drop-down calendars to enter the date ranges.

• If appropriate, use the Chart or Document option to print patient charts or documents for those patients checked-in.

• Click **Print** or to preview the report onscreen select the **Preview** option and then Print.

**Reservations**

• From the Whiteboard Arriving tab select the **Boarding** sub-tab.

• On the **File** menu, click **Print Census** to display the Print Boarding Reservations window.

• Use the **Print to** drop-down list and select the correct printer.

• For a specific date range, select the **Check-in Date Range** option and use the **From** and **To** drop-down
calendars to enter the date ranges.

- If appropriate, use the Facility drop-down list and select a specific facility.
- If appropriate, select a Sort By option.
- Click Print or to preview the report onscreen click Preview.

Census (Check-ins)

- From the Whiteboard select the Checked-in tab.
- On the File menu, click Print Census to display the Print Hospital Census.
- Use the Print to drop-down list and select the correct printer.
- For a specific date range, select the Check-in Date Range option and use the From and To drop-down calendars to enter the date ranges.
- To include the Scheduled Activities on the report, select Include Activities.
- If appropriate, use the Facility drop-down list and select a specific facility.
- If appropriate, select a Sort By option.
- Click Print or to preview the report onscreen click Preview.

Print Tab Layout

If you have customized the layout of a tab in the Whiteboard by arranging, removing or adding columns AVImark gives you the ability to print this layout as it is displayed on screen.

- In Whiteboard select the desired tab.
- Right-click and from the shortcut menu select View, Print.
- Choose a printer and click Print to print the layout of that selected tab.

Print Scheduled Activities

AVImark gives you the ability to print the list of activities for those patients who are checked-in.

- From the Whiteboard select the Schedule tab.
- On the File menu, click Print Schedule to display the Print Whiteboard Schedule window.
- Use the Print to drop-down list and select the correct printer.
- To print activities for one specific doctor or staff member use the Doctor drop-down list to choose the appropriate person.
- Use the Whiteboard Category drop-down list to print activities associated with a specific category.
- To print activities for a specified time period select Date Range and enter the desired dates.
- If appropriate choose to include More Stuff information, Notes and Completed Activities.
- If appropriate, select a Categorize by option.
- Click Print or to preview the report onscreen click Preview.

Link a Whiteboard Category to Treatments, Items, and/or Diagnosis

AVImark allows you to link Treatment, Inventory and/or Diagnosis Categories or individual Treatments, Items, and/or Diagnosis to a Whiteboard Category. These Whiteboard Categories will need to be set up in System Tables, Whiteboard Categories. This feature is particularly useful when you want to group specific services together on the Whiteboard.

- On the CID, open the Work with menu. Click Treatments, Inventory, or Diagnosis List.
Link a Treatment, Inventory, or Diagnosis category
- From the Categories section of the appropriate list, select the correct Category.
- **Right-click** and from the shortcut menu, click **Change** to display the Change window for that list.
- Using the Whiteboard drop-down list, choose the appropriate category name and click **Done**.

Link an individual Treatment, Item, or Diagnosis
- Click the **Category** name which contains the service to be linked.
- Select the correct item. **Right-click** and from the shortcut menu, click **Change** to display the Change window.
- Click the **Whiteboard** tab. Using the Whiteboard drop-down list, choose the appropriate category name and then click **Done**.

Sort Whiteboard Entries
Sort the Arriving, Checked-in, or Schedule Tab by using the “Group by Panel”. This will allow you to sort by a column heading.
- Select the Whiteboard tab you wish to sort.
- On the **View** menu, click **Show/Hide Group Panel** to display a gray area above the Whiteboard entries.
- Select the Column Heading you wish to sort by. Drag the heading to the gray area. This will display the entries in a “tree style” grid.
- On the **View** menu, click **Expand All/Collapse All** to expand or collapse all entries at once.

Expand a Treatment Group on the Whiteboard
When choosing a treatment group to add to the activity schedule on the Whiteboard, you have the option of expanding or not expanding the group.
- In an activity area on the Whiteboard, **right-click** to see the shortcut menu. Point to **Choose** and click **Treatment** to display the Treatment List window.
- Select the desired Treatment Group. Click **Done** to display the Treatment Group on the New Whiteboard Activity window.
- Click **OK**. You will need to click **Yes** or **No** to confirm.

Create Additional Data Fields for Whiteboard
Additional Data Fields may be created for the “Checked-in tab” or the “Schedule” tab.
- On the CID, open the **Work with** menu. Click **System Tables**.
- Select the **Additional Data Fields** Table.
- In the Entries for Additional Data Fields section, select the area you wish to create fields for.

Additional Check-in Fields
Selecting this field, you may create Additional Data Fields for the Checked-in tab.

Additional Whiteboard Fields
Selecting this field, you may create Additional Data Fields for the Schedule tab.
- **Right-click** and from the shortcut menu, click **More Stuff Fields** to display the Define More Stuff window.
- **Right-click** and from the shortcut menu, click **New** to display the Additional Data Field window.
In the Name field, type the description of the field you want to create.

Using the Type drop-down list, select the field type that would be best for data that will be entered into the field you are creating.

Click Done to add the field. Continue adding the desired Additional Data fields in the same manner, and click OK when you are finished.

Click Done on the System Tables window.

**Access Additional Data Fields from the Whiteboard**

**Checked-in tab**

- On the Checked-in tab, select the correct patient. Right-click and from the shortcut menu, click Change to display the Change Check-in window.
- Enter the data to record for the patient and then click OK.

**Schedule tab**

- On the Schedule tab, select the correct entry. Right-click and from the shortcut menu, click Change to display the Change Whiteboard Activity window.
- Enter the data to record for the patient and click OK.

**Record Estimate Details on the Whiteboard**

AVImark allows you to post, “Patient Specific Estimates”, “Canned Estimates” or an “Individual Estimate” entry to Whiteboard. This can be done automatically or manually.

**Automatically**

- On the CID, click the patient’s Estimate tab.
- Choose or create an Estimate.
- When selecting the Estimate, you will need to click Yes to confirm.

**Manually**

- On the CID, click the patient’s Estimate tab.
- Select the desired Estimate. Right-click and from the shortcut menu, click Post to Whiteboard.
- You will need to click Yes to confirm.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include More Stuff on Schedule</td>
<td>Print Whiteboard Entries</td>
</tr>
<tr>
<td>Whiteboard Categories Setup</td>
<td>Whiteboard Categories Table</td>
</tr>
</tbody>
</table>
CHAPTER 20: PERIOD-TO-DATE REPORTS

At the end of each business day you will want to have AVImark prepare reports that summarize the day’s activity and income, as well as print your deposit slip. Furthermore, at the end of the month you will probably want summary reports of the month’s activity. AVImark provides a flexible method whereby you can have various reports prepared that list income, treatment, rabies vaccinations, controlled substances, and other data for any period of time.

Run the Reports
Select the report period

With the exception of the Payment Summary Report, Open Invoice Report, and the Unposted Transaction Report, all reports can be printed for any time period you choose.
On the CID, open the **Work with** menu. Click **Reports** to display the End of Period Reports window.

Use the **Period** drop-down list to select the time period you wish the report to cover. By selecting a period, AVImark automatically specifies the dates for that period with today’s date as the ending date.

**Print by menu**

AVImark also allows you to print reports for a period beginning with the previous date and time of the day. This is kept by AVImark as the closing date and time, allowing you to print activity reports back to the time the reports were last closed.

- Open the **Print by** menu and click **By closing** to display the Select period to print window.
- If business has been conducted since the last closed report, the top entry will be **open period**.
- Select the reports which you wish to print and click **Print**.
- You will need to click **Yes** to confirm.

**Start/End**

If appropriate, you may choose the Start/End dates for the period.

- Using the **Start/End** drop-down calendar, select the date for the period you wish to print for.

**Doctor**

Allows you to organize the reports you are printing. You may choose for a selected doctor, for all doctors as separate reports, or for a consolidated report which includes all doctors.

- Use the **Doctor** drop-down menu and select how you wish to organize the reports.
- In the **Doctor** field, right-click to see the shortcut menu. Select the **Include** and **Sort** by options that you wish. Options include:
  - **Include Users**
    - This allows you to add all users in Users and Security to the drop-down menu.
  - **Include Inactive**
    - This allows you to add all users in Users and Security who have the Inactive Box checked.
  - **Sorting Options**
    - This allows you to sort the drop-down menu by selecting; By Name, By Sequence, or By Appointment Sequence.

**Print to**

- Use the **Print to** drop-down list to select the printer to use for the reports. By specifying the **Excel** option, you can print or save this report to the desired location.
Preview

As with any other print area of AVImark, you may preview, email or save reports.

• Select Preview and click Print to preview the report on screen.

Sort by

You may choose how to sort the report(s) you are printing. You may sort by Account number, Amount, Date, ID number, Name, Rabies Tag number, County, Species, and City.

• Use the Sort by drop-down menu to select how you wish to sort the report(s).

Report Code

You may print an activity log for patients receiving treatments and/or inventory items for which one or more, (up to three), Report Codes have been assigned.

• If appropriate, type the Report Code(s) you wish to print for.

Company

When adding clients to AVImark, each client is automatically assigned a Company number (typically 01). You may wish to divide your clients into groups for reporting and billing purposes, you may assign any client company number according to the group they belong to.

• If appropriate, enter the Company number you wish to print for.

• To print reports by company number as specified in Medical History, activate the Detailed reporting by company in Hospital Setup, Advanced Options.

Site

When charges are entered into Medical History, you may enter a Site number. In addition, over-the-counter sales entered into accounting may also have a Site number specified. AVImark lets you print most reports by Site number.

• If appropriate, use the Site drop-down menu and select the Site number you wish to print for.

Choose a Report

• Select the name of the report you wish to print from the Don’t Print These field.

• Use the Single Left Arrow (<) button to move the report over to the Print These field.

• Repeat this procedure to select other reports.

• Using the same technique, you may move any report back to the Don’t Print These field by using the Single Right Arrow (>).

• Move all reports within either field by using either the Double Left (<<) or Double Right Arrows (>>) appropriately.

See the Bottom Line

In addition to running and printing reports, AVImark allows you to see instant production totals for any period. (Returned checks will be subtracted from the bottom line because the bottom line shows the current amount of money).

• Select the period of time you wish to view statistics for using the Period drop-down menu.

• Ensure the period of time shown in the Start and End fields reflects the period of time you wish to report.

• Click the Bottom Line button.
Account Summary
This report summarizes the accounting of each client that made a payment or incurred a charge during the period. It shows such information as beginning balance, charges, payments, and ending balance.

Audit Trail
This report tells you which employees performed certain functions, at what time and at which workstation the task was performed. These functions/tasks include removing accounting transactions, removing clients, etc. as shown in the Audit Table as part of the System Tables window. This report is designed to tell you which employees are doing certain tasks that you would like to monitor.

Controlled Substance

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save/E-mail Reports</td>
<td></td>
</tr>
<tr>
<td>Reports that can be printed by Client Code</td>
<td></td>
</tr>
<tr>
<td>Sort and Filter Reports</td>
<td>Running Reports</td>
</tr>
<tr>
<td>Export Reports to Excel®</td>
<td></td>
</tr>
<tr>
<td>Reconcile Reports</td>
<td></td>
</tr>
</tbody>
</table>

This report lists activity for controlled substances. In order for a treatment or item to appear on this report, it must meet one of the following criteria listed below:

- The treatment/item must have a C Action Code at the time it was entered into Medical History and be posted to accounting.
- Items linked to treatments must have a C Action Code when entered into Medical History and be posted to accounting.
- Received items on Purchase Orders must have a C Action Code.

Deposit Slip
Included on the deposit slip is the date of each transaction, the type, check number, client name, and the amount of each entry.

Health Plan Report
This report will display a list of all patients currently on a Health Plan. Each Plan will be displayed with a heading on the report, with a list of all patients on this plan. Along with patient information, other pertinent information will be reported as well, such as the expiration date of the plan and which services have yet to be performed.

Held Check Report
The Held Check Report will display a list of all checks being held during the current time frame. This report is also printed automatically after the Deposit Slip Report.

Income by Provider Report
The Income by Provider Report will display an income analysis for all providers in your clinic. Income is defined by payments received. It may be broken down by doctor and is based on charges, such as treatments, items and diagnosis, showing the percent of your income. AVImark will know which doctor the income is specified for by looking at the charges for which the income was applied and which doctor implemented the charges. When this report is selected for printing, you will notice a tab on the right side of the screen will appear named Income options. These options are only relevant to this report, and give you the opportunity to print this report including Client detail, Transaction detail, and/or Include Inventory Sales. With none of these options checked, AVImark will print a report with Totals Only.

Income by Treatment Summary Report
This report shows your income for treatment, inventory and diagnosis, showing the percent of your income. This report may be printed for each doctor or a consolidated report which reports the activity of all doctors com-
bined. Treatments, Items and Diagnosis given to patients that have income, are listed alphabetically under each
category. For each treatment, item or diagnosis, income values are given with percentages of the total income
along with quantities and percentages of the total quantity. Totals are given at the bottom of each column. It
also summarizes your income by treatment type, showing the percent of your income that was derived from
each treatment category. You also have the option to use the Average Cost or current Cost when calculating the
Expense of Inventory items.

Inventory Used Report (Illinois)
The state of Illinois requires clinics to charge tax for items that are sold to clients as part of a service. For those
clinics that do not choose to stop selling retail items they must start tracking all items that are administered to a
patient as part of a service that is performed. The report lists patients who received items sold as inventory used
verses being sold directly. The Total, Cost and Price amounts on the report will look directly at the inventory
item at the time the report is processed. The exact cost and price amounts specified in the Inventory List at the
time the item is dispensed is what AVImark will use to process the report figures.

Open Invoice Report
This report will display a list of all open invoices along with their totals and dates of service. This report is usu-
ally printed before statements so you can see which clients still have invoices open.

Patients by Treatment Report
This is a consolidated report for all doctors with treatments, items and diagnosis listed alphabetically for each
category. For each treatment, item or diagnosis, the client(s) for whom the service was performed, are listed
beneath. Several columns of information are available displaying the client number, the client name, residence
phone, patient name, doctor performing the procedure, quantity, date, time, price, species, breed, age and sex
values. This report provides a list of all patients that have received each treatment, item and diagnosis during
that period. It is intended to serve as a reference source to determine quickly which patients were given which
treatments, items or diagnosis.

Payment Summary Report
This report prints month-to-date totals for each payment type in the current month. Typically, this is a monthly
report used to view payments in a summarized format Combined totals for Cash, Check, Master Card and Visa
will print at the end of this report.

Period Totals
This Period Totals Report shows payments, production by provider, taxing amounts, late charge totals, account
adjustments, etc.

Rabies Report
This report will include only those patients for which rabies vaccinations (treatments for which an Action Code
of R have been assigned) were performed during the report period.

Rabies Report for Cary, North Carolina
A program was written for clinics in Wake County, North Carolina who need to send certain rabies information
to the county. The utility program CaryRabies creates an xls file for clinics to send the county either by email
or on CD. For more information about the CaryRabies program, please call Technical Support.

Rabies Reports for Kane County, Illinois
A utility program was written for clinics in Kane County, Illinois who need to send certain rabies information
to the county. The utility program KaneCountyRabiesReport creates a txt file for clinics to send the county
either by email or on CD. For more information about this please call Technical Support.

RabiesCSV Utility
AVImark has designed a utility program that will include required information for the following areas: El Paso,
TX; Hamblen County, TN; Albuquerque, NM; and Charlotte County, FL. To access this utility from the CID
select the menu option **Utilities, Utilities.** Type the name of the utility program, **Rabiescsv.** To print the appropriate report for your area select your location. The appropriate county must be assigned to the client for the information to be reported for Hamblen, TN or Charlotte, FL. Clients must have the appropriate city and state associated with their information and the rabies treatment must have the R action code in order for the proper information to print.

**RabiesCSV Requirements for El Paso, TX**
For clinics in El Paso, TX you are required to display on the Rabies report the Vaccine MFG and Serial number along with a column on the report showing the annual registration certificate due date and patient name due to renew the certificate. To report the renewal certificate date you must create a treatment with the exact description of **EP Registration Certificate.** This code must also have an annual reminder setup so the due date is reported and printed in the correct column on the report. The city of El Paso must be assigned to the client for the correct information to be reported.

**Referral Report**
This report is sorted by referral source. For each referral source, the invoice date is given along with the referred client’s name and phone number, patient’s name, charges, and payments made. The report only includes new clients who were added to the computer, did business with you during the report period and were referred to your hospital by an existing client. Referral thank-you letters may be automatically printed after the report, addressed to each of the referral sources.

**Sales Summary**
This report identifies production generated by the Admitting Doctor that is specified in the Enter Medical History Window. On the surface, this report is identical to the Transaction Summary report, however, this report is designed to be printed by the admitting doctor. The Sales Summary Report will show income for each treatment, item, and diagnosis. The usage column shows quantity used and the expense column shows the associated inventory expense. You also have the option to use the Average Cost or current Cost when calculating the Expense of Inventory items.

**Tax by Area**
The Tax by Area report is used to assist clinics located in Ohio, Georgia, and Washington for compliance with state tax laws. This report is used in conjunction with the Zip field in the Enter Medical History window. This report displays the date of the transaction, the client’s name and account number, along with the total amount of non-taxable services for that client and date, amount of taxable services, tax paid, and total of the invoice. This information will be printed for each area that was used in the Zip field of the Enter Medical History window.

**Transaction Journal**
This report shows a very detailed list of all treatments, items, or diagnosis performed during the time period. Because it is so detailed, you probably would NOT want to print one for any period other than a day at a time. The report is printed chronologically from top to bottom, listing every client and patient you treated, showing the treatments performed on each patient. Also shown are date of the transaction, type of transaction, descriptions, quantities, the expense of any inventory items included on the report, and the amount of each transaction.

**Transaction Summary Report**
This report shows totals of the categories of transactions for treatments, items, and diagnosis. It is used as a guide for determining what percentage of income comes from each category - a profit center report. You also have the option to use the Average Cost or current Cost when calculating the Expense of Inventory items.

**Treatment Control Log**
This report allows you to produce a list of all patients that have received specific types of treatments or items, categorized by what is called a Report code. Up to 3 Report codes may be entered into the Report code field for any of your treatments listed in the Treatments or Inventory List. The report will list all selected patients in order of patient name. Patients having received a particular coded treatment or item will be listed under that heading. All treatments or items will be listed in alphabetic order by treatment code. If treatments or items from multiple categories are listed, the treatment or item category name will appear as a report section title.
These treatment or item categories will also appear in alphabetic order.

**Unposted Transactions**
This report will show the total amount of services, items or diagnosis which have not yet been posted to any client’s account.

**K.A.S.P.E.R. (Kentucky All Schedule Prescription Electronic Reporting)**
This is a controlled substance log (primarily for Kentucky hospitals) that will include the hospital DEA identification with the provider’s identification for all designated items. The report will include the hospital’s DEA number, the client’s social security number or driver’s license number, the patient’s birthday, the date of transaction, the controlled substance’s item code, the quantity of the item dispensed, the item’s NDC identification, the performing doctor’s DEA identification, the client’s name, the patient’s name, and the client’s address.

**Setup**
- Specify all doctors DEA identification in Users and Security.
- Specify the hospital’s DEA identification in the Demographics tab of Hospital Setup.
- Specify each controlled substance in the Inventory list with its own NDC code along with a C Action code.

**Send the data**
- On the CID, open the Applications menu and click KASPER to start the KASPER program.
- Using the From date field, specify the start date.
- Enter the number of days you wish the report to include.
- If using the Export to option, you will need to specify the drive you wish the data to be copied to.
- Insert a blank media disk in the correct drive and click Run.

**A.S.A.P. (American Society for Automation in Pharmacy)**
This is a controlled substance log that will include the hospital DEA identification with the provider’s identification for all designated items. The ASAP Report is applicable for specific states. Call Technical Support to see if your state is included within this report and state specific instructions.

**Basic Setup:**
- Specify all doctors DEA identification in Users and Security.
- Specify the hospital’s DEA identification in the Demographics tab of Hospital Setup.
- Specify each controlled substance in the Inventory list with its own NDC code along with a C Action code.
- Create a unique RX number of each controlled drug. In order to get the unique number, use the Sequence numbers on drug labels in Hospital Setup, Document tab.
- To include the RX number on the ASAP report set the Hospital Advanced option, Include Sequence.
Number set to True.

Basic Data Sending:

• From the CID Utilities menu select Utilities and type ASAP.
• Using the From date field, specify the start date.
• Enter the number of days you wish the report to include.
• If using the Export to option, you will need to specify the drive you wish the data to be copied to.
  Insert your selected media in the correct drive.
• Select your location or state (i.e. MS, TN)
• Click Run.

The file will be in a .DAT format and will be named with your Hospital DEA number_date'.
CHAPTER 21: SECURITY ADMINISTRATION

AVImark contains a security feature that allows the hospital administrator to control the use of the different capabilities of the system in a very flexible way. The security feature is designed in such a way as to not affect the use of AVImark, except when a user attempts to do something that they are not authorized to do. This fact makes the security feature transparent to the user. The only extra action required by the user is that they log on when they first start AVImark. If you choose not to make use of the new security feature, all you will need to do is enter your list of doctors and other staff, and the security feature will be completely invisible to you. Likewise, you can choose to protect just a few functions in AVImark and those functions that you have not protected will be automatically available to everyone.

In this chapter you will learn about...

» Add Categories and Employees on page 282
» Completing the Setup on page 285
» Change User Information on page 285
» Change Passwords on page 285
» Specify Doctor Sequence and Location on page 285
» Authorize User Functions on page 286
» Specify Security for other User Groups on page 288
» Print the Users and Security Report on page 288
» On-going Security Administration on page 288
» Log On to AVImark on page 288
» AVImark Compliance with FACTA Red Flags Rule on page 288
» AVImark Account Locking Feature on page 289

Identify and Add AVImark Users

Whether or not you choose to use the AVImark security feature to control the activities of your staff, they will still need to be identified. Information should be recorded for each provider such as ID, names, license numbers (printed on the rabies certificate), and a staff sequence number which will determine the order doctors appear in the Doctors drop-down menu and on the Appointment Calendar.

• On the CID, open the Work with menu. Click Users and Security to display the Security Maintenance window.
Add Categories and Employees
Once the appropriate staff members have been added to the Hospital Administrators Category, you may add other categories, and then other employees as required.

Add a new category

- Point in the **Category** section of the Security Maintenance window.
- **Right-click** and from the shortcut menu click **New** to display the New User Category window.
- In the **Category** field, type the name for this category.
- Use the TAB key to move to the **Auto-logoff** field. Click the **Up** and/or **Down** arrow to specify the number of minutes to wait (if the user does not touch the keyboard or mouse) before automatically logging the user out of AVImark.
- Click **OK**.

Add new employees
- Click the **Category** you wish to add the new user to.
- Point in the **User for** section. **Right-click** and from the shortcut menu click **New** to display the New User window.
- Enter the appropriate information for the employee and click **OK**.

Category
This menu allows you to change the category in which to include this user. AVImark automatically enters the
Category name depending on the Category you have selected when adding new staff.

- If appropriate, click the Category drop-down and select a category.

*First*
- Type the user's first name.

*Last*
- Type the user’s last name, including ending titles such as DVM, VMD, etc.

*ID*
- Type the user’s initials or other ID; up to three characters.

*Password*
When entering a password, choose 3 to 5 characters using any combination of letters and numbers. Do not use spaces and/or punctuation marks. You will notice that when you open this window asterisks automatically appear. Whether or not the user has been assigned a password these asterisks will appear for security reasons. If you do not intend to use the AVImark security feature at this time, leave this field blank.

- Type an appropriate password.

*Cell Phone*
- If appropriate type the user’s cell phone number.

*Type*
This field is used by VetCor® veterinary hospitals to indicate the type user.

- Click the Type drop-down and select the Type user.

*E-mail*
This option allows reply e-mails that are received back from customers to be sent directly to a specified user.

- Enter the employees current e-mail address.

- A drop-down selection list of email addresses can be accessed when sending e-mail from the CID Client Area, Right-click, Send Email and from Information Search. AVImark will not display the address of persons that have been inactivated in Users and Security.

*Report*
This feature allows the user to enter a different name, other than the one entered in Users and Security. This Report name will be shown when printing an Invoice.

- If appropriate, type a Report name.

*Inactive*
AVImark allows you to mark an employee as inactive, causing them to be removed from the Doctor drop-down list, and from the Appointment Calendar. This may be especially useful in the event you wish to keep a user’s Time Card history for future reference.

- If appropriate, check the Inactive box.

*User is a Doctor*
When adding a new doctor to Users and Security, you will want to select this option. In doing so, the Sequence, DEA, License, and User Appears on Appointment Calendar fields are activated, allowing you to select and enter information.

- If appropriate, check the User is a Doctor box.
DEA (K.A.S.P.E.R. and A.S.A.P. integration)
AVImark provides controlled substances reports to meet the requirements for specific states. The doctor’s DEA number will need to be entered for the use of these reports.

- If appropriate, type the doctor’s DEA number.

License
This field allows you to enter the doctor’s rabies license number.

- If appropriate, type the doctor’s License number.

License Experation
This field allows you to enter in the Doctor’s license expiration date.

NABP Number
Some states require this number to be included in their controlled substance reports. This field will only allow up to 10 characters.

User Appears on Appointment Calendar
This feature allows you to have a user appear on the Appointment Calendar.

- If appropriate, check the User Appears on Appointment Calendar box.

Appointment Color
AVImark allows you to assign a color for each doctor’s appointments on the calendar. You may select from a list of basic colors, or you may choose to create and add a custom color.

- Click the Appointment Color drop-down and then select the desired color or click Custom Color to display the Color window.
- Select the desired color from the Custom colors section and click OK.

Group
Each user that is displayed on the Appointment Calendar can be assigned a unique Appointment Group. Once users are assigned an Appointment Group, these users can be displayed according to the group in which they are included. Appointment Groups can be defined from this window by clicking the New button and entering a new code and description or from the new Appointment Groups table within System Tables.

- If applicable, use the Group drop-down list and select the correct Group.

Clocks In
This function allows you to track hours and activity with the AVImark Time Clock feature. For those staff members using the Time Clock check this option. This option must also be checked for those administrators who wish to view or change entries in an employees Time Card.

- If appropriate, check the Clocks In box.

Period Start
AVImark allows you to select the beginning date the user’s Time Card will default to.

- Click the Period Start drop-down calendar.
- Select the date you wish the Time Card to default to.

Track Overtime by Day
AVImark allows you to track an employee’s overtime by day.

- If appropriate, check the Track Overtime by Day box.
• Using the **Daily Hours** field, enter the number of hours the user works before overtime is tracked.

**Client Account Access**
You may prevent an employee from having access to add, change, or remove certain information. By adding the AVImark client account number of the employee to the Account field, you may select the access type you would like to grant that employee. **View only** will allow the user to open their account with a Read only access. **Add patient** allows the employee to add, change, or remove patient information. **Add history** gives access to adding, changing, or removing Medical History as well as patient information. **Full Access** will give the employee full access to their account. Selecting either **Add Patients**, or **Add History**, will prevent the employee from adding, changing, and removing **Accounting** entries.

  • If appropriate, click the **Browse** button to display the Client Selection window.
  • Type the employee’s name in the **Client** field and click **Continue**.
  • Click the **Access Type** drop-down and select the access type you wish to grant.

**Completing the Setup**
• Click **OK** to add and save the new user information. After selecting **OK**, you will notice a **User Sites** window will appear. This will allow you to select the site where this user typically works. This is applicable for clinics with multiple sites.

  • In this window choose **right-click** **New**.
  • From the **Site** drop-down list select the appropriate Site and click **OK**.
  • Click **Done** once the appropriate information has been entered.
  • Another **New User** window will open allowing you to enter another staff member. You can do that at this time or click **Cancel** to close the **New User** window.

**Change User Information**
AVImark allows you to change information for any user within Users and Security.

  • From the **User for** section, double-click on the correct name to display the Change User window.
  • Change any necessary information. Use the **TAB** key or simply click to move from one field to another.
  • Click **Done** to record any changes.

**Change Passwords**
Passwords may be changed from the AVImark Logon window at anytime. AVImark does not force a user to change their password. However, it is recommended to do so periodically.

  • On the CID, press **F12** to display the AVImark Logon window.

    • Enter the current **Password**. Use the **TAB** key to move to the **New password** field.
    • Enter the **New password** and click **Logon**.

**Specify Doctor Sequence and Location**
Specifying Site Location for User
When AvImark data is being shared by multiple hospitals you can specify the site or location this user normally works.

- From the Security Maintenance window highlight the user and from the **right-click** menu select **Locations**.
- Click the **Site** drop-down and select the appropriate **site**.
- Click **Ok** once the appropriate information has been entered.

If the user works at multiple locations follow the above steps to add another location for the user.

Doctor Sequence
Once you have selected the option, User is a Doctor, AvImark will automatically enter the sequence number of how the doctor will appear in the Doctor drop-down list throughout AvImark. The sequence is set by the order in which the doctor was entered into Users and Security. Once the new doctor information has been added and saved, you may change this sequence number if you wish.

- From the Security Maintenance window highlight the appropriate doctor.
- From the **right-click** menu select **Sequence, Doctors**.
- Highlight the doctors name and use the green up and down arrows to move the user in the desired sequence. You can also drag-and-drop the user in the desired sequence.

Appointment Sequence
Selecting the option, User Appears on Appointment Calendar automatically assigns an Appointment Sequence number. As with the Sequence number, the Appointment Sequence is set by the order in which the user has been entered into Users and Security. You may change the Appointment Sequence once the new user information has been entered and saved.

- From the Security Maintenance window highlight the appropriate doctor.
- From the **right-click** menu select **Sequence, Appointments**.
- Highlight the doctors name and use the green up and down arrows to move the user in the desired sequence. You can also drag-and-drop the user in the desired sequence.

Authorize User Functions
Included with AvImark is a list of functions that can be protected. The use of these functions can be controlled through the use of the security feature. As you select the different Categories, you will notice the different functions associated with that category. You will want to identify what AvImark functions are to be protected, and which users are authorized to use these functions.

Hospital Administrators
Authorize the hospital administrator to perform only those functions which you want to prevent other categories of users from performing. By authorizing the function, **Administer AvImark (System-wide Authority)** to the hospital administrator, this will grant full authority to all functions in AvImark in one step.

- On the **Security Maintenance** window, click **Hospital Administrator**.
- Point in the **Authorized Functions** section. **Right-click** and from the shortcut menu click **Choose** to display the User Functions window.
• From the **Category** section, click **System Administration**.

• From the **AVImark functions for System Administration** section, point to ADM01, **Administer AVImark (System-wide Authority)**.

• **Right-click** and from the shortcut menu, click **Select** to copy the function into the **Selected** area.

• Continue selecting the other functions you wish to prevent other user groups from performing.

• After the appropriate functions have been copied to the **Selected** area, click **Done**.

### Remove authority

Once functions have been authorized to a user group and you find it necessary to remove one or more of these functions, you may choose to do so a couple different ways.

• On the **Security Maintenance** window, click the **Category** name you wish to remove a function from.

• From the **Authorized Functions** section, point to the function you wish to remove.  **Right-click** and from the shortcut menu, click **Remove**.

• You will need to click **Yes** to confirm.

   **OR**

• From the **User Functions** window, click the **Category** name for which functions had been authorized.

   **In the AVImark functions for section, functions which have been authorized to a user group will be indicated by a check mark in the Authorized column.**

• In the **AVImark function for** section, point to the authorized function that you wish to remove.

• **Right-click** and from the shortcut menu, click **Authorized Categories** to display the Authorized to User Categories window.

• Point to the appropriate **User Category** name.  **Right-click** and from the shortcut menu, click **Remove**.

• You will need to click **Yes** to confirm.

• Click **Done** when finished removing the function from the appropriate user groups.
Specify Security for other User Groups
Use the discussion above to establish authority for other groups of users, if appropriate. Understand that with the functions you secured to the Hospital Administrator group, those functions are automatically off limits to other user groups, unless you authorize them as well. For those functions you have secured, you will need to decide if there are other groups of users which you want to authorize any of these same functions. Do not make the mistake of thinking you have to authorize everyone to all the functions they can perform. For any given function, if you don’t secure it as Hospital Administrator, everyone will be able to use it. When a user does not have the authority to perform certain functions or make desired changes, the window will be displayed as VIEW ONLY, and the fields within this window will be locked, preventing any change from being made. If the user attempts to click Done on a window that displays the VIEW ONLY message, they will be prompted with an unauthorized message.

Print the Users and Security Report
AVImark gives you the ability to print, e-mail, save and/or export a report containing a list of users, user groups, and secured functions for specific user groups.

Print the report
• On the Security Maintenance window, open the File menu. Click Print to display the Print Users window.
  • Click the Category drop-down and select a Category or select (All Categories).
  • Click the Print To drop-down and select the printer to print to.
  • Click Print or click Preview to view the report on-screen.

On-going Security Administration
Once your users have been identified and authorized to the correct functions, the security feature more or less takes care of itself. As new employees join your staff or leave the hospital, you will simply add them to the appropriate user group or mark them as Inactive. As you become more comfortable with the security feature and the functions that you can protect, it is likely that you will gradually fine tune the security on your system to a more restrictive, yet workable level.

Log On to AVImark
From this point on, you are using the security feature. This implies several things, including the fact that you will be prompted for a password each time you start AVImark. AVImark will automatically allow or disallow the user to perform protected functions, based on what you have specified. From the Windows desktop, start AVImark in the normal manner. The logon window will appear in the center of the screen requesting you to enter your password. Enter your password and then click Logon.

AVImark Compliance with FACTA Red Flags Rule
AVImark includes security features that will aid in hospitals efforts to be compliant with the new Fair and Accurate Credit Transactions Act (FACTA) Red Flags Rule. The Red Flags Rule sets out how certain businesses must develop, implement and administer Identity Theft Prevention Programs.

AVImark security must be in place to protect and secure client privacy. To begin using security in these areas you must give access to one user group that has authority to perform the task. These new security functions apply to fields in the Client Area that store personal client information.

Having the following functions secured will safeguard customer information from being viewed on the main screen of the CID, from being accessed when the Change Client window is open and from being accessed from Information Search reports or utility program reports that contain this information. It is our recommendation that each function be secured only to the hospital administrator group.

- **CLT12** – Change Client Drivers License
- **CLT13** – Change Client SSN

Unauthorized user groups will not be allowed to view or enter information in the SSN or DL fields in a New or Change Client window.

These security functions also protect the following areas:

- The third-party reports generated by CareCredit, ASAP and Kasper
- The SSN and Drivers License fields will be protected from printing on the Information Search
- The information in the SSN and Drivers License fields will not be viewable in the Enter Payment and Invoice windows.

**AVImark Account Locking Feature**

For hospitals that choose to use this feature, AVImark can now force users to correct mistakes by making Accounting and History adjustments, instead of only modifying amounts or removing entries. This feature is being implemented in order to help clinics ensure their historic data is consistent.

**NOTE:** Hospitals that use the AVImark Sidekick feature cannot use Account Locking when Importing. For more information contact AVImark Technical Support at 877-838-9273 opt 1.

The locking feature consists of three options stored within Users and Security. The Record Locking options can be restricted by time-frames that are explained below.

- From the CID, **Work With** menu, select **Users and Security**
- Select the menu option **File, Additional Security**
1. **Lock Accounting Records**
   - **No Locking** - Set by default
   - **By Day** - Ability to edit records for today’s date only. Past accounting records are locked.
   - **By Week** - Ability to edit records for 7 days.
   - **By Month** – Ability to edit account records dated in the current calendar month.

2. **Lock History Records**
   - **No Locking** - Set by default
   - **After Posting** - Ability to edit un-posted Medical History; posted entries are locked.
   - **By Day** - Ability to edit Medical History entries for today’s date only.
   - **By Week** - Ability to edit records for 7 days.
   - **By Month** - Ability to edit entries for the current calendar month.

3. **Seal Lock Permanently**
   - Seal Lock Permanently is used to permanently LOCK past Accounting and History records. You will find AVImark locks these files based on the Account and History locking selections that have been set. This option is unchecked by default. It can only be checked and unchecked by someone with System Wide Authority (ADMO1). All other users will receive a security message as notification that they are not authorized to set this function.
   - When checked, AVImark will give a message prompt asking, “Are you REALLY sure you want to lock\unlock records? A log will be sent to MSS Headquarters for your record. Do you want to continue?” Yes or NO
   - Clicking Yes will permanently seal the Accounting and History Locking options as they have been selected above. Having checked Seal Lock Permanently the Account and History selections are grayed out and cannot be changed by anyone other than ADMIN. (Once grayed out, the edit boxes can only be changed when Seal Lock Permanently has been unlocked by ADMIN.)

*How AVImark works when Accounting\History Locking are in place:*

- When an unauthorized user tries to make a change to Accounting or History they will receive a warning message saying, “You are attempting to modify LOCKED Medical Records. Account Locking was set by a System Administrator.”
- **Built-In Utilities**: When Account Locking is active, AVImark prevents running built-in utilities that can alter Accounting and History records. Users will receive a warning message saying, “This utility is unable to run due to the Account/History Locking feature. Account Locking was set by a System Administrator.”
- **Locking Prevents use of Sidekick**: Hospitals that have the Account Locking feature active will not be able to Import from Sidekick. When accessing Utilities.. Sidekick on the Server a warning message prompt says, “Sidekick feature is disabled due to the Account Locking feature. Account Locking was set by a System Administrator.”
- **Transferring Accounting**: Locking Account records prevents using the Right-click Transfer option from the Accounting window. When attempting to transfer accounting to another client a warning message prompt says, “You are attempting to transfer LOCKED Accounting Records. Account Locking was set by a System Administrator.”
- **Moving a Patient**: When using History Locking and moving a patient using Right-click Move from the Patient Area. AVImark will allow history records to be moved along with the Patient record, but the history remains locked and cannot be modified.
Backdate Medical History: History Locking prevents backdating history entries when the date falls prior to the time-frame set. For example, if you are Locking History by Month, it should allow the date to be set back to yesterday, January 18th, but not to December 31st because December is locked. When trying to backdate beyond the time-frame specified AVImark will give a warning message prompt that says, “You are attempting to modify LOCKED Medical Records. Account Locking was set by a System Administrator.”
CHAPTER 22: TIME CLOCK

AVImark lets you track and report hourly employment activity. As the Hospital Administrator, you alone will be allowed to set up and edit Time Cards, print reports, and so on. As an employee, after you log into AVImark, you are given the opportunity to clock in and out using the Time Clock function.

In this chapter you will learn about...

- Set up the Time Clock on page 293
- Enter Clock out Reasons on page 294
- Track Hourly Staff on page 294
- Work with the Employee Time Card on page 295
- Use the Time Card Report on page 295
- Undo and Redo Time Card Changes on page 296
- View History of Entry on page 297

Set up the Time Clock
To set up the Time Clock, you should set options regarding the rounding of clock in and out times, when to display the employee’s time card and synchronizing the time on your workstations with that on the server. Also, if you have not set up AVImark Security, you should do that to protect at least basic security functions. If you’re not sure how to do this, refer to “CHAPTER 21: SECURITY ADMINISTRATION”.

- On the CID, open the Work with menu. Click Users and Security to display the Security Maintenance window.
- On the Time Clock menu, click Setup to display the Time Clock Options window.

![Time Clock Options window]

When clocking in
Use this field to clock in your employees as of a time of day rounded back to a previous time value. For in-
stance, an employee clocks in after lunch at 1:03 pm. You would like to give your employees no more than a five minute grace period. In this case, you would set this value to “5”. By doing this, each time an employee clocks in, their actual time, as recorded in AVImark, would be rounded back to the nearest 5 minute value—in this example, 1:00 pm.

- If appropriate, type a value, using a whole number, in the **When clocking in** field.

**When clocking out**

Use this field to clock out your employees as of a time of day rounded forward to a future time value. For instance, an employee clocks out for lunch at 11:57 am. You would like to give your employees no more than a five minute grace period. In this case, you would set this value to “5”. By doing this, each time an employee clocks out, their actual time, as recorded in AVImark, would be rounded ahead to the nearest five minute value—in this example, 12:00 noon.

- If appropriate, type a value, using a whole number, in the **When clocking out** field.

**Display the Time Card**

AVImark gives you two options in which to display an employee’s Time Card. It can be displayed when they are not clocked in “Only”, or you have the option to have it displayed every time the employee logs into AVImark. Most of the time, employees will be allowed to log out and back into AVImark while they are still “on the clock” and would not want to be bothered with the Time Card window every time. With the top box checked, if the employee is still clocked in, the Time Card will not be displayed when they log out and back into AVImark. With the second option checked, AVImark will display the Time Card every time.

- Choose the desired option for displaying the Time Card.

**Synchronize workstation clock with the server**

The AVImark Time Clock feature offers the option to synchronize the time of day with the server. By checking this option, each time a user clocks in or out of the Time Clock, AVImark forces the system time-of-day on all workstations to match that of the server. Once you check the “Synchronize workstation clock with the server” box, you will need to specify the server’s location on the network. You have three choices in which to access the server by.

- Choose the appropriate option from the **Access server by** area.

**Enter Clock out Reasons**

When an employee clocks out, they will need to select from a list of reasons, why they are clocking out. You will need to set up a table of typical reasons for clocking out. This list will be set up in System Tables, Clock out reasons. For more information on entering Clock out reasons, refer to “CHAPTER 2: SYSTEM TABLES”.

**Track Hourly Staff**

Of course, there are certain staff that work by the hour and those who do not. You will need to tell AVImark which personnel you wish the Time Clock function to track.

- On the CID, open the **Work with** menu. Click **Users and Security** to display the Security Maintenance window.
- Choose the **Category** group which is made up of hourly employees.
- From the **Users for** section, select the **Name** of one of the hourly users.
- Right-click and from the shortcut menu click **Change** to display the Change User window.
• Check the **Clocks In** box. This option must be checked in order to open the Time Clock.

• In the **Period Start** field, use the drop-down calendar and select the **Date** which the users Time Card will default to.

• If appropriate, check the **Track Overtime by Day** box and then use the UP and DOWN ARROWS to indicate the daily regular hours before overtime starts.

• Click **OK** to save the changes. Repeat this process for each staff member for whom you wish to track hourly activity.

### Work with the Employee Time Card

Whenever an employee clocks in or out, that activity is recorded on the employee’s individual Time Card.

#### Clock in

Whenever an employee logs into AVImark, if they are not already clocked in, AVImark will automatically open that person’s Time Card window. When an employee is already logged into AVImark, but not clocked in, they will need to access their Time Card through the Utilities menu.

- On the CID, open the **Utilities** menu. Click **Time Card** to display the employee’s Time Card.
- Click **Clock In**. After the date and time have been added to the Time Card click **Done**.

#### Clock out

When an employee is ready to clock out, they will need to open the **Time Card** to clock out and select a reason for clocking out.

- On the CID, open the **Utilities** menu. Click **Time Card** to display the employee’s Time Card.
- Click **Clock Out** to display the Clock-Out Reason window.
- Use the **Reason** drop-down list and choose a clock out reason.
- Click **OK**.

### Use the Time Card Report

TO LEARN MORE ABOUT:  
Start a Pay Period  
Add Notes to a Time Card  
Accessing the Time Card

SEARCH THE HELP FOR:  
Adding & Changing Staff  
Time Card  
Time Card

AVImark gives you the ability to print, email, save and/or export the Time Clock Report. This report may be accessed through both Users and Security and the Utilities menu. When printing the Time Card Report, there is a summary report option that will calculate overtime based on a forty hour work week. When running a summary report, overtime total by day may also be shown.

#### Print the report

- On the CID, open the **Utilities** menu. Click **Time Card Report** to display the Time Card Report window.
AVImark User Manual

Time Clock

- Using the User drop-down list, select the employee you wish to print for or select (all).
- Use the Start and End drop-down lists to indicate the period to print for. If you wish to close the current period, leave the Close Period on print box checked.
- In the Print To field, use the drop-down list to choose the printer to print to.
- Click Print or select Preview and click Print to preview an onscreen report.

Email the report
- Preview Print the report.
- On the Report Preview window, open the File menu. Click Email.
- Enter the email address, desired subject and text and click Send.

Save the report
- Preview Print the report.
- On the Report Preview window, open the File menu. Click Save As. The report may be saved as a PDF, HTML, RTF, TXT or an NDR file.

Export the report to Excel
- In the Print To drop-down list, select Excel and then click Print to display the report in Excel format.
- After the report has been generated, you may print, email and/or save the report using the same procedures as previously discussed.

Undo and Redo Time Card Changes
Any change in the Time Card window can be undone or redone. This is accomplished within the Time Card window. These options will not be available for Users who can not Change or Remove Time Clock entries.
- On the Time Card window, open the Edit menu. Click Undo Change User Category or Redo Change User Category.

To learn more about:
Change Time Card Entries

Search the Help for:
Change Time Clock
View History of Entry
When a change to a line entry in the Time Card has been made, AVImark will create a log that records the Date, Time, User and the action that was used to make the change of the line entry.

- On the Time Card window select the entry you wish to view the history of.
- Open the View menu and click Entry History to display the Entry History window.
CHAPTER 23: WORD PROCESSING

AVImark allows full access and integration with Microsoft Word® for all your word processing needs. You will be able to use several special merge words in the text of any MS Word® document, which will insert the correct information from your data files, along with importing digitized images and pictures of your clients, animals or images linked with medical records. Your hospital logo may also be included on any document. AVImark has the ability to use the Sun Microsystems’s products; StarOffice® and OpenOffice®, as alternative word processors. OpenOffice® is a free open source where as StarOffice® can be downloaded at a minimal charge. Although Microsoft® is not an absolute requirement, it is a recommended program for at least one computer on your network. As of this printing, StarOffice® and OpenOffice® do not have the capability to print reminders in AVImark, nor does AVImark support the spreadsheet capabilities of these products.

In this chapter you will learn about...

» Use Merge Words on page 299
» Use Merge Words for Additional Data Fields on page 307
» Work with Microsoft Word® on page 307

Use Merge Words

By typing merge words in the text of virtually any correspondence, AVImark will insert the correct information, at that position in the text. When using a merge word that would require a text box - that is, animal-pictures, graphs, or weight-graphs - AVImark will not allow this document to be printed through OpenOffice®/ StarOffice®. To print a photo or graph using these products, the text box must be removed. When using merge words in a document or in an AVImark notes window, include the less than (<) and greater than (>) symbols, before and after the word as shown below.

<table>
<thead>
<tr>
<th>AVImark</th>
<th>MS WORD®</th>
<th>MERGE WORD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;address&gt;</td>
<td>the client’s address, (1564 East Walnut Ave)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;added&gt;</td>
<td>date client added</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;address2&gt;</td>
<td>the client’s second line of address, (P.O. Box 356)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;age&gt;</td>
<td>the age of the patient, (3w)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;age-name&gt;</td>
<td>the full description of the age, (3 weeks)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;allergy&gt;</td>
<td>the allergy specification of the patient, (Flea)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal&gt;</td>
<td>the patient’s name</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal-alert&gt;</td>
<td>the animal’s alert message</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal-folder&gt;</td>
<td>the patient’s folder number</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal-names&gt;</td>
<td>list of living pets, (names only)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal-notes&gt;</td>
<td>Will include any notes placed in patient area, do not include this merge word with other text on the same line.</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animal-pic&gt;</td>
<td>the patient’s picture</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;animals&gt;</td>
<td>a list of living animals for this client, (includes breed, sex, age, and species)</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>&lt;appt-date&gt;</td>
<td>the date of the patient’s next appointment</td>
</tr>
<tr>
<td>Tag</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;appt-doctor&gt;</code></td>
<td>doctor’s initials assigned to the patient’s next appointment</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;appt-doctorname&gt;</code></td>
<td>the doctor’s name assigned to the patient’s next appointment</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;appt-notes&gt;</code></td>
<td>Any notes attached to the appointment. Only to be used on the check-in document.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;appt-time&gt;</code></td>
<td>the time of the patient’s next appointment</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;appt-treatments&gt;</code></td>
<td>treatments chosen for the patient’s next appointment</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;area&gt;</code></td>
<td>the client’s Area Code, (604)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;balance&gt;</code></td>
<td>the client’s balance due, (231.45)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;birthday&gt;</code></td>
<td>the patient’s birthday, (12-23-90)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;bovines&gt;</code></td>
<td>a list of living bovines for this client</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;breed&gt;</code></td>
<td>the breed of the patient</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;business&gt;</code></td>
<td>the client’s business phone number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;canines&gt;</code></td>
<td>a list of living canines for this client</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;cell-phone&gt;</code></td>
<td>the client’s cellular phone number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;census&gt;</code></td>
<td>the client’s name, patient’s name, facility, check-in date, and check-out date of all patient’s currently checked in</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;census-in&gt;</code></td>
<td>Patients check-in or Inpatients</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;census-out&gt;</code></td>
<td>Patient checked-out or Out-patients</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;census-hosp&gt;</code></td>
<td>Patients checked-out as Hospitalization</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;certificate&gt;</code></td>
<td>the current rabies certificate number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;check-in&gt;</code></td>
<td>the check-in date of the patient’s boarding or hospitalization</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;check-out&gt;</code></td>
<td>the check-out date of the patient’s boarding or hospitalization</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;checkin-waiting&gt;</code></td>
<td>The patient’s date and time of check-in The Patient is Waiting option must be selected for that patient in order for this merge word to work.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;city&gt;</code></td>
<td>the client’s city of residence, (Patterson)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;client&gt;</code></td>
<td>the client’s last name</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;client-alert&gt;</code></td>
<td>the client’s alert message</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;client-notes&gt;</code></td>
<td>all notes entered for the client</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;client-pic&gt;</td>
<td>the client’s picture</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-address&gt;</td>
<td>the address of the hospital, (453 East Elm St.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-address2&gt;</td>
<td>the second line of hospital address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-city&gt;</td>
<td>the city of the hospital</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-phone&gt;</td>
<td>the hospital phone number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-slogan&gt;</td>
<td>the hospital slogan as listed in Hospital Setup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-st&gt;</td>
<td>the state of the hospital</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;co-zip&gt;</td>
<td>the zip code of the hospital</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;color&gt;</td>
<td>the color of the patient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;company&gt;</td>
<td>the name of your hospital</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colorb&gt;</td>
<td>the body color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colore&gt;</td>
<td>the eye color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colorh&gt;</td>
<td>the hoof color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colorm&gt;</td>
<td>the mane color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colors&gt;</td>
<td>the sclera color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;colort&gt;</td>
<td>the tail color of patient   (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;contact&gt;</td>
<td>the client’s first name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;county&gt;</td>
<td>the client’s county name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;current-estimate&gt;</td>
<td>Used to print estimates on templates from the Pred Tablet® only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;current-userid&gt;</td>
<td>The ID or initials of the staff member currently logged onto AVImark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;current-username&gt;</td>
<td>The name of the staff member currently logged onto AVImark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;damname&gt;</td>
<td>The dam name of patient (AVImarkEQ only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;date&gt;</td>
<td>the current date, (01-13-94)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;death&gt;</td>
<td>date of death, (date service performed with Action Code of “D”)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;dx-descriptions&gt;</td>
<td>The description of all diagnosis that are in a patients Medical History.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;e-mail&gt;</td>
<td>the client’s e-mail address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;employer&gt;</td>
<td>the client’s employer</td>
</tr>
<tr>
<td>Tag</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;equines&gt;</code></td>
<td>a list of living equines for this client</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;estimate&gt;</code></td>
<td>a list of services that make up the selected estimate</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;est-entry-user&gt;</code></td>
<td>The name of the logged in user who created the estimate</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;est-expires&gt;</code></td>
<td>Expiration date of the printed estimate.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;estimate-name&gt;</code></td>
<td>The name of the current estimate</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;estimate-doctor&gt;</code></td>
<td>the doctor selected for a particular estimate</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;estimate-minus&gt;</code></td>
<td>prints the normal estimate detail without the quantities</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;estimate-range&gt;</code></td>
<td>prints the price variance for each item on the estimate plus a total</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;expiration&gt;</code></td>
<td>an inventory item’s expiration date</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;facility&gt;</code></td>
<td>the facility the current patient was most recently contained in while checked into boarding</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;fax&gt;</code></td>
<td>the client’s fax number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;felines&gt;</code></td>
<td>a list of living felines for this client</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;ferrets&gt;</code></td>
<td>a list of living ferrets for this client</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;first-and-spouse&gt;</code></td>
<td>Client and spouse first names</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;first-name&gt;</code></td>
<td>the client’s first name, (John)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;folder&gt;</code></td>
<td>the client’s folder number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;full-list&gt;</code></td>
<td>a list of patients due and all treatments due for each</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;graph&gt;</code></td>
<td>prints an AVImark graph on documents</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;gst&gt;</code></td>
<td>prints the tax ID number for Canadian clinics</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;he&gt;</code></td>
<td>the correct pronoun, (‘he’ or ‘she’)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;hers&gt;</code></td>
<td>the correct pronoun, (‘his’ or ‘hers’)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;him&gt;</code></td>
<td>the correct pronoun, (‘him’ or ‘her’)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;his&gt;</code></td>
<td>the correct pronoun, (‘his’ or ‘her’)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;id&gt;</code></td>
<td>the patient’s micro-chip or tattoo number</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-category&gt;</code></td>
<td>the category name for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-code&gt;</code></td>
<td>The code of the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-codes&gt;</code></td>
<td>the action code(s) for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-cost&gt;</code></td>
<td>the amount last paid for the item, (package)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-description&gt;</code></td>
<td>the item description</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-location&gt;</code></td>
<td>the item location, (the ‘loc’ field)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>&lt;item-measure&gt;</code></td>
<td>the item unit of measure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;item-price&gt;</td>
<td>the normal price of the item.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;height&gt;</td>
<td>the height of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;[History-Doctor-DEA]&gt;</td>
<td>the doctor’s DEA number that performed the selected service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;item-upc&gt;</td>
<td>the UPC code for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;item-vendor&gt;</td>
<td>the vendor name for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;lasthistdate&gt;</td>
<td>Will print the date of the patient’s last Medical History entry (posted or unposted) as the date of its last visit.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;last-name&gt;</td>
<td>the client’s last name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;license&gt;</td>
<td>the client’s drivers license number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;list&gt;</td>
<td>a list of patients due reminders on a consolidated card</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;locating-service&gt;</td>
<td>the locating service (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;locator&gt;</td>
<td>information about the Pet Portal’s patient ID number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;logo&gt;</td>
<td>the hospital logo graphic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markingb&gt;</td>
<td>the body marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markingh&gt;</td>
<td>the head marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markinghoof&gt;</td>
<td>the hoof marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markinglfl&gt;</td>
<td>the left foreleg marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markinglhl&gt;</td>
<td>the left hind leg marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markingm&gt;</td>
<td>The mottling marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markingrfl&gt;</td>
<td>The right foreleg marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;markingrhl&gt;</td>
<td>The right hind leg marking of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;measure&gt;</td>
<td>the unit of measure of the patient weight</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;mfg-code&gt;</td>
<td>the manufacturer’s code for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;number&gt;</td>
<td>the client’s AVImark Client ID Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;old-tag&gt;</td>
<td>the tag number of the last rabies vaccination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;on-hand&gt;</td>
<td>the item on-hand quantity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;on-order&gt;</td>
<td>the item quantity currently on order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;order-pack&gt;</td>
<td>the item order-pack quantity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;order-point&gt;</td>
<td>the order point for the item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;order-qty&gt;</td>
<td>the item on-order quantity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;overdue&gt;</td>
<td>a list of services, with reminders attached to them, that are past due for the patient</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;patient-record-id&gt;</td>
<td>patient’s record number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;pref-doctornamename&gt;</td>
<td>clients preferred doctor</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------</td>
<td>--------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;phone&gt;</td>
<td>the client’s home phone number, (555-6079)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;photo&gt;</td>
<td>current photo of the patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rabies&gt;</td>
<td>the current rabies tag number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;referred-by&gt;</td>
<td>the referring clients account number and last name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;reminders&gt;</td>
<td>the reminder schedule for the patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-address&gt;</td>
<td>address of the client in the Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-address2&gt;</td>
<td>the second line of address of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-business&gt;</td>
<td>the associated client’s work phone number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-city&gt;</td>
<td>the city of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-email&gt;</td>
<td>the email address of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-fa&gt;</td>
<td>the fax number of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-first-name&gt;</td>
<td>the first name of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-last-name&gt;</td>
<td>the last name of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-phone&gt;</td>
<td>the telephone number of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-st&gt;</td>
<td>the state of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-title&gt;</td>
<td>the title of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rel-zip&gt;</td>
<td>the zip code of the client in the patient’s Relationship field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-address&gt;</td>
<td>the referring client’s address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-address2&gt;</td>
<td>the referring client’s second line of address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-city-st-zip&gt;</td>
<td>the referring client’s city, state, and zip code</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-client&gt;</td>
<td>the referring client’s account number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-faxno&gt;</td>
<td>the referring client’s fax number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-first-name&gt;</td>
<td>the referring client’s first name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-last-name&gt;</td>
<td>the referring client’s last name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-phone&gt;</td>
<td>the referring client’s phone number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;rf-title&gt;</td>
<td>the referring client’s title</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;serv-amount&gt;</td>
<td>the selected service amount</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;serv-code&gt;</td>
<td>the selected service code</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;serv-date&gt;</td>
<td>the selected service date</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-description&gt;</td>
<td>the selected service description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;registration-name&gt;</td>
<td>The registration name of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-doctor&gt;</td>
<td>the doctor’s ID (initials) performing the selected treatment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-doctorname&gt;</td>
<td>the doctor’s full name performing the selected treatment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-license&gt;</td>
<td>the doctor’s license number that performed the selected service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-notes&gt;</td>
<td>medical history notes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-pic&gt;</td>
<td>a photo that has been linked to a treatment into a document</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;serv-qty&gt;</td>
<td>the selected service quantity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;sex&gt;</td>
<td>the sex code of the patient, (S)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;sex-name&gt;</td>
<td>the sex name, (Male, Female)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;sirename&gt;</td>
<td>The registration name of patient (AVImarkEQ only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-address&gt;</td>
<td>the address of the current site, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-city&gt;</td>
<td>the city of the current site, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-name&gt;</td>
<td>the hospital name of the current site, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-phone&gt;</td>
<td>the area code and phone number of the current site, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-state&gt;</td>
<td>the state the current site resides in, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;site-zip&gt;</td>
<td>the zip code of the current site, (site clinics)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-abnormalities&gt;</td>
<td>Selected abnormalities within the Objective area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-abnormality-%&gt;</td>
<td>Selected individual abnormalities. Replacing the percent sign with the code of an abnormality will include linked notes for that abnormality.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-assess-notes&gt;</td>
<td>Free-form notes that are linked to the Assessment area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-bcs&gt;</td>
<td>Actual BCS value within the Vital Signs area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-bcs-high&gt;</td>
<td>High BCS value within the Vital Signs area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-crt&gt;</td>
<td>CRT value within the Vital Signs area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;soap-diagnoses&gt;</td>
<td>Diagnosis codes that have been accepted into the Assessment area of the SOAP record</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tag</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-diagnostic&gt;</td>
<td>Diagnostic codes that have been accepted into the Plan area of the SOAP record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-heart-rate&gt;</td>
<td>Heart rate value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-instructions&gt;</td>
<td>Client Instructions within the Objective area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-other&gt;</td>
<td>Actual Other value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-other-high&gt;</td>
<td>High Other value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-obj-notes&gt;</td>
<td>Free-form notes that are linked to the Objective area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-painscale&gt;</td>
<td>To show on the Report Card</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-plan-notes&gt;</td>
<td>Free-form notes that are linked to the Plan area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-problems&gt;</td>
<td>Problems that are linked to the SOAP record within the Presenting Problems area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-problem-protocols&gt;</td>
<td>Diagnostic protocols that are linked to problems listed in the Presenting Problem area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-problem-ruleouts&gt;</td>
<td>Rule-out protocols that are linked to problems listed in the Presenting Problem area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-resp-rate&gt;</td>
<td>Respiratory rate value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-ruleouts&gt;</td>
<td>Rule-out protocols that have been accepted into the Assessment area of the SOAP record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-subj-notes&gt;</td>
<td>Free-form notes that are linked to the Subjective area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-temp&gt;</td>
<td>Temperature value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-therapeutic&gt;</td>
<td>Therapeutic codes that have been accepted into the Plan area of the SOAP record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;soap-weight&gt;</td>
<td>Weight value within the Vital Signs area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;species&gt;</td>
<td>the patient’s species name, (Canine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;species-name&gt;</td>
<td>patient’s species common name, (in Species Table)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;spouse&gt;</td>
<td>the client’s spouse name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;ssn&gt;</td>
<td>the client’s Social Security number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;st&gt;</td>
<td>the client’s state of residence, (MO)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;std-date&gt;</td>
<td>the current date, (June 7, 2010)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;time&gt;</td>
<td>the current time, (for example, 12:14)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;title&gt;</td>
<td>the client’s title</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;treatments&gt;</td>
<td>the list of remindable treatments the patient is due for</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;user-friendly&gt;</td>
<td>prints the doctor’s “user friendly” name</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-admin&gt;</td>
<td>the vaccine method of administration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-date&gt;</td>
<td>the vaccination date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-description&gt;</td>
<td>the vaccination description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-doctor&gt;</td>
<td>the doctor ID that performed service, (having a vaccine spec.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-dosage&gt;</td>
<td>Prints, on the Rabies certificate, the items measure (cc or ml) attached to a Rabies vaccination or the item measure directly entered in Medical History.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-due&gt;</td>
<td>the vaccination date due</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-exp&gt;</td>
<td>the vaccine expiration date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-id&gt;</td>
<td>the rabies tag number of the vaccination</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-license&gt;</td>
<td>the doctor’s license performing this vaccination, (having a vaccine spec.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-lot&gt;</td>
<td>the vaccine lot number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-mfg&gt;</td>
<td>the vaccine manufacturer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-name&gt;</td>
<td>the vaccine ‘Code’ in Work with...System Tables...Vaccine Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vacc-virus&gt;</td>
<td>the vaccine virus type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;vaccs&gt;</td>
<td>a list of services performed that include a “V” Action Code</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;web-address&gt;</td>
<td>the hospital web address specified in Hospital Setup, Demographics Tab in the Web site field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;weight&gt;</td>
<td>the weight of the patient, (25 lbs.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;weight-graph&gt;</td>
<td>the patient’s entire weight history in a graph form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;workstation&gt;</td>
<td>provides the computer name of the workstation being used</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;zip&gt;</td>
<td>the client’s Zip/Postal Code, (63956 or A4R3E3)</td>
<td></td>
</tr>
</tbody>
</table>

**Use Merge Words for Additional Data Fields**

If and when you define additional data fields related to clients, animals, treatments, inventory items, and/or diagnoses, AVImark allows you to use the name you assigned to each of the fields as a merge word to be used in any MS Word document. AVImark also allows you to merge photos into MS Word documents using More Stuff data fields of type *Photo*.

- Type the name of the additional data field into the document text.
- Enclose the name with the **Less than** (<) and **Greater than** (>) symbols.

**Work with Microsoft Word®**

AVImark gives you the ability to work with and create new documents using Microsoft Word. Although working with Microsoft Word is very beneficial, it is obviously beyond the scope of this manual to try to explain the details of this software product.
Open an existing document from the CID

• On the CID, open the **Applications** menu. Click **MS Word** to display the MS Word Document display window.

• On the MS Word Document display, open the **File** menu. Click **Open** to display the Open Window.

  ![Open Window](image)

  • Select the document you wish to work with. Click **Open** to display the document.
  
  • After the necessary changes have been made, open the **File** menu and click **Save** or **Save as**.
  
  • You will need to close MS Word.

Create a new document from the CID

• On the CID, open the **Applications** menu. Click **MS Word** to display the MS Word Document display window.

• On the MS Word Document display, open the **File** menu. Click **New** to display the New Document window.

• Choose from among the sample templates to begin with an appropriate document style and click **OK**.

• Use the prompts on the sample form to type the new document, using the appropriate merge words if applicable.

• On the **File** menu, click **Save as** to display the Save as window.

• In the **File name** window, type the name you wish to save the document as and click **Save**.

Delete a document from the CID

• On the CID, open the **Applications** menu. Click **MS Word** to display the MS Word Document display window.

• On the MS Word Document display, open the **File** menu and click **Open** to display the Open Window.

• Select the document you wish to delete. **Right-click** and from the shortcut menu click **Delete**.

• You will need to click **Yes** to confirm.

---

**To learn more about:** Specify using MS Word®/Open Office®

**Search the Help for:** Table of Contents – Word Processing & Forms
CHAPTER 24: DISCOUNT PLANS

AVImark provides the means to put a patient on a health maintenance plan including provisions for automatic discounting for specific treatments, courtesy discounting on others, and automatic reminding for plan renewal at the end of the period covered by the plan. The function allows the hospital to charge the customer up front for a treatment program for the patient and then automatically track the patient’s progress throughout the plan as time progresses. Provision is made for any number of discount plans to be defined by the hospital and any client may have each of their animals on a different plan. However, any given patient may only be qualified for one plan at a time.

In this chapter you will learn about...

- Defining a Discount Plan on page 309
- Reminding for the Plan on page 309
- Tracking Discount Plans on page 309
- Setting Up a New Plan on page 309
- Specifying Covered Services on page 310
- Changing the Discount Rate and/or Quantity of a Selected Service on page 311
- Putting a Patient on a Plan on page 311

Defining a Discount Plan

First, it is important to understand that a discount plan is represented by a treatment in your Treatment List. This is not an actual treatment of course but simply acts to identify the plan and define its cost to the customer. It also acts as a basis upon which to remind for the plan, later on a regular basis. It is recommended that you create a new category of treatments called something like Health Plans in your Treatment List, in which you will add all the different plans you intend to offer your clients. Each plan within the category will consist of treatments that you will create using an appropriate code, description, as well as a price.

Reminding for the Plan

Once these treatments have been created, you may want to set up reminder templates using the same procedures as you would for normal treatments within your Treatment List. For more information on setting up reminder templates, refer to “CHAPTER 11: REMINDERS”.

Tracking Discount Plans

Using the AVImark End of Period Reports, you may choose to print the Health Plan Report that tracks those patients currently on a Health/Discount Plan.

Adding a Plan

AVImark needs to know that the “treatment” you created, is actually a discount plan. Also you will need to specify the covered services associated with the plan. This will be accomplished by adding the treatment to System Tables, in a table called Discount Plan Table.

Setting Up a New Plan

- From the CID, open the Work with menu. Click System Tables to display the System Tables window.
From the Table section, click Discount Plan Table. Point in the Entries for Discount Plan Table section. Right-click and from the shortcut menu click New to display the New Plan Entry window.

![New Plan Entry Window]

**Code**
This field will be the code of the treatment which is already defined in your Treatment List.
- Type the plan Code as defined in your Treatment List.

**Plan**
After the correct Code has been entered AVImark will enter the Plan description for you.

**Courtesy Class**
This field allows you to specify a Client Discount Class that should be applied to clients and patients that purchase the Discount Plan.
- Using the Courtesy Class drop-down, select the appropriate Client Discount Class.

**Courtesy Rate**
AVImark allows you to specify what percentage discount is to be allowed on all treatments and/or inventory items NOT specifically covered by the plan.
- If appropriate, specify a Courtesy Rate percentage using whole numbers.

**Months**
This field indicates the number of months the plan will be active. Discounts defined in the plan will be extended to the client ONLY for the number of months from the day the plan is entered into the patient’s Medical History.
- Using the UP and DOWN ARROWS, specify the number of months for the plan.
- Click OK to save the entry. Another New Plan Entry window will display which will allow you to enter the next New Plan Entry.
- When finished with all entries, click Cancel.

**Specifying Covered Services**
- From the Entries for Discount Plan Table section, click the Plan you wish to define.
- Right-click and from the shortcut menu click Included services to display the Included services window.
- In the Included services window, right-click to see the shortcut menu. Point to Choose and click
Treatments, Items, Diagnosis and/or Problems to display the appropriate list.

- Select the treatments, items, diagnoses and/or problems you wish to add to the plan.

![Included Services Window]

- Click Done after all services have been added.

**Changing the Discount Rate and/or Quantity of a Selected Service**

- From the Included services window, select the treatment, item, diagnosis and/or problem you wish to change.

- Right-click and from the shortcut menu click Change to display the Change Plan Treatment or Item window.

![Change Plan Treatment or Item Window]

- If appropriate, use the Discount field to type the discount percentage allowed for this service.

- If appropriate, use the Count field to enter the number of times the service can be performed during the plan period and still qualify for the discount.

- Click Done on the Change Plan Treatment or Item window. Click Done on the Included services window.

**Putting a Patient on a Plan**

When a client has decided to purchase one of your discount plans, simply enter the defining “treatment” into the Medical History area for the correct patient. This will initiate the discounting process specific to this plan and allows for the renewal reminding to take place a year later. From this point on, any treatments and/or items performed which are covered under the plan, will be priced according to the values and qualifications described above. When the plan expires, AVImark will automatically remind for plan renewal and halt the discounting process until the client chooses to purchase the plan once more.

**To learn more about:**

- Courtesy Class
- Health Plans

**Search the Help for:**

- Discount Plans
CHAPTER 25: ADDITIONAL DATA FIELDS

AVImark allows you to add extra fields of information to those already existing in AVImark. For instance, you may want to add a field for client information called, “Spouse phone” in order to record the spouse’s phone number. AVImark allows you to define any number of Additional Data Fields for clients, patients, treatments, SOAP records and Whiteboard. These Additional Data Fields may be of several different types and you may add as many fields as you wish. Telling AVImark which fields you want to add to the system and what type of data you intend to enter into each of the fields might be called Additional Data Field definition.

In this chapter you will learn about...

» Define Additional Data Fields for Clients/Patients on page 313
» Set Normal Values on page 317
» Define Additional Data Fields for Treatments on page 317
» Set up a Data Table on page 318
» Define Additional Data Fields for SOAP Records on page 319
» Define Additional Data Fields for Whiteboard on page 319
» Create New Generations of Definitions on page 320
» Enter Information on the CID on page 320
» Enter Multiple Entries on page 320
» Enter Information into the Diagnosis Window on page 321

Define Additional Data Fields for Clients/Patients

• On the CID, open the Work with menu. Click System Tables to display the System Tables window.

• From the Table section, click Additional Data Fields to display the entries for this table.

• From the Entries for Additional Data Fields section, select Client. Right-click and from the shortcut menu click Change to display the Change More Stuff Entry window.
The **Code** and **Description** fields will be defined for you.

If appropriate, use the **Action Codes** drop-down list and select the **B** Action Code. By selecting the **B** Action Code, AVImark will automatically prompt you to input additional client information each time you add a new client to your system.

Click **OK**.

### Add data fields

- In the Entries for Additional Data Fields area, select **Client**.
- Right-click and from the shortcut menu click **More Stuff Fields** to display the Define More Stuff window.

Point in the **Define More Stuff** window. Right-click and from the shortcut menu click **New** to display the Additional Data Fields window.
Name
This is the name that staff will see when entering new information.

- Type an appropriate name or other identifier.

Type
This field indicates the type of data that will be used.

<table>
<thead>
<tr>
<th>DATA TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age</td>
<td>Use this field type when the data will be some age value.</td>
</tr>
<tr>
<td>Date</td>
<td>Use this type of field when you intend to use the field to hold a date. Use the format: “MM-DD-YY” (i.e. “08-11-10” for August 11, 2010). If appropriate, use the drop-down Default menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>Decimal</td>
<td>Use this field type for values that require a decimal point. If appropriate, use the drop-down Default menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>Use the Diagnosis field type for inputting any of the diagnoses in Work with, Diagnoses. This field type might be used in a table of other Additional Data Fields related to a patient “check-in” procedure or S.O.A.P. format for patient medical history. See the topic called “Entering Information into the Diagnosis Window”.</td>
</tr>
<tr>
<td>Integer</td>
<td>Use this field type when the field is intended to be used for integer values (whole numbers), such as counters, quantities, etc. Be aware that a field of this type can “hold” any value between -32,767 and +32,768, so plan accordingly. If the numerical value you need to record for this field is sometimes outside this allowable range, use the Decimal type instead. If appropriate, use the drop-down Default menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>Item</td>
<td>Use this field type when the data is to be an Item Code from the AVImark Inventory List in Work with, Inventory.</td>
</tr>
<tr>
<td>Photo</td>
<td>Use this field type to enter any digitized image (photo or scanned image) into the data field.</td>
</tr>
<tr>
<td>Phrase</td>
<td>Use this field type when you intend to enter up to 255 characters of descriptive information in this field. Contrast this field type with “W/P” (Word Processing) that allows you to enter unlimited scroll text in a separate “notes” window. This field type will also let you choose a system table.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Pos/Neg</td>
<td>Use this field type when the information is either <strong>Positive</strong> or <strong>Negative</strong>. These are the only two allowable values for this field type. If appropriate, use the drop-down <strong>Default</strong> menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>Sen/Res</td>
<td>Use this field type for Susceptibility (results of lab tests). The allowable values you can select with this field type are <strong>Susceptible</strong>, <strong>Mod Suscept</strong> (Moderately Susceptible), <strong>Resistant</strong>, <strong>Not Tested</strong> and <strong>Not Done</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>This is a very powerful field type in AVImark. It allows you to enter a table of values that is unlimited in the number of rows and whose width is limited only by the size of your printer.</td>
</tr>
<tr>
<td>Time</td>
<td>Use this field type when you intend to use the field to hold a time value. Use the format: “HH:MMa (or p)” (i.e. “7:46a” for seven forty-six am). If appropriate, use the drop-down <strong>Default</strong> menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>Treatment</td>
<td>Use this type when the data is to be a Treatment Code from the AVImark Treatment List.</td>
</tr>
<tr>
<td>User</td>
<td>Use this type definition when the data is one of your staff as listed in <strong>Work with, Users &amp; Security</strong>. If appropriate, use the drop-down <strong>Default</strong> menu to choose an appropriate default value for this field definition.</td>
</tr>
<tr>
<td>W/P</td>
<td>This indicates that this field is a Word Processing field. This means that when you want to enter information into the field, you will open a window and will be allowed to enter unlimited scrollable word-wrapped, spell-checked text in the window.</td>
</tr>
<tr>
<td>Yes/No</td>
<td>Use this field type when the only data values appropriate for this field are <strong>Yes</strong> or <strong>No</strong>. If appropriate, use the drop-down <strong>Default</strong> menu to choose an appropriate default value for this field definition.</td>
</tr>
</tbody>
</table>

- Using the **Type** drop-down list, select the type data.

**Default**

When defining certain field types, for example; **Pos/Neg, Yes/No, Decimal**, and so on, there may be one of the values which would typically be appropriate over the other. AVImark allows you to enter a default value for these certain data types.

- If appropriate, use the **Default** drop-down list and select a Default value.

**Options**

This field allows you to choose from 4 options that are specific for Additional Data Fields.

**On Patient Chart**

This option causes this field to be included on the Patient Chart. For example, you have to set up an Additional Data Field for client information called Spouse phone to be included when printing the Patient Chart.

**Searchable**

This option causes AVImark to include this field in the system index for clients and patients. If you specify the option of Searchable for any Client Additional Data Field of type **Phrase**, you will be able to locate the client from the CSD by typing some or all of the information in the Client field.

**Merge Words**

AVImark allows you to insert the value of the Additional Data Field into the text of any MS Word document. 
simply by using the Additional Data Name Field, enclosed with the Less than (<) and Greater than (>) symbols, as a merge word in the document.

*Print if positive*
AVImark allows you to print the results of a test showing positive results. The type must be selected as Pos/Neg for this option to work. When results prove positive, the information will print on the Patient Chart. When results prove negative no results will be printed on the Patient Chart.

- If appropriate, click the **Option** which applies to this data field.

**Qualifier**
This is intended for values which need some unit of measure. For example, miles, days, ml/kg. It can be used to record lab results and other values that need a qualifier after the value itself.

- If appropriate, specify the **Qualifier** for this data field.

*Choose from menu*
Within **System Tables**, AVImark allows you to create your own tables of information. These tables can be made up on any list of values. When you select **Phrase** in the Additional Data Field **Type** field, you will notice a **Choose from** drop-down menu. This menu will allow you to select the System Table from which you could choose the appropriate information when you start recording data in this field. Specifying the table name here will let you pick from that list when you are actually entering the data. If you click the **Must Choose** box, AVImark will display the System Table’s contents as a drop-down menu for you to choose from when you’re entering new client data. If you do not click the **Must Choose** box, AVImark gives you the option to either type your own value or choose from the table.

- If appropriate, use the **Choose from** drop-down list and select the correct System Table.
- If appropriate, click **Must choose**.
- Click **Done** to record the field definition.

*Set Normal Values*
AVImark allows you to specify minimum and maximum expected values for any additional data field that is intended for either **integer** or **decimal** values.

- With the correct field selected in the Define More Stuff window, right-click and from the shortcut menu click **Normals** to display the Normal Values window.
- In the Normal Values window, right-click and from the shortcut menu click **New**.

**Species**
This field allows you to select a specific species, or all species.

- Using the **Species** drop-down list, select the appropriate species.

**Min/Max**
These fields are used to set the expected normal values for the specified species.

- Enter the **Min** and **Max** expected values.
- Click **OK** to return to the Normal Values window.
- If appropriate, repeat for setting the expected values for other species.
- When finished entering Normal Values, click **OK**.

**Define Additional Data Fields for Treatments**
As mentioned above, AVImark also lets you specify Additional Data Fields for any treatment in your Treatment List. (AVImark does not support adding additional data fields to inventory items or diagnoses.)
For example, let's say you wanted to keep specific results of lab tests in a certain format. AVImark allows you to add Additional Data Fields to your Blood Profile service(s) to provide a proper framework for later data entry.

- From the Treatment List, select the correct treatment. Right-click and from the shortcut menu click **Change** to display the Change Treatment Window.
- Click **More Stuff** to display the Define More Stuff window.

Define Additional Data Fields for this treatment using the methods discussed in the topic “Add Data Fields” on page 314.

### Set up a Data Table

One of the Additional Data Field types is a field type called “Table”. This field type allows you to set up a table of values that can be used as a unique Additional Data Field. The definition of this table of values will be set up in a separate category of System Tables called, Additional Data Tables.

- From the Table section of System Tables, click **Additional Data Tables**.
- Click in the Entries for Additional Data Tables section.
- Right-click and from the shortcut menu, click **New** to display the New More Stuff Table Entry window.

- In the **Code** field, type a Code appropriate for the entry that will be defined.
- Use the TAB key to move to the **Description** field. Type an appropriate Description.
Click **OK** to display another New More Stuff Table Entry window. You may enter other new entries or click **Cancel** to return to the Additional Data Tables Entries display.

With the new entry selected right-click and from the shortcut menu click **More Stuff Fields** to display the Define More Stuff window.

Define Additional Data Fields for the entry using the methods discussed in the topic “Add Data Fields” on 314e 303.

### Set up the Data Table “field” for clients
With a user-defined data table setup, you are able to set up a new Additional Data Field for Clients which will allow you to enter specific information from the CID.

- From the Table section in System Tables, click **Additional Data Fields**.
- From the Entries for section, click **Clients**. Right-click and from the shortcut menu, click **More Stuff Fields** to display the Define More Stuff window.
- In the Define More Stuff window, right-click and from the shortcut menu, click **New**.
- Type a Name similar to that of the user-defined table which you have set up.
- Use the **Type** drop-down, and select the field type **Table**.
- Use the TAB key to move to the Choose from field and select the appropriate table.
- Click **Done** to return to the Define More Stuff window and then click **OK**.

### Define Additional Data Fields for SOAP Records
AVImark allows you to create additional data fields for each of the folders in the Medical Condition window. These additional data fields are created in the Additional Data Fields System Table in much the same way as you would create additional data fields for client or patient information.

- On the CID, open the **Work with** menu and click **System Tables** to display the System Tables window.
- Select the **Additional Data Fields** table and then the correct **Entries for** folder.
- Right-click and from the shortcut menu click **More Stuff Fields** to display the Define More Stuff window.
- Add the data fields you would like to create and click **Done**.

### Define Additional Data Fields for Whiteboard
Additional Data Fields may be created for the “Checked-in” tab or the “Schedule” tab.

- On the CID, open the **Work with** menu. Click **System Tables**.
- Select the **Additional Data Fields** Table.
- In the Entries for Additional Data Fields section, select the area you wish to create fields for.

#### Additional Check-in Fields
Selecting this field, you may create Additional Data Fields for the Check-in tab.

#### Additional Whiteboard Fields
Selecting this field, you may create Additional Data Fields for the Schedule tab.

- Right-click and from the shortcut menu, click **More Stuff Fields** to display the Define More Stuff window.
- Right-click and from the shortcut menu, click **New** to display the Additional Data Field window.
- In the **Name** field, type the description of the field you want to create.
- Using the **Type** drop-down list, select the field type that would be best for data that will be entered into
the field you are creating.

• Click **Done** to add the field. Continue adding the desired Additional Data fields in the same manner, and then click **OK** when you are finished.

• Click **Done** on the System Tables window.

**Create New Generations of Definitions**
From time to time you may find the need to change the kinds of additional information you want to keep for clients, patients, or for a given treatment. Since there may be many clients for which the original fields of information have already been entered, AVImark **will not** allow you to simply go to the Additional Data Fields Definition Window and add another field definition. AVImark will, however, allow you to define more than one “set” of Additional Data Fields for a given client, patient, or treatment. A new and different definition for the same treatment, client, or patient is called a **New Generation**.

• On the CID, open the **Work with** menu. Click **System Tables** to display the System Tables window.

• From the Table section, click **Additional Data Fields** to display the entries for this table.

• Select the correct Entry for Additional Data Fields. Right-click and from the shortcut menu click **More Stuff Fields** to display the Define More Stuff window.

• On the **Generation** menu, click **New**.

• The original definition fields will automatically copy over to the new generation. Add as many new definitions as you like and/or remove those you wish to leave out.

• Click **OK** to save the new generation.

**Enter Information on the CID**
Now that you have defined Additional Data Fields, you may enter information into these fields from the CID.

• On the CID, click in the area in which you wish to enter information into an Additional Data Fields window.

• Additional information related to a specific treatment, click on the treatment in the Medical History for the correct patient.

• Right-click and from the shortcut menu, click **More Stuff** to display the specific Additional Data field window.

• If entering data into a “Table” data field, right-click and from the shortcut menu click New.

• Enter the appropriate information into each field and click **OK**.

**Enter Multiple Entries**
AVImark allows you to enter more than one set of information for any client, patient or treatment record. For instance, let’s say you are working with a household that is made up of multiple pet owners and you would like to keep the added fields data for the different owners.

### Multiple data entry for clients
- From the Additional Client Data window, enter the information for one of the clients.
- On the **Data** menu, click **New**.
- Enter the information for the other person and then click **OK**.

### Enter Information into the Diagnosis Window
When a data field has been defined as a type of “Diagnosis”, you are allowed to choose a diagnosis from the list. When entering a data field of this type and the diagnosis code is known, you may just type the code. When the code is not known, you must select the diagnosis from the list.
- Click in the data field which has been defined as a diagnosis.
- On the **Diagnosis** menu, click **Choose** to display the Diagnosis List Maintenance window.
- Select the correct diagnosis from the list and then click **Done**. Only one diagnosis per field may be selected.
CHAPTER 26: INFORMATION SEARCH

AVImark allows you to locate or target a variety of information in your data including clients, patients, Medical History, and accounting. The data can be sorted, filtered, printed, and exported to a variety of formats. You set the criteria by specifying what type of information you want to look for in the Look for column, specifying a Comparison test that tells AVImark how to look, and typing certain Value(s) that you want AVImark to search for. Selected data may then be viewed, organized, sent to a printer for reports and/or labels, and/or sent to a word processor, and so on. You may also choose to send documents to any client/patient selected by the search.

In this chapter you will learn about...

- Access the Information Search Display on page 323
- Utilize New Search Criteria Window on page 325
- Create and Run a Search on page 326
- Save a New Search on page 331
- Print and E-mail Results on page 331
- Create a Sample Search on page 333
- Print the Criteria on page 334
- Omit Information on page 335
- Modify an Existing Search on page 335

Access the Information Search Display

- On the CID, open the Work with menu. Click Information Search to display the Search library window.

Choose Search Criteria (Library) Window
AVImark User Manual

Information Search

From the Choose Search Criteria window or library window AVImark allows you to create search categories that can be used to organize searches pertaining to a specific group of clients and/or patients.

**File Menu**
- Select the **Print** option to print a search category and the criteria for each search.
- From the Print window use the **Category** drop-down option to choose the category you want to include on the report. Leave the option set to All Categories to include all categories on the report.
- Check the **Print Criteria** option to include the set up of each search included on the report.
- Under the **Sort By** area select to sort the report by Category and then by Code or Name.
- In the **Print To** field click on the drop-down list to choose a printer.
- Use the **Preview** option to view the report on screen and select **Print** to print the report.
- Click **Done** to close the window.

**Edit Menu**
- Use the **Undo** and **Redo** options to revert back to changes that have been made.
- Click **Select All** to choose all entries within the category that is currently selected or choose to **Invert the Selection**.

**View Menu**
- Select **Refresh** to refresh the screen or press F11.
- Use the **Columns** feature to customize the displayed columns.
- The **Entry History** option will display a history of changes made to the selected entry.
- Select **Show/Hide Preview** to view or hide notes associated with the entries.
- Use the **Show/Hide Group Panel** option to display a panel area allowing you to choose a category you want to organize the entries by.

**Help Menu**
- Select the **Topic** options to access AVImark’s Help file.

**Creating a Category**
- Under the Category window choose **right-click New** to begin creating a category.
- In the **Category** field enter a descriptive name that will represent searches associated or located in this category.
- Click **OK** to complete the setup.

**Assigning a Search Name**
Before creating a search or defining the criteria for the search you can assign the search a name and attach notes to the search. However, this can also be done after setting up the search.
- From the Library window under the Search Criteria section choose **right-click New**.
- The **Category** field displays the category this search will be associated with. By choosing another category AVImark will move this search to the selected category after clicking **OK**.
- In the **Code** field type a code that will represent this search.
- Type a descriptive name for the search in the **Name** field.
- Use the **Text** area to type notes that refer to the search.
• Click OK to complete the setup.
• You can then double left-click on this search name to begin defining the criteria.

**Utilize New Search Criteria Window**
After creating a search or selecting a search you will automatically be taken to the New Search Criteria window.

**Menu Options**
By utilizing the menu options you can perform many functions.

*File Menu*
- Selecting New Criteria allows you to open and create a new search.
- To work with another search select the Choose Criteria option.
- After working with the selected search choose Save to save your additions and changes.
- The Save As New Criteria saves the search under a new name.
- Select Remove to delete the selected search.
- The Print Criteria option will print the information search specifications. When the Print window opens click Print to view the setup of the search. This is the information used by AVImark’s Technical Support to review the setup of the search.

*Edit*
- Select New Condition to begin creating conditions for the selected search.
- The Delete Condition option will delete the condition you have currently highlighted.

*View*
- Refresh will refresh or redisplay the screen.
- Click the Search option to run the search and have AVImark display the results.
- The Code Editor option allows you to copy and paste search specs.

*Results*
- Select the Email option to send a mass email to your clients found in the search.
- The Export option allows you to merge your search results to Excel.
- Selecting Print will display the Print Query window again.

**Tab Pages**
The new search window uses 3 tabs to accomplish setting up the entire search criteria. You will work with all 3 areas to complete setup of each search.

*Search Criteria Tab*
The information search only requires you specify what information will be used to narrow down your database and you will do this on the Search Criteria tab. You do not mark or select the fields that will be reported in this tab.

Entries setup in the Search Criteria window determines what area of the program information is being pulled from.

- To setup a new search choose right-click New Condition to open the New Search Condition window.

*Report Criteria Tab*
From the Report Criteria tab you will select what information needs to be printed on the report

- Use the Find field to select the item in the list you wish to report.
Information Search

- Double left-click on the entry or use the arrow buttons to move it under the Report Fields area or use the drag and drop function.

Search Results Tab
- To run the search, click the Search button at the bottom of any tab. The search results will be displayed in the Search Results tab.

Create and Run a Search
You may add any number of new searches to the Search Library, giving each search a name of your choice.
- On the Search Criteria (Library) window, click Cancel to display a New Search window.
- Begin defining the criteria under the Search Criteria tab.

Search Criteria
Under the Search Criteria tab you will define the values needed for locating the desired information. Keep in mind you do not need to include all values you want to print on the report only those main values used to find the clients or patients.
- Under the Search Criteria tab select right-click New Condition or click the Page like icon to begin defining the values for the search.
- From the scrollable list choose an area you want AVImark to search in (i.e. Clients, Accounting, etc.).
  - To search for a specific field within the client area select Client
  - Use the Account option to search for a specific field within the Accounting area for a client.
  - To set up criteria searching by patient age, breed, check-in date, etc. select the Patient option.
  - The History option allows you to search for fields or information within the Medical History area.
  - Use the Patient Reminder option to define criteria that will search for patients based on when reminders are due, reminder description, series name, etc.
  - To search for patient test results located in the patient Medical History Analyte window select the Analyte option.
  - Select the Appointment option and use a number of the criteria options such as when the appointment is due, the appointment type, or if it’s an appointment for a new client or patient.
Restrict the search by searching for Check-in information such as In Date, Out Date, Waiting Since Date or Time, Released, Status, etc.

If using the Client File Attachment option you can search for the attachment description, filename, attached notes and other client information.

To search for credit card information select the Credit Transaction option.

To search for entries that are on the E-Travel Sheet select the E-Travel Entry option.

Search for the patients associated follow-up information by selecting the Follow-up option.

Select the History File Attachment option to search for file attachments that are linked to a medical history entry.

The History Item Used option can be used to search for inventory used items in Medical History. From this criteria option you can also search for container and variance information.

To search for information contained in a Medical Condition Record such as the vitals, notes and More Stuff select the Medical option.

To search for the abnormality information within a SOAP record select the Medical Abnormality Entry option.

Use the Medical Diagnoses Entry option to search for the diagnoses information such as code, description and rejected in the SOAP record.

To search for the diagnostic entry in the SOAP record select the option Medical Diagnostic Entry.

Search for the rule-out entries by selecting the option Medical Rule-out Entry.
Use the **Medical Subjective Entry** option to search for notes or other information contained in the Subjective area of the SOAP record.

To search for the quantity or repeat values of therapeutic entries included in SOAP records select the option **Medical Therapeutic Entry**.

Select the **Ownership** option to search for split-billing information such as percent, previous owner and the start and end dates.

To search for patients by estimates select the **Patient Estimate** option. By selecting this option you can search for active estimates, expiration dates or those that have expired as well as the name and date given.

To search for an entry included in an estimate by searching for the Code, Description, Count, Amount and other criteria select the option **Patient Estimate Entry**.

To search for the name or description of a file attached to a patient select the option **Patient File Attachment**.

Select the **Payment Account** option to search for clients who are on a payment plan. This is for clinics using MPS.

Use the option **Problem History** to search for the description, open date and closing date of entry within a patient Problem History.

Select the **Recurring Payment** option to search for a client that has been set up on a recurring payment plan. This is for clinics using MPS.

Search for a requisition form attached to a patient by using the **Requisition** option.

Use the **Requisition Entry** option to search for a specific entry on a Requisition form.

If using Sound Technologies and wanting to search for the file or associated entry select the **Sound Image** option.

To locate test result information such as instrument name, test date, status and other information located in the Medical History Tests window select the **Test** option.

Search for specific information based on a patient's vaccination using the **Vaccine** option.

Use the **Whiteboard Activity** option to search for information such as Rate, Completed, User ID and other values for a scheduled entry on the Whiteboard.

Search for entries on a Work List by using the **Work List** option.

By using the **Other Areas** drop-down list you can choose other areas that you would like for AVImark to search in, such as; audit trail entries, block-offs, purchase orders, etc. By selecting another area other fields will be displayed.

After choosing an area press **Enter** or click **Next**.

Next choose to have AVImark search through all clients or through those that have been included in a search and click **Next**.

AVImark defaults to the option **Search based on a particular Client field values**, which is the value you are currently defining for the new search.

Under the Advanced area choose to have AVImark **Search for values within another previously defined search**, **Search on a summary field within another previously defined search** or **Select All**.
Choosing an option under the Advanced tab and selecting Next will open another window allowing you to select the search you want to search in and/or the specific field.

- Choose a specific value you want to use to restrict the search and click Next to advance to the next screen. It is not necessary to search for all fields you want to include on the report. From this window simply select the main values used to locate the group of clients and/or patients you are searching for.
- In the next screen choose a Comparison value by clicking on the drop-down list and then entering the appropriate value in the adjacent field.
- Select Finish after defining the appropriate information and the criteria condition will appear under the Search Criteria tab.
- Select right-click New to define more values and comparisons for the selected search.
- A checkmark will appear by the criteria you want to use for defining the search.
- You can quickly change a comparison value by clicking on the comparison and selecting a value from the drop-down list.

Creating Sub-Conditions
When searching for criteria and defining values where you need to search for either or, you will want to create sub-conditions. For example; when searching for clients that live in a specific area you can have AVImark locate the clients by searching for the city or zip code.

- From the Search Criteria tab select the value line you want to create a sub-condition under.
- From the right-click menu select New Sub-condition.
- Use the appropriate drop-down arrows to change the value from all to one or more or from True to False.

Report Criteria
After defining the search values you will determine what information needs to be included on the report and also how to sort the information.

- Click the Report Criteria tab
• From the scrollable list on the left choose the field you want to include on the report and click the green arrow pointing to the right or double left-click on the field. Repeat this process until the desired fields or values are selected.

• Use the Find field to quickly locate the desired field by typing the name in the field and AVImark will display fields matching the characters typed.

• To determine the report sorting options for a value double left-click on the value under the Report Fields area or select right-click Change.

• If appropriate change the title of the column heading in the Caption field.

• Use the Width field to specify the amount of characters allowed for the width of the column.

• In the first Sort Order field specify the sequential number this column will appear in. Click on the sort drop-down list to have AVImark sort the column by Ascending, Descending or leave it unsorted.

• Under the Summary area choose the desired summary or count total.
  ◦ Select Sum to have AVImark add the values in the associated column.
  ◦ Use the Count option to display a total count of the selected criteria.
  ◦ Select Count Distinct to prevent duplicates from being added into the total amount.
  ◦ If you want an Average of the number found in the associated column select this option.
  ◦ Select the Min or Max options and AVImark will print the minimum and maximum values for the column on the Subtotal line.

• Click OK once all appropriate information has been specified.

Subtotals and Summary Setup
Use the Subtotals and Summary option to customize the information AVImark is subtotaling and summarizing.

• If appropriate from the Report Criteria tab select the Setup option for Subtotals and Summary.

• To subtotal a column you are sorting click on the Subtotal By drop-down arrow to select the column you want to use for subtotaling.

• Under Summarize check the Summarize by Sort Order option to reflect on how the columns are already sorted. Or to have AVImark sort the column differently or group things together check the Specify Summary Order option.

Search Results
After the search criteria has been defined you can then run the search to determine the results.
• From any tab in the Information Search window click the Search button at the bottom of the window.
• The results will be displayed on the Search Results window and the Print Query window will open.
From the Print window click Print to print the results or click Done to close the Print window and review the results.

You can open a clients file by double left-click on the appropriate client name.

After clicking Done on the Print window and reviewing the results simply click the Printer icon or select Results, Print from the menu to reopen the Print window.

Save a New Search

Saving the Search
Once the criteria and report values have been defined it is recommended to save the search.

From the File menu select Save.

Choose the Category where the search will be contained, enter a Code and the search Name.

Click OK to save the search.

Print and E-mail Results

Print Query Window
By using the Print Query window you can print results, documents, postcards or mailing labels.

To open the Print Query window select the Search button at the bottom of the Criteria window or from the Results menu click Print.
Print Results

- Click on the Print To drop-down arrow to choose the appropriate printer you are sending the results to.
- AVImark defaults to having the Print Results option selected and you will want this checked when printing the search results.
- To view the results and the report layout before printing click the Preview button.
- When ready to print the results click the Print button.

Merge to Document

To print documents for clients and patients found in the search you will want to use the Merge to Document option.

- In the Print Query window select the Merge to Document option.
- From the Document field click the search or browse button.
- Locate the document, select it and click Open to display the document name in the Document field.
- Click on the Sort By drop-down arrow to choose how you wish to sort the documents.
- If multiple patients belonging to one client are listed in the search results you can print one document for the client instead of for each patient by clicking the One per client option.
- Click Print when ready to print the documents.

Print Post Cards

After running the search you can also print postcards for the clients found in the search.

- In the Print Query window click on the Print To drop-down arrow to select the printer you are sending the postcards to.
- You will then check the Print Post Cards option.
- To begin entering the text click the Post Card Text Setup option. This will display a note window allowing you to enter the desired text and appropriate merge words. Click Done once the text has been entered.
- Use the Per Page drop-down arrow to select how many postcards will be printing on one page.
- To sort the postcards by a default sort, Zip Code, Client Name or Account click on the Sort By drop-down arrow and select the desired option.
- If the client has multiple pets that were found on the search check the One Per Client option to print only one postcard per family.
- Click Print when ready to print the postcards.

Print Mailing Labels

If using the Information Search to print letters or documents to the group of clients found in a search you can also print mailing labels for those clients.

- In the Print Query window click on the Print To drop-down arrow to select the printer that will be used for printing the mailing labels.
- Click the Print Mailing Labels option to define the label settings.
- From the Style drop-down arrow choose the style AVImark should print the labels in.
- Click on the Sort By drop-down arrow to sort the labels by Zip Code, Client Name, Account or the default sort.
- Click Print when ready to begin printing the labels.
E-mailing Results
After running a search you can email the results.

- From the Results menu click E-mail.
- Select the Message Text box to enter the email text in an AVImark Note window. Click Done after entering the text.
- To send one e-mail per client check the One Per Client checkbox.
- Use the Attached File browse button to search for a file you wish to include with the e-mail. This could be a document, photo, pdf, etc.
- Click on the Reply To drop-down arrow to select the reply e-mail address, which is found in Hospital Advanced Options.
- When ready to send the e-mails click Send.

Exporting Results
The results of an Information Search can be exported to Excel allowing you to change the format and arrange the information and also save the information results.

- After running the search choose Results, Export from the menu.
- In the File Name field type the name of the file followed by the extension CSV or DBF. You can also click the browse button to search for a file and save the merged file as the selected file.
- Click on the Merge Format drop-down arrow to choose the format for the information being exported to Excel.
  - Standard, consolidated - The first line of the merge file will contain titles for common client and patient data fields. Then, for each client selected, the merge file will contain this information.
  - Client information - This merge file will contain detailed client fields for the clients selected in the search.
  - Account transaction - This merge file will contain detailed accounting fields for the accounting information selected in the search.
  - Patient information - This merge file will contain detailed patient fields for the patients selected in the search.
  - Medical history - This merge file will contain detailed medical history fields for the medical history selected in the search.
  - Reminder information - This merge file will contain detailed reminder fields for the reminder information selected in the search.
  - Custom format - This will provide up to 20 fields of information in the merge file for those fields you are searching for. These fields may include client, account, patient, and/or medical history data.
- To list the client only once in the exported file select the One Per Client option.
- Click Export when ready to send the information search results to an Excel format.

Create a Sample Search
For this example we will set up a new search to find all active canines born in the month of June, belonging to owners who have spent greater than $1000 in the last 12 months with your hospital.

- From the CID access the Work with menu and choose Information Search to display the Choose Search Criteria window.
- At this time you can define a search name and click Done or press Cancel to set up the search first.

Search Criteria
- Under the Search Criteria tab select right-click New Condition.
AVImark User Manual

Information Search

- From the Area scrollable list select Client and click Next.
- Leave the default option Search based on a particular Client field value selected and click Next.
- Choose Fiscal Sales from the field list and click Next.
- From the Comparison drop-down list select is greater than and in the value field enter $1000 and click Finish.
- Choose right-click New Condition to define the patient values.
- From the area scrollable list select Patient and click Next.
- Leave the default option Search based on a particular Patient field value selected and click Next.
- Select the Birthday field and click Next.
- Use the Comparison drop-down list to choose the appropriate value and for our example we will choose equals and tab to the next field and type Jun or 06.
- Click on the Date Calculation drop-down list and select Month of.
- Select Finish after defining the criteria for this value.
- Choose right-click New Condition.
- Choose the Patient area and click Next.
- Leave the default option selected and click Next.
- In the Find field type Species Name, click the plus symbol next to Species Entry and select Species Name. Click Next to continue.
- Use the Comparison equals and type Canine in the value field. Click Finish to complete the setup.

Report Criteria
After defining the criteria for the search you will then specify the information to be included on the report.

- Select the Report Criteria tab to define the report values.
- Use the Find field or scroll through the list to find the field you wish to report.
- After selecting the field, click the right green arrow or double left-click on the field to place it under the Report Fields area.
- Change the order or placement of the field by selecting right-click Change.

Run the Search

- Click the Search button to display the results on the Search Results tab.
- You can then choose to print the results.

Saving the Search
Once the criteria and report values have been defined it is recommended to save the search.

- From the File menu select Save.
- Choose the Category where the search will be contained, enter a Code and the search Name.
- Click OK to save the search.

Print the Criteria
There may be an instance where you need to print the criteria for a search and this can be easily done.

- In the Search Criteria window select File, Print Criteria from the menu
- Click on the Print To drop-down list to select the desired printer.
• Use the **Preview** button to view the search specifications directly on the screen.
• When ready to print the criteria setup select **Print**.

**Omit Information**
With the new design of the Information Search feature AVImark provides a much more controllable and flexible way of omitting information from searches. The idea is to create two searches minimizing the detailed setup of one search and allowing you to use the searches within other searches.

• You will first create the main search. For example, look for all patients who have received a Heartworm treatment.

• Next you will create a second search that will locate patients that have not received a Heartworm.
  o From the **Search Criteria** tab define a **Patient** value and choose the Advanced option **Search for Patient within another previously defined search**.
  o From the next screen set the value to **Does Not Exist in** and click on the second drop-down list to choose the appropriate search, for example Patients with Heartworm.

• Run the search and AVImark will omit patients that have received a heartworm treatment and will display only patients meeting the set criteria that have not received a heartworm treatment.

**Modify an Existing Search**
AVImark allows you to modify the search criteria of an existing search.

• From the Choose Search Criteria (Library) window, select the search you wish to modify and click **Done** or double left-click to display the Information Search criteria for the selected search.

• Modify the search criteria as desired and from the **File** menu click **Save** to save the new modifications.

• To save the modified search and give a new name, open the **File** menu and click **Save As** to display the Change Information Search window.

• Type the name you wish to assign the modified search and click **Done**.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Last Search option</td>
<td>Information Search</td>
</tr>
</tbody>
</table>
CHAPTER 27: FOLLOW-UP LIST

The AVImark Follow-up List is a list of patients who need to be called back after a short period of time for one reason or another. Follow-ups which become past due will be displayed in red in both the patient’s Follow-ups Folder tab and the Follow-up List. Follow-ups for checked-in patients will be displayed in blue and future follow-ups appear in black.

In this chapter you will learn about...

» Create a Follow-up from the CID on page 337
» Create an Automatic Follow-up on page 338
» Work with the Follow-up List on page 338
» Use the Follow-up List Shortcut Menu on page 339
» Print the Follow-up List Report on page 339

Create a Follow-up from the CID
AVImark allows you to create a follow-up for a patient from the CID.

• Ensure the correct patient is selected.
• From the Patient area, select the Follow-ups tab.
• Right-click and from the shortcut menu click New to display the New Follow-up window.

- Type the Subject of the follow-up.
- Use the Doctor drop-down list and select the appropriate doctor related to the follow-up.
- Select the Critical box if the callback is considered serious or life-threatening.
- From the Due date field, use the drop-down calendar to specify the date the callback should be made, or TAB to the next field and type the number of days from the current date the call should be made.
- Use the Repeat fields to specify when the follow-up should be repeated and for how many times, if applicable.
Follow-up List

• Type any comments pertaining to the Follow-up and click Done.

Create an Automatic Follow-up
AVImark also lets you set up a more automatic way of following up with certain patients relating to the services they have received. You may specify a Follow-up callback for any treatment, item or diagnosis in your Treatment, Inventory or Diagnosis List.

• From your Treatment, Inventory or Diagnosis List select the service you wish to link a Follow-up to.
• Right-click and from the shortcut menu click Change to display the Change window.
• From the Treatment Change window click on the Treatment Tab. In the Inventory Change window click on the Advanced tab. From the Diagnosis Change window click on the Diagnosis tab.
• From the Follow-up in field, specify the number of days the patient is to be contacted once the service is entered into Medical History.
• If appropriate, select the Critical? box.
• Click Done to save your changes.

Work with the Follow-up List
The Follow-up List will be displayed in a tree-format based on the status of the Follow-up. The Follow-up List may be added to, modified, or removed at your discretion.

• On the CID, open the Work with menu and click Follow-up List to display the Follow-up List.

![Follow-up List](image)

Change the width of columns
You may change the column width as you wish.

• Change the columns by holding the left mouse button on the gray line which separates each column title and move either left or right.

Change a Follow-up callback
• With the correct follow-up selected, right-click and from the shortcut menu click Change to display the Change Follow-up window.
• Enter the appropriate changes and/or mark the callback as Confirmed or Left message by selecting the appropriate option from the drop-down list.
AVImark User Manual

Follow-up List

• Click Done.

Post Follow-up comments

AVImark lets you save comments in the Medical History area of the patient for future reference.

• From the Follow-up List, select the correct follow-up. Right-click and from the shortcut menu click Post.

Remove a Follow-up

You may remove a follow-up once it has been made.

• From the Follow-up List, select the correct follow-up. Right-click and from the shortcut menu click Remove.

Go to the CID for the selected patient

You may go to the CID for any patient from the Follow-up List.

• From the Follow-up List, select the correct follow-up. Right-click and from the shortcut menu click Go to Patient to display the CID for that patient.

Use the Follow-up List Shortcut Menu

Within the Follow-up List window there are other features found in the shortcut menu. Click the right mouse button to see the shortcut menu.

Edit Changes

Use the Edit menu to select follow-up entries or to undo or redo changes to an entry.

To learn more about: Removing Multiple Follow-ups
Search the Help for: Remove follow ups

View

From the View shortcut menu you can Refresh the window, customize columns, view the Entry History for this follow-up, Preview or Hide text associated with the follow-up or you can choose how to sort the window.

Entry History

Use this option to view a history of changes made to the select follow-up.

• Select an entry and choose right-click View, Entry History.

• View date and time the change was made, the logged in user who made the change and a description of the change that was made.

• Click Done to close the window.

Go To Patient

Use this menu to have AVImark automatically access this patient’s file on the CID.

• With the appropriate follow-up selected, from the right-click shortcut menu select Go to Patient.

• AVImark will close the Follow-up list with the selected patient’s file open on the CID screen.

Enter follow-up notes

You may enter notes regarding a specific follow-up entry using all of the available AVImark note feature options. When the follow-up is posted the notes will be posted to the patient’s medical history.

• With the correct entry selected, right-click and from the shortcut menu click Notes to display the Notes window.

• Type the appropriate notes for this entry. All of the AVImark notes feature options are available in this
window.

- Click **Done** to save the notes.

**Post**

Once a follow-up has been performed it can then be posted, which will remove it from the follow-up list but mark it as complete.

- From the Follow-up List, select the appropriate follow-up and from the right-click shortcut menu click **Post**.
- The follow-up will automatically be removed from the list.

**Print**

From the Follow-up list a specific document can be printed as well as the entire follow-up list.

- Within the Follow-Up List window select right-click **Print**.
- Choose **Document** to print a specific MS Word document.
- Choose **Report** to print out the entire list of follow-ups or print only critical or non-critical.

**Print the Follow-up List Report**

You may wish to print either the list itself or print documents to the clients on the list.

**Print the Follow-up List**

- From the Follow-up List, open the **Print** menu and click **Report** to display the Print Follow-up Report window.

- Use the **Print to** drop-down list to specify the correct Printer.
- If appropriate, use the **Doctor** drop-down list to specify a specific doctor.
- Type the number of copies to print.
- Use the drop-down list to select the list you wish to print;
  - Critical/Non-Critical
  - Critical
  - Non-Critical
- If appropriate, use the **From** and **To** drop-down calendar and select a date range.
- Click **Print** or to view the report onscreen, select **Preview** and click **Print**.
Print a document for a selected client

- From the Follow-up List, open the Print menu and click Document to display the Print Follow-up window.

- Double-click in the Document field to display the Open window.
- On the Open window, double-click on the correct document.
- Specify the number of copies to print and use the Print to drop-down list to select the correct printer.
- Click Print.
CHAPTER 28: BACKING UP & RESTORING

Why back up at all? Simply put, you can’t recover lost or corrupt data files from nothing. Backing up is the activity of copying files so that they will be preserved in case of equipment failure or other catastrophe, and should be made routine with the daily operations of the hospital. When backing up your data we do not recommend that you use “scheduled back-ups”, or “tape” backup devices. Our experience from restoring data from old tapes (as part of the data conversion process) is that 10% of the tapes we receive are unreadable. In addition to AVImark providing a means of backing up your data, AVImark also provides the ability of retrieving files that you backed up called “restore”. Restore is a process that involves copying backup files from secondary storage (tape, Zip disk, CD or other backup media) to hard disk. A restore is performed in order to return data to its original condition if files have become damaged or lost.

In this chapter you will learn about...

» Making a Back-up on page 343
» Format Zip Disks/CDRW’s on page 344
» Restoring Data on page 344

Making a Back-up

• Ensure you have labeled the media for the correct day of the week.

• Insert the selected media into the correct drive.

• On the CID, open the Utilities menu. Click Back Up AVImark files to display the Backup window.

• Click Yes to confirm that all other users have exited AVImark.

Drive

The Drive menu indicates the drive you are backing up to. This drive letter should also be displayed in the Destination and Path windows.

• If necessary, use the Drive drop-down list to select the correct drive.
Destination
The Destination window will display the drive and/or directory you are backing up to. If the incorrect drive is specified, you will need to select the correct drive from the Drive menu.

Verify Back-up
AVImark lets you verify the data that is copied on the specified back-up media is exactly the same as the data that is on your hard disk.

- Select Verify back-up.

Include
AVImark allows you to choose what will be backed up. If nothing is selected under “Include”, the only thing backed-up will be the AVImark data files. Selecting “Program Files” will back-up the AVImark data files as well as any necessary files AVImark needs to run.

- Select the applicable options to have included in the back-up and click Backup.

Format Zip Disks/CDRW’s
Zip Disks
Most Zip Disks you buy these days are “pre-formatted” for use and will not need formatting right away. It is strongly suggested that you replace or at least format your backup disks every six months. Understand that formatting a disk completely erases the disk, so make sure you are not formatting a disk that contains something you will need later.

- Exit all programs which you might be working in and insert the disk into the Zip drive.
- On the Windows Desktop, double-click My Computer to display the My Computer window.

![If the My Computer icon is not displayed on the Windows® desktop, you can access it through the Start menu.](image)

- Point to the Zip Drive. Right-click and from the shortcut menu, click Format to display the Formatting window.
- Change any parameters which may be necessary.

![You may not want to choose the long/full format type. Choosing the short/quick format options will NOT check the disk for any damage.](image)

- Click Start to begin Formatting.
- When finished formatting, close the Format window. If Windows indicates that the disk has been damaged, it is recommended to just discard the disk.

CDRW
When using a CD burner, the disks MUST be formatted with the ability to drag-and-drop files like any other drive on the computer. Roxio®’s Drag-to-Disc or Direct-CD software works very well when formatting disks.

Restoring Data
The purpose of this AVImark function is to allow you to restore information which had previously been saved from a back-up. If you have some sort of catastrophe with your hardware (the computer), or perhaps realize that you have entered a considerable amount of data in the wrong way or on the wrong computer, you may need to restore your data from backup diskettes. In the latter case, you probably won’t have much of an option. In the former, it may be easier to just restore data from a backup disk than try to sort it out. You do need to realize that this will only allow you to restore information up through the last day’s backup disk, so you would need to
CALL AVIMARK’S TECHNICAL SUPPORT DEPARTMENT PRIOR TO RESTORING!

- With the exception of the file server, ensure that all other workstations have exited AVImark prior to starting the process.
- Insert the back-up disk which you plan to restore from.
- On the CID, open the Utilities menu. Click Restore from back-up to display the Restore window.
- If you are absolutely certain this is the appropriate thing to do, click Yes on the confirmation window.

Drive
This field will display the drive from which you will restore from.
- If necessary, use the Drive drop-down list to select the correct drive to restore from.

Back-up file
This field will display the Back-up Zip file from which you will restore from.
- If necessary, use the Back-up file drop-down list to select the correct Zip file.

CALL AVIMARK’S TECHNICAL SUPPORT DEPARTMENT PRIOR TO RESTORING!

- Click Restore to proceed. When the process is finished, click OK. AVImark will close and you will be returned to the Windows Desktop.
Restore from Diskettes

- With the exception of the file server, ensure that all other workstations have exited AVImark prior to starting the process.
- Insert the last Back-up Diskette of the daily back-up set.
- On the CID, open the Utilities menu. Click Restore from back-up to display the Restore window.
- If you are absolutely certain this is the appropriate thing to do, click Yes on the confirmation window.
- If necessary, use the Drive drop-down list to select the correct drive to restore from.
- Click Restore to proceed. You will be prompted to insert disk number one of the spanned disk set. Insert disk one and click OK.
- Once the information has been unzipped from the first diskette, you will be prompted to insert disk number two. Insert disk number two and click OK.
- When the process is finished, click OK. AVImark will close and you will be returned to the Windows Desktop.

Restore Individual Files

- With the exception of the file server, ensure that all other workstations have exited AVImark prior to starting the process.
- Insert the back-up disk which you plan to restore from.
- On the CID, open the Utilities menu. Click Restore from back-up to display the Restore window.
- If you are absolutely certain this is the appropriate thing to do, click Yes on the confirmation window.
- If necessary, use the Drive drop-down list to select the correct drive to restore from.
- If necessary, use the Back-up file drop-down list to select the correct Zip file.
- Using the Files to restore field, type the specific file names you wish to restore. Separate each file name with a space.
- Click Restore to proceed. When the process is finished, click OK. AVImark will close and you will be returned to the Windows Desktop.

<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up your data</td>
<td>Table of Contents – Backing Up</td>
</tr>
<tr>
<td>Restoring your data</td>
<td>Restoring</td>
</tr>
</tbody>
</table>
CHAPTER 29: AVIMARK SIDEKICK

With AVImark installed on a laptop computer, AVImark gives you the ability to use the Sidekick feature. This will allow you to use the laptop in the field in the same manner as you would in the hospital. Data added to the laptop can be merged into existing data on the hospital system over your hospital’s local area network. In order to use AVImark Sidekick, it is necessary that you have a network installed on your hospital’s computer(s) and that the laptop you use in the field can be connected as a workstation on the network.

In this chapter you will learn about...

» Installing AVImark on the Laptop on page 347
» Importing Data on page 347
» Refreshing Data Files on the Laptop on page 348

Installing AVImark on the Laptop
Before using Sidekick, it is necessary to have AVImark installed on the laptop. You may do this by logging the laptop onto the hospital network and then copy the entire AVImark directory from the hospital server computer onto the root of the C: drive of the laptop. It is recommended that you contact AVImark’s Technical Support at 1-877-838-9273 for assistance with installing AVImark.

It is important that you DO NOT mark the drive on the Sidekick computer (the drive on which AVImark is installed) as “Read Only”. In addition, either the drive or the AVImark folder on the laptop must be fully shared.

• With AVImark installed and a shortcut created on the desktop, disconnect the laptop from the hospital network. (To avoid possible confusion, rename the desktop shortcut to SIDEKICK).
• Run AVImark on the laptop (disconnected from the hospital network).
• On the CID, open the Work with menu. Click Hospital Setup and select the Miscellaneous tab.
• From the Other Options section, select the AVImark Sidekick option and click Done.

Importing Data
Once you have finished using AVImark in the field, you are now ready to import the information you have added and/or changed on the laptop into the hospital computer.

• Log the laptop onto the hospital network.
• Ensure AVImark is closed on the laptop and then go to the hospital server computer.

To learn more about: Minimum Laptop Requirements
Search the Help for: Sidekick; Setting up Sidekick

• On the CID, open the Utilities menu. Click Sidekick to display the Sidekick Import window.
• If the correct location of AVImark on the laptop is not specified correctly in the Import from window, click Browse to display the Open Sidekick’s files window.
Using the **Look for** drop-down, select **Network** to display a list of all computers currently logged onto the network.

- Double-click the name of the laptop computer to display a list of drives available on the laptop.
- Double-click the **Drive** where AVImark is installed on the laptop to display a list of folders (directories) on the selected drive.
- Double-click the **AVImark** folder and click **Open** to return to the Sidekick Import window. A list of all transactions/information to be imported into the hospital system will be displayed.

- **Click Next** to display the Import Sidekick’s Records window.
  
  It is recommended you leave the “Create backup of main system” box checked. With this checked, AVImark will automatically take a backup of the hospital system data before the Sidekick data is imported. If you decide to leave this checked, you will need to ensure no other computer on the network (including the Sidekick) is running AVImark.

- **Click Import** and click **Yes** to confirm.
- **Click OK**. A list of data records that were imported from Sidekick will be displayed.

**Refreshing Data Files on the Laptop**

Once you have imported the information from the Sidekick computer into the hospital data files, you now have the option to refresh the Sidekick. During this process, AVImark copies all of the data files from the hospital system to the Sidekick computer. In addition, you have the option to have AVImark automatically make a backup of the data on the Sidekick computer prior to refreshing.

- Ensure AVImark is not running on the laptop computer.
- **Click Refresh** and click **Yes** to confirm.
CHAPTER 30: NOTE GLOSSARY AND Q & A

The Note Glossary feature allows you to create and store note templates. Note templates help automate the entire process of producing accurate and consistent notes for your clients, patients and medical history. The Question and Answer feature is unique in that it can be used in many different ways. It is more commonly used for a Q & A format for frequently asked questions. The Q & A provides listed categories with questions for each category.

In this chapter you will learn about...

» Accessing and Setting-up Glossary Categories on page 349
» Edit a Glossary Category on page 350
» Create a Note Template on page 350
» Add Another Similar Template on page 351
» Move Note Templates to Other Categories on page 351
» Create Note Templates from a Note Window on page 351
» Print Note Templates on page 352
» View Notes Attached to Glossary Entries on page 352
» Refresh the Note Glossary Window on page 352
» Undo and Redo Changes on page 352
» View History of Entries on page 352
» Create Notes on page 352
» Use Note Templates on page 352
» Copy and Paste Note Templates on page 353
» Importing Files on page 353
» Printing from the Note Window on page 353
» Accessing and Create Categories for Q & A on page 353
» Enter a Question on page 354
» Entering an Answer on page 354

Accessing and Setting-up Glossary Categories
The Note Glossary is designed similar to the Treatment and Inventory Lists, in that you can create categories to organize your note templates. In addition, you can create a “tree structure” where you have multiple levels of template categories displayed in outline form. Expand and Collapse buttons, indicated by a minus sign or plus sign, appear next to categories that contain sub-categories.

• On the CID, open the Work with menu. Click Glossary to display the Glossary window.
• In the Categories section, right-click and from the shortcut menu click New to display the New Glossary Category window.
Name
This is the descriptive name assigned to each category.
  • Type a Category Description.

Category
The Category field allows you to enter the new category as a new/parent category or a sub-category of an already existing category. When entering as a new parent category, this field should be set to (none).

  • If appropriate, use the Category drop-down list to select a category.

Area
This field allows you to assign an area that the new category will be associated with.
  • If appropriate, use the Area drop-down list to select an associated area.
  • Click OK.

Edit a Glossary Category
  • Select the Category name you wish to change. Right-click and from the shortcut menu click Change to display the Change Glossary Category window.
  • After the change has been made, click Next and/or Prior to move through the list of categories or click OK when finished.

Create a Note Template
You may create note templates from the Note Glossary or from any Note window in AVImark.
  • Select the category you wish to create a template for.
  • Point in the Records for section. Right-click and from the shortcut menu click New to display the New Glossary window.
Code
This is the code that will identify the template. In addition, from any AVImark notes window you may enter the template code and then press SHIFT + SPACE to “auto-import” the note template into the note window.

- Type the Code for the template.

Description
This is the descriptive name assigned to the note template.

- Type the template Description.

Category
This field allows you to move the template from the assigned category to a different category.

- If appropriate, use the Category drop-down list to select a different category.

Note section
AVImark allows you to customize the note to a particular patient and or client by the use of Merge Words. Within any note window you may also use the caret symbol (^) to quickly add information in certain locations of the template. When the template is imported to a note window, use the F12 key to skip to each location of the caret symbol to enter the appropriate information. You may also use the right-click options in the Note section.

- Type the notes for the template and click OK.

- After clicking OK, a New Glossary window will continue to appear. This will allow you to create additional templates under the selected category. When you are finished, click Cancel.

Add Another Similar Template
AVImark allows you to easily duplicate templates that you had previously created. When adding another similar template, you will need to type a different code for the template.

- Select the template you wish to duplicate.
- Right-click and from the shortcut menu click Another to display the New Glossary window with the same values already entered.
- Edit the new template and click OK.

Move Note Templates to Other Categories
AVImark allows you to easily move note templates from one category to another.

- From the Glossary window, select the template you wish to move.
- To select multiple templates to move, press CTRL and then click the templates to be moved.
- Right-click and from the shortcut menu click Move. You will need to click Yes to confirm.
- Click the category you wish to move the specified template(s) to.

Create Note Templates from a Note Window
AVImark allows you to enter notes from any AVImark note window and then create a template to save in the Note Glossary.

- From any notes window, enter the notes you wish to create a template for.
- Use the mouse to highlight the text, or press CTRL+A to highlight all text.
- Right-click and from the shortcut menu click Add to glossary to display the New Glossary window.
- AVImark automatically enters the code and description for the template. If appropriate, change the code and description as necessary.
• AVImark automatically enters the category depending on the area you are currently in. If appropriate, use the Category drop-down list to select a different category.

• Click OK to save the note template.

Print Note Templates
• On the Glossary window, open the File menu. Click Print to display the Print Glossary window.

• Use the Print to drop-down list and select the correct printer.

• Click Preview to preview the templates onscreen or click Print.

View Notes Attached to Glossary Entries
Notes attached to glossary entries can be automatically previewed in the Glossary window.

• On the Glossary window, open the View menu. Click Show/Hide Preview.

Refresh the Note Glossary Window
AVImark allows you to refresh the Note Glossary. This may be necessary if a user on another workstation has updated the Glossary.

• On the Glossary window, open the View menu. Click Refresh.

Undo and Redo Changes
Changes to the Note Glossary list or to a note template can be reversed using the Undo and/or Redo feature.

• On the Glossary window, open the Edit menu. Click Undo or Redo.

View History of Entries
When a change to a line entry in the Note Glossary has been made, AVImark will create a log that records the Date, Time, User and the Action that was used to make the change of the line entry.

• On the Glossary window, open the View menu. Click Entry History.

Create Notes
AVImark allows you to create unlimited notes or memos from any appropriate AVImark display.

• From any appropriate AVImark display area, right-click and from the shortcut menu click Notes to display the Notes window.

• Type the desired note or memo. Word wrap and spell check are active in this window.

• If appropriate, right-click and from the shortcut menu select Date/Time to insert the current date and time into the text.

• Click Done to save or click Cancel to exit without saving.

Use Note Templates
After creating and storing note templates into the Note Glossary, you now have the ability to import those note templates into any AVImark note window.

Note template code is known
• Open any note window and type the code for the note template.

• Press SHIFT+SPACEBAR to import the template.

Note template code not known
• Open a note window. Right-click and from the shortcut menu click View Glossary to display the Glossary window.

• Click the appropriate template(s) to display the template name(s) in the Selected area and then click Done.
Copy and Paste Note Templates
You may copy and paste note templates from the Note Glossary into any AVImark note window or any other application such as MS Word.

- From the Note Glossary window, select the template(s) you wish to copy.
- Right-click and from the shortcut menu click Select to list the template(s) in the Selected and Preview windows.
- Use the MOUSE to highlight the text you wish to copy.
- Right-click and from the shortcut menu click Copy.
- Open any note window. Right-click and from the shortcut menu click Paste.

Importing Files
AVImark allows you to import text files (with an extension of .txt) into any note window. In addition, you may also import MS Word documents by saving the document as a text file and then storing it in the same directory as your other text files.

- From any note window, right-click and from the shortcut menu click Import a file to display the Open window.
- Use the Files of type drop-down list and select Text Files.
- Select the correct text file and click Done.

Printing from the Note Window
AVImark allows you to print any note from a note window.

- From any note window, open the File menu. Click Print to display the Print window.
- Use the Print to drop-down list and select the correct printer.
- Click Preview to preview the notes onscreen or click Print.

Accessing and Create Categories for Q & A

The Q & A Maintenance window is an in-house question and answer area. AVImark allows you to create categories within the Q & A in order to group similar topics together. You may organize the questions by category or by topic.

- On the CID, open the Work with menu. Click Q & A to display the Q & A Maintenance window.
Enter a Question

- Select the Category you wish to create a question for.
- Point in the Questions for section. Right-click and from the shortcut menu click New.

Category
This field indicates the category where the question will be saved. AVImark will enter the category name automatically; however, you may change this to a different category if appropriate.

- If appropriate, use the Category drop-down list and select a Category.

Code
This is the code that will identify the Q & A.

- Type the desired Code for the question.

Description
This field is used for entering the desired question.

- Type the desired question and click OK.
- After clicking OK, a New Q & A window will continue to appear. This will allow you to create additional questions/answers under the selected category. When you are finished, click Cancel.

Entering an Answer

- With the correct question selected right-click and from the shortcut menu click Notes to display the Comments for window.
- Type the desired Answer/Comments and click Done.
CHAPTER 31: EXPORTING TO QUICKBOOKS®

AVImark allows you to send/export financial information to QuickBooks® for any specified length of time. Each time you export information to QuickBooks®, AVImark takes all appropriate financial information from the current date back to the most recent instance that you exported information to QuickBooks®.

In this chapter you will learn about...

» Setting Up QuickBooks® to Receive from AVImark on page 355
» Setting up AVImark to Export to QuickBooks® on page 355
» Export to QuickBooks® on page 356
» Exporting for the First Time on page 356
» View the Exported File Prior to Importing to QuickBooks® on page 356

Setting Up QuickBooks® to Receive from AVImark
AVImark requires that certain accounts be set up in QuickBooks® before any information can be exported out of AVImark. The first requirement is that an Income Type account be set up in QuickBooks® for each AVImark treatment and inventory category. In QuickBooks® you set up an Income Type account for each of these categories. When setting up these income accounts you may have the option to assign account numbers to these accounts. As an alternative, it is not necessary to assign account numbers to the income accounts in QuickBooks® if the name of the income account matches exactly the description name in AVImark. The second requirement is that you will need to set up a liability account in QuickBooks® called Sales Tax Payable. The Code of the entry is Tax and the Description should be Sales Tax Payable. In QuickBooks®, you should have a vendor called Treasurer, state of (state name).

Setting up AVImark to Export to QuickBooks®
If assigning account numbers to your Income Type accounts in QuickBooks®, you will also need to assign the corresponding account number to each of your treatment and inventory categories. In addition, QuickBooks® has several predefined asset accounts that AVImark exports transaction totals to. Because of this, AVImark maintains a System Table called QuickBooks® Accounts. If you do not want to use the QuickBooks® Account Names listed in the QuickBooks® Accounts Table, you may change the table entry description only. Do Not change the code of the entries. These codes are specifically marked in AVImark so that when you export from AVImark and import into QuickBooks®, it will recognize those specific types of accounts.

Assign account numbers in AVImark

• On the CID, open the Work with menu. Click Treatments to display the Treatment List window.

• Double-click the correct Treatment Category name to display the Change Treatment Category window.

• In the Account no. field, type the account number that is used for this account in QuickBooks®.

• Click Done or press Enter.

Change QuickBooks® Accounts System Table names

• On the CID, open the Work with menu. Click System Tables to display the System Tables window.

• From the Table section, click QuickBooks® Accounts to display the Entries for QuickBooks® Accounts.

• Double-click the Entry you wish to change the description for.

• On the Change Entry window, type the desired Description and click OK.
Exporting to QuickBooks®

The information that is exported to QuickBooks® is all the transactions that have been posted from Medical History to Accounting. First, you need to tell AVImark to send all transactions to QuickBooks® that have been posted on or before a specified date. This date is specified by you and is done through the Utilities menu option from the CID. The second step is to import this information into QuickBooks® from the QuickBooks® program.

- On the CID, open the Utilities menu. Click QuickBooks® to display the QuickBooks® Interface window.

Posted on or before
The date entered in this field determines what transactions will be exported to QuickBooks®. Any transactions posted to accounting on or 30 days before this date will be exported to QuickBooks®.

- Enter the date.

For company
In most cases, this field will be left blank. Only if you have another Company Number defined in AVImark would you enter a company number. (It is not necessary to enter a number 1 if all you want to export is Company 1 information).

- If appropriate, enter the company number you wish to export for. Click Send.

Exporting for the First Time
The first time you export information from AVImark requires an additional step you would not otherwise make. As mentioned above, when you click Send from the QuickBooks® Interface window, AVImark takes all transactions posted on or 30 days before the date you entered in the date field. If it has been several months or years since you began using AVImark, and you are now going to use this feature, this first “export” out of AVImark will contain all financial information on or 30 days before the date you enter. To overcome this problem, the first time you export from AVImark, you should enter a date one day prior to when you want to commence sending information to QuickBooks®. For example, say you want to begin sending information to QuickBooks® beginning January 1, 2010. The first time you export information from AVImark you would enter a date of 12/31/09 in the date field of the QuickBooks® Interface window. Each time you export information AVImark will create an .iif file with the date and a sequence number as the name, identifying the date the file was exported from AVImark (i.e. 2010-01-31_1.iif).

View the Exported File Prior to Importing to QuickBooks®
If you are unsure as to what will be in the .iif file when you do an export, you have the ability to view this file in
the Microsoft Notepad program.

- On the Microsoft Windows® Start menu, point to All Programs.
- Point to Accessories and click Notepad to display the Notepad window.
- On the File menu, click Open to display the Open window.
- Use the Look in drop-down list and select the correct directory as specified in AVImark for exporting to.
- Select the (date).iif file and click Open to display the document listing all entries and amounts that have exported from AVImark.

AVImark does not allow you to redo the export once you click Send in the QuickBooks® Interface window. As a precaution, you should take a backup of your AVImark data just before exporting the information. In addition, once you import the .iif file into QuickBooks®, it will be very time consuming to delete all the entries that were posted to QuickBooks® if there was an error in how QuickBooks® or AVImark was set up prior to exporting the data from AVImark. As a result, you should also take a backup of your QuickBooks® data each time before importing the .iif file.
CHAPTER 32: CUSTOMIZING COLUMNS

AVImark gives you the ability to customize the look of the columns being displayed in several areas of the program. In addition, you may select multiple entries from these areas, and make a change to them at one time. Customizing columns is a workstation specific feature, meaning, the layout change will be held only on the computer it is changed on. The areas which have been formatted to allow you to utilize these features are: Treatment List, Inventory List, Estimates List, Diagnosis List, Problem List, Follow-up List, Q & A, Note Glossary, Users and Security, Time Card, System Tables, Appointment List, and the Whiteboard.

Customizing Columns
AVImark gives you the ability to arrange the Column Headings in the order you would like them to appear.

- Using a drag-and-drop operation, move the heading to the location you wish. Arrows will be displayed to indicate where the heading will be placed.

Adding and Removing Columns
You may add and remove Column Headings that you wish from the formatted areas.

Remove a heading

- In the formatted window, right-click to see the shortcut menu. Point to View and click Columns to display the Columns window.

- Move the heading to the Drag & Drop tab of the Columns window by using a drag-and-drop operation.

Add a heading

- From the Drag & Drop tab of the Columns window, select the heading you wish to add.

- Using a drag-and-drop operation, move the heading to the desired location. Arrows will be displayed to indicate where the heading will be placed.
Renaming Columns
AVImark gives you the ability to modify/change the name of a Column Heading.

- In the formatted window, right-click to see the shortcut menu. Point to View and click Columns to display the Columns window.
- In the Columns window, select the Advanced tab. All Column Headings currently being displayed will be shown in black and those that are not being displayed will be shown in gray.
- Select the heading you wish to modify/change.
- Using the Caption field, type the name you wish to change the heading to.
- To make the heading visible or not visible, select/unselect the Visible field.

Sort the Columns
There are two options for sorting the formatted Windows. You may sort entries by Column Headings, and/or by panel. Sorting by panel allows you to combine entries having the same characteristics into one group.

Sort by Column Heading
- In the formatted window, click a Column Heading to sort. With each click, the column will sort in ascending, descending or the default sort.

Group by Panel
- In the formatted window, right-click to see the shortcut menu. Point to View and click Show/Hide Group Panel to display a gray section just above the Column Headings.
- Move a heading into the gray section by using a drag-and-drop operation to display the entries in a collapsed view.
- Click the PLUS SIGN (+) to expand the view of the entries under that heading.
- If appropriate, move additional headings into the gray section next to the primary heading to further group the panel.

Change the Width of Columns
You may expand or narrow columns in the formatted windows.

- Point to the dividing line for the Column Heading you wish to change the width for.
- Drag the pointer in either direction to expand or narrow the column.

Change Multiple Entries
AVImark gives you the ability of changing Multiple Entries at one time in the formatted windows.

- Press CTRL and click the random entries you wish to change.
  OR
- Press SHIFT+UP ARROW/DOWN ARROW to select consecutive entries you wish to change.
- Right-click and from the shortcut menu click Change to display the Change window of the first entry selected. The fields containing different information will be outlined in yellow.
- Enter the necessary change(s) and click OK to make the change(s) on all selected entries.

After you have customized columns on a certain workstations, you may find it necessary at some point to return the window back to the original view. You may do so by clicking on the AVImark icon on the upper left-hand corner of the screen and selecting default layout from the drop down list.
CHAPTER 33: LAB INSTRUMENTS

AVImark interfaces with several different lab instruments allowing the hospital to become more self-sufficient with regards to laboratory needs. In addition, AVImark gives you the ability to import test results from outside laboratories.

In this chapter you will learn about...

- Instrument Management on page 361
- Set up the Abaxis® VetScan® HMT, HM II, HMV and the VetScan® Chemistry on page 364
- Defining Fields and Importing Results for Abaxis® Instruments on page 365
- Set up the Abaxis® VS2 on page 366
- Interface with the CDC Hemavet® on page 367
- Interface with the Hemagen® Analyst on page 368
- Interface with the Heska®/Scil Vet® ABC on page 371
- Interface with the Heska® Spotchem EZ on page 372
- Interface with the Heska® CBC-Diff on page 374
- Interface with the Heska® DCU on page 375
- Interface with the IDEXX® VetTest on page 376
- Interface with the IDEXX® LaserCyte on page 377
- Interface with the IDEXX® LabREXX on page 378
- Interface with the Forcyte® on page 383
- Interface with Antech® on page 384
- Antech® XML Result Storage on page 388
- Work with Requisition Management on page 389
- Interface with VetConnect® on page 389
- Interface with VDIC® VetMedStat Telemedicine on page 391
- Interface with Vmed® Technology on page 394
- Abaxis® i-STAT Integration on page 394
- Abaxis® VetScan VSpro Integration on page 395
- Scil Vet abc Plus+ Integration on page 397

Instrument Management

All integrated, in-house lab equipment can now be setup and managed in a single location within AVImark. We have taken the setup existing in Hospital Setup and Advanced Options and merged them into the new Instrument Management window. During the AVImark update process, instruments existing and in use on the AVImark Server computer will automatically have their instrument information automatically moved to the new location.

One of the biggest benefits of this new feature is the ability to have more than one instrument of the same type (such as the Abaxis® VS2) installed on the same AVImark workstation, and easily differentiate between them.

NOTE: We have provided a new built in utility that can be run on AVImark workstations to transfer the instrument information on those computers that are currently in use for sending and/or importing test results. Instructions for this utility can be found at the bottom of this feature.

**The Instrument Management window will only display instruments installed on that physical AVImark workstation. Instruments installed on other AVImark workstations on your network will not be visible in the Instrument Management window on any other AVImark workstation.

- From the AVImark Client Information Display (CID), select Services, Instrument Management. You will be presented with the Instruments window where instruments can be added, changed, or removed from AVImark.
Adding an Instrument
Right-click and select New or use F2 to open the Instrument Setup window. Select the appropriate Instrument Type from the drop down menu. The Name, Computer ID, and Protocol will automatically be selected based on the selected instrument. The Active checkbox will also default to being checked.

If you choose to have more than one instrument of the same type in use on an AVImark workstation, you will need to add an identifiable name for each of those instruments. See the image below:
The Instrument Name will be the name you will see when importing test results. This will allow you to identify which instrument associated to that treatment you are wanting to retrieve results from, as seen below:

Press the button labeled ‘Next’ to proceed to the window. You will make your Com Port and Baud Rate selections, or enter Proxy Server information, based on the instrument type selected in the previous window.
Once you have added all desired instruments, you are ready to begin retrieving results. Results will be imported with the same IVLS Proxy or Instrument Import utilities as before.

**Running the InstrumentUpdate Utility**
This utility will copy all instrument settings from their existing Hospital Setup and/or Advanced Option locations into the new Instrument Management area. This will need to run on each workstation being used for transmitting results into AVImark.

- Locate the AVImark workstation that communicates directly with in-house lab instruments, and log into AVImark.
- Select Utilities > Utilities > and type in InstrumentUpdate and press OK.
- Press No to the “A backup should be performed…”.
- Click Run to import the instrument settings.

You should now be able to select Work With > Instrument Management and see the instruments installed on that workstation.

**Set up the Abaxis® VetScan® HMT, HM II, HMV and the VetScan® Chemistry**
The Abaxis® machines are very similar in that you may collect data from the machines and input the data directly into the patient’s Medical History. The AVImark setup for all five machines is the same and the setup process need only be done once. You will be able to capture and store results as they are completed until you are ready to import them, and these results can be stored in one centralized location for easy access until you are
ready to import results into your AVImark patient’s Medical History Test field.

**AVImark settings**
- On the CID, open the **Work with** menu. Click **Hospital Setup** to display the Hospital Setup window.
- Select the **System** tab and select the **Instrument** tab.
- Select the correct machine from the list of Lab Instruments.
- From the **Instrument on** dropdown list select the correct Comport you are using.
- Using the **Baud Rate** dropdown list, select **9600**.
- Use the **Data Bits** dropdown list and select **8**.
- Use the **Parity** dropdown list and select **None**.
- Use the **Stop Bits** dropdown list and select **1**.
- Click **Done** to save the settings.

**Abaxis® VetScan® HMT settings**
- From the **VSHMT Ready** screen, press the **Menu** key.
- Select **Management**.
- Select **System** and press **Enter**.
- Select **Communication** and press **Enter**.
- Verify that the Serial Port setting for computer communication is the same as set in AVImark.
- Select **9600** for the **Baud Rate**.
- Select **8 bits** for the **Data**.
- Set the **Parity** and the **Data Out** to **None**.

**Abaxis® HMII & HMV settings**
- On the Abaxis® machine, press the **Nut and Bolt** icon.
- Select **Settings** and then select **Customize**. You should see **Input/Output**.
- Set the **Baud Rate** to **9600**.
- The **Serial Port Version** must be **3.0** or higher.
- Set the **Serial Decimal Dot** to **Lang Def**.

AVImark allows you to have several workstations in your hospital attached to the HMT and the HM II instruments. Consequently, the settings you enter into Hospital Setup at one workstation are kept separate from those entered at another workstation. For example, you may have workstation A connected through COM 1 and workstation B may be connected through COM 2.

**Abaxis® VetScan® Chemistry settings**
- Ensure the machine is connected with the cables provided by Abaxis®.
- Set the **Baud Rate** to **9600**.

**Defining Fields and Importing Results for Abaxis® Instruments**
With the AVImark Tests window you will not need to define test result fields but simply download the results.

**Import results for VetScan® HMT and VetScan® Chemistry**
- Enter the correct treatment code into the patient’s Medical History.
• On the highlighted entry click the **Tests** attachment option to the right of the Medical History area.

• From the **Import From** menu select **Instrument Types** to select an instrument.

• Choose the appropriate Instrument Type and click **Import Results**.

• The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.

• The results will be permanently associated to this Medical History entry.

**Import results for Abaxis® HM II & HMV**

You can go through AVImark and connect to the HMII and then run your test, or AVImark will automatically pull the results from the selected test that was run by resending it. When selecting a test that has already been run, ensure the correct patient is displayed on the CID.

Communication between the desired Abaxis® instrument and AVImark can be established allowing results to be passed to AVImark and stored until they are ready to be imported. This communication is established by an internal application called Instrument Import.

A storage folder to receive the results from the instruments is needed. This folder can be created inside the AVImark folder on the server computer. Once this storage folder is created, the path must be defined within the Advanced Option **Save Lab Instrument Results To**.

Now that the AVImark setup is complete, results from the Abaxis® instruments can now be transferred to the storage folder mentioned above.

• Open the connection by going to menu **Utilities, Run Instrument Import** select the appropriate instrument click on the Connect button. This should display a shaking hands icon in your System Tray.

• Each Abaxis® Instrument has an instrument specific way to transmit results; it is at this point you will follow the steps to send the desired results from the analyzer to the AVImark computer. Your results will then be transmitted into the Instrument folder you have created and set your AVImark path to reflect as outlined in previous steps.

To view and import results into patient records you will need to close the connection between your AVImark computer and the Abaxis® instrument. In order to accomplish this you will need to right-click on the shaking hands icon on the System Tray and click Close. You are now able to access these results through AVImark.

• Tests results can be automatically imported into the Medical History of the proper patients.

• Make sure the properly defined treatment code is entered into the patient’s Medical History.

• On the highlighted entry click the **Tests** attachment option to the right of the Medical History area.

• From the **Import From** menu select **Instrument Types** to select an instrument.

• Choose the appropriate instrument type and click **Import Results**.

• The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.

• The results will be permanently associated to this Medical History entry.

**Set up the Abaxis® VS2**

The setting up and importing of the Abaxis® VS2 results into AVImark can be easily performed.
AVImark settings

- On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
- Select the System tab and select the Instrument tab.
- From the Instrument on dropdown list, select the correct Comport you are using.
- Click Done to save the settings.

Data Import

- Select the treatment in the patient’s Medical History where the results will be stored.
- On the highlighted entry click the Tests attachment option to the right of the Medical History area.
- From the Import From menu select the appropriate machine. Click the Instrument Types option from the menu to select an instrument.
- Select an option from the menu will automatically open the download window. If you have selected an Instrument Type choose an instrument and click Import Results.
- The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.
- The results will be permanently associated to this Medical History entry.

Interface with the CDC Hemavet®

AVImark will allow importing of CDC Hemavet® test result data. AVImark lets you collect data from the CDC Hemavet® machine and input the data directly into the patient’s medical history.

AVImark settings

- On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
- Select the System tab and select the Instrument tab.
- Select the CDC Hemavet® machine from the list of Lab Instruments.
- From the Instrument on dropdown list, select the correct Comport you are using.
- Using the Baud Rate dropdown list, select 9600.
- Use the Data Bits dropdown list and select 8.
- Use the Parity dropdown list and select None.
- Use the Stop Bits dropdown list and select 1.
- Click Done to save the settings.

Define result fields

In order for AVImark to allow the Hemavet® to import the results for a given treatment the fields will need to be defined. This can be done from either Medical History or the Treatment List.

- From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click Change to display the Change Treatment window.
- In the Attachments section, select More Stuff to display the Define More Stuff window.

OR

- Select the correct treatment from the patient’s Medical History.
- Right-click and from the shortcut menu point to More Stuff and click Define Fields.
- On the Work With menu, click CDC Hemavet®.
• You will need to click Yes to confirm. A message will display at the bottom of the More Stuff window informing you that it is connecting to the instrument.

• Run the test on the CDC Hemavet®. After approximately 5 minutes the fields will be defined.

• It is recommended that you define Normals at this time.

Data import
Once the data fields are defined as described above, you will be able to automatically import data from the Hemavet® machine directly into the Medical History of the patient when the treatment is performed.

• Enter the correct treatment code into the patient’s Medical History.

• With the treatment highlighted in Medical History, right-click and from the shortcut menu point to More Stuff and click Enter Data.

• On the Work With menu, click CDC Hemavet®.

• You will need to click Yes to confirm and proceed.

• Run the test on the machine and after approximately 5 minutes, the results will import into the fields.

Interface with the Hemagen® Analyst
AVImark allows you to collect data from the Hemagen® Analyst and input the data directly into the patient’s Medical History.

AVImark settings
• On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.

• Select the System tab and select the Instrument tab.

• Select Hemagen® from the list of Lab Instruments.

• From the Instrument on dropdown list, select the correct Comport you are using.

• Using the Baud Rate dropdown list, select 9600.

• Use the Data Bits dropdown list and select 8.

• Use the Parity dropdown list and select None.

• Use the Stop Bits dropdown list and select 1.

• Click Done to save the settings.

Define result fields
In order for AVImark to allow the Hemagen® to import the results for a given treatment the fields will need to be defined. This will need to be done from the Treatment List.

• From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click Change to display the Change Treatment window.

• In the Attachments section, select More Stuff to display the Define More Stuff window.

• On the Work With menu, click Hemagen®. You will need to click Yes to the prompt and a message will display at the bottom of the More Stuff window informing you that it is connecting to the instrument.

• Run the test on the Hemagen®. After approximately ten minutes the fields will be defined.

Data import
Once the data fields are defined as described above, you will be able to automatically import data from the Hemagen® machine directly into the Medical History of the patient when the treatment is performed.
• Enter the correct treatment code into the patient’s Medical History.

• With the treatment highlighted in Medical History, **right-click** and from the shortcut menu point to More Stuff and then click **Enter Data**.

• On the **Work With** menu, click **Hemagen®**. You will need to click **Yes** at the prompt to proceed.

• Run the test on the machine. AVImark will import the results into the data fields.

**Hemagen® Instrument Interface**

The Hemagen Analyst III and HC5 in-house analyzers are the newest addition to the AVImark Instrument Import utility. Results can be captured and automatically imported into patient records with minimal user intervention.

**Setup:**

Assign the appropriate comport for each instrument on the appropriate AVImark workstation. For example, if you have the Hemagen HC5 connected to serial port Com 1, then your AVImark port setting in Hospital Setup, System tab, Instrument sub tab should reflect that setting.

Assign your instrument to the Instrument Types tab of the appropriate AVImark treatment.

**Important NOTE:** As of AVImark version 2009.3, you have the ability to assign multiple instruments or labs to a single AVImark treatment. If you have more than one instrument that is used to perform a single treat-
ment such as a pre-surgical panel, you are no longer required to have one AVImark treatment per instrument; or in the case that you have more than one instrument that can perform the same test, such as an IDEXX instrument and a Heamgen instrument that can each run the same CBC test.

- The utility can be found by accessing Utilities, Run Instrument Import.
- This utility is now set up to automatically start when AVImark starts, and has the option to Close on AVImark Shutdown.
- When AVImark opens you will see the “shaking hands” icon located in the System Tray of your workstation. This indicates that AVImark is in communication with the instrument(s) assigned to communication ports on this computer, and is “listening” on each port for any incoming data.
- The options to Start when AVImark opens, and Close on AVImark Shutdown can be controlled by right click options on the icon in the System Tray.

**Important NOTE:** If you have de-selected the Close on AVImark Shutdown option, please note you will need to manually close the connection utility prior to index rebuilding or any other maintenance utility that requires exclusive access to AVImark files.

Once the instrument is properly assigned in Hospital Setup, and associated to the AVImark treatment(s), your setup is complete.

*Use:*

When a treatment is entered into Medical History for a patient that has an instrument assignment, AVImark will start listening to the ports in which the associated instruments are assigned for results. As results are ready to be transmitted, AVImark will import the results to the proper Medical History entry. If the proper Medical History cannot be located, the results will be sent to the new "**Test Inbox**" to await manual import.

- First, the import utility looks for a patient with a record number that matches the “Patient ID” field received from the instrument.
  - The Patient ID that is being searched for a match is the AVImark Patient ID.
  - When running the test on the designated analyzer, and prompted for a patient identifier, the AVImark Patient ID is the number that will allow the utility to make the proper patient association for automatic result import.

- Once the patient identifier is located on the incoming results, the utility will begin searching for a Medical History entry for that patient that is awaiting results.

- When that Medical History entry is located, the results will be automatically imported into the Tests Attachment area.

- If the Patient ID doesn’t match or exist or there is no matching Medical History entry on that patient awaiting results, the test results are placed in the “**Test Inbox.**”

- To manually import the results that were sent to the Test Inbox, simply highlight the Medical History entry you wish to import results for, select the Tests attachment, **Import From, Test Inbox.** You will be presented with a list of results that were transmitted from instruments that did not find the Medical History entry to complete the automatic import. Select the set of results you wish to import to this history entry, and click Done.

- When you “Import from” the Test Inbox, the record is actually moved from the Test Inbox onto that Medical History entry. This will allow the Test Inbox to only contain results that have not been imported to Medical History.
• As an additional safety measure to ensure no results are lost, an RX$ file is also created with the transmitted results. This RX$ file is sent to the user defined Instruments storage folder. This path to this storage folder will need to be set in Advanced Options. Select the “Save Lab Instrument results To” entry and assign the path to your storage folder. If you are currently using AVImark to retrieve your results, you likely already have this in place.
  ○ Results can be imported from this location if needed by opening the Tests attachment, select **Import From, Stored Tests.** This will display all stored RX$ files on the left pane. You can select the RX$ file that holds your test, move to the right pane, select the test, right-click and select Import Test.

• In the case of an emergency, where access to results is immediately needed, right click on the treatment in Medical History that has the lab instrument association that represents the test instrument being used, and select **Import Results.** This will open the **Associated Instruments** window displaying a list of associated instruments for this treatment. Place a check in the box that represents the instrument from you wish to receive results, click the Import Results button, and AVImark will begin listening to these ports. In the event there is only one instrument associated to the treatment, the instrument checkbox will automatically be checked and listening to the proper port. As the data is sent from the instrument via the port, AVImark will capture and place it immediately in the Test Results window. After the results are received, the Import Results window will disappear, and you can view the results by selecting the Tests attachment option for that Medical History entry.

**Important NOTE:** To alleviate the chance of sending results automatically to the wrong Medical History record that may also meet the requirements for automatic import selection we have incorporated a two day time frame to use for searching, then selecting the oldest entry in that time frame for which these results would apply, to make the result attachment. To summarize, the utility will look for that patient record, then start at the farthest date/time as dictated by the two day time frame, and apply it to the first one it finds....versus starting with the most recent and looking back.

**Interface with the Heska®/Scil Vet® ABC**
AVImark allows you to collect data from the Heska®/Scil Vet® ABC and input the data directly into the patient’s Medical History. You may run up to 16 tests at a time; however, you will not be able to run a panel. Before using this machine, in **Work With, System Tables** you must have a Chemistry Table. If this table does not appear please call Technical Support.

**AVImark settings**

  • On the CID, open the **Work with** menu. Click **Hospital Setup** to display the Hospital Setup window.
  • Select the **System** tab and select the **Instrument** tab.
  • Select **Heska® ABC** or **Scil Vet® ABC** from the list of Lab Instruments.
  • From the **Instrument on** dropdown list, select the correct Comport you are using.
  • Using the **Baud Rate** dropdown list, select **9600**.
  • Use the **Data Bits** dropdown list and select **8**.
  • Use the **Parity** dropdown list and select **None**.
  • Use the **Stop Bits** dropdown list and select **1**.
  • Click **Done** to save the settings.

**Heska®/Scil Vet® ABC settings**

  • Ensure **Main** menu is displayed.
  • Press 5 for **Setup**.
  • Press 5 again for **Host Option**.
  • Press 1 for **Host Comm**.
• Press 3 for **Standard**. This will return you to the previous menu.
• Press 2 for **Send limit**.
• Press 2 again for **Off**. This will return you to the previous menu.
• Press 3 for **BAUD** rate.
• Press 5 for **9600**. This will return you to the previous menu.
• Press **ESC** several times to return to the main menu.

**Define result fields**
AVImark can assist you with the process of defining the data fields using the Heska®/Scil Vet® ABC instrument if you wish. Defining your fields this way insures that the fields are properly defined with exactly the right field names and data types. If you elect to auto-define the fields from the patient’s medical history, the results will NOT be automatically imported.

> Different analysts are returned with different species cards. If you have only one treatment for the test, it is recommended that you use the Dog species card because it has the most extensive list.

• From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click **Change** to display the Change Treatment window.
• In the **Attachments** section, select **More Stuff** to display the Define More Stuff window.
  
  OR

• Select the correct treatment from the patient’s Medical History.
• Right-click and from the shortcut menu point to **More Stuff** and click **Define Fields**.
• On the **Work With** menu, click **Scil Vet ABC** or point to **Heska®** and click **Heska® ABC**.
• Insert the species card into the Heska® and then select the option to load the new card.
• Click **Yes** to the prompt. A message will display at the bottom of the More Stuff window informing you that it is connecting to the instrument.
• Run the test on the ABC. This will take approximately 1 ½ minutes to run. You may run up to 16 tests at a time; however, you can not run a panel.
• It is recommended that you define **Normals** at this time.

**Data import**
• Enter the correct treatment code into the patient’s Medical History.
• With the treatment highlighted in Medical History, **right-click** and from the shortcut menu point to **More Stuff** and click **Enter Data**.
• On the **Work With** menu, click **Scil Vet ABC** or point to **Heska®** and then click **Heska® ABC**.
• You will need to click **Yes** to confirm and proceed.
• Run the test on the machine. This will take approximately 1 ½ minutes to run. AVImark® will import the results into the data fields.

**Interface with the Heska® Spotchem EZ**
AVImark allows you to collect data from the Heska® Spotchem EZ and input the data directly into the patient’s Medical History. You may run up to 9 tests at a time. In addition, you may also run panels and/or individual test. Before using this machine, in **Work With, System Tables** you must have a Chemistry Table. If this table does not appear please call Technical Support.
AVImark settings

- On the CID, open the **Work with** menu. Click **Hospital Setup** to display the Hospital Setup window.
- Select the **System** tab and select the **Instrument** tab.
- Select **Heska® Spotchem EZ** from the list of Lab Instruments.
- From the **Instrument on** dropdown list, select the correct Comport you are using.
- Using the **Baud Rate** dropdown list, select **9600**.
- Use the **Data Bits** dropdown list and select **7**.
- Use the **Parity** dropdown list and select **Even**.
- Use the **Stop Bits** dropdown list and select **2**.
- Click **Done** to save the settings.

Heska® Spotchem EZ settings

- Ensure **Main** menu is displayed.
- Press **Menu** and **Stop** simultaneously.
- At the prompt for a password, press the **-/.** Button.
- Enter **4430** and then press the **-/.** Button.
- Press **Enter**. You will be returned to the Main menu and the PLUS SIGN (+) should be present on the right side of the screen.
- Press 2 for **Submenu**.
- Press 6 for **Setup**.
- Press 3 for **Communication**. The cursor will be located in the **Use** field.
- Press the **-/.** button to toggle to **On**.
- Press **Enter** to move to the **Format** field.
- Press the **-/.** Button until **1** is displayed.
- Press **Enter** to move to the **BAUD rate** field.
- Press the **-/.** Button until **9600** is displayed.
- **ID** format will be displayed, press **Enter**.
- Writing will be displayed, press **Enter**.
- Press **Stop** until **Back to User Mode?** is displayed.
- Press **Start**.

Define result fields

In order for AVImark to allow the Spotchem to import the results for a given treatment the fields will need to be defined. This can be done from either Medical History or the Treatment List.

- Run the test on the Spotchem. Each test takes a different amount of time to run. Normally, it will take 9 ½ minutes when using blood and 6 ½ minutes when using serum.
- From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click **Change** to display the Change Treatment window.
- In the **Attachments** section, select **More Stuff** to display the Define More Stuff window.
OR

- Select the correct treatment from the patient’s Medical History.
- Right-click and from the shortcut menu point to More Stuff and click Define Fields.
- On the Work With menu, point to Heska® and then click Heska® Spotchem EZ.
- You will need to click Yes to confirm and proceed.
- Select the option on the Spotchem to send the desired results (generally the last test run).
- It is recommended that you define Normals at this time.

Data import

- Run the test on the Spotchem. Each test takes a different amount of time to run. Normally, it will take 9 ½ minutes when using blood and 6 ½ minutes when using serum.
- Enter the correct treatment code into the patient’s Medical History.
- With the treatment highlighted in Medical History, right-click and from the shortcut menu point to More Stuff and click Enter Data.
- On the Work With menu, point to Heska® and click Heska® Spotchem EZ.
- You will need to click Yes to confirm and proceed.
- Select the option on the Spotchem to resend the results from the last test that was ran.

Interface with the Heska® CBC-Diff

AVImark lets you collect data from the Heska® CBC machine and input the data directly into the patient’s Medical History. In order to utilize the interface between the CBC Diff and AVImark, you must be on AVImark version 174 or higher. Before using this machine, in Work With, System Tables you must have a Chemistry Table. If this table does not appear please call Technical Support.

AVImark settings

- On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
- Select the System tab and select the Instrument tab.
- Select Heska® CBC from the list of Lab Instruments.
- From the Instrument on dropdown list, select the correct Comport you are using.
- Using the Baud Rate dropdown list, select 9600.
- Use the Data Bits dropdown list and select 8.
- Use the Parity dropdown list and select None.
- Use the Stop Bits dropdown list and select 1.
- Click Done to save the settings.

Heska® CBC-Diff settings

There are some settings to choose from on the CBC-Diff for the various printer options. This will allow you to print to an external printer as well as import results into AVImark.

- From the CBC-Diff Main menu, select option 2 or 3.
- Select 6 to only send results to AVImark.
- Select 7 to send results to AVImark and print results in text only.
- Select 8 to send to AVImark and print the text results as well as graphs.
**Define result fields**

In order for AVImark to allow the CBC-Diff to import the results for a given treatment the fields will need to be defined. This can be done from either Medical History or the Treatment List.

- From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click **Change** to display the Change Treatment window.
- In the **Attachments** section, select **More Stuff** to display the Define More Stuff window.

**OR**
- Select the correct treatment from the patient’s Medical History.
- Right-click and from the shortcut menu point to **More Stuff** and click **Define Fields**.
- On the **Work With** menu, point to **Heska®** and click **Heska® CBC-Diff**.
- You will need to click **Yes** to confirm. A message will be displayed at the bottom of the Define More Stuff window indicating it is connecting to the CBC-Diff and preparing to run a test.
- It is recommended that you define **Normals** at this time.

**Data import**

Once the data fields are defined you will be able to automatically import data from the Heska® CBC-Diff directly into the patient’s Medical History once the service is performed. If you have defined the data fields through the patient’s Medical History you will need to run the test again to enter the results. If you have defined the fields through the Treatment List follow these steps:

- Enter the correct treatment code into the patient’s Medical History.
- With the treatment highlighted in Medical History, right-click and from the shortcut menu point to **More Stuff** and click **Enter Data**.
- On the **Work With** menu, point to **Heska®** and click **Heska® CBC-Diff**.
- Click **Yes** to download the test results.

**Interface with the Heska® DCU**

AVImark has the ability to retrieve lab results via the Heska® DCU. This interface will allow the capture and subsequent storage of results from several Heska® instruments. With our DCU interface you will now be able to utilize results from these instruments as well as the following: Hema True; DRI-CHEM; and i-STAT.

**Setup**

The results will be automatically transmitted to a user specified storage folder in an .XML format. This storage folder will need to be assigned in the DCU software as well as AVImark. You can create the storage folder in any accessible location. An example of an accessible location would be in the AVImark folder as a sub-directory.

- From your System Tray open the Heska® DCU
- Click **Preferences**
- In the Output folder click on the browse button to locate the storage folder you created

In order to retrieve results using this interface, you will need to assign the directory location for these stored results in the AVImark Advanced Options.

- Click on the hammer, wrench, and screwdriver icon in the AVImark Speedbar.
- Type **DCU** in the Search field
- Select the **DCU Results Path** option and enter the path to the location in which your DCU software receives and stores results.
Data Import

- Select the appropriate entry in the patient's Medical History.
- Select the treatment in the patient’s Medical History where the results will be stored.
- On the highlighted entry click the Tests attachment option to the right of the Medical History area.
- From the Import From menu select Heska® DCU.
- Select the appropriate file to display the file details.
- Select the line that represents the test that you want to import into the patient’s record, and choose right-click Import.
- A message will be prompted indicating that the results have been imported, click OK.
- The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.
- The results will be permanently associated to this Medical History entry.

Interface with the IDEXX® VetTest

AVImark gives you the ability to use the VetTest instrument to automatically define the AVImark test result fields for your different analysis tests, as well as to import test results into the patient’s medical history for these analyses. A single test result or a panel of up to 12 result values (the capacity of the VetTest instrument) can be imported at one time. AVImark also allows tests to be run with the results automatically transfer to a location that has been defined within the AVImark Advanced Options without having a More Stuff window open during the test. This allows for the fields to be defined and results to be entered at a more convenient time during the day. Before using this machine, in Work With, System Tables you must have a Chemistry Table. If this table does not appear please call Technical Support.

AVImark settings

- On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
- Select the System tab and select the Instrument tab.
- Select IDEXX® Vettest from the list of Lab Instruments.
- From the Instrument on dropdown list, select the correct Comport you are using.
- Using the Baud Rate dropdown list, select 9600.
- Use the Data Bits dropdown list and select 8.
- Use the Parity dropdown list and select None.
- Use the Stop Bits dropdown list and select 1.
- Click Done to save the settings.

IDEXX® Vet Test settings

- From the Main menu of the IDEXX® 8008 machine press 5, 7, 4 to display the Transmission Control. This should read Disable.
- From the Main menu of the IDEXX® 8008 machine press 5, 7, 3 to display the Transmission Format. Set to Original format.
- From the Main menu of the IDEXX® 8008 machine press 0, 4 to display the Enable Interpretation and Enable Serial Comms options.
- Set Enable Interpretation to On.
- Set Enable Serial Comms to Off.
Connectivity test
Before running an actual test it is recommended to do a dry run to ensure there is a valid connection.

• Enter a treatment code into the patient’s Medical History.
• In the Attachments section of Medical History, select More Stuff.
• Click Yes to the prompt to display the Define More Stuff window.
• On the Work With menu, point to IDEXX® and click IDEXX® Vet Test.
• Click Yes to the prompt.
• Click 6 on the IDEXX® 8008 machine to initialize remote devices. A message will be displayed at the bottom of the Define More Stuff window indicating it is connecting to the IDEXX® Vet Test.

On the Vet Test® 8008 machine you should see an icon of a small computer. This will only appear for a few seconds. If no icon appears, stop here and contact our Technical Support to see if we can further assist you.

Data import
• Enter the correct treatment code into the patient’s Medical History.
• Select the treatment in the patient’s Medical History where the results will be stored.
• On the highlighted entry click the Tests attachment option to the right of the Medical History area.
• From the Import From menu select the Instrument Types option.
• Click the IDEXX Vettest option and click Import Results.
• Click 6 on the IDEXX® 8008 machine to initialize remote devices.
• Load the appropriate slide(s) and conduct the analysis on the sample. The Vettest will prompt you to remove the sample when the test is complete.
• Press E on the IDEXX® 8008 machine to send the results to AVImark.
• The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.
• The results will be permanently associated to this Medical History entry.

Interface with the IDEXX® LaserCyte
AVImark lets you collect data from the IDEXX® LaserCyte machine and input the data directly into the patient’s medical history. To utilize the interface between the IDEXX® LaserCyte and AVImark, you must be on AVImark version 174 or higher. The integration provides the ability to run several tests on the LaserCyte and store these results until you are ready to import them into AVImark. In addition, this integration gives you the ability to run tests on multiple IDEXX® instruments at once and have all of the results sent to AVImark as they are completed. By setting up the IDEXX® machines (VetTest, Snap Reader, Vet Stat, LaserCyte, and QBC) to connect directly into the IDEXX® Vetlab Station, the results from each of these machines can be sent from the Vetlab Station to AVImark as soon as they are completed. Before using this machine, in Work With, System Tables you must have a Chemistry Table. If this table does not appear please call Technical Support.

AVImark settings
• On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
• Select the System tab and select the Instrument tab.
• Select IDEXX® LaserCyte from the list of Lab Instruments.
• From the Instrument on dropdown list, select the correct Comport you are using.
Using the Baud Rate dropdown list, select 9600.
- Use the Data Bits dropdown list and select 8.
- Use the Parity dropdown list and select None.
- Use the Stop Bits dropdown list and select 1.
- Click Done to save the settings.

**IDEXX® LaserCyte settings**

- Once the LaserCyte recognizes the connection to the AVImark computer an icon of a computer (PIMS) will show on the LaserCyte.
- On the main screen go to the settings, Practice Management and choose other.
- You can then set transmit to On in the Practice Management tab.

**Data import**

- Enter the correct treatment code into the patient’s Medical History.
- Select the treatment in the patient’s Medical History where the results will be stored.
- On the highlighted entry click the Tests attachment option to the right of the Medical History area.
- From the Import From menu select the Instrument Types option.
- Click the IDEXX Laser Cyte option and click Import Results.
- The results will be received in any value, type and with notes or comments as they are sent from the lab/instrument, as well as display the normal ranges as dictated by the lab or instrument at the time the test was completed.
- The results will be permanently associated to this Medical History entry.

**Interface with the IDEXX® LabREXX**

AVImark includes LabREXX, a feature that allows you too quickly and easily create IDEXX® Reference Laboratories bar-coded test orders to be used in conjunction with VetConnect®. AVImark and IDEXX® have teamed up to help increase the efficiency of your practice AND improve your bottom line. Best of all, LabREXX in AVImark can eliminate some of the paperwork.

- To utilize this interface you will first need to have your Username and Password set up through IDEXX®.
- This can be accomplished by sending a request to lablink@IDEXX.com. You should include your Hospital Name, phone number, and your request for a username and password that will allow access to send and retrieve results via the AVImark/LabREXX interface.
- Once you have been assigned your username and password, you will need to enter them into the appropriate fields in AVImark Advanced Options. You will find the proper data fields by using the Options Maintenance icon on the CID screen, type IDEXX into the Search field, you will see two options, IDEXX LabREXX Password, and IDEXX LabREXX User ID.
- Enter the appropriate information into the corresponding field by clicking on the Change Button for each and setting the Hospital Default Value.
- You also have the option of having each doctor have their own Username and Password. This can be beneficial in a practice where there are multiple doctors, each sending and receiving Lab Requisitions and Results. Having each doctor have their own individual access codes will allow each doctor
to choose and store their own favorites, for fast easy selection. When a user with a user specified LabREXX username and password logs into AVImark, the information associated to that username and password will be the information that will be automatically displayed in the IDEXX® LabREXX Site.

**Set up a Requesting Doctor**
AVImark gives you the ability to select a requesting doctor for the requested test without being logged in as the particular requesting doctor. This feature allows doctors to be selected on-the-fly in the LabREXX window, no longer causing doctors to share their AVImark passwords with staff members to allow the filling of LabREXX requisitions on their behalf.

- Open the Options Maintenance window by selecting the Advanced Options speed button.
- In the Search field type labrexx. Click on the plus symbol next to IDEXX VetConnect to expand the view and display options.
- Select the option Password and in the User area select right-click New. Choose the staff member or leave the option set to none if the same values will be used by all doctors.
- If your clinic wishes to use one default password for multiple doctors enter the password in the Default field. For doctors that want to use their own specific password, enter their assigned password instead of the default password.
- Use the Value field to enter an ID User value, which is user specific.
- Click OK once the appropriate information has been entered.
- Next select the Username option and choose right-click New under the User area.
- Click on the User drop-down list to choose the appropriate doctor or leave it set to none.
- Enter their Username that they previously set up on www.VetConnect.com.
- Click OK once the appropriate information has been entered.

When creating a requisition form you will have the option to select a Test Doctor and this doctor will also be recognized as the performing doctor for the corresponding Medical History entries. Both the user who is logged in when creating the Requisition Form and the Testing Doctor will appear on the Requisition Form.

**Attaching LabREXX Codes to AVImark Treatments**
LabREXX codes can be associated to existing AVImark treatments.

- Choose Work with, Treatments from the CID menu.
- Locate the appropriate treatment you wish to associate the LabREXX code and select right-click Change.
- In the Change Treatment window click the Laboratory tab and select the VetConnect sub-tab.
- Right-click in the LabREXX field and select Code List. This will display a list of all LabREXX codes and their associated prices.
- Choose the appropriate code and click Done.
- Once the selection is made the LabREXX code will appear in the LabREXX field.
- Click OK once the information has been set.

The LabREXX code is now associated with the selected treatment. When you finalize a LabREXX requisition that has been associated to an AVImark treatment, the treatment will automatically be entered in the pets Medical History.

**Using the LabREXX Requisition**

- Right-click in the AVImark Patient Area, select Interfaces, IDEXX LabREXX.
- You will be presented with the **IDEXX LabREXX** window with two tabs being displayed.

![IDEXX LabREXX window](image)

- On the **Create Requisition tab**, you will see that the Patient Name, Species, Breed, Gender, and Client Name will automatically be populated based on the information. You have the opportunity to make changes in the Group, Breed, or Gender by using the available drop down lists. Click the **In House Pet** option to indicate this form is being created for a pet belonging to a staff member.

- To proceed with creating the requisition form, click on the **Create** button.

- This will open a Web Browser that will open to the LabREXX window.

**Viewing the LabREXX Web Browser**

![LabREXX Web Browser](image)
• The first section will be **1. Tests** which is where you will select the test(s) to be performed, view the Top 20 Tests Ordered, Full List of available tests, and filter the list by categories.

• You will see in the lower right corner a Current Requisition area. This will already contain the patient you are working with as well as the doctor performing the request.

• To make a selection for a test to be added to the Requisition form, simply find the test in the list and click on the **Select** option to the right of the Test Name.

• The Current Requisition area will then display the chosen tests for this patient.

• When you have made your final selection, you have the option of Saving a Draft to this point to be completed at a later time, or clicking **Next** to proceed.

• Clicking **Next** will take you into the second main section, **2. Specimen Details**. In this area you can make selections for collection methods as required by certain tests, add Notes and Instructions, comparison requests, or provide a number where you would like faxed results sent, etc.

• You have the ability at this point to continue on by clicking Next, or Saving the Draft to be continued at a later time.

• When you click **Next** you will be taken to the third section, **3. Review Form**.

• In this section you can verify that all the information is accurate, all the proper tests have been
requested, and Print and Finalize the Requisition Form. You also have the ability to Save a Draft at this point, or go Back if there is some information missing or changes that need to be made before finalization and printing.

**Print and Finalize**

- Once you have verified that the Requisition Form has all the appropriate information, you can click on the Print and Finalize Button and you will have your printed Requisition Form to send along with the appropriate samples to the lab for testing.

**Note:** If at any time during the LabREXX process, you need to save your requisition to come back and complete at a later time, you can do so by clicking on the Save Draft option, then close the window. This will save your work up to that point so you can pick it back up where you left off.

- To access the saved Draft, simply right-click in the patient area of the AVImark CID screen, select Interfaces, IDEXX LabREXX. Select the Retrieve Requisition Tab. A list with all currently saved drafts will be displayed. Simply scroll through the list of Drafts, find the desired draft, select it, and click on the Retrieve button. This will take you into the saved draft where you can continue with the requisition process.

- Upon Clicking Print and Finalize, the requested test will be entered into the patient’s Medical History. If the requested test does not currently exist in your AVImark Treatment List, it will be created. You will receive a message indicating a new treatment has been added.

- Clicking OK to this message will open the AVImark New Treatment window, where you can assign your desired clinic information such as Price, Action Code, Discount Classes, etc. and the newly added Treatment will be placed into the Medical History.
• These Treatment List entries will be assigned to a new Treatment Category called **IDEXX LabREXX Treatments**. If this category does not currently exist, it will be created. If this category already exists, then the new treatments will be added to the existing Treatment Category.

• If you would prefer to create the Treatment Category and add all the possible IDEXX® LabREXX treatments prior to the first Print and Finalization of a LabREXX code, you have the option of creating the category and populating it all with a single click. With this option you can set your customized treatment information for each new treatment prior to the first IDEXX® LabREXX use. This can be accomplished by opening the AVImark Treatment List, going to **Import Treatments**, Import IDEXX® LabREXX Treatments.

• This will create your IDEXX® LabREXX Treatments category, and populate it with all the possible tests set up as new treatments. You will be prompted for each treatment to enter the desired price, action code(s), species, etc. then when you click OK, you will be presented with the next New Treatment window, this will continue until all the new treatments have been added.

• You are now ready to define and import your test results for the appropriate treatment/patient when the results are received via your normal AVImark/VetConnect® interface.

**Interface with the Forcyte®**
AVImark will allow importing of Forcyte® test result data. AVImark lets you collect data from the Forcyte® machine and input the data directly into the patient’s medical history.

**AVImark settings**
• On the CID, open the **Work with** menu. Click **Hospital Setup** to display the Hospital Setup window.

• Select the **System** tab and select the **Instrument** tab.

• Select Forcyte® from the list of Lab Instruments.

• From the **Instrument on** dropdown list, select the correct Comport you are using.

• Using the **Baud Rate** dropdown list, select **9600**.

• Use the **Data Bits** dropdown list and select **8**.

• Use the **Parity** dropdown list and select **None**.

• Use the **Stop Bits** dropdown list and select **1**.

• Click **Done** to save the settings.

**Define test result fields**
• From your Treatment List, select the correct treatment. Right-click and from the shortcut menu click **Change** to display the Change Treatment window.

• In the **Attachments** section, select **More Stuff** to display the Define More Stuff window.
OR

- Select the correct treatment from the patient’s Medical History.
- Right-click and from the shortcut menu point to More Stuff and click Define Fields.
- On the Work With menu, click Forcyte®.
- You will need to click Yes to confirm. A message will be displayed at the bottom of the Define More Stuff window indicating it is connecting to Forcyte®.
- Run the test on the Forcyte®. After approximately 5 minutes the fields will be automatically defined.
- It is recommended that you define Normals at this time.

Data import

- Enter the correct treatment code into the patient’s Medical History.
- With the treatment highlighted in Medical History, right-click and from the shortcut menu point to More Stuff and click Enter Data.
- On the Work With menu, click Forcyte®.
- You will need to click Yes to confirm and proceed.
- Run the test on the Forcyte®. After approximately 5 minutes the results will import into the correct data fields.

Interface with Antech®

AVImark gives you the ability to import test results that are downloaded from the Zoasis® Corporation’s website (zoasis.com). You will first need to download your test results from Zoasis®. The data will be in the form of an XML file and can be downloaded to any entry in Medical History.

Setup

Before using Antech® some options must be defined.

- On the CID click the Hammer, Wrench and Screwdriver speed bar icon to open the Advanced Options.
- In the Search field, type Antech®.
- If already using Antech® with AVImark the Antech® ID Number, Password, User Name and Zoasis ID Number will already be defined. You will need to define the Region information.
- Additional Antech® options can also be defined if appropriate.
- Click Done to save the setting.

Species and Breed Table Information

Species Table

Each species in the Species Table will need to have the corresponding Antech® Species Code assigned as designated by Antech®. Should you need help identifying the appropriate species code contact Antech®.

- From the CID Work with menu select System Tables.
- Choose the Species Table, highlight the appropriate species and from the right-click menu select Change.
- In the Antech® Species field enter the appropriate Antech® Species Code.

Breed Table

To allow the current AVImark breeds to be linked to the Antech® established breed list, there is the ability to
assign a breed association between AVImark and Antech®.

- From the CID Work with menu select System Tables.
- Choose the Breed Table, highlight a breed and from the right-click menu select Change.
- Click on the Antech® Breed drop-down list to choose the Antech® Breed.
- An Antech® breed can also be associated at the time the Requisition is being created. If no Antech® breed is associated with the breed a message will be displayed and clicking OK will allow you to make an association.

Treatment List Laboratory Associations
In order to use Antech® the desired Antech® tests must be associated to the treatment in the Treatment List.

- From the CID Work with menu select Treatment List.
- Choose the appropriate treatment and from the right-click menu select Change.
- Click the Laboratory tab and then the Labs sub-tab.
- While in this tab select New from the right-click menu.
- From the Lab Company drop-down list choose the appropriate lab for this treatment.
- This will assign the ID and if it is a Pathology/Cytology request place a check in the box provided.

Creating Lab Requisition
Generating requisitions can be performed from more than one area.

Patient Area
- While highlighted in the Patient area right-click and from the shortcut menu select Create Requisition.
- Select Antech® as the Lab Company, highlight the desired test from the list provided and press the Spacebar to make the selection.
- Choose a doctor and the selected test(s) will be added to Medical History.
- This entry will be the entry that will receive the imported test results.

Medical History Area
- From the Medical History area select the desired entry.
- Right-click and from the shortcut menu select Create Requisition.
- Choose Antech® as the Lab Company, select the test and choose a doctor.

Automatically
- If a treatment has an assigned Antech® Lab Company and Order Code a requisition will automatically be created when it is entered into Medical History.

Printing Requisitions
Before printing requisitions define the default printer under Utilities, Printer Setup from the CID menu area. When an Antech® requisition is generated the form will automatically prompt for printing if the Advanced Option to Automatically Print Requisitions is set to True.
Requisitions can also be manually printed.

- From the CID Work with menu select Requisition Management.
- Find and highlight the requisition that represents the sample you are sending for analysis.
- From the File menu select Print, Print Requisition or right-click and from the shortcut menu select
Print, Print Requisition.

Download Results
The test results will automatically be transmitted and stored to the proper Medical History record of the patient for which the test was requested when the requisition was created through AVImark. In the event that some results are missing some or all of the identifying information that allow automatic transmission of the results to the history record, the requisition and results will be accessible from the Requisition Management area where they can be selected, viewed and manually attached to the appropriate history record.

- From the CID Work with menu select Requisition Management.
- Once inside the window select the Download Requisitions tab.
- Choose Antech® as the Lab Type and click Load.

The results will be automatically imported into the Test Results area of the Medical History area in AVImark.

Import Results
Results will be automatically downloaded and transmitted into the proper Medical History entry as long as all the identifying requisition information is in place. Should there be an instance where the appropriate Medical History record cannot be located or the treatment does not yet exist in the patient’s Medical History, you can add the treatment and bring in the results in one step.

- From the CID Work with menu select Requisition Management and click the Download Requisitions tab.
- From the Lab Type select Antech® and click Load.
- Locate and select the desired requisition, verify the lab associated to each test on that requisition you wish to import, then right-click on each test and click Select Lab.
- The Lab Selection Form will display allowing you to choose the AVImark treatment that represents the Antech® test. Click OK.
- Once all lab selections are set, and black in color, you will right-click on the requisition and select Import Results.

View Client and Patient Names for “Orphaned” Antech® Results
To allow client and patient names to be displayed as they are on the result file return from the lab, drag out Lab Client Name and Lab Patient Name by following these steps:

- Right-click in top pane of the Download Requisitions tab
- Select View, Columns
- Enter Lab in the Find field
- Drag out the Lab Client Name and/or the Lab Patient Name
This will add the appropriate AVImark treatments to Medical History as well as assign the test results to that entry.

**Viewing Imported Results**
- In the patient’s Medical History select the appropriate entry and click the *Tests* box under the Attachment area.
- Select the entry in the Tests window that represents the set of results you wish to view and **double left-click** to open the Analytes window.
- This window will display the Analytes, Measure, Result, Low Value, High Value, as well as the Quick Chart indicating where the result value falls in comparison to the High-Low Range.
- If the result falls outside the normal range the line representing the result for that analyte will be displayed in bold red.
- The columns can also be customized to meet your clinic’s preference.

**Graphing Results**
- In the Tests window of Medical History **double left-click** on the test to open the Analytes window.
- Highlight the appropriate line entry, right-click and from the shortcut menu select *Graph, By Treatment* or *Graph, By Field Name*.

The result values can be graphed using AVImark or Excel.

Results that currently exist in More Stuff values will not be affected by the new Antech® update so those results can still be graphed directly from the More Stuff window.
Printing Results

There are two methods for printing patient test results.

**Patient Chart**
- From the Patient area right-click and from the shortcut menu select **Chart**.
- Under the **Include** area select **Tests** to include stored result data.

**AVImark Results Report**
- From the Medical History area select the appropriate entry and click the **Tests** option under the Attachment area.
- Highlight the test you want to report and from the File menu click Print.

**Antech® XML Result Storage**
When loading results using the “Load” button in the Requisition Management window, all available test results will be downloaded from Zoasis and stored in individual XML files in a new directory. Acknowledgement of results will be automatic at the time of download and no longer repeatedly load the same set(s) of test results until the time they are imported to patient records. Results that have been imported to an AVImark patient record will be stored in a different new directory. These imported XML files will be automatically deleted after 45 days.

The above described directories will be automatically created within the AVImark folder. These directories are:
• **Antech® Requisitions** – This folder will be created directly within the AVImark directory and contain all downloaded result XML files that have not yet been imported to an AVImark patient record.

• **Imported Results** – This directory will be automatically created directly within the Antech® Requisitions directory. All results will be transferred from the Antech® Requisition folder to this location upon being imported to a patient record. The XML files will reside at this location until 45 days have passed, at which time they will be automatically deleted. This automatic file deletion will help prevent the folder from becoming unnecessarily large.

**Important:** These folders should not be renamed, moved, or deleted. There are no options to allow file name or location changes. When not found, these directories will be automatically recreated each time the “Load” button is pressed from within the Requisition Management window.

A new button has been added to the Download Requisitions tab in the Requisition Management window. The Load Previously Imported button will allow users to load results that have already been imported to a patient record for viewing or importing. This feature will make it unnecessary to move a previously imported set of results manually from the Imported Results folder to the Antech® Requisitions folder to be viewed or re-imported. When previously imported results have been loaded, the results will be displayed in green to allow an “at a glance” determination of the import status as well as (Viewing Previously Imported Results) in title bar.

**Work with Requisition Management**

The Requisition Management area is a centralized location to monitor, control, access, download and view lab results from any AVImark labs; containing in-house and reference laboratory information.

• From the CID Work with menu select Requisition Management.

**Using Requisition Management**

**Requisitions Tab**

This tab contains status information on all laboratory requisitions. From this tab you can select the lab(s) and date range for any lab requisition information. You can collect detailed requisition information regarding patient, created date, Lab Company, status, etc. This area also allows column customization.

**Download Requisitions Tab**

• From this tab select the Lab Type drop-down list to select a lab service and click Load.

• This will poll the Antech®/Zoasis site for any lab results for your hospital and display them.

• If the requisition is matched to an entry in Medical History the results will be downloaded directly to that entry.

• The top pane will display the Created Date, Requisition ID, Patient, Lab Company and Accession ID.

• When a requisition is selected in the top pane, the tests associated to that requisition will be displayed in the lower pane. This will display the Test ID, Test Description, Test Status and Imported Status. Columns can also be customized in this tab.

**Interface with VetConnect®**

AVImark allows you to import test results that are downloaded from the VetConnect® website. The data will be in the form of an RTW file and can be downloaded to any folder on your network. A good location might be a sub-folder of the AVImark directory. In order to utilize the AVImark VetConnect® interface, you must be on version 174 or higher with a created date of 11/11/04 or above.

**File set up**

The first setup requirement entails the installation of a program developed by IDEXX® used to download your test results. This download module is a program initialized by AVImark and consists of two files; VCAgent.jar and Parser.exe. AVImark will install these files for you automatically upon installation, in a sub-folder named VetConnect®.
Program installation
In order to download test results you will need to install a Java Runtime program. This program is required by the IDEXX® download module and must be installed on each computer you will be downloading test results on. AVImark technical support cannot provide technical support assistance with the installation of this program, but will provide you with written instructions on downloading and installation of this program as a courtesy to VetConnect®.

AVImark settings
The last setup requirement is to obtain a user name and password from IDEXX®. This information will be entered into Hospital Setup, along with the file download directory, and allows you access through the IDEXX® download program to their website. Your user name and password may be requested by sending an email to lablink@IDEXX.com. When creating your email be sure to include the following information: Hospital name, Phone number and a request for user ID and password to be used to download test results from VetConnect®.

• On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
• Select the System tab.
• Select the Laboratory tab.
• In the VetConnect® Login section, type the Username and Password as issued from IDEXX®.
• Select the Advanced tab and click Advanced Options to display the Option Maintenance window.
• Click Yes to the prompt to save the settings already made.
• In the Search field, type Vet Connect and click Download Test Results To.
• In the Default Value field, click Change and type the location and name of the directory you have created for your VetConnect® RTW files. If this is a subdirectory of the AVImark folder, you may type VetConnect® since this folder has already been created for you.
• D code in the Change Treatment window.

Data import
Importing test results may be done in three different ways; Individual test, Accession, or RTW file.

Import individual test
• Select the correct treatment in the patient’s Medical History.
• With the treatment highlighted in Medical History, click the Tests attachment option to the right.
• From the Import From menu select VetConnect.
• Select the correct RTW file from the left-hand side.
• Select the correct patient to import to and select the correct test. The test should display a green light indicating that it has found the test in Medical History and that the fields have been defined.
• With the correct test highlighted right-click and from the shortcut menu point to Import and click Test.
• Click Done to return to the Tests window.

Import by Patient
Importing by Accession will import all tests for a patient at one time. It does not have to be done from the patient the results belong to or the client the patient belongs to. You will need to ensure that the treatments are in the patient’s Medical History prior to importing.

• Select the correct treatment in the patient’s Medical History.
• With the treatment highlighted in Medical History, click the Tests attachment option to the right.
• From the Import From menu select VetConnect.
• Select the correct RTW file from the left-hand side.
• Select the correct client and patient name.
• To ensure the results are imported to the correct client/patient, right-click and from the shortcut menu click Choose to display the Client Selection window.
• After choosing the correct client and patient, click Continue to return to the VetConnect® Lab Reports window.
• With the correct client/patient name highlighted, right-click and from the shortcut menu point to Import and click Patient.
• You will receive the message “Test results imported”, click OK.
• Click Done on the VetConnect® Lab Reports window.

Import by RTW file
Importing by RTW file will import all test results for all clients and patients at one time once the data fields are defined. It is similar to importing by Accession in that the importing does not have to be done from the client or patient the results belong to; however, you will need to ensure that the treatments are in the patient’s Medical History prior to importing.

• Select the correct treatment in the patient’s Medical History.
• With the treatment highlighted in Medical History, click the Tests attachment option to the right.
• From the Import From menu select VetConnect.
• Select the correct RTW file from the left-hand side.
• For each client/patient name you wish to import for, right-click and from the shortcut menu click Choose to display the Client Selection window. The correct client/patient name should be displayed, click Continue to return to the VetConnect® Lab Reports window.
• Select the top line on the right-hand side where the date and RTW file is listed. A green light should display next to those clients/patients which were chosen. A green light will also be displayed next to those tests which were found in Medical History.
• Right-click and from the shortcut menu point to Import and click File.
• You will receive the message “Test results imported”, click OK.
• Click Done on the VetConnect® Lab Reports window.

Tests which display a yellow light indicate that they have been defined and imported already. A red light displayed next to a test would indicate that the test was not found in Medical History or possibly the VetConnect® ID code is incorrect. A patient's name which is displayed in red normally indicates that the spelling of the name in AVImark is different than that on the RTW file from VetConnect®.

Interface with VDIC® VetMedStat Telemedicine
AVImark has the ability to access VDIC’s Telemedicine Services website directly from within the program to allow easy online access to radiology, ultrasound, cytology, and telemmedicine consultation. There is nothing to install.

AVImark Access
• In the Patient area choose right-click Interfaces, VetMedStat.
• The VDIC website will be displayed assisting new users in setting up a Telemedicine account, or submitting a Telemedicine request.
Once you have opened your VetMedStat account and received your Account Name and Password provided by VDIC®, you can enter that information into AVImark’s Advanced Options.

• From the CID click the Advanced Options icon (hammer, wrench, screwdriver icon)

• Type VetMedStat in the Search field.

• Enter the assigned Account Name into the VetMedStat User ID field, and the assigned password into the VetMedStat password field. Assigning this information to the corresponding Advanced Option field will allow you to automatically be logged into the site upon opening through AVImark. If you prefer to not be automatically logged into the VDIC® site, you can simply skip the step of entering the information into Advanced Options and you will be presented with the login fields upon accessing the site through AVImark.

Setup is complete, and you are now ready to begin making your telemedicine requests.

Submitting Requests

• To make a request, access the VetMedStat site and enter your Account Name and Password.

• Select the New Patient button.

• A patient information page will be displayed. This will automatically default to the AVImark patient and client you have selected on the CID, as well as the DOB and weight of the patient.

• You can select the Species, Breed, and Gender that applies to this patient and click OK.

• This will take you to the Request Form where you can make your Telemedicine Requests and click Next.

• You can then click on your Category to see and select your options and click Next.

• You will be prompted with a message confirming that your patient will be assigned a VMS patient ID number, click Yes to proceed or No to go back. If you click Yes, you will be prompted with a message confirming the Request ID number assignment for that patient. Clicking Yes again will allow the # to be assigned and you can proceed to complete your case. You will be presented with a window to make
your courier selection, or upload images.

- Press Complete when done.

Check Status of Request
Once a request has been submitted you can easily check the status of that request.

- Access the site by selecting your AVImark patient and choosing right-click Interfaces, VetMedStat.

- If the patient you have selected in AVImark is already set up in the VetMedStat site, their Patient ID number will automatically be displayed in the Patient ID field and any associated requests will be automatically loaded in the Request ID drop down for quick retrieval of reports.

You also have the ability to search for the case request for patients other than the one defaulted to being listed. Case requests can be searched by using one of the following options:

- The Patient Search
- Case Search requires you to know the request number
- Searching through Incomplete Requests
- Search through Cases in Progress

You have the same search options available to you from the Home Screen of the VMS site after you have logged in.

When you have selected the desired patient, you are able to review the findings based on the request submitted as they are available.

- The Request IDs will always be displayed in the Request ID drop down with the most recent being first in the list for that Patient ID. This will allow easy access to previous requests for this patient.
• To review any previous results for this patient, you simply select the desired Request ID and press the View Request button.

• When you are finished reviewing request results, you can exit the site by either clicking Done or simply choosing the red X in the top right of the window.

**Interface with Vmed® Technology**
The Vmed integration allows for specific client/patient data to be pulled from within AVImark and automatically populate the Vmed “Patient Episode File” within the PC Display software. This software is used in conjunction with Vmed’s PC-Vetgard and PC-Vet wireless monitors for the purpose of storing patient monitor parameters and ECG waveform data.

**Register the AVImarkCOMServer.dll File**
You must first register the appropriate dll file to begin using the Vmed Technology within AVImark.

• From the AVImark CID screen press Ctrl+Shift

• While pressing those function keys select the Utilities menu

• Additional options will appear and you will need to select Register, AVImarkComServer.dll.

You will then be able to select the desired AVImark client and patient from the CID and populate the PC-Display software after the Bluetooth connection is established. This will further allow you to save, print and review episode information in the PC-Display Software as well as the ECG Reviewer software that will include the AVImark client and patient specific information.

**Abaxis® i-STAT Integration**
AVImark users will have the ability to import results from the Abaxis® VetScan i-STAT Handheld Analyzer with AVImark version 2011.1. Results will be transmitted to AVImark via the Abaxis CDS software installed on the AVImark workstation PC.

NOTE: Abaxis® CDS software is not compatible with Windows 7 or 64 Bit environment. CDS Setup Abaxis® CDS software must be installed on an AVImark workstation and configured to the proper interface protocol for data type record transmittal as well as designating the proper folder path for result records. Information for making these settings can be found in the CDS Software Users Manual.

**AVImark Instrument Management Setup**
The Instrument Management area of AVImark will need to be configured to retrieve and import results from the i-STAT via the CDS software.

• Select Work With Instrument Management.

• Right-Click, select New, or use F2 to open a new Instrument Setup window.

• Select Abaxis CDS in the Type field.

• Your Computer ID and Protocol should be automatically populated with the proper information.

• Make sure the Active option is checked.

• Select Next to set your paths for your result folders.

• Instrument Results Path should be the full path to the same location used for the Data Files Path setup in the i-STAT CDS Interface Options in the CDS software. This will be the location AVImark will look to for results to be imported.

• AVImark Results Path should be the full path to the folder location you wish to have result files deposited after import to AVImark Medical History.

• Days to Save Imported Results will determine how many days the imported results will be stored in the AVImark Results Path location before being deleted.
Retrieving Results
Completed tests results can be selected and transmitted from the i-STAT to AVImark Medical History.

- Select the Tests Attachment for the Medical History for which you wish to import results.
- Select Import From > Abaxis CDS.
- Find and select the test you wish to import.
- In the right pane, highlight the test then right-click > Import > Test. Then Click Done.
- Your results will now be displayed in the Tests window, and the file used for import will be moved from the Instrument Results Path location to the AVImark Results Path location.

Abaxis® VetScan VSpro Integration
With AVImark version 2011.1, users will have the ability to import results from the Abaxis® VetScan VSpro. This new integration requires minimal setup and will use the existing “Run Instrument Import” utility. Connection to this instrument is supported by a TCP connection instead of the typical serial port connection.

Setup
In order to begin importing results the following steps will need to be taken to establish a connection between AVImark and the VSpro instrument. From the AVImark workstation you wish to use for communication:

- Select Instrument Management from the Work With menu on the CID to open the Instruments window.
- Open a new Instrument Setup window by F2, or right-click, New.
- Select Abaxis VetScan Pro from the available drop down list.
- The Name, Computer ID, and Protocol, fields should automatically be populated with the proper information once the instrument has been selected.
- Place a check in the Active box if not already defaulted to being checked.
- Select Next to enter the Host IP address. This Host IP will be the IP address of the AVImark workstation you are using.
- The Port can be left as defaults (to 33333).
- Clicking Finish completes the instrument setup.

NOTE: It will also be necessary to enter this AVImark workstation IP address on the VSpro instrument. You can assign the VSpro to the Instrument Types tab for the appropriate AVImark treatment.

Importing Results
Importing test results can be accomplished through use of the Instrument Import utility. The utility is much the same as in previous AVImark versions.

- The utility can be found by accessing Utilities, Run Instrument Import.
- This utility is now set up to automatically start when AVImark starts, and has the option to Close on AVImark Shutdown.
- When AVImark opens you will see the “shaking hands” icon located in the System Tray of your workstation. This indicates that AVImark is in communication with the instrument(s) assigned to communication ports on this computer, and is “listening” on each port for any incoming data.
- The options to Start when AVImark opens, and Close on AVImark Shutdown can be controlled by right click options on the icon in the System Tray.
NOTE: If you have de-selected the Close on AVImark Shutdown option, please note you will need to manually close the connection utility prior to index rebuilding or any other maintenance utility that requires exclusive access to AVImark files.

When a treatment with an instrument assignment is entered into Medical History for a patient, AVImark will start listening to the ports in which the associated instruments are assigned for results. As results are ready to be transmitted, AVImark will import the results to the proper Medical History entry. If the proper Medical History cannot be located, the results will be sent to the new “Test Inbox” to await manual import.

- First, the import utility looks for a patient with a record number that matches the “Patient ID” field received from the instrument.
  - The Patient ID that is being searched for a match is the AVImark Patient ID.
  - When running the test on the designated analyzer, and prompted for a patient identifier, the AVImark Patient ID is the number that will allow the utility to make the proper patient association for automatic result import.
  - If this is successful, then the recent medical history of that patient is searched for a recorded treatment that is set to store results from the instrument.

- Once the patient identifier is located on the incoming results, the utility will begin searching for a Medical History entry for that patient that is awaiting results.

- When that Medical History entry is located, the results will be automatically imported into the Tests Attachment area.

- If the Patient ID doesn’t match or exist or there is no matching Medical History entry on that patient awaiting results, the test results are placed in the “Test Inbox.”

- To manually import the results that were sent to the Test Inbox, simply highlight the Medical History entry you wish to import results for, select the Tests attachment, Import From, Test Inbox. Here you will be presented with a list of results that were transmitted from instruments that did not find the Medical History entry to complete the automatic import. Select the set of results you wish to import to this history entry, and click Done.

- When you “Import from” the Test Inbox, the record is actually moved from the Test Inbox onto that Medical History entry. This will allow the Test Inbox to only contain results that have not been imported to Medical History.

- As an additional safety measure to ensure no results are lost, an RX$ file is also created with the transmitted results. This RX$ file is sent to the user defined Instruments storage folder. This path to this storage folder will need to be set in Advanced Options. Select the “Save Lab Instrument results To” entry and assign the path to your storage folder. If you are currently using AVImark to retrieve your results, you likely already have this in place.
  - Results can be imported from this location if needed by opening the Tests attachment, select Import From, Stored Tests. This will display all stored RX$ files on the left pane. You can select the RX$ file that holds your test, move to the right pane, select the test, right-click Import Test.

- In the case of an emergency, where access to results is immediately needed, right click on the treatment in Medical History that has the lab instrument association that represents the test instrument being used, and select Import Results. This will open the Associated Instruments window displaying a list of associated instruments for this treatment. Place a check in the box that represents the instrument from you wish to receive results, click the Import Results button, and AVImark will begin listening
to these ports. As the data is sent from the instrument via the port, AVImark will capture and place it immediately in the Test Results window. After the results are received, the Import Results window will disappear, and you can view the results by selecting the Tests attachment option for that Medical History entry.

NOTE: To alleviate the chance of sending results automatically to the wrong Medical History record that may also meet the requirements for automatic import selection we have incorporated a two day time frame to use for searching, then selecting the oldest entry in that time frame for which these results would apply, to make the result attachment. To summarize, the utility will look for that patient record, then start at the farthest date/time as dictated by the two day time frame, and apply it to the first one it finds....versus starting with the most recent and looking back.

**Scil Vet abc Plus+ Integration**

Results from the scil Vet abc Plus+ can be transmitted to Medical History with AVImark version 2011.1. Results can be captured and automatically imported into patient records with minimal user intervention.

**Setup**

This feature will use the new Instrument Management area for making your connection settings. To begin setting up AVImark to retrieve results:

- Select Services, Instrument Management
- Open a new Instrument Setup window by F2, or right-click, New.
- Select Scil Vet abc from the available drop down list.
- The Name, Computer ID, and Protocol should automatically be populated with the proper information once the instrument has been selected.
- Place a check in the Active box if not already defaulted to being checked.
- Select Next and choose the appropriate Com Port. The Baud Rate should be set to 19200. The Port can be left as defaults (to 33333).
- Clicking Finish completes the instrument setup.

You can now assign the Scil Vet ABC to the Instrument Types tab for the appropriate AVImark treatment in the Change Treatment window, Laboratory tab, Instrument Types subtab.

**Use**

Importing test results can be accomplished through use of the Instrument Import utility. The utility is much the same as in previous AVImark versions.

- The utility can be found by accessing Services, Run Instrument Import.
- This utility is now set up to automatically start when AVImark starts, and has the option to Close on AVImark Shutdown.
- When AVImark opens you will see the “shaking hands” icon located in the System Tray of your workstation. This indicates that AVImark is in communication with the instrument(s) assigned to communication ports on this computer, and is “listening” on each port for any incoming data.
- The options to Start when AVImark opens, and Close on AVImark Shutdown can be controlled by right click options on the icon in the System Tray.

**Important NOTE:** If you have de-selected the Close on AVImark Shutdown option, please note you will need to manually close the connection utility prior to index rebuilding or any other maintenance utility that requires exclusive access to AVImark files.

When a treatment with an instrument assignment is entered into Medical History for a patient, AVImark will start listening to the ports in which the associated instruments are assigned for results. As results are ready to be transmitted, AVImark will import the results to the proper Medical History entry. If the proper Medical History
cannot be located, the results will be sent to the “Test Inbox” to await manual import.

- First, the import utility looks for a patient with a record number that matches the “Patient ID” field received from the instrument.
  - The Patient ID that is being searched for a match is the AVImark Patient ID.
  - When running the test on the designated analyzer, and prompted for a patient identifier, the AVImark Patient ID is the number that will allow the utility to make the proper patient association for automatic result import.
  - If this is successful, then the recent medical history of that patient is searched for a recorded treatment that is set to store results from the instrument.

- Once the patient identifier is located on the incoming results, the utility will begin searching for a Medical History entry for that patient that is awaiting results.

- When that Medical History entry is located, the results will be automatically imported into the Tests Attachment area.

- If the Patient ID doesn’t match or exist or there is no matching Medical History entry on that patient awaiting results, the test results are placed in the “Test Inbox.”

- To manually import the results that were sent to the Test Inbox, simply highlight the Medical History entry you wish to import results for, select the Tests attachment, Import From, Test Inbox. Here you will be presented with a list of results that were transmitted from instruments that did not find the Medical History entry to complete the automatic import. Select the set of results you wish to import to this history entry, and click Done.

- When you “Import from” the Test Inbox, the record is actually moved from the Test Inbox onto that Medical History entry. This will allow the Test Inbox to only contain results that have not been imported to Medical History.

- As an additional safety measure to ensure no results are lost, an RX$ file is also created with the transmitted results. This RX$ file is sent to the user defined Instruments storage folder. This path to this storage folder will need to be set in Advanced Options. Select the “Save Lab Instrument results To” entry and assign the path to your storage folder. If you are currently using AVImark to retrieve your results, you likely already have this in place.

  - Results can be imported from this location if needed by opening the Tests attachment, select Import From, Stored Tests. This will display all stored RX$ files on the left pane. You can select the RX$ file that holds your test, move to the right pane, select the test, right-click Import Test.

  - In the case of an emergency, where access to results is immediately needed, right click on the treatment in Medical History that has the lab instrument association that represents the test instrument being used, and select Import Results. This will open the Associated Instruments window displaying a list of associated instruments for this treatment. Place a check in the box that represents the instrument from you wish to receive results, click the Import Results button, and AVImark will begin listening to these ports. As the data is sent from the instrument via the port, AVImark will capture and place it immediately in the Test Results window. After the results are received, the Import Results window will disappear, and you can view the results by selecting the Tests attachment option for that Medical History entry.

**Important NOTE: To alleviate the chance of sending results automatically to the wrong Medical History record that may also meet the requirements for automatic import selection we have incorporated a two day time frame to use for searching, then selecting the oldest entry in that time frame for which these results would apply, to make the result attachment. To summarize, the utility will look for that patient record, then start at the farthest date/time as dictated by the two day time frame, and apply it to the first one it finds....versus starting with the most recent and looking back.
CHAPTER 34: AVIMARK SITE SUPPORT

Site support is designed for hospitals with more than one location (satellite/remote hospitals) yet want a centralized database. Each location shares the same database of clients while having the opportunity to maintain their own unique Treatment, Inventory List, Appointments and Reporting. To do this, AVImark lets you assign what is called a “site number” to each of your Medical History and Accounting records, Treatment and Inventory lists including purchase orders, appointments and block-offs, as well as hospital staff. To use AVImark Site support, you will need to purchase a copy of AVImark for each central and satellite locations.

In this chapter you will learn about...

- Set up Site Support on page 401
- Set up Users and Security on page 401
- Work with Site Manager on page 402
- Choose a Treatment and Inventory List on page 403
- Change Site Options on page 404

Set up Site Support

In order to take advantage of the site feature in AVImark, there are some hardware/software requirements which must be met. A remote connection must be established between satellite clinics and the home office. This is most commonly accomplished by using the Terminal Services feature of Microsoft Windows® 2000 Server or Microsoft Windows® Server 2003 Standard, Enterprise, or DataCenter Editions. Once the necessary connections have been established, you will need to obtain a copy of a site file from us. This file contains the encrypted names and addresses of the businesses which will be using AVImark. For assistance in obtaining and installing the necessary file, contact our Technical Support at 877-838-9273.

Central hospital requirements:

From the central hospital you must have Windows® 2000 Server Edition or Windows® 2003 Server Standard, Enterprise, or DataCenter Edition on a dedicated server. In addition, Windows® Terminal Services “Server” software must be installed on the server computer.

Satellite hospital requirements:

At the satellite locations, each will require Windows® 98se, Windows® 2000 Professional, or Windows® XP Professional. Also, each workstation at the satellite hospitals will require Terminal Services “Client” software and a broadband/high speed, internet connection installed.

To learn more about: Search the Help for:
Hardware/Software Requirements Table of Contents – Site Support

Set up Users and Security

Prior to using the AVImark Site feature, there are some necessary settings which will need to be made in Users and Security. AVImark will need to identify you as a Hospital Administrator. There are a few security functions which will need to be set in order to do this. In addition, all employees from all locations will need to be added into Users and Security.

Specifying Site Location

For staff members who work at multiple sites you will want to specify the locations they are associated with.

- On the CID, open the Work with menu. Click Users and Security to display the Security Maintenance window.
  - Select the appropriate user category.
  - Highlight the staff member name and from the right-click shortcut menu select Locations.
The main clinic or site will automatically be listed. If necessary remove this site by selecting Remove from the right-click shortcut menu.

To specify the site(s) the user works at select right-click New from the shortcut menu.

Use the Site drop-down list to select the location the user works at.

Click Ok.

Security Functions
- On the CID, open the Work with menu. Click Users and Security to display the Security Maintenance window.
- Select Hospital Administrators from the Category section to display a list of Administrators in the User for section.
- In the Authorized Functions area, right-click and from the shortcut menu click Choose to display the User Function window.
- Select System Administration from the Category section.
- In the AVImark functions for section, select the function, ADM01-Administer AVImark (System-wide Authority).
- Right-click and from the shortcut menu click Select, or use the SPACEBAR to choose the function and place in the Selected area.
- Choose the functions, ADM02-Work With Users and Security, and ADM03-Authorize AVImark Functions to Users in the same manner and click Done.
- Select your name from the Users for section. Right-click and from the shortcut menu click Change to display the Change User window.
- In the Password field, type a Password.
- Use the Site drop-down list and select the appropriate hospital.

Work with Site Manager
Once the site file has been copied into the AVImark folder on your server computer, and the basic security described above has been set up, the next thing you will need to do is use the AVImark Site Manager to complete the information about the satellite hospitals or businesses listed there.

- On the CID, open the Work with menu. Click Hospital Setup to display the Hospital Setup window.
- Click Site Manager at the bottom of the window to display the AVImark Site Manager.

```
<table>
<thead>
<tr>
<th>Site</th>
<th>Name</th>
<th>Address</th>
<th>City</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Clearwater Boarding &amp; Kennels</td>
<td>124 Main St</td>
<td>Pleasanton</td>
<td>1-877-555-2013</td>
</tr>
<tr>
<td>2</td>
<td>Grooming Salon</td>
<td>Rt. 1 Box 1025</td>
<td>Pleasanton</td>
<td>1-877-555-9274</td>
</tr>
</tbody>
</table>
```

- Double left-click the hospital name you wish to work with to display the Change Site window.
• If appropriate, use the Slogan field and type a Slogan for the location you are working with.

Choose a Treatment and Inventory List
It is from the AVImark Site Manager where you will decide whether or not to share the same Treatment and Inventory List or have separate lists.

Use a common list(s)
Certain central hospital/satellite arrangements will want to use a common treatment list so that pricing, discounting, and client education documents may be standardized throughout the group of hospitals. Using this setup option, all of the hospitals will be using a common Treatment/Inventory List and changes made at one location will be instantly reflected at all locations.

• Choose the Same as option and use the drop-down list to select the central hospital’s name.
• Click Done.

Modify a common list(s)
There will be certain central/satellite arrangements that will want to begin with a common Treatment List, but allow the satellite office(s) to make appropriate changes that are unique. Using this setup option, all of the hospitals will be using a treatment list that has a common origin and format (possibly common codes and descriptions) but that will be unique in other appropriate ways.

• Choose the Copied from... option and use the drop-down list to select the central hospital’s name.
• Click Copy Now to copy the central hospital’s list with the ability to make any necessary changes.
• After the copy process is complete, click Done.

Use a completely unique list(s)
In other cases, each satellite location will have its own unique Treatment/Inventory List and will therefore want to “start from scratch”. In this case, there would be very little, if any, commonality between the Treatment/Inventory Lists of the central location and satellite office(s).

• For a given satellite location, choose the Copied from... option.
• Use the drop-down list and select the satellite hospital’s name.
• Click Done to erase the list(s).
Change Site Options
From the AVImark Site Manager window you will also make the decision whether to use separate Rabies Tag numbers, synchronize company numbers with particular site numbers, and whether to keep the Appointment Calendar separate by site.

- From the AVImark Site Manager window select the Options tab.

Separate tag numbers
By placing a tag number that is unique to this particular site you will be allowed separate tag numbers for each site. You will need to repeat this step for each site in your site manager.

- Type the tag number to start with for the given satellite location.

Synchronize company numbers
When the Refresh option is clicked before running statements AVImark will look at the clients’ latest accounting transaction and change their company number to match. AVImark can keep track of which site each transaction was performed at but cannot run statements by site, only by company number. Before running statements, each site needs to be set up in the Company Table within System Tables. Company 1 will represent the home or central hospital; company 2 will represent site 1 and so on. If you choose you may click the refresh button before running statements to update the company number.

- If appropriate, select Synchronize company number with site number.
- Click Refresh.

Separate Appointment Calendar
You may choose to view the appointments for only the site you are logged in to or you may view appointments for all sites. With this option checked you will see only the appointments for the site you are logged in to; unchecked you will view all sites appointments.

- If appropriate, select Separate appointment calendar by site.
- Click Done when finished.
<table>
<thead>
<tr>
<th>To learn more about:</th>
<th>Search the Help for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Site Treatments &amp; Inventory</td>
<td>Table of Contents – Site Support</td>
</tr>
<tr>
<td>Site Reports</td>
<td></td>
</tr>
<tr>
<td>Site Appointments</td>
<td></td>
</tr>
<tr>
<td>Site Statements</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 35: PRACTICE ANALYSIS

The AVImark “Practice Analysis” feature provides you with the option of viewing and printing reports and graphs to help better manage your business. Each graph and report will have different restriction options available.

In this chapter you will learn about...

» Use the Different Reports on page 407
» Work with Graphs on page 408
» Print, Save, Export, and/or Email Reports on page 409

• On the CID, open the Work with menu. Click Practice Analysis to display the Practice Analysis window.

Use the Different Reports
The reports that are available may be restricted by Doctor, Species, Zip Code, and/or Company. Each report will have different restriction options available. AVImark lets the user know which restriction options are available by graying out the options not applicable to the selected report.

• On the Practice Analysis window, select the Reports tab.

• Choose the appropriate report.

• Using the Period drop-down list or the Start and End drop-down calendars, select the correct period to report.

• If appropriate, select the restriction options you wish.
Top 50 clients for last 12 months
This report will list the top 50 clients with the most charges for the last 12 months. This report will include account numbers, client names, balance due, and number of visits for the last 12 months, as well as payments and charges. In addition, AVImark gives you the ability to export the Top 50 Clients information to Purchasing Services Inc. (PSI). With the Top 50 Clients report selected, the Pet Quarterly button will be visible.

- If appropriate, click Pet Quarterly to export the information to your hard drive or to email directly to PSI.

When exporting to PSI, the clients’ balances and payment totals will not be included in the exported information. However, the client’s mailing address will be included.

Top 50 Treatments Performed
This report lists the income produced from your top 50 services.

Top 50 Items Sold
This report shows the income from your top 50 items with the profit from each (retail price minus average cost). This report will not include the charges for late fees and adjustments.

Client Retention
This report shows the number of active clients at the beginning and end of a selected period, plus the number of new clients added during this time frame. It also shows the number and percentage of clients counted as lost during the selected time frame, along with the percentage of clients retained. When selecting a time frame, you will specify a date in the “Invoices After” field to determine what period you would like to define active clients. When setting the “Invoices After” date, make certain the date is a prior to the specified Start date. If it is not, the report will not be able to determine the number of active clients at the beginning of the period.

Months to Compare Considerations
When using the “Months to Compare” option, make certain that the selected “Period” is not set to greater than a month. The “Months to Compare” option will only be able to accurately compare the current information to past information if the “Period” is set to a month or less than a month. If the “Period” is set to a week and the “Months to Compare” is set to 3, the “Period” will be compared to that time frame on the selected number of months. For example: Period is set to June 3rd through June 10th; Months to Compare is set to 3. April 3rd to the 10th and May 3rd to the 10th will be compared to June 3rd to the 10th.

Years to Compare Considerations
When using the “Years to Compare option”, the “Period” may be set to more than a year. The “Years to Compare” option is able to compare the results of the “Period” to the same “Period” for the selected number of years. For example: Period is set to January 1, 2008 through June 30, 2009 will be compared to January 1, 2007 through June 30, 2008 and January 1, 2006 through June 30, 2007.

To learn more about:  Search the Help for:
Different Reports (Examples)  Practice Analysis – Reports Tab

Work with Graphs
Graphs may be printed using either Excel® or AVImark. This option may be set from Hospital Setup, Advanced Options. When graphing through AVImark you can easily change the style of the graph to Line, Bar or Area by choosing the “Style” in the bottom right hand corner of the graph. You may use only one ‘Organize By’ option at a time when running graphs. After selecting the graph, and the “Organize By” option the user can choose to restrict the graph to specific Doctor, Species, Age, Zip Code, and/or Company.

- On the Practice Analysis window, select the Graphs tab.
- Choose the appropriate graph.
Using the **Period** drop-down list or the **Start** and **End** drop-down calendars, select the correct period to graph.

In the **Organize By** area, select how you wish to organize the graph.

If appropriate, select the restriction options you wish.

Click **Run** to display the graph onscreen.

Use the **Graph** drop-down list to specify how you wish to display the graph.

Use the **Style** drop-down list and select either **Line**, **Bar** or **Area**.

Use the **Print to** drop-down list and select the correct **Printer**. Click **Print**.

**Clients**

This graph will generate a list of new clients added during the period selected and may be restricted by Zip Code and/or Company. Clients listed on this report are not required to have accounting. This report is looking strictly at the client’s added date.

**Patients**

This graph will generate a list of new patients added during the period selected and may be restricted by Species, Zip Code, and/or Company. This graph will also allow you to report total number of patients.

**Income**

This graph will generate totals of income collected during the selected period and may be run by Zip Code, Doctor, Species, or Company. All four graphs may be restricted by Doctor, Species, Zip Code, and/or Company.

**Visits**

This graph will generate the total number of visits during the period selected and may be run by Zip Code, Doctor, Species, or Age. All four graphs have no further restrictions.

**Total Charges**

This graph will generate total charges during the period selected and may be run by Zip Code, Doctor, Species, or Company. All four graphs may be restricted by Doctor and/or Species.

**Total Payments**

This graph will generate total payments during the period selected and may be run by Zip Code, Doctor, Species, or Company. All four graphs may be restricted by Doctor and/or Species.

**Print, Save, Export, and/or Email Reports**

After selecting the appropriate report, AVImark gives you the ability to Print, Save, Export, and/or Email the report.

**Print the report**

- Choose the correct report along with the appropriate period and/or restrictions.
- Use the **Print To** drop-down list and select the correct **Printer**.
- Click **Run**. To display the report onscreen, click **Preview** and click **Run**.

**Save the report**

- Preview **Print** the report to display the Report Preview window.
On the File menu, click Save As to save to the desired location.

Export to Excel®
- Use the Print To drop-down list and select Excel®.
- Click Run to display the report in Excel format.

Email the report
- Preview Print the report to display the Report Preview window.
- On the File menu, click Email to display the Send e-mail window.
- Enter the Email address, desired Subject and Text and click Send
CHAPTER 36: DENTAL CHART

The AVImark Dental Chart feature provides you with the ability to have easy access to a patient’s dental records. It also allows for viewing past dental records, recording probing depths and gingival recession as well as the ability to print the records. When a Dental Chart is created for a patient the appropriate canine or feline chart will be displayed. Currently, only canine and feline charts are available.

In this chapter you will learn about...

» Working with the Dental Chart on page 411
» Record Probing Depths on page 413
» Record Gingival Recession on page 413
» View Previous Dental Charts on page 414
» Work with Annotations on page 414
» Create Dental Abnormalities on page 415
» Print the Dental Chart on page 416
» AFP® Imaging on page 416

Working with the Dental Chart
A Dental Chart can be associated to any entry in a patient’s Medical History.

Creating a Dental Chart
- Highlight the desired entry in Medical History and select the Dental Chart attachment option.
- Press the Tab key to scroll from tooth to tooth and record probing depths, gingival recession and add annotations.
- Click OK to save the chart.

Viewing the Dental Chart
Viewing a chart, you will see the four quadrants as well as the four dental views: Buccal, Occlusal, Palatal, and Lingual. Above the upper quadrants and below the lower quadrants are boxes for recording the probing
depth of each tooth. Pressing the Tab key will begin scrolling from tooth to tooth. When a tooth is selected, its Triadan number will be displayed and the probing depth value will be highlighted for entry.

The View menu option contains several functions for displaying the chart and the linked drawings and abnormalities.

- From the View menu option in the Dental Chart select Zoom In to zoom in on the chart.
- Located under the View menu use the Zoom Out option to zoom out on the chart.
- Selecting Normal Zoom from the View menu returns the chart to its normal viewing display if the chart has been zoomed in or out.
- The option Current History Only, under the View menu, allows only those drawings or abnormalities that are linked to the current history entry to be displayed.

**Setting Entry Order**
Tabbing from tooth to tooth will move from right to left and quadrant to quadrant. The tabbing order of quadrants is defaulted to Upper Right, Upper Left, Bottom Right and Bottom Left. The tabbing order can be customized.

- From the menu option select Assessment, Entry Order.
- Select a quadrant number and use the up and down arrows to move the quadrant to the desired order.
- Use the Direction List to modify the right-to-left tabbing order.

**Tooth Selection**
A specific tooth can also be selected by using its Triadan number. When selecting a tooth its Triadan number will be displayed.

- From the menu option select Assessment, Tooth Selection.
- Enter the appropriate Triadan number and select Ok.
- AVImark will select the specified tooth.

**Saving the Dental Chart**
Once all drawings and abnormalities have been added to a chart, all of these changes can be saved.

- Click OK on the chart to save changes.
- Or from the File menu select File, Save.

**Deleting a Dental Chart**
Removing a Dental Chart from a medical history entry will only remove the drawings or abnormalities that
were saved to the history entry selected. Additions made to charts that have been saved to other Medical History entries will remain in tact.

- From the File menu select **Delete** in order to delete the selected Dental Chart.

### Record Probing Depths

A probing depth value can be recorded for one side of the tooth or for all four sides. For the upper quadrants the value will be displayed in the box directly above the tooth and for the lower quadrants directly below the tooth.

When a tooth is selected, the Occlusal view of the tooth will display a selection point on each side of the tooth. These points allow a side of the tooth to be selected in order to record the probing depth for that side.

- Highlight the desired tooth and select the desired side by clicking on the point.
- In the value box enter the recorded probing depth value.
- You can also **right-click** and from the shortcut menu select **Tooth Side** to choose the side for which you wish to record a value.
- Once a value has been entered the box will be displayed in red indicating a value has been recorded.
- Click **OK** to save the values entered.

### Record Gingival Recession

The gingival recession can be recorded for one side of the tooth or for all four sides. The value will be displayed in a box above or below the tooth.

Before recording the gingival recession you must be in the appropriate view.

- From the Dental Chart menu select **Assessment, Gingival Recession**.
- The probing depth values will be replaced by recession value boxes.
- Highlight the desired tooth and select the desired side by clicking on the appropriate point.
- In the value box enter the recorded gingival recession value.
- Once a value has been entered the box will be displayed in red indicating a value has been recorded.
- You can also **right-click** and from the shortcut menu select **Tooth Side** to choose the side for which you wish to record a value.
- Click **OK** to save the values entered.
View Previous Dental Charts
With each new dental chart created, all procedures, images and notations that have been added to previous charts for the selected patient will be displayed on the new chart. The entire dental history of a patient will be defaulted to each new chart that is created so all past procedures, images and notations can be modified or added with each new chart.

- To view the current dental history for the selected entry, choose View, Current History Only from the Dental Chart menu.

From the Dental Chart you can view dental records from previous charts.
- Click on the History drop-down list and select a date.
- The dental record with the annotations made on that record will be displayed.
- Under the History date the Code and Description of the entry the chart is linked to will also be displayed.

Work with Annotations
To the left of the Dental Chart is the Toolbar which contains a list of tools and functions that can be used for desired record keeping. This toolbar contains two groups of procedures and functions, General and Abnormalities. When these functions are drawn on a chart they will be saved to the selected Medical History entry, displayed on the current chart and included on future charts.

Once several drawings or annotations have been made on different charts it may be hard to determine when the annotation was made. To identify when the annotation was made select the annotation and in the Added On area of the chart AVImark will display the date it was made and the code and description of the medical history entry that entry is associated with.

Working with the Toolbar
This toolbar can be anchored, left floating or closed completely.

- Select the pushpin icon to cause the toolbar to always be displayed or anchor the toolbar.
- Leaving the toolbar floating will allow it to disappear when not selected and reappear when the Toolbox button is selected.
- Selecting the X on the toolbar will cause it to close completely. To redisplay the toolbar select View, Toolbox from the Dental Chart menu.

Drawing an Annotation
- From the General toolbar select an annotation (i.e. ellipse).
- Over the desired tooth hold down the left mouse key and drag the annotation to the desired size to create the drawing.
- Once the annotation has been made you can then move or resize the drawing.
- Continue to create as many notations as desired.

Deleting an Annotation
- Click on the appropriate annotation. The sides of the annotation should be highlighted.
- Right-click and from the shortcut menu select Delete Annotation.

Text Annotation
- From the General toolbar select the Text annotation.
- On the appropriate tooth hold down the left mouse key and drag the annotation to create a text box.
• Click in the text box and type the appropriate notes.
• **Right-click** and from the shortcut menu select **Font** to change the size, color and style.

**Image Annotation**
Selecting this function will access a browse window allowing a photo of any type that is saved anywhere on your network to be accessed and stored on the Dental Chart.

• From the General toolbar select the **Image** annotation.
• In the Open window locate the desired photo and click **Open**.
• The photo will be displayed in the **Images** section.
• Left click on the image and in the Dental Chart hold down the left mouse key over the desired tooth and drag the box to the desired size.
• The image will then be displayed on the chart where you then have the ability to move or resize the image.

**Create Dental Abnormalities**
The Abnormalities toolbar contains a list of common dental procedures and problems such as; bridge, missing tooth, extraction, root canal, etc. All of these abnormalities are part of a default list but this list can be completely customized to suit what your clinic needs.

**Drawing an Abnormality**
• Click on the **Abnormalities** toolbar and select an annotation (i.e. Bridge).
• Over the desired tooth hold down the left mouse key and drag the annotation to the desired size to create the drawing.
• Once the annotation has been made you can then move or resize the drawing.
• Continue to create as many notations as desired.

**Creating Dental Abnormalities**
All abnormalities are maintained in the Problem List in the Dental Abnormalities category. Abnormalities can be modified or added from this list. Once a new user defined abnormality is created it will automatically appear on the Dental Chart Abnormalities toolbar.

• From the CID menu select **Work with, Problem List**.
• Select the **Dental Abnormalities** category to modify the pre-defined abnormalities or to create new ones.
• From the shortcut menu select **right-click New** to create a new abnormality.
• Enter a Code, Description and any other necessary information and click **OK**.

• To set the values for this abnormality select **right-click Dental Properties** from the shortcut menu.

• In the Change Problem Extra window check the option **Include on Dental** to cause the abnormality appear on the Dental Chart toolbar.

• Select the **Dental Icon** drop-down list to choose an icon for this abnormality. Selecting the **Custom** option will allow any image file to be selected as an icon for this abnormality.

• The **Dental Annotation** option will determine the type of drawing or annotation that will represent the abnormality. The **Image annotation** will display a new field, Dental Image, which allows a photo to be selected. This will cause the image associated with this annotation to appear when this annotation is used for the Dental Chart. This image must be stored within the Dental folder.

• Use the **Dental Pen Color** to select the desired color for the drawing. This only applies to the ellipse, line, polyline and rectangle.

• Selecting the **Dental Fill** checkbox allows you to select a fill color for the ellipse or rectangle.

• To choose a fill pattern for the ellipse or rectangle select the **Dental Fill Style**.

• Use the **Dental Shortcut Key** option to create a user defined shortcut key for this abnormality.

Once several drawings or annotations have been made on different charts it may be hard to determine when the annotation was made. To identify when the annotation was made select the annotation and in the **Added On** area of the chart AVImark will display the date it was made and the code and description of the medical history entry that entry is associated with.

### Print the Dental Chart

There are two printing methods in the Dental Chart.

**Dental Chart Report**
The Dental Chart report will print the chart just as it is displayed, with all drawings and abnormalities, but the probing or gingival recession values will not be included.

• In the Dental Chart select the **File, Print** menu option.

• Choose the desired printer and select **Print**.

• To view the report before printing select **Preview**.

**Progress Report**
The Progress Report will print two reports, one will be from the currently selected Dental Chart and the other will be the chart that is immediately prior to the selected chart. The report of the currently displayed Dental Chart will print as the After and the report of the chart immediately prior will print as the Before.

• From the Dental Chart **Assessment** menu select **Progress Report**

• Choose the desired printer and select **Print**.

• To view the report before printing select **Preview**.

### AFP® Imaging

AVImark integrates with AFP® Imaging, a digital radiographic system that is very common in veterinary
dentistry. Hospitals using ImageWorks equipment can launch the ProImage® software directly through AVImark Dental Chart to view images within the ProImage® software.

Setting up AVImark with ProImage.exe
In order to utilize this integration, you will need to indicate where the ProImage® software is installed on your computer.

- Go to the Options Maintenance window.
- Locate the advanced option in the Lab Instruments category called AFP.
- Inside this category select the option called Application Path.
- Enter the path to where the ProImage® executable file is stored.

Using the ProImage® software
- Once the path is set correctly there will be a new Menu group named Pro Image® in the Dental Chart.
- Clicking this will reveal three menu items: Camera, Image Processing, and X-Ray.
- Selecting any of these three will launch the ProImage® software in that specified area. If this menu does not exist the ProImage.exe cannot be found at the path specified in advanced options.
- ProImage® will open to the patient you are creating the dental chart for in AVImark if that patient also exists within ProImage®. If the patient does not exist in the ProImage® database it will add them.
- If a patient that exists in ProImage® is deleted from AVImark the patient can also be removed from ProImage® by manually finding them then deleting. To delete the patient you will have to manually find them in ProImage® and then select the Delete Patient option.
CHAPTER 37: DIGITAL RADIOGRAPHY

Digital radiography is a form of x-ray imaging, where digital x-ray sensors are used instead of traditional photographic film. Advantages include time efficiency through bypassing chemical processing and the ability to digitally transfer and enhance images. Also less radiation can be used to produce an image of similar contrast to conventional radiography.

AVImark currently integrates seamlessly with several outside PACS systems.

In this chapter you will learn about...

CONTENTS

» DragonflyPACS® on page 419
» IDEXX® InterLink Technology for DICOM Imaging on page 427
» Radiographs Medical History View Tab on page 432
» Sound-Eklin™ DICOM Integration on page 434

DragonflyPACS®

DragonflyPACS is integrated with AVImark veterinary software, allowing veterinarians to request, receive, view, and store images within AVImark’s Client Information Display (CID), while automatically capturing charges and passing them on to clients.

Dragonfly is a DICOM 3.2 compliant DICOM PACS Server/Worklist/Viewer bundle developed by O&R Technology (http://www.or-technology.com/) and distributed exclusively for NA veterinary purposes by McAllister Software Systems, LLC.

Dragonfly (dicomPACS® 5) is in conformance with the Digital Imaging and Communications in Medicine standard (DICOM) and is conformant with the recommended format as described in PS 3.2 of the DICOM standard (Digital Imaging and Communications in Medicine (DICOM), NEMA PS 3.1-15, 2000.).

DragonflyPACS® Hardware Requirements (Minimum)

The Dragonfly database will work on 32 and 64 bit platforms. Server requirements should take into consideration Microsoft SQL requirements.

Workstation Requirements

• Processor: Intel Core Duo/Core 2 Duo or comparable AMD Dual Core Processor with more than 2 GH. The application will benefit from four or multi-core-processors.
• RAM: minimum 1GB RAM for the dicomPACS Viewer.
• For diagnostic and slices: 2GB RAM for the dicomPACS® Viewer.
• Hard Disk: 80 GB hard disk min.
• CD/DVD drive (if burning a CD)
• Network Card: 100 MB
• Graphics card: Resolution of at least 1,280 x 1,024 pixels in the True Color mode; For diagnosing special graphics cards must be used, depending on the resolution of the diagnosis monitor.

AVImark Setup for DragonflyPACS®

Advanced Options

Launch Advanced Options window by selecting the wrench icon of the AVImark CID and begin typing “dragonfly” in the Search field.
Active - Setting to True will activate feature when appropriate licensing is present.

Computer GUID to Monitor Dragonfly PACS Request Status - Will be set automatically by using the “Set Dragonfly Watch Computer” menu found in the Utilities menu. More information below.

Dragonfly Local PACS Program Path - Will default to being assigned with typical setting: c:\dicom PACS.

Dragonfly Network PACS Program Path - Will default to being assigned with typical setting: N:\dicomPACS.

Dragonfly PACS Imported Shots Treatment Code - AVImark treatment code used when importing previously “Archived” images. The AVImark code assigned to this entry cannot contain any pre-defined DICOM entries, and should be set up in your AVImark Treatment List.

Dragonfly Miscellaneous Shot Treatment Code - This code will be used for instances where there were more images captured than originally requested. This code will be added to the Medical History with a quantity reflecting the number of additional images and should be set up in your AVImark Treatment List.

Dragonfly PACS Server - This will be the path to your Dragonfly PACS server. This should typically be an IP address and program path. For example: 123.45.6.78\dicomPACS

If writing to a CD, Dragonfly requires that the software program Nero (version 8 or above) is installed on the workstation.

Location of BDT2Pacs.exe File - Typically c:\BDT

Minutes Between Status Checks - Defines the number of minutes between status checks performed by the Dragonfly Watch Computer.

SQL Database - should typically be AVImark

Wait Seconds After Starting Up Dragonfly PACS - If a command requiring Dragonfly is issued, and Dragonfly is not running, it will be launched automatically. It usually takes a few seconds or more for Dragonfly to load. This is the number of seconds to wait before continuing with the request (if we had to start Dragonfly).

Modality Setup
From the AVImark CID, select Work With, DICOM Modalities to open the DICOM Modalities area where you can begin setting up your modality lists. In the left pane, you will see a list of current DICOM modality types. Additional modality types can be added manually if desired.
• To add a Modality select the appropriate Modality category from the left pane.

• Navigate to the right pane, and add a new modality by right-clicking and select New or F2 New.

• You will be presented with the Enter DICOM Modality window with three tabs.
  - **Modality Tab**
    - **AE Title (Application Entity)** – The value found in the Modality AE Title (SCU) field.
    - **Description** – User defined description for reference.
    - **Ini Section** – This is a uniquely named section to store description information within a configuration file for reference only.
    - **Type Code** – Represents the Modality Type.
  
  - **Plan Codes Tab**
    - Using F2, right click and select New, or the Add button, begin adding the valid plan codes this modality is configured to support.
    - You should enter the Code and a Shot Description. This should match the information available in the modality.
    - We have incorporated the ability to import a Plan Code list, if one is provided with your modality. To use this import feature, the Plan Code list must be an ASCII Tab delimited file containing two columns (plan code and plan description).
    - Right-click in the Plan tab, select Import Codes from File, select the desired list file to import your plan code list file.
  
  - **Notes Tab**
    - A Notes tab has been provided to enter any general purpose information related to this modality.

Saving this entry will create a section for this modality in the BDT2PACS.ini file. To update your DT2PACS.
ini file after any additions or modifications to your Modality List, select Write to the BDT2PACS Configuration File. From the DICOM Modality Maintenance window, select Edit > Rewrite the BDT2PACS Configuration File.

**AVImark Treatment Setup**

Designated AVImark treatments will need to be set up to generate shot requests. You can create new treatments, or add DICOM request information to existing treatments.

- Open either a New or Change Treatment window.
- Select the Laboratory tab, then Radiograph subtab.
- Open the new Radiography window by right-click New, or F2.
- Select Dragonfly from the Radiograph Source drop down.
- Select the AE Title by using the ellipses.
- Once the AE Title has been set, you will be presented with the list of choices for Shot Descriptions; this is based on the list of Plan Codes you have entered for this Modality.
- When the Shot Description has been selected, the corresponding Plan Code will automatically be entered.

**Note:** If you change your AE Title, the Shot Description and Plan Code will be removed, as they will no longer be valid. A new Shot Description and Plan Code should be selected if the AE Title has changed.

As mentioned in the Advanced Option Setup section of this document, you should also have Miscellaneous Shot Treatment and an Imported Shot Treatment codes created. It is important that neither of these treatments have Dragonfly Shot Requests associated.
Creating Radiograph Requests from AVImark

Generating a request from AVImark can be accomplished in multiple ways. Adding a treatment with associated Dragonfly requests directly to Medical History is the most common method for submitting a shot request.

- Right-clicking in the Patient Area, and selecting Radiography, Create Request will display a selection screen displaying all AVImark treatments with associated DICOM requests.
- To make your selection(s) from this window, highlight the desired entry, and press the Spacebar to place the highlighted entries in the Selected area found in the lower pane of the window.

- Choose the appropriate doctor, then click OK. This will create a Medical History entry for each selection made.
- By creating the Medical History entries, shot requests are automatically created in Dragonfly PACS using the associated plan codes for the designated modalities.
- Highlighting an AVImark Medical History entry with associated shot requests will display the Radiograph checkbox in the Attachments pane in red with a check. This bright red color indicates there is a pending shot request.
- When the shot request is completed by the modality and updated in the Dragonfly PACS system, the Radiograph attachment will become maroon in color, indicating images are available for viewing.

Completed Shot Requests

AVImark will query Dragonfly for any requests that have been completed, but not yet updated in AVImark. When found, the appropriate association is made and the entry will be automatically updated indicating the status is complete and add information to the files to allow viewing and all other DICOM related functions.

If more images were taken for a request than were initially ordered, the user is notified, and an entry for the miscellaneous shots (Using the Miscellaneous Shot Treatment Code as defined in Advanced Options) is added.
to the patient’s Medical History. The quantity of this entry reflects the difference between the number of shots initially ordered and the actual number of images captured with this request.

The “Check for Completed Results” can be automated. This automation will allow a designated AVImark workstation to poll on a regular basis for completed requests and automatically update Medical History with the captured shot information.

- To initiate the automation, you will want to select an AVImark workstation that will have AVImark running during all business hours.
- From the AVImark CID on the chosen workstation, select Utilities > Set Dragonfly Watch Computer. You will be asked to confirm your designation. It is important to remember that only one AVImark workstation can be set as the “watch” computer at a time.
- If you currently have a computer set as the “watch” computer, and you set another to be the “watch”, the newly selected workstation will override the previously assigned computer.

**Viewing Images and Checking Request Status**
You can view the status of any shot request, view shots taken, as well as manage shot status from within the same area.

- To access images, click the Radiographs attachment.
- You will be presented with the details of the Radiography Requests for this Medical History entry, such as Status, number of Ordered Shots, and number of Taken Shots.

- Right click on a completed request to see the following options:
  - **View Images**
  - **Send To Web** - Allows you to post images on a Dragonfly PACS Web Server. Within the scope of the images selected from the menu option, you will be able to manually exclude any images you wish. You will be asked for email addresses to send to the individuals you wish to be able to view these images from the web. The image retention on the web is determined by your Dragonfly PACS Web Server.
  - **Choose from All**
  - **Burn to CD or Folder** – Allows you to designate a CD RW or a thumb drive to burn the images onto. A lightweight Dragonfly DICOM viewer will be included. To burn a CD your computer must have a CD burner and NERO software installed.
  - **Digital Imaging Send** – will allow users to send images from PACS while still in AVImark,
provided PACS is setup to perform the Telemedicine function.

- **E-Mail** – allows you to convert a set of DICOM images to JPEG, BMP or PNG and attach to an email to send. Boilerplate is inserted into the email body, but can be customized by the user before sending.

- **Request Status**
  - Check for Completed Requests will poll the Dragonfly software for completed shot requests.
  - Set Status for Requests to Complete will mark the status of this request as completed. This will need to be done to manually close the request if it has been completed without taking the recommended number of shots.

**Emergency Shot Reconciliation**

In the event there are emergency capture studies (or studies not yet associated to an AVImark patient’s Medical History), you will be provided a way to reconcile those shots with AVImark.

- From the Patient Area of the AVImark CID, right-click, select Radiography, Create Request.
- In the DICOM window, select the appropriate doctor.
- Click on the Dragonfly PACS menu, Reconcile from Emergency List to Current Patient
- You will be presented with a screen containing a list of all currently non-reconciled shots. Upon making your shot selection, a new Medical History entry will be created with the Miscellaneous Shot Treatment Code (as assigned in Advanced Options), and the appropriately linked images.

**Importing Images**

The ability to import jpg images from a disk has also been provided. This feature will allow you to archive your images through Dragonfly, and then import the images into AVImark via an automatically created Medical History entry.

- Right-click in the AVImark Patient Area, select Radiography, Dragonfly JPG/BMP Image Import.
- Dragonfly will open, and the selected patient information should appear in the upper left corner.
- In the lower right pane, you will need to select the Images, In/Out button.
- From the menu that opens, select the Import Images button.
- Browse and select the images you wish to import for this study.
- Once images are selected, press the Import Images button.
- The images can now be archived by selecting the <<Management button found in the lower right pane.
- Select Archive from the opened menu.
- Select the option that best represents the images you would like to archive.
- Verify the proper patient selection. It is possible you may have to select the appropriate client/patient from the list provided in the Patient Data section.
- Make any desired notations or comments to the study from within the Study Data section.
- When image selection and study notations have been made, and patient verified, the Archive button should become available for selection. Press Archive.
- You should notice the client/patient information is no longer displayed in the upper left corner of the Dragonfly window.
- There will be a new entry in the Medical History for that patient with the Dragonfly Imported Shot Treatment Code as designated in Advanced Options.
• Upon the next automatic status update, whether manual or scheduled, the imported image thumbnails for the study will be displayed in the Radiographs window.

**Patient Charts**
DICOM shot information can be reported on the Patient Chart by selecting the new AVImark Patient Chart option DICOM Info, found in the “Include the Following” list of check boxes.

**Reporting**
Right-click in the Patient Area, select Radiography, Print Requests Status List, to generate a Radiograph Request report. The Radiograph Requests window will open. You will be able to select the provider, status, start, and end dates you wish to be reported.
IDEXX® InterLink Technology for DICOM Imaging
AVImark has once again teamed up with IDEXX® to bring our users bi-directional communication. With this feature, you will have the ability to send radiography requests and view study images without leaving AVImark!

Advanced Options
• IDEXX Digital Imaging Active - Set to True

• IDEXX Digital Imaging Miscellaneous Shot Treatment Code – The AVImark treatment you wish to represent additional shot charges. More information below in the section labeled Additional Features > Capturing Additional Shots.

• IDEXX Digital Imaging PACS Timeout – Allows users to increase the PACS Timeout to assign a designated wait time to bypass the default time period.

• IDEXX® Digital Imaging PACS User Password – enter user specific password information used for logging into IDEXX® PACS

**Important Note:** When you set up or modify the IDEXX®-PACS passwords of users in Advanced Options, they will automatically be created or modified in the PACS system as well. Conversely, if you change a password through the PACS system, they will NOT be updated in AVImark. It will then become necessary to also log into AVImark and set this information to match. We always recommend all password maintenance be performed from within AVImark.

Treatment Configuration
You may add Radiography shot requests to any existing treatment or create new treatments for shot requests.

• In the Change Treatment window, select the Laboratory tab.

• Within the Laboratory section, select the Radiographs Tab.

• Right-click, New to add the shot request, and select IDEXX PACS as the Radiograph Source.
• Click the button for the Code field. You will be presented with the IDEXX® Digital Imaging Shot Tree window to make your shot selection.

• Selecting a group of shots is possible by selecting from a higher level on the shot tree, as shown in the example below:

• Selecting Thorax-Routine will add one line to the Radiograph tab of the Treatment, but will request 2 radiographs when the treatment is assigned to a patient (THX – Lat, and THX – VD).

• When you press OK, the entry form will be filled in.

• Click OK to finalize the shot addition to this treatment. You can continue adding shot requests, if desired.

**NOTE:** If a single radiograph shot request is desired, simply drill down to the desired individual shot in the Shot Tree to make your selection.

Although we recommend proper advance setup of IDEXX® Radiograph Code association to your AVImark treatments, and creating shot requests using the pre-defined AVImark Treatments for this feature; we understand there will inevitably be times when it will become necessary to send a generic or unspecified shot request. Pre-defining an AVImark treatment with an Unspecified Shot will allow a user to select the shot(s) from the IDEXX®-PACS Imaging Dashboard.

• In the Change Treatment window, select the Laboratory.

• Right-click, New to add the shot request, and select IDEXX®PACS as the Radiograph Source.
• Click the **Unspecified Shot** button.

• In the Enter Description window you can create the description that best defines your desired use for this treatment.

![Enter Description Window](image)

• When this treatment is selected and added to Medical History, you will be presented with the DICOM Request Instructions window. Enter the number and type of shots to be taken. This information will appear in the IDEXX®-PACS Imaging Dashboard request as well as the DICOM Radiography Request Record.

![Radiography Requests Status](image)

**Important NOTE:** While it is possible to have more than one DICOM Shot Request on an AVImark treatment, it is NOT possible to have more than one DICOM Shot Request on an AVImark treatment that has an Unspecified Shot Request (code 9999) assigned.

**Client and Patient Records**

• When new Clients and Patients are added to AVImark, they will be added to the PACS database as well.

**Please Note:** New clients alone will not be added to the IDEXX® InterLink system. Only new clients that have patients will be automatically added.

• Saving changes to client or patient records in AVImark will automatically update records in the IDEXX® InterLink database.
**Please Note:** Deleting client/patient records automatically is not supported by the IDEXX® InterLink interface at this time.

Creating Radiograph Requests
Creating your InterLink Radiograph Requests from within AVImark can be accomplished in a variety of ways. You can simply add an AVImark treatment containing a radiograph shot assignment into Medical History using any of the many available Medical History addition methods, such as F2, right-click New, right-click Choose, etc. The preferred method is to right-click in the AVImark Patient Area, and select Radiography, Create Request.

- A DICOM window will be displayed with your IDEXX® InterLink associated AVImark treatments.
- Make your treatment selection by highlighting the appropriate treatment; hit the Spacebar or right-click, Select.
- Select your doctor, and press Done.

Your AVImark treatment will be entered into Medical History, and the shot request will be sent to the InterLink software.

Once a shot request has been generated from within AVImark, you will notice the Radiographs option in the Medical History Attachments section will become red, and be marked with a check. This indicates that a shot request has been sent, and is awaiting images.

- When the shots are completed and available for view, you will see the Radiographs Attachment is now brown in color.

Viewing Images and Checking Request Status
You can view the status of any shot request, view shots taken, as well as manage shot status from within the same area.

- To access images, click the Radiographs attachment. You will be presented with the details of the Radiography Requests for this Medical History entry, such as Status, number of Ordered Shots, and number of Taken Shots.

- Right click on a completed request to see the following options:
  - View Images – allows you to either view the selected series or whole study.
  - Burn to CD or Folder - will allow you to burn images to a CD or Folder
  - Digital Imaging Send – will allow users to send images from PACS while still in AVImark, provided PACS is setup to perform the Telemedicine function.
  - E-Mail – allows users to email images from PACS while still in AVImark, provided the E-Mail feature is set up in PACS.

  - Request Status:
    - Check for Completed Requests will poll the InterLink software for completed shot requests.
    - Set Status for Requests to Complete will mark the status of this request as completed. This will need to be done to manually close the request if it has been completed without taking the recommended number of shots.
Additional Features

Reconciling Studies
Occasionally you may need to reconcile a study that was performed in the InterLink software, but not generated by an AVImark request.

This can be accomplished by:

- Right-click in the AVImark Patient area and select Radiography, Create Request.
- You will be presented with the DICOM list containing the radiography request associated AVImark treatments. From this list, right-click on the entry that represents the study, select IDEXX® Digital Imaging, and the appropriate reconciliation option.
- Once you have made your Reconciliation selection, the AVImark treatment is added to Medical History with the study assigned, in both AVImark as well as IDEXX® InterLink, and the status will be marked as Reconciled.

**NOTE:** When using the reconciliation option and selecting an AVImark treatment with multiple shot requests associated, the IDEXX® InterLink shot count will all be assigned to the first entry in the list. When a study is initiated outside AVImark, the shot mapping information is not sufficient to fully align shots to the AVImark “canned” shot requests. This results in all captured shots pulled to this selected treatment, but simply not broken down into separated shot requests for that selected treatment.

- **Capturing Additional Shots** – When shots are taken in addition to the shots requested from an AVImark request, AVImark provides the ability to automatically make additional entries in Medical History. The purpose of this added feature is to allow any additional shots taken to be easily tracked, as well as reducing missed charges.
  - To benefit from this ability, you will need to make sure the IDEXX® Digital Imaging Miscellaneous Shot treatment Code is established in AVImark Advanced Options.
  - Create or locate the AVImark treatment you wish to represent additional shot charges.
  - Open Advanced Options, type IDEXX® in the Search field, select IDEXX® Digital Imaging Miscellaneous Shot treatment Code, press the Change button, and add your AVImark treatment code in the field provided.

- During the shot capture, if it is determined that shots are needed in addition to images requested from within AVImark, simply continue with the shot capture as desired.

- When accessing the Radiographs Attachment for that original Medical History entry, you will be alerted with a message that additional shots were taken.

- An additional entry will be placed in Medical History using the code designated in Advanced Options, with the quantity and amount representing the number of additional shots taken. All images will be associated to the original Medical History entry, including the additional images.
Closing a Request
If a request is completed without taking the number of shots recommended, it will become necessary to close the request manually.

- Select the Radiographs Attachment, right-click on the open request, select Request Status, Set Status for Request to Complete.

- This process will also “complete” the request in the IDEXX® InterLink software.

**NOTE:** The forced closure must be preformed from within AVImark, as there is no way currently to “complete” a request in IDEXX® InterLink software without taking all requested shots. In addition, if you delete a Medical History entry from AVImark containing shot requests for which none of the shots have been taken, the request will be closed and removed from IDEXX® Imaging Dashboard.

Review Status List
You can print or view a list of requests by right-clicking in the Patient Area, selecting Radiography, Print Request Status List.

- The Radiograph Requests print dialogue window will open.
- From this window you are able to select the parameters of the report you wish to generate.

<table>
<thead>
<tr>
<th>Client</th>
<th>Patient</th>
<th>Rq Date</th>
<th>Description</th>
<th>ID</th>
<th>Ordered</th>
<th>Taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cravens, Maria</td>
<td>Zoe</td>
<td>12-14-09</td>
<td>Skull</td>
<td>64</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Cravens, Maria</td>
<td>Toby</td>
<td>12-14-09</td>
<td>Skull</td>
<td>56</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Cravens, Maria</td>
<td>Flota</td>
<td>12-16-09</td>
<td>Skull</td>
<td>66</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Cravens, Maria</td>
<td>Toby</td>
<td>12-18-09</td>
<td>Skull</td>
<td>68</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Dalila, Pamela</td>
<td>Buster</td>
<td>12-30-09</td>
<td>Skull</td>
<td>60</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>Dalila, Pamela</td>
<td>Buster</td>
<td>12-30-09</td>
<td>Dental - Mandible Right OBL</td>
<td>62</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Dalila, Pamela</td>
<td>Buster</td>
<td>12-30-09</td>
<td>Dental - Mandible Right OBL</td>
<td>63</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Dalila, Pamela</td>
<td>Buster</td>
<td>12-31-09</td>
<td>Dental - Mandible Right OBL</td>
<td>64</td>
<td>1</td>
<td>4</td>
</tr>
</tbody>
</table>

Radiographs Medical History View Tab
A Radiographs Medical History View tab is available to allow users to view all Medical History entries that have associated Radiograph shots. Treatments with radiograph assignments in the Change Treatment window will automatically be displayed on the Radiographs History tab when posted to Medical History.
<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Dr.</th>
<th>Type</th>
<th>Code</th>
<th>Description</th>
<th>Qty</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-23-10</td>
<td>3:05p</td>
<td>MKC</td>
<td>S</td>
<td>ABDOMINAL ABDOMINAL STUDY</td>
<td>1</td>
<td>80.00</td>
<td></td>
</tr>
</tbody>
</table>
Sound-Eklin™ DICOM Integration
AVImark is compatible with Sound-Eklin DICOM Imaging. With this new feature, you will be able to send DICOM Imaging requests, as well as view the images by accessing the Sound-Eklin viewer from an AVImark Medical History Entry.

AVImark Advanced Option Setup
- Click on the Advanced Options speed bar button (wrench icon), type DICOM in the Search field, select Sound DICOM and you will see the appropriate fields for entering your Sound information.

- **Computer MAC Address to Monitor Sound Work List Folder** – Will be set automatically by using the “Set Sound Watch Computer” menu found in the Utilities menu when the Sound Digital Imaging Active is set to True. This information is for reference only and we do not recommend manually entering or altering.

- **Sound Digital Imaging Active** – Activates the Sound feature.

- You will need to create two folders. These directories are user defined, and can be created in any shared fully accessible location on your AVImark network. AVImark will need full directory paths set to the appropriate folders.

- **Sound Work List Server In Folder** - receives exported DICOM requests from AVImark automatically Sound Work List Server Watch Folder- folder that alerts AVImark that DICOM Study is ready to be accessed.

AVImark Modality Setup
Modalities for Sound are defined in System Tables. There is a new table necessary and if not present, should be manually created:

**MODALITY (Table Code) – Modality Table (Table Description)** – This table will be used to define all Modality types as well as their location.
AVImark Treatment Setup
To setup the Treatment List to accommodate this interface, you can use an established AVImark Treatment, or create new ones specifically to use for this feature. Each treatment will need to have the Modality assigned.

Attaching a Modality
- Open the Change Treatment window; select the Laboratory tab, then the Radiograph subtab. Right-click and select New to open the Radiography window. Select Sound for your Radiograph Source, select the appropriate Modality, and Study Type.

We have also incorporated the ability to generate an “On Demand” shot request. This will allow users to leave the Modality and Study List Type fields set to (None).

Users will be presented with a drop down list for shot and count selection at the point of Medical History entry.
This completes the setup for the new Sound-Eklin interface; you are now ready to begin assigning treatments to patients.

**Medical History Access**

When a treatment is posted to Medical History with a Sound shot request, an .xml file is generated and sent to the “Sound Work List Server In Folder” where the DICOM Server will read it and route the study to the correct Modality. This is performed in the background automatically. The DICOM Server will send an .xml file to the “Sound Work List Server Watch Folder” when the study is complete. At this time, AVImark will read from the “Sound Work List Server Watch Folder” and attach the DICOM Image location to the AVImark Medical History record that generated the request. You can identify a Medical History Record that has a completed study by a check in the Radiograph checkbox in the Attachments Window in Medical History.

Once the study is complete, you can view that DICOM Image from the Medical History Entry by either clicking on the Radiograph Attachment option to launch Antech Imaging Services web access viewer.

NOTE: Viewing images will require web access from all workstations intended for viewing.
CHAPTER 38: DOCUMENT MANAGEMENT

The Document Management area allows users the ability to add, remove, update, or switch documents for all treatments, items, diagnoses, and problems from one location.

In this chapter you will learn about...

» Document Management Window on page 437
» Lifelearn on page 441

To launch the Document Management window, select Services, Document Management. This area will default to opening Tx, Items, Dx, and Problems that have document associations.

Document Management Window

- **Load All Codes** – Will load all AVImark treatment, item, diagnosis, and problems codes, including those without associated documents.

- **Load All Lifelearn Documents** *only visible for Lifelearn users* – Will load all Lifelearn documents, including those that are not associated to any treatment, item, diagnosis, or problem.

- **Lifelearn ClientEd Update** *only visible for Lifelearn users* – Will compare your current Lifelearn documents to currently available documents from Lifelearn, and update/replace any necessary. These changes will appear in the Document Management area only, and not applied to the AVImark database until changes are applied. This will allow users the opportunity to make any personalized changes before using the Preview and Apply button to make the changes permanent.
Lifelearn ClientEd Online link *only visible for Lifelearn users* – will launch the Lifelearn site (www.lifelearn-cliented.com).

**Group by** – Will allow you to group the displayed entries by the following methods:

- Species
- Code
- Old Document
- New Document
- Error Code

**Subgroup by** – Will allow you to further categorize displayed entries if a “Group by” option has been selected. These subgroup options are:

- Species
- Code
- Old Document
- New Document
- Error Code

**Validate File Names** – When checked will verify document names in the New Document field before applying. Any document name entered that does not exist in the My Documents folder will cause a warning prompt upon clicking Preview & Apply Changes.

**Document assignment**

- Select a line entry for which you wish to make a document modification.
  - To add a document to an AVImark code with or without a current document displayed in the Old Document field, click in the New Document field, and select the ellipsis.
    - This will open to display the documents contained in the My Documents folder allowing you to make your document selection, and click OK.
    - You will now see your document selection in the New Document column.
  - To remove a document from an AVImark code, click in the New Document field and swipe out the document name.

**NOTE:** If at any time you wish to revert to the document listed in the “Old Document” field, simply click into the Old Document field for that line entry and select the double right arrow. This will reassign the document name as it was prior to the change. However this ONLY applies to changes that have not yet been applied.

**NOTE:** Offending document entries can be easily identified if the Document Management window is grouped or sub-grouped by Error Code. Error code grouping is automatically applied when an error occurs during
• Adding one or multiple species specific documents to an AVImark code can be accomplished, however you cannot add more than one document per species to an AVImark code. For example, your AVImark treatment may have two documents assigned, one each for canine, feline, but cannot have two feline entries.
  ○ To add a species specific document to an AVImark code entry that does not currently have a document attached, select the AVImark line entry, and choose the desired species from the Species drop down list. Then make your document selection to be attached.
  ○ If an AVImark code has a saved document, you cannot change the species assignment for that line entry; however, you can create a new line entry for that AVImark code and make your species association on that new entry.

• To create the new line entry, click into the row labeled “Click here to add a new row.”
• Each field has the ability to enter or select the appropriate information.
  ○ Click into the Code field and type in the exact AVImark code or you may choose to use the ellipsis to open the Select Entry Code window to make a selection.
  ○ From within the Select Entry Code window a list of Treatments, Items, Diagnoses, and Problems can be displayed by entering some or all of description until the desired code is displayed.
  ○ Highlight the entry and click OK. You will be returned to the Document Management window with your Code and Description fields filled on your new row.
  ○ Select the applicable species option from the Species field.
  ○ Select the desired document.
  ○ When all fields are complete, press Enter on your keyboard and your new line entry will be complete.

• Search fields have been added to allow users to locate and display all entries meeting user specified criteria. By clicking on the row labeled “Click here to search” in the field representing the area for which you wish to search, you can enter identifying information. All entries in the Document Management area meeting your search criteria will be displayed. The example below shows I used Declaw as my search criteria in the Description field and the resulting search results.
The “Use asterisk (*) for wildcard” option allows you to match a partial word or description by placing an asterisk before and after the search entry. An example would be you wanted to find all AVImark code descriptions containing allergy or allergies. You could enter *allerg* in the Description column on the Search row, hit the Tab or Enter keys, and all entries in the Document Management window meeting that criteria will be displayed. The below example shows the resulting Lifelearn documents when searching the New Document field for *ALLERG*, when the “Load All Lifelearn Documents” option was used.

<table>
<thead>
<tr>
<th>Species</th>
<th>Code</th>
<th>Description</th>
<th>Old Document</th>
<th>New Document</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>(all)</td>
<td>P05</td>
<td>Allergies</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZA2319</td>
<td>ALLERGIC REACTION</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZA3940</td>
<td>ALLERGY, SUSPECTE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZA6639</td>
<td>ALLERGY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZB4832</td>
<td>BRONCHITIS, ALLERG</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZC2547</td>
<td>COITIS, ALLERGIC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(all)</td>
<td>ZD5865</td>
<td>DERMATITIS, ALLERG</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**LIFELEARN**

The Lifelearn ClientEd Document feature in AVImark allows a more user-friendly application by streamlining document assignment and better access to the most current client handout documents.

For Lifelearn ClientEd purchase information and installation assistance, please contact our MSS Sales department at 877-838-9273, option 2, submenu 4. A member of our Sales Team will assist you with downloading and installing the following files:

The following files will be downloaded and placed in the AVImark directory:

- ArticlesToDP.xtr
- LL05to09
- A Lifelearn subdirectory must be added to your existing My Documents folder within the AVImark directory. It is necessary for this Lifelearn folder to be a **subdirectory to the My Documents** folder. This Lifelearn directory will contain:
  - Lifelearn_ClientEd_Sync.jar
  - Lib folder containing the following two files:
    - appframework-1.0.3.jar
    - swing-worker-1.1.jar

In order to begin using this feature, it is necessary to possess login credentials provided by Lifelearn. These credentials can be obtained by contacting 1-800-375-7994 or sales@lifelearn.com.

**Setup**

In AVImark, you will need to verify the path to the Lifelearn Files Path directory. This can be accomplished by the following:

- Launch Advanced Options, and enter Lifelearn in the Search field.
- Verify the path for the Lifelearn folder. It is important that the Lifelearn folder is a subdirectory of the My Documents folder within AVImark. The path will be simply “LIFELEARN” using the recommended setup.

The Lifelearn Sync tool will be used to activate your integration and sync the complete up-to-date list of Lifelearn Handout documents with your AVImark/Lifelearn directory. Please use the following steps:

- Open the Lifelearn folder located as a subdirectory of your AVImark My Documents folder.
- Locate the Lifelearn_ClientEd_Sync.jar, and double left click on it.
- You will be presented with the Lifelearn ClientEd Sync window.
- Enter the username and password received from Lifelearn in the Lifelearn Account Information fields.
- In the Local Repository section, browse to the Lifelearn folder stored within your AVImark My Documents folder to set the path.
- Select DOC in the File Format field.
- Header provided by Lifelearn ClientEd Online should be selected to allow your hospital header to be printed with each document.
- Press Sync Now. This will sync all current Lifelearn ClientEd documents to your Lifelearn folder.
AVImark Species settings
• It will be necessary to assign your Lifelearn Species to your AVImark Species Table. Please use the available species options found in the Lifelearn Species drop down list in the Change Species window.

Feature use
Lifelearn ClientEd Document Search window – A new area has been provided to allow users the ability to search for the desired Lifelearn document. This window has been made available from multiple locations.

• From the AVImark CID you can access the Lifelearn ClientEd Search and Print utility by using the new Lifelearn Speedbar button.

• The AVImark Print Document window provides a Lifelearn Search button.
• The AVImark Change Item, Treatment, Diagnosis, and Problem windows all have the Lifelearn Search button located in the New Document window of the Documents tab.

![Lifelearn Search Window](image)

• The Lifelearn ClientEd Document Search window offers several search options for locating, sorting, and filtering, Lifelearn documents.

Each of these options are able to be used by entering information in their respective fields. By clicking in a field listed above, the Index search window is automatically updated to display selection options appropriate for that field. Double clicking on an Index menu entry will allow that entry to be added to the chosen field. When entries are selected, click the Search button to display all Lifelearn documents that meet the selected criteria. Multiple entries are able to be selected, however only documents meeting all selected criteria will be displayed. For example, In the Topics field, select Breeding, then select Conditions, and press the Search button. You will only be presented with a list of documents that meet both Breeding and Conditions criteria, instead of Breeding or Conditions.

Once the desired document is found, double left clicking will open the Print window so the document can be previewed or printed.
CHAPTER 39: WORK LIST

AVImark lets you define a Work List of jobs that would typically be assigned to appropriate staff to perform depending upon their abilities. For example: Update medical records; feeding; blood samples; recording vital signs, and so on. This list of jobs is up to you and may be defined in your System Tables. The Work List window is a free floating window that works along side the CID. Also if the Work List is left open and a patient is open on the CID, if the patient is on the Work List AVImark will automatically select the patient on the Work List.

In this chapter you will learn about...

» Accessing the Work List on page 445  
» Toggling Between Lists on page 445  
» Manually Assign a Patient to Work List on page 445  
» Automatically Link a Patient to a Work List on page 446  
» Enter/View Work List Notes on page 446  
» Use the Work List on page 447  
» Posting Work List Entries on page 447  
» Renew a Patient on the Work List on page 447  
» Go to the Selected Patient on page 447  
» Transfer a Patient to Another List on page 447  
» Additional Work List Options on page 448  
» Add Patient to Work List at Check-In on page 448  
» Work Lists More Stuff on page 449

Accessing the Work List
The Work Lists can be accessed by using one of two methods:

• From the CID menu area select Clients, Work Lists. You can then choose the list you want AVImark to display. The shortcut keys Ctrl+Alt+F10 can also be used to open the lists.

• Or in the Patient area, right-click to display the shortcut menu, and point to Lists and click the appropriate Work List name.

Toggling Between Lists
Once a Work List is open you can easily toggle between the lists you have defined.

• In the Work List click on the Work List drop-down arrow and select the list you wish to display.

• Or in the list press Shift+Tab until the Work List field is highlighted. In this field simply type a few characters of the list name you want to display and AVImark will display the list and the associated entries.

Manually Assign a Patient to Work List
You may manually assign a patient to any number of Work Lists so that a staff member may view or print a list of patients on the list(s) that is their job to perform.

• In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List name.
From the Work List window, **right-click** and from the shortcut menu click **New** to include the patient on the list.

**Automatically Link a Patient to a Work List**

AVImark allows you to assign up to three Work Lists Codes to any treatment so that when you perform the treatment, the patient is automatically added to one or more Work Lists. For more information on assigning Work List codes, refer to “CHAPTER 3: TREATMENT LIST”.

**Enter/View Work List Notes**

- With the correct patient highlighted in the Work List window, **right-click** and from the shortcut menu click **Notes** to display the Notes window.
- Enter the notes about the job as related to the patient and click **Done**.
- To view notes in the Work List window, open the **View** menu and click **Preview Text**.
• Click the Notes option and click in the Show Preview Text box.
• After clicking OK AVImark will display the notes directly on the screen.

Use the Work List
• In the Patient area, right-click to see the shortcut menu. Point to Lists and click the correct Work List.

• With the correct patient highlighted right-click and from the shortcut menu click Accept to display the CID for that patient. The Status for the selected patient will be set to In progress.
• After the work is completed, select the correct patient from the list.
• Right-click and from the shortcut menu click Remove to remove the patient from the Work List.
• You will need to click Yes to confirm.

Posting Work List Entries
After a patient has been accepted on the Work List and you have attached notes you might find it beneficial to post the entry to the patients Medical History. This will store the attached notes in Medical History which helps in keeping efficient notes.

• Open the appropriate Work List and select the correct patient.
• Right-click and from the shortcut menu click Post to remove the entry from the Work List and post the notes to the patients Medical History.

After closing the list and opening the patients file on the CID you will see the notes entry displayed in the pets Medical History.

Renew a Patient on the Work List
When a patient has been accepted or removed from the Work List, the patient may be renewed/added back to the list.

If the patient has been accepted:
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.

If the patient has been removed:
• From the Work List window, open the Work List menu and click Show ghost to display the removed patient.
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Renew. The Status for the selected patient will be set to New.

Go to the Selected Patient
You may access any patient that is displayed on the Work List.
• Select the correct patient from the Work List.
• Right-click and from the shortcut menu click Open Patient to display the CID for that patient.

Transfer a Patient to Another List
You may transfer a patient from one Work List to another.
• With the correct patient selected in the Work List window, right-click to see the shortcut menu and point to Change.
• Click on the Work List drop-down arrow and select the Work List you wish to move the patient to.
After clicking OK AVImark will transfer the selected patient to the Work List you had selected.

### Additional Work List Options
The Work List can be customized to fit your needs by utilizing the customizable features and many features have been added to give flexibility when working in a Work List.

- In the desired Work List you can customize the displayed columns by selecting **View, Columns** from the **right-click** menu. Use this option to display or remove columns on the list.
- To select multiple entries highlight an entry and press the Shift key to select consecutive entries or use the Ctrl key to select random entries. You can then Remove, Accept, Post or Renew those entries by selecting the desired option from the **right-click** menu.
- To open the selected patients account open the **right-click** menu and point to Open Patient.

### Add Patient to Work List at Check-In
By utilizing an Advanced Option AVImark will allow you to add a patient to a Work List at the time they are checked in.

**Set up**
Before you set the Advanced Option you will need to open Work With, System Tables and locate the Work List table. Open the Change window of the appropriate Work List entry and make note of the code.

- From the CID select the **Hospital Advanced Options** speed bar icon.
- In the **Search** field type work and select the entry **Add Patient to Work List Code**.
- Once the entry is selected click **Change** under the **Values** tab.
- In the **Value** field type the code of the Work List you want to add the patient to at the time they are checked in.

Once the pet is checked in they will automatically be added to this Work List.
Work Lists More Stuff
AVImark gives you the ability to create Additional Data Fields that can be utilized in the Change Work List window.

Setup
The additional data fields must be defined in System Tables.

- From the CID menu area select **Work with, System Tables**.
- Under the Table area click on the **Additional Data Fields** table and click once on the **Additional Work List Fields** entry.
- To begin creating additional data fields right-click and select **More Stuff Fields** from the menu.
- Enter the desired fields and click **OK** to save them and then click **Done** to close the window.

To have a blank field for typing information you will want to use the type of Phrase when defining the data field.

Using Additional Fields
After the fields have been defined they will appear in the Change Work List window.

- From the CID, **Patient** area open the desired **Work List**
- In the Work List highlight an entry, right-click and select **Change** from the menu.
- The additional field will appear at the bottom of the Change window ready for you to enter the desired information.

By utilizing the Columns feature you can display the defined Additional Data Field as a column on the Work List.
CHAPTER 40: AVIMARK EQ

In this chapter you will learn about...

» Client Selection on page 451
» Hospital Setup Advanced Options on page 452
» System Tables on page 453
» Split Billing on page 456
» Patient Area on page 457
» Microchip ID Prompt on page 463
» Treatment and Inventory List Features on page 463
» Appointment Calendar on page 463
» Word Processing and Documents on page 466
» Hoof Chart on page 466
» Dental Chart on page 468

Client Selection
The ability to search for the patient’s Registration Name or Barn Name can be done by entering one of the names in the Patient field of the Client Selection Window.

- This Registration Name is specified in the Equine tab, Registration tab of the New/Change Patient Information window.
- In the Client Selection window click in the Patient field and enter the appropriate name.

The equine patient fields are searchable through the Information Search feature.
Hospital Setup Advanced Options

Appointment Calendar Options
There are new advanced options added for the Appointment Calendar. These options are:

*Print Directions Separately*
- From the **Advanced Options** maintenance window search for **Directions**.
- Selecting the Option to **Print Directions Separately** and setting the value to **True** will print your directions after printing your appointments for the day.
- If you select **False** it will print them all together.

*Appointment Proximity Searching*
- From the **Advanced Options** maintenance window search for **Proximity**.
- Selecting the option **Use Proximity Searching** and setting the value to **True** will allow you to schedule appointments in the same area at the same time.

*Appointment Proximity Searching Days*
- From the Advanced Options maintenance window search for Proximity
- Selecting the option Number of Days to Search and setting the value to a specific number will allow you to search for the set number of days for appointments in the same proximity as the appointment in which you are making.

*Invoice and Patient Chart*
Additional advanced printing options have also been added.
**Print the Registered Name on Invoice**

- From the **Advanced Options** maintenance window search for **Registered Name**.
- Selecting the option **Print the Registered Name on Invoice**, setting the value to **True** will allow you to print the patient registered name on the Invoice and not the barn name of the patient.
- If no registered name is found, AVImarkEQ will print the pet’s barn name.
- If the value is set to **False** it will print the Barn Name of the patient on the Invoice.

**Microsoft Bing Maps**

Advanced Options have been added for the Mapping Feature.

- From the **Advanced Options** maintenance window search for **Mappoint**.
- Enter the **Mappoint Username** and **Mappoint Password** given to you by an AVImark Equine Technician to define the appropriate information to use with the Mapping feature within AVImark.

**System Tables**

**Markings Table**

A new Markings table in System Tables allows you to add markings for specific areas of the patient’s body.

- Add an entry by **right-clicking** under the Entries for Markings area and select **New**.
- Begin adding the detailed information for the marking. These entries will appear in the Equine tab, Identification sub-tab of the New/Change Patient window where you can select the markings for the animal.
Breed Table
The Breed table will now allow you to access the Equine Registries; from this area you can also access the website of the registries and view registries associated with this breed.

- Select the desired breed and right-click, Equine Registry.

From the displayed window you will be able to define the necessary information for the Equine Registry.
• Next you will right-click, Choose.

• Under the Records for area select right-click, New to define the new information on the equine registry.

Locating Service Table
The Locating Service Table allows the user to place the name of the Microchip company that the patient’s chip is registered with, for example AVID. This information will link into the change patient window on the Equine
tab, Supplemental sub-tab.

- From System Tables select the **Locating Service** Table
- **Right-click** select **New** under the Entries area to begin adding a Locating Service.
- After the appropriate information is entered click **OK** to add the entry.

![Image of System Tables window](image)

**Usage Table**

In order to identify what the animal is used for, such as breeding, barrel racing, trail ride, etc., the user can create entries in the Usage Table then from the Equine tab, Supplemental sub-tab of the New/Change Patient information window identify the appropriate usage for the patient.

- Select the **Usage Table** in System Tables
- From the Entries area **right-click**, **New** to create a usage entry.
- Specify the Code and Description then click **OK**.
Split Billing

Prompt
There are additional split billing options available. You must first define the Ownership details for the patient, as shown below.

- If the client comes in, and they have ultimate authority ownership, and you need to print an invoice for this client you will receive a prompt after printing the first invoice stating “Print Invoices for Split billed Clients”.
- Selecting Yes to the prompt it will print the other clients invoice
- Selecting No to the prompt will not print the second invoice.

This is the prompt that will appear:
There is also a new Action Code which will allow you to split the price of an inventory item or treatment between specific split billed clients. The 6 action code will need to be added to a treatment or inventory item in order to split these prices.

- **Right-click, Change** on a treatment or item in the appropriate lists and assign the 6 action code.
- Enter that treatment or item in a patient’s Medical History.
- You will receive the following window and will press your **Spacebar** to select the patients you would like to split the price between.

**Patient Area**

**Client/Patient Relations**

In the New/Patient window there has been an option added to the Client/Patient Relationship information.

- From this area you can associate the **boarding stable** and or **trainer** in which the patient is located.
- To identify the pet has a relationship with another client select the appropriate Client Relation entry and press the **Spacebar**.
- To use the client/patient relationship feature you must define the relationship entries in System Tables in the Client/Patient Relations table.
Additional options have also been added to the client/patient relationship area of the Patient information window.

- **Right-click** in the Relationship area to select a Default Farrier. When you have selected a Farrier the entry will be shown in **Red** so that you can identify the default Farrier, only one default can be selected.

- From this area you can also **right-click** and select **Go To**, which will open the related clients account you selected.

- Select **right-click, Remove** to remove the client and patient association. This does not remove the Relation entry from the list, it simply dissolves the specified relation.

- Select **right-click option Resides In** to learn the physical location of the patient when making an appointment for them.

You must be utilizing the Mapping feature in AVImark EQ in order to use this function.

- If you **double left-click** on one of the names in the client/relationship area it will display the window shown below. This window cannot be edited, it is designed to allow the user to view the information for that specific Trainer, Stable, or Farrier and it will also list anyone else in your data that is associated with the facility.
When the animal has the species of Equine, you can select the Equine tab that will appear under the Name field. This will allow access to fields where specific information can be defined for the equine pet.

**Registration Tab**

![Registration Tab Image]
- **Registered Name** for the registered name of the patient.
- **Sire** the Sire’s Registration Name.
- **Sire Registration Number**
- **Dam** for the Dam’s Registration Name.
- **Dam Registration Number**
- **Tattoo** if the patient has a tattoo the tattoo number can be entered here.
- **Tattoo Location** will allow you to select from a drop down that contains the options, *upper* and *lower*.
- **Brand Photo** this will allow you to attach a photo of what the animals brand looks like.
- **Brand Type** will allow you to select from a drop-down list that gives the options, **hot iron** or **freeze**.
- **Brand Description** will give you an area to create a brief description of the brand. The Brand Description field will hold up to 255 Characters and will allow you to use the arrows on the keyboard to scroll up and down in this field.

**Breed Window:** listed in this field will be the breed of the animal. In the instance where the animal is a mixed breed you can select multiple breeds for the equine pet.

- By doing a **right-click, New** in this window it will allow you to type in a specific breed.

![New Equine Breed Window](image)

- On the appropriate breed right-click select Primary Breed. This will allow you to specify the primary breed for the animal when it is a mixed breed. AVImark will display the Primary Breed in the Breed field of the Change Patient window and also on the CID, Patient area.

![Equine Registry Window](image)

**Equine Registry Name:** In this area you can have AVImark list the Equine Registries for the breed(s) of the pet. The Equine Registry information is defined in the System Tables, Breed table on the chosen breed.

- To choose an Equine Registry Name directly from this area, **right-click** select **Choose**. This will redirect you to the Equine Registries allowing you to choose the appropriate associated name.
- After displaying the Equine Registry for the breed use **right-click, Change** to enter the **Registry No**
for the registry you have selected.

- From this area use right-click, View Registry to view the Equine Registry information that was defined in System Tables, Breed Table.

**Identification Tab**
Under this tab use the desired fields to click on the drop-down lists and choose the appropriate patient description.

- **Body Color:** Over all body color of the patient
- **Tail Color:** Tail color of the patient
- **Eye Color:** The eye color of the patient
- **Mane Color:** The mane color of the patient
- **Hoof Color:** The color of the patients hoofs
- **Sclera Color:** Considered the white of the eye
- **Body Markings:** Markings on the patients’ body
- **Head Markings:** Markings on the patients’ head
- **Hoof Markings:** Any markings on the patients’ hooves
- **Skin Markings:** Any skin markings the patient may have
- **Left ForeLeg Markings**: Markings that on the patients’ left foreleg
- **Right ForeLeg Markings**: Markings on the patients’ right foreleg
- **Left HindLeg Markings**: Markings that appear on the patients’ left hind leg
- **Right HindLeg Markings**: Markings on the patients’ right hind leg

**Supplemental Tab**

- **Height**: This will allow you to store the patient’s height. The measurement will be displayed in hands or inches. When printing anything that shows the height for the Equine species it will display the height measurement in hands and or inches.
- **Usage**: Required by many states for inclusion in vet records is Usage information. The usage entries are defined in the Usage Table located in System Tables.
- **Locating Service**: This will allow you to select locating service the patient is currently using from a drop-down list. The locating service’s that appear in this drop-down will be defined in System Tables under the Location Table. Below is the entry window that appears in System Tables.

- **Authorized Visitors**: This area is available to list the authorized visitors for the patient. This information will only be visible from the Patient area on the Supplemental tab and will not print in any area of AVImark.
The equine patient fields are searchable through the Information Search feature.

**Microchip ID Prompt**

An action code can be used to auto-prompt a Microchip window when a specific service is added to the pets Medical History.

- From System Tables select the **Location Table**
- Choose **right-click, New** to create the new Locating Service and click **OK**.
- In the Treatment List **right-click, Change** on the desired treatment and assign the [ action code to prompt for microchip.
- Next enter the treatment in Medical History and you will receive the following prompt:

![Microchip ID Prompt](image)

- When you enter the Microchip number you will receive the following prompt:

![Microchip ID Prompt](image)

**Treatment and Inventory List Features**

- You will have the ability to add the 6 action code to any treatment or item in order to split the bill on that specific entry for all the clients which are using the split billing feature.
- A new action code for the Hoof Chart has been added and it is the 8 action code. When associating this code with a treatment or inventory item and adding the service or item into medical history it will attach the Hoof Chart to that entry.
- Associate the 5 action code to a treatment or item and when the service is entered in Medical History AVImark will link a Dental Chart to that entry. You must have the patients species set to Equine for AVImark to display an Equine Dental Chart.

**Appointment Calendar**

**Printing the Schedule**

- With the Hospital Advanced option **Proximity Searching** set to **True** you can schedule appointments
in the same area at the same time.

- When you print out the appointments for a given time frame, it will include the driving directions as well as a map using MapQuest.

- In order to print your directions for your appointments you have to select the option **Include Directions** in the Printing Appointments window. The schedule will have the written directions and the second page will include a map. These Maps can be printed for all species.

- For pets with Client/Patient Relations the directions printed will be based on where the pet resides.
New Patient Appointment Prompt

- When creating a new patient appointment you will now receive an alert in AVImarkEQ that states “New Equine Patient. Remind owner to bring all registration and prior medical information with them to their appointment”.

- The prompt New Appointment Alert for Equine can be defined in Hospital Advanced Options.
  - This prompt will only appear when the patient species is Equine or Horse.
  - When defining this prompt in Advanced Options the value can be set to one of the following:
    - Never, meaning the clinic will disable the feature and will not receive the message;
    - New Appointment will display the message only when creating a new appointment;
    - New Patient, which will display the message only when selecting the New Patient option when creating a new appointment.
**Word Processing and Documents**

New documents have been added into the Equine AVImark program for Equine Clinics along with new merge words. Below is a list of the new merge words that can be utilized in both AVImarkEQ and MSWord and they are used to include equine information:

<table>
<thead>
<tr>
<th>AVImark</th>
<th>MS WORD®</th>
<th>MERGE WORD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;registration-name&gt;</code></td>
<td>registered name of the patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;dam-name&gt;</code></td>
<td>dam’s name</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;sire-name&gt;</code></td>
<td>sire’s name</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;height&gt;</code></td>
<td>height of the patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;locating-service&gt;</code></td>
<td>locating service</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colorb&gt;</code></td>
<td>body color of the patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colorm&gt;</code></td>
<td>patient’s mane color</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colort&gt;</code></td>
<td>patient’s tail color</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colorh&gt;</code></td>
<td>patient’s hoof color</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colore&gt;</code></td>
<td>eye color of the patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;colors&gt;</code></td>
<td>patient’s sclera color</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markingb&gt;</code></td>
<td>patient’s body marking</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markingh&gt;</code></td>
<td>head marking on patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markinghoof&gt;</code></td>
<td>hoof marking on patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markingm&gt;</code></td>
<td>patient’s motting marking</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markinglft&gt;</code></td>
<td>left fore leg marking on patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markingrft&gt;</code></td>
<td>right fore leg marking on patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markinglhl&gt;</code></td>
<td>left hind leg marking on patient</td>
</tr>
<tr>
<td>❗️</td>
<td>❗️</td>
<td><code>&lt;markingrhl&gt;</code></td>
<td>right hind leg marking on patient</td>
</tr>
</tbody>
</table>

**Hoof Chart**

**Accessing the Hoof Chart**

The Hoof Chart can be accessed from the CID, in the Medical History area under the Attachments section.

- Highlight an entry and click the **Hoof Chart** Attachment option.
- The action code 8 will allow you to have the Hoof Chart automatically opened when entering a treatment or inventory item into Medical History. This action code will be selected in the Treatment or Inventory list.
• When printing the Hoof Chart you will have the option to select which hoof(s) you would like to print on the Hoof Chart. The Hoof Chart will include the Farrier information no matter what pages you have selected to print.

Hoof Chart Tabs
The Hoof Chart will show 4 tabs and these tabs will include information about each hoof. The 4 tabs are named Left Front, Left Hind, Right Front and Right Hind.

The information held on each tab is listed below:

• **Radiograph Date** – date radiograph taken
• **Collected Date** – date of data collected
• **Wire Length Actual**
• **Wire Length Radiological**
• **Angle S** - Dorsal Wall Angle
• **Angle T** - P-3 Angle
• **Angle U** - Phalanx Angle
• **Angle of Distal Phalanx Rotation** - Angle T minus Angle U
• **Angle of Hoof Capsule Rotation** - Angle T minus Angle S
• **(L) Palmar Cortex** - Distal Phalanx Distance
• **Corrected for Magnification**
Dental Chart
The Dental Chart has been modified for the Equine species and this image is an example of how the Equine Dental Chart will appear.

The Dental Chart abnormalities have also been replaced with the following abnormalities:

- **SP**: Sharp enamel Points
- **BI**: (L, A, or U): buccal injury (laceration, abrasion, and ulcer)
- **LI**: (L, A, or U): lingual injury (laceration, abrasion, and ulcer)
- **CH**: crown hook
- **BK**: beak
- **RP**: ramp
- **Sp**: step
- **Wa**: Wave
- **ETR**: excessive transverse ridge
- **Cup**: cup in central portion of crown
- **TC**: tall crown
- **PD**: periodontal pocket
- **Fx**: fracture
- **CAL**: calculus
- **DT/R**: deciduous root silver or fragment
- **CA**: cavity
• SN: supernumerary tooth
• O: missing tooth
• WC: worn crown
• ROT: rotated
• X: extraction
• (WT) Wall thickness Radiological
• Corrected for Magnification
• (D) Founder Distance
• Corrected for Magnification
• (F) Frog Plate Placement Calculation
• Corrected for Magnification
INDEX

A

Abaxis VetScan 354
Abaxis VS2 356
Accounting
   Age the Client’s Account 109
   Capturing Signatures for Credit Card Payments 157
   Closed Invoice 109
   Debit Card Payments 158
   Enter a Payment on Account 107
   Open Invoice 109
   Reprint an Invoice 156
   Return a Check 111
   Return an Item 157
   Transfer Invoices 159
   Undelete Accounting 110
   View Client Stats 109
   View/Print the Client’s Accounting 108
   X-Charge 157
Action Codes
   Client 101
   Diagnosis 179
   Inventory 63
   Patient 115
   Problem List 191
   Treatments 43
Add a New Client 98
Additional Data Fields
   Add data fields 304
   Clients/Patients 303
   Create New Generations 310
   Data Table 308
   Enter Information 310
   Name 305
   Normals Minimum & Maximum 307
   Normal Values 307
   Options 306
   SOAP Records 309
   Treatments 307
   Type 305
   Whiteboard 309
Add New Medical History 145
Add Staff Members 271
AFP Imaging 404
Age the Client’s Account 109
Alerts
   Client 104
   Patient 130
   Show Alerts 20
Appointment Calendar 227
   Adding Services to an Appointment 234
   Appointment Calendar Views 224
   Appointment Facilities 33
   Appointment Notes 237
   Appointment Openings 233
      Email Appointment Openings 234
      Print Appointment Openings 234
   Automatically Schedule Next Appointment 240
   Block-off Exceptions 245
   Creating Appointments 231
      New Appointment Window 234
      Next Patients Appointment 235
      Reminders 235
   Customizing Appointment Rows and Columns 239
   Daily (ad-hoc) block-offs 244
   E-mail Appointment Schedule 242
   Export Appointment Schedule to Excel 242
   Grouping Appointments 233
   Link Appointments 232
   Move Appointments 240
   Patient Check In 239
   Print Appointment Schedule 241
   Quick Edit Window 241
   Recurring Appointments 237
   Removing an Appointment 239
   Reschedule Appointments 241
   Save Appointment Schedule 242
   Scheduled Block-offs 242
   Toolbar buttons 228
   Appointment Calendar Setup 16
      Always Show Ghosts 17
      Appointment Time Incrments 16
      SOAP Check-in code 17
      Start and Stop Times 16
   Appointment Time, Treatments 46
   Auditing 20
   Audit Trail 31
   Authorize User Functions 276
   AVImark Compliance with the FACTA Red Flags Rule
      278
   AVImark EQ 439, 444
      Appointment Calendar 451
      Client Selection 439
      Dental Chart 456
      Hoof Chart 454
      Hospital Setup Advanced Options 440
      Identification Tab 449
      Microchip ID Prompt 451
      Microsoft Bing Maps 441
      Patient Area 445
      Registration Tab 447
      Split Billing 444
      Supplemental Tab 450
      System Tables 441
Treatment and Inventory List Features 451
Word Processing and Documents 454

B

Backing Up
  Drive, Destination 333
  Files to Include 334
  Formatting Medias 334
  Making a Back Up 333
  Verify Back-up 334
Billing document, Statements 9
Block-off Exceptions 245
Boarding Calendar 247
  Add Boarding Facilities 251
  Add Facility Groups 249
  Add Services to a Check-In 255
  Boarding Calendar Views 248
  Change a Check-In 255
  Change Boarding Reservations 251
Charge for Boarding 247
Check-in an Out-Patient 255
Choose Facility 253
Choosing a Client from Boarding 252
Create a Reservation 251
Creating New Patient Reservation 252
Patient Check-In 254
Patient Check-Out 256
Remove a Check-In 256
Boarding Calendar Setup 16
  Boarding Check-out time 17
  Charge for Boarding 18
Breed and Color Tables 32

C

Cash Drawer 24, 155
CDC Hemavet 357
Change Maker Window 4
Change Passwords 275
Check-in Document 11
Choose facility, Boarding Calendar 248
CID 91, 94, 95, 215, 218, 283, 284, 285, 395
CID Menus
  Applications Menu 93
  Clients Menu 91
  Help Menu 93
  Utilities Menu 93
  Work With Menu 92
CID Speed Bar Buttons 94
Client Area 94, 97
Action Codes 101
Add a New Client 98
Add Client Alerts 104
Change Client Information 98
Client Mailing Label 111
Client Notes 103
Client Selection Window 97
Closed Invoice 109
Create a Pre-Invoice 110
Delete a Client 103
Dial the Client's Phone Number 111
Enter a Payment on Account 107
File Attachments 104
Folder Number 102
Handle Over-the-Counter Sales 107
Invoice Instructions 105
Open a Client's File 97
Open Invoice 109
Photo 105
Reprint a Client Statement 111
Return a Check 111
View/Print the Client's Accounting 108
Clinic Logo 2
Clinic Slogan 2
Clinic Website 2
Clocking In 283, 285
Clocking Out 284, 285
Clock out 285
Clock Out Reasons 32
Closed Invoice 109
Company Table 32
Contract Prices
  Inventory 69
  System Tables 32
  Treatments 53
County Table 33
Create and Run a Search 316
Create a New Document 297
Create a Pre-Invoice 110
Create a Reminder 167
Create Purchase Orders 83
Customizing Columns 349
Add a Column 349
Advanced Tab 350
Caption 350
Group by Panel 350
Remove a Column 349
Rename Columns 350

D

Daily (ad hoc) block-offs 244
Debit Card Payments 158
Decline Medical History 148
Delete a Document 298
Dental Abnormalities 403
Dental Annotations 402
Dental Chart 399, 456
Critical 327
Due date 327
Entry History 329
Follow-up List 328
Patient Follow-up 124
Post Follow-ups 329
Print the Follow-up List 330
Remove a Follow-up 329
Repeat 327
Treatment Follow-ups 52
Forcyte 373
Forms 47, 149

G
Gingival Recession 401
Graphing Setup 25
Graphs, Inventory 74
Graphs, Treatments 55
Graph Vital Signs 204
Group Appointments 233

H
Handling fee, Statements 8
Health Plans 33, 299
Help Menu 93
Hemagen Analyst 358
Heska CBC-Diff 364
Heska/Scil Vet ABC 361
Heska Spotchem EZ 362
Hoof Chart 454
Hoof Chart Tabs 455
Hospital Information 1
Hospital Setup Advanced Options 26

I
IDEXX LaserCyte 367
IDEXX VetTest 366
Information Search
   Access the Information Search Display 313
   Create and Run a Search 316
   Create a Sample Search 323
   Modify an Existing Search 325
   Omit Information 325
   Print and E-mail Results 321
   Print the Criteria 324
   Save a New Search 321
   Search Library 313
Instructions
   Client Invoice Instructions 105
   Patient Invoice Instructions 132
   Interface with the Heska DCU 365
   Interface with the IDEXX® LabREXX 371
   Inventory
   Action Codes 63
   Add a duplicate item 73
   Add an Inventory Item 62
   Add items to the Need List 73
   Add or change an Inventory Category 59
   Add Vendors 82
   Contract Prices Tab Values 69
   Create Purchase Orders 83
   Documents Tab Values 69
   Drug label 74
   Entry History 73
   Inventory Colors 61
   Inventory Report 81
   Inventory Summary Report 82
   Mark up 75
   Mark up Percent 67
   Markup Percentage 60
   Mixture items 77
   Move to Treatments 61
   Notes 77
   On Hand Quantity 63
   Pharmacy Tab Values 70
   P/O History 78
   Price History 78
   Printing the Vendor List 82
   Purchase Order History Report 82
   Purchasing Tab Values 71
   Purge Orders 85
   Reminder 78
   Remove an Inventory Category 61
   Reorder Report 82
   Report Codes 60, 65
   Sales Tab Values 72
   Travel Sheet 81
   Units of Measure Table 34
   Update Inventory Sales 82
   Variance 79
   Variance Reasons 34
   Whiteboard Tab Values 72
   Whogot list 80
Invoice
   Change Posting Date 154
   Enter a Payment 154
   Make Change 155
   Print an Invoice 156
   Use a calculator 156
Invoice Number 4
Invoice Values 3

L
Lab Instruments
   Abaxis HM II Settings 355
   Abaxis VetScan Chemistry 355
QuickBooks Accounts 345
Set up AVImark 345
Set Up QuickBooks 345
View the Exported File 346
QuickBooks Account Number
  Inventory Category 60
  Treatment Category 39, 178, 190
QuickBooks Accounts 33

R
Rabies assignment 19
Rabies certificate 12
Rabies certificates 20
Rabies Vaccination Prompt 19
Recurring Appointments 237
Referrals 33, 101
Refill a Prescription 149
Refill Control Fields 207
Refill Prescriptions 207
Release a Patient 259
Remind as 52, 69
Reminders
  Apply All Reminders 171
  Apply a Single Reminder 170
  Create a Reminder 167
  Diagnosis 186
  E-Mail Reminders 176
  Healthy Pet 174
  Inventory 78
  Patient Specific Reminders 171
  Patient to be treated 168
  Paw Print 174
  Pet Quarterly 174
  Print Reminders 172, 175
  Print Reminder Templates 170
  Problems 192
  Remind if never treated 168
  Show in Vaccine History 168
  Treatments 56
  US NetCom 174
Reminders Folder, CID 122
Report Codes 46
  Inventory 65
  Treatments 38
Report Name
  Inventory Category 61
  Treatment Category 39
Reports
  Account Summary 266
  Audit Trail 266
  Bottom Line 265
  Controlled Substance 266
  Deposit Slip 266
  Health Plan 266
  Held Check 266
  Income by Provider 266
  Income by Treatment Summary 266
  Open Invoice 267
  Open Period 264
  Patients by Treatment 267
  Payment Summary 267
  Period Totals 267
  Print by closing 264
  Print by Report Code 265
  Print to Excel 264
  Rabies Report 267
  Referral Report 268
  Sales Summary 268
  Tax by Area 268
  Transaction Journal 268
  Transaction Summary 268
  Treatment Control Log 268
  Unposted Transactions 269
  Reprint a Client Statement 111
  Reprint an Invoice 156
  Reschedule Appointments 241
  Restore Data 334
  Return a Check 111
  Return an Item 157
  Returned Check Fee 4
  Rule-Outs 194

S
Schedule Folder 126
Search for a Client File 97
Security
  Add Staff Members 271
  Add User Categories 272
  Authorize User Functions 276
  Auto-logoff 272
  Change Passwords 275
  Logging in to AVImark 278
  Marking Employees Inactive 273
  Remove Authority 277
  Setting Passwords 273
  Track Overtime 274
  User Appears on Appointment Calendar 274
  User Appointment Groups 274
  User Clocks In 274
  Service charge, Statements 8
  Sex, Treatment Specific 46
  Sidekick 337
  Import Data 337
  Install AVImark on Laptop 337
  Refresh Data 338
  Site 389
Central Hospital Requirements  389
Satellite Hospital Requirements  389
Separate Appointment Calendar  392
Separate Tag Numbers  392
Set Up Site  389
Site Manager  390
Site Options  392
Slogan  391
Synchronize Company Numbers  392
Treatment and Inventory List  391
Users and Security  389

Species
  Diagnosis Specific  182
  Item Specific  68
  Problem Specific  191
  Setup Species  34
  Treatment Specific  47

Split Billing  444

Statements
  Apply service charge  162
  A/R Summary, Credit Balances  164
  A/R Summary, Inactive Clients  164
  A/R Summary Report  163
  Collection Letters  164
  Open Invoices  162
  Print For One Client  161
  Print Statements  161
  Reprint a Client Statement  111
  Reprint Statements  163
  Undo Statements  162

Statement Values  8
System Tables  92, 284
  Add a New Table and Table Entries  284
  Add a New Table and Table Entries  30

  Allergy Table  31
  Antech Profile Names  31
  Antech Test Names  31
  Appointment Groups  31
  Audit Trail Table  31
  Breed and Color Tables  32
  Clock Out Reasons  32
  Contract Prices  32
  Special Fees Table  34
  Tax Table  34

T

  Tax Values  4
  Time Card  285
  Time Clock  283
    Clocking In  283
    Clocking Out  284, 285
    Clock Out Reasons  284
    Display the Time Card  284

  Email the Report  286
  Entry History  287
  Export Report to Excel  286
  Setup the Time Clock  283
  Synchronize Clocks  284
  Time Card Report  285
  Track Hourly Staff  284
  Track Overtime  285
  Undo and Redo Time Card Changes  286
  Work with the Employee Time Card  285
  Track Overtime  274, 285
  Transfer Invoices  159
  Treatment Protocol  186
  Treatments  37
    Add a Treatment  42
    Add or Change a Treatment Category  38
    Contract Prices Tab Values  53
    Cost  46
    Create a Treatment Group  53
    Discount Class  46
    Documents Tab Values  53
    Entry History  55
    Follow-up  52
    Laboratory Tab Values  54
    Linking Items to Treatments  50
    Link Treatments/Diagnosis/Problems  50
    List Codes  46
    Move treatments  55
    Price History  56
    Print Graphs  55
    Print the Treatment List  57
    Remind as  52
    Reminders  56
    Remove a Treatment Category  39
    Travel Sheet  58
    Treatment Tab Values  43
    Undelete a deleted treatment  57
    Whiteboard Tab Values  54
    Whogot list  56

U

  Undelete a Patient  127
  Undelete a Treatment  39
  Undelete Medical History  147
  User Appears on Appointment Calendar  274
  User Appointment Groups  274

V

  Vaccination History  118
  Vaccine Table  34
  Variance  79, 144, 217
  VDIC VetMedStat  381
  Verify Back-up  334
VetConnect 379
VetEnvoy® eClaim Integration 457
Insurance Sales Lead Status 463
Message Handling 463
Processing Claims 457
Setup 457
VetScan Chemistry 354
View/Print the Client’s Accounting 108
Vmed Technology 384
VPR Formulary 88
Accessing VPR 88
Assigning VPR Drug Codes to Items 89
Using the Formulary 89

W
Weight Surcharge 52
Whiteboard 257
Access Additional Data Fields 262
Adding Estimate to Whiteboard 262
Add Services to Schedule Tab 258
Appointments Tab 257
Boarding tab 258
Check a Patient Out 259
Create Additional Data Fields 261
Expand a Treatment Group 261
Patient Check-In 257
Post Services from Schedule Tab 259
Print Census 259
Print Scheduled Activities 260
Print the Reservations 259
Release a Patient 259
Sort Whiteboard Entries 261
View Patient Activities 258
Whiteboard Categories 35, 260
Whiteboard Categories 61
Treatments 39, 178, 190
Whiteboard Layout 259
WhoGot List 152
Inventory 80
Problem List 193
Treatments 56
Windows date format 21
Word Processing
Create a New Document 297
Delete a document 298
Merge Words 289
Merge Words for Additional Data Fields 297
Work List 133
Work List Codes 181
Work Lists Table 35
Work with Graphs 396
Work with Requisition Management 379

X
X-Charge 157
X-Charge Setup 26

Z
Zip Code Table 35